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ABOUT THIS MANUAL 

New users are recommended to follow this manual in order, as each 
section builds on the information introduced in previous sections.  Check 
the glossary in the back of this manual for quick explanations of unfamiliar 
terms.  An index has also been included for your convenience. If you 
would like an overview of the essential NEXUS series (NEXUS, 
UltraNEXUS, UltraNEXUS-SDI) information, refer to the booklet of quick 
guides included with your NEXUS series server/controller.      

First Time Install Checklist 

Not sure where to start?  The following checklist provides the bare bones steps 
necessary to get your NEXUS series system up and running.   

 TASK 

Install NEXUS series system (for an overview, refer to the UltraNEXUS/NEXUS 
Installation Quick Guide or, depending on your product model, UltraNEXUS-SDI 

Installation Quick Guide): 

 
1. Connect NEXUS series signal wiring (see “Connecting 

NEXUS/UltraNEXUS Signal Wiring,” on page 60 or “Connecting 
UltraNEXUS-SDI Signal Wiring,” on page 65). 

 Route video/audio sources to switcher input connectors. 

 Route destinations (such as modulators or televisions) to switcher 

output connectors. 

 Set up video/audio sources to receive NEXUS series control commands 

via PRO-BUS, integrated IR, or DVply, as appropriate. 

 Attach storage devices to NEXUS series system. 

NOTE: LEIGHTRONIX requires the use of two USB hard drives with 
an UltraNEXUS/UltraNEXUS-SDI combined with the 

LEIGHTRONIX PEG Central streaming video-on-demand 
service. 

 
2. Connect UltraNEXUS-SDI/UltraNEXUS/NEXUS to an Ethernet TCP/IP 

network (see “Configuring Ethernet Network Host Management,” on page 

72). 

 
3. Enter TCP/IP addresses into the NEXUS series system’s front panel (see 

“Configuring Front Panel Settings,” on page 76). 
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 TASK 

Install & Configure the NEXUS series control software, WinLGX (for an overview, 
refer to the WinLGX Installation & Configuration Quick Guide): 

 
4. Load WinLGX software on a PC (see “Installing WinLGX Software,” on 

page 85). 

 
5. Add your NEXUS series server’s IP address to the “Locations” database 

(see “Adding / Deleting NEXUS Locations in the Site Manager,” on page 
89). 

 
6. Log into WinLGX (see “Connecting to Your NEXUS Series 

Server/Controller,” on page 93).   

 
7. Create user accounts and assign rights (see “Setting User Account Rights 

(Including WinLGX Password Changes)” on page 110). 

 
8. Set time zone and clock (see “Configuring Site Information, Clock, 

Updating Firmware, and Rebooting,” on page 114). 

 
9. Configure the NEXUS series server/controller’s system properties (see 

“Configuring the Switch Type of a NEXUS Series System,” on page 136) 
and IR ports (see “Configuring NEXUS Series IR Port Properties,” on page 

151). 

 
10. Configure the following device properties: 

 Internal (see “Configuring Broadcast MPEG Recording Presets,” on 

page 152 and “Editing Internal MPEG Player and Recorder Device 
Resource,” on page 155)  

 External (see “Creating External Device Resources,” on page 160) 

 
11. Check PRO-BUS interface, IR port, DVply, and switcher wiring by sending 

a command to each device from the control panel as follows: 

a. Select a device controlled by a PRO-BUS interface, IR port, or DVply in 
the left-hand “Device” column on the control panel window. 

b. Send a command to the selected device from the “Device control” 
section of the control panel and ensure the device itself responds 
accordingly (see “Using Control Panel to Perform Immediate Device 

and Switch Actions,” on page 306). 

NOTE: To check video quality, switch your device to an output 
connected to a monitor.   
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 TASK 

 
12. Upload slides to the NEXUS series user folders through the WinLGX 

Storage Manager window (see “Managing all Digital Files,” on page 330) or 
WebNEXUS (see “Uploading Slides to a NEXUS Series Server/Controller,” 

on page 370).   

NOTE: Slides are activated for display through the WinLGX 

schedule or control panel. 

 
13. Create device media and switch library resources under the “Library” tab 

(see “Creating Library Resources,” on page 177). 

 
14. Save your system configuration settings and resources in a NEXUS image 

file (see “Saving NEXUS Series Image Files,” on page 225). 

Use WinLGX to control the NEXUS series system (for an overview, refer to the 
WinLGX Scheduling Quick Guide): 

 
15. If not already open, load a NEXUS series image file with your system 

configuration settings and resources (see “Opening NEXUS Series Image 

Files,” on page 220). 

 
16. Control NEXUS series system through either of the following: 

 Create & execute a schedule. 

 Immediately control devices through control panel. 
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INTRODUCTION 

Each of the LEIGHTRONIX NEXUS 
series server/controllers combines 

digital video server technology, DVD 
and VCR control, and digital video 
messaging in one rack-mountable 

chassis.  Each NEXUS series system 
provides fully integrated digital video 

recording and dual channel playback, 
while still supporting legacy 
equipment.   

Both the UltraNEXUS-SDI and 
UltraNEXUS include a second encoder 

that records digital video programming 
for use in LEIGHTRONIX Internet 
video-on-demand streaming.  The dual 

encoders streamline your workflow, 
eliminating the need to convert 
broadcast resolution programming into 

Internet-ready videos.  NEXUS owners 
have the option of upgrading to an 
UltraNEXUS.  Contact LEIGHTRONIX 
for more information. 

 Provided with each NEXUS series 
system is WinLGX, a software application 
with a programmable database of events 

for unattended, automated control.  When 
a NEXUS series server/controller “sees” a 
match between the current day and time 

and a programmed event, the event is 
executed. 

 

 

 

 

 

 

The UltraNEXUS includes all of the standard 
NEXUS server/controller features plus a 

second encoder just for Internet programming. 

The popular NEXUS video server/controller is the 

all-in-one solution for television broadcasting. 

WinLGX User Interface 

The UltraNEXUS-SDI offers high-quality, SD-
SDI video and AES or analog audio recording 
and playback. 
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Your LEIGHTRONIX NEXUS series server/controller is designed to be used in a host 
of different applications, including the following: 

 AUTOMATED PROGRAM BROADCASTING 

NEXUS series server/controllers are intended for automated program 
broadcasting throughout the cable television and broadcast industry on locally 
originated cable television channels such as public access, educational access, 

government access, and leased access.  The NEXUS series server/controllers 
are also ideal for private in-house networks in hospitals, hotels/resorts, 
corporations/industries, and colleges. 

 VIDEO-ON-DEMAND STREAMING— ULTRANEXUS-SDI & ULTRANEXUS ONLY 

When their second encoders are enabled, the UltraNEXUS-SDI and UltraNEXUS 

automatically create secondary digital media files optimized for video-on-demand 
streaming during every recording session.  The optimized media files are 
automatically transferred to PEG Central, the web media hosting and streaming 
video-on-demand subscription service from LEIGHTRONIX.  

 

 UNATTENDED PROGRAM RECORDING 

NEXUS series server/controllers are well suited for use in satellite and network 
recording.  With a NEXUS series server/controller, you are able to switch to the 

proper satellite at the desired time in order to capture the programming you need 
for your operations. 

NEXUS series server/controllers may also be used for playback verification and 
program archiving.  
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 DIGITAL VIDEO MESSAGING 

 The NEXUS series server/controllers have 

integrated digital video messaging systems, 
allowing you to complement program playback 
with your own slide shows, graphic/text 
program overlays, program guides, and 

emergency messages.  Take advantage of the 
optional LEIGHTRONIX TOTAL INFO dynamic 
video content service to display current 

weather, news, traffic, sports, and 
entertainment information on your channels, as 
part of your playback schedule or in place of 
regular programming.   

 

 

  
 

   

The TOTAL INFO dynamic video content 
service from LEIGHTRONIX allows you to 
display current news, sports, weather, 
entertainment, and traffic information on 

your television channels. 

Program Guide 

Graphic/Text Overlay 

Slide 
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IMPORTANT SAFETY INSTRUCTIONS 

1. Read these instructions. 

2. Keep these instructions. 

3. Heed all warnings. 

4. Follow all instructions. 

5. Do not use this apparatus near water. 

6. Clean only with dry cloth. 

7. Do not block any ventilation openings. Install in accordance with the manufacturer’s 

instructions. 

8. Do not install near any heat sources such as radiators, heat registers, stoves, or 

other apparatus (including amplifiers) that produce heat. 

9. Do not defeat the safety purpose of the grounding-type plug. A grounding-type plug 
has two blades and a third grounding prong. The third prong is provided for your 

safety. If the provided plug does not fit into your outlet, consult an electrician for 
replacement of the obsolete outlet. 

10. Protect the power cord from being walked on or pinched particularly at the plugs, 
convenience receptacles, and the point where they exit from the apparatus. 

11. Only use attachments/accessories specified by the manufacturer. 

12. Unplug this apparatus during lightning storms or when unused for long periods of 

time. 

13. Refer all servicing to qualified service personnel. Servicing is required when the 

apparatus has been damaged in any way, such as power-supply cord or plug is 
damaged, liquid has been spilled or objects have fallen into the apparatus, the 

apparatus has been exposed to rain or moisture, does not operate normally, or has 
been dropped. 

14. When the apparatus is turned off, certain components in the power supply and 
system board remain energized. In order to remove all electrical power from the 

apparatus, unplug the power cord from the MAINS socket outlet. 
 

 
WARNING 

To reduce the risk of electric shock, do not expose this apparatus 

to rain or moisture. 

 

 
WARNING 

This apparatus must be connected to a MAINS socket outlet with a 
protective earthing connection. 
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NEXUS SERIES TECHNICAL SPECIFICATIONS 

NOTE: In no event shall LEIGHTRONIX be liable for any damages whatsoever 

resulting from loss of use, data, or profits, whether or not advised of the 
possibility of damage, and on any theory of liability, arising out of or in 
connection with the use or performance of a NEXUS series server/controller 
and the WinLGX software. 

DIMENSIONS AND WEIGHT 

 Dimensions:  3.50"H X 19.00"W X 15.00"D 

 Weight, without carton or cables: 

 NEXUS/UltraNEXUS: 17 lbs. 

 UltraNEXUS-SDI: 15 lbs. 

FRONT PANEL 

 Display:  2 X 24 character vacuum fluorescent display 

 Status LEDs:  four light-emitting diodes (LEDs) provide status on valid video 
signal, schedule activity, network management, and logging. 

 Keypad:  four push buttons which allow password protected front panel status and 
configuration 

BACK PANEL 

 Power Input/Supply:  three-position IEC power input with removable power cord; 
uses internal “ATX” style, 200W power supply which accepts 90–264VAC @ 47–

63Hz; power rating of 100 Watts 

 Infrared (IR) Control Ports:  four IR mini-jack device control ports are built into 

each NEXUS series server and may be configured to operate with a variety of DVD 
and videotape equipment. 

 DVply Ports:  2 DB9M RS-232 device control ports provide random disc access 
with title:chapter selection for two commercial grade DVD players. 

 COM Ports: 2 communication ports with 9-pin male RS-232 DTE connectors, with 

COM 1 for use with supported external routing switchers and COM 2 for use with 
supported master clocks 

 PRO-BUS Port:  six-position/six-conductor modular port connects to LEIGHTRONIX 
proprietary interface control buses for versatile device control solution. PRO-BUS 

device control interfaces are available for popular VCRs, DVD players and 
recorders, and GPI devices. 

 Ethernet Port 1:  eight-position/eight-conductor RJ-45 modular Ethernet Port 1 
provides a high speed 10/100/1000BASE-T Ethernet connection to a TCP/IP 

network with user-configurable IP address, subnet, and gateway. 
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 Ethernet Port 2:  eight-position/eight-conductor RJ-45 modular Ethernet Port 2 

provides a high speed 10/100/1000BASE-T Ethernet connection to a private, local 
media storage network using the TOTAL SHARE option. 

 USB Ports:  local digital media storage via four USB 2.0 ports allows configuration 
of up to one terabyte for a NEXUS and four terabytes for an 
UltraNEXUS/UltraNEXUS-SDI of local media storage on approved external hard 

drives. 

 Video Inputs/Outputs (I/O): 

 UltraNEXUS-SDI:  

o 1 digital video input (record) 
o 2 digital video outputs (playback) 
o SD-SDI digital video 

o SMPTE 259M-C 

 UltraNEXUS/NEXUS: 

o 6 BNC video inputs 
o Video inputs 7 and 8 internally tied to MPEG Players 1 and 2, respectively 
o 3 BNC video outputs 

o NTSC composite video 1V P-P 
o Active switching 
o Unity gain 

 Audio Inputs/Outputs (I/O): 

 UltraNEXUS-SDI:  
o AES3 Digital Audio (IEC 60958 Type 1 Balanced): 2 AES input tension clamp 

pairs on two terminal block audio inputs and 2 AES output tension clamp 
pairs on two terminal block audio outputs 

o Balanced Two Channel Analog: 4 analog tension clamp pairs on two terminal 

block audio inputs and 4 analog tension clamp pairs on two terminal block 
audio outputs 

 UltraNEXUS/NEXUS: 

o 6 dual RCA audio inputs 
o 3 dual RCA audio outputs 

o -10dBV unbalanced line level 
o Unity gain 

VIDEO STANDARD 

NTSC, standard definition, 4x3 aspect ratio 

VIDEO ENCODING 

 UltraNEXUS-SDI:  
 MPEG-2, full D1 resolution 
 3-10Mb/s variable bit rate encoding 

 3-8Mb/s constant bit rate encoding 

 UltraNEXUS/NEXUS: 
 MPEG-2, full D1 resolution 
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 MPEG-2, half D1 resolution 
 1.5-10Mb/s variable bit rate encoding 

 3-8Mb/s constant bit rate encoding 

AUDIO ENCODING 

 MPEG-1 layer II 

 44.1 khz and 48 khz sampling rates 

 192kb/s, 224kb/s, and 256kb/s audio bit rates 

 Maximum individual MPEG program length of 23 hours, 59 minute 

VIDEO FILE STORAGE 

Configure file storage capacity with up to four external USB hard drives purchased 

from LEIGHTRONIX.  LEIGHTRONIX formats each drive with a FAT32 file system and 
an MPEG file directory. 

Each USB drive used with a NEXUS series system must be:     

 Only used to store MPEG files 

 Powered on until the NEXUS series system is shut down from its front panel 

 Only removed or installed after the NEXUS series system is shut down from its 

front panel.  Do not connect the drives to a PC for file management 
operations.  

The server/controllers support the following total USB drive storage capacities: 

 UltraNEXUS-SDI / UltraNEXUS: 4 TB 

NOTE: LEIGHTRONIX requires the use of two USB hard drives with an 

UltraNEXUS-SDI / UltraNEXUS combined with PEG Central or other 
LEIGHTRONIX streaming service. 

 NEXUS: 1 TB    

For more information on using USB drives with a NEXUS series system, refer to 

www.leightronix.com or contact LEIGHTRONIX at (800) 243-5589. 

See “MPEG Recorder Specifications,” on page 38, for information on MPEG recording 
rates. 

INTERNAL REAL TIME CLOCK 

 Type:  microprocessor interfaced 

 Reference:  crystal controlled 

 Accuracy:  +/- 5 seconds per month 

INTERNAL STORAGE 

 Internal battery-backed memory 

 Data integrity verified 

 Elements: 

 IP address 

 Subnet mask 

http://www.leightronix.com/
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 Gateway 
 Time clock parameters 

 User information 

 Log files 

 Slides/Overlays 

FIRMWARE 

 Updateable via Ethernet 

 Cycle redundancy check (CRC) verified at time of reprogram 

WINLGX MANAGEMENT AND CONTROL SOFTWARE 

 Compatible with Windows® 2000/XP/Vista/7 operating systems 

 Event Capacity: 3,000 

 Control modes: 

 Drag and drop event scheduling with error/conflict reporting 

 System control panel for immediate control 

 Library stores up to 2,000 resources, including: 

 MPEG video files 

 JPEG slides 
 Slide show: initiates automatic sequence of selected slides 
 PNG overlays 

WEBNEXUS WEB CONTROL INTERFACE 

 Connect to your NEXUS series system’s web interface through popular web 
browsers, including Chrome and Internet Explorer  

 Password protected with user rights maintained from WinLGX 

 Obtain system status and USB storage drive information, upload slides to the 

NEXUS series system’s internal flash drive, configure slides for display in slide 
shows, activate emergency messaging, create and save Virtual Channel playlists, 
view log files, record and manage MPEG files 

 UltraNEXUS-SDI/UltraNEXUS only: enable/disable VOD encoder and control 
automatic file transfer destinations 
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LIMITS ON CONTROL OF DVD PLAYERS 

The LEIGHTRONIX NEXUS series provides three different types of DVD automation 
control: 

 Integrated DVply: RS-232 with full random-access DVD control, including title 

and chapter cuing for select commercial DVD models 

 Integrated IR: built-in infrared control ports with basic play-stop DVD player 

control and play-stop-record control for select player/recorders 

 PRO-BUS: optional device control interfaces for infrared and wired remotes 

provide basic play-stop DVD player control and play-stop-record DVD 
player/recorder control for select DVD players/recorders 

Despite our best efforts, some operational functions are beyond our control.  Even with 

the power of DVply control interfaces, some DVDs possess formatting that prevents 
cuing to specific disc titles and chapters. The control method and protocol utilized by 
the DVD player can also impact control of DVD playback. 

 
The following sections discuss some of the limits on the control of DVD players. 

AUTOMATIC POWER SAVING FEATURES 

Newer consumer model DVD players may automatically power off after a period of 

inactivity as part of an energy saving effort sponsored by the U.S. Government. This 
makes control difficult and, in some cases impossible. Not all consumer models have 
this energy saving feature. The effected models can sometimes be identified by an 

ENERGYSTAR® label on the shipping container and often on the product itself (refer 
to www.leightronix.com for more details).  The use of commercial/professional DVD 
equipment is recommended to avoid this problem. 

PLAYBACK OF COMMERCIAL MOVIES 

Commercial movies licensed for broadcast on a cable network are often no different 
from movies rented at a local video outlet.  DVD movies usually contain formatting that 
forces the viewing of copyright warnings, movie previews, and main menus.  In some 

cases, once the DVD is placed in the DVD player, the DVD forces the player into a 
PLAY mode and cannot accept external control until certain information has been 
displayed in its entirety, hindering the ability to control the DVD.  

While the LEIGHTRONIX DVply control scheme supports random access of DVD 

media, the DVD itself may inhibit the operation of the control system.  Not all movie 
DVDs may be suitable for use within an automated playback system.  

The Integrated IR and PRO-BUS DVD control schemes support DVD PLAY and STOP 

functions and have the ability to initiate playback of a movie from the beginning of the 
DVD.  The results of the PLAY command are dependent on the DVD structure.  Use of 
Integrated IR and PRO-BUS (infrared and wired control) is not recommended with 

commercial movie playback from DVD. 
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PLAYBACK OF YOUR OWN DVDS 

 DVDs Created with a DVD Authoring Station 

DVD authoring software in conjunction with DVD recordable drives allows the user 
to specify how a DVD will be formatted. If you are burning DVDs using a personal 

computer, use the minimum in menuing and interactivity.  If possible, burn only one 
title on the DVD.  If you intend to invest in an advanced DVD control system 
capable of addressing individual programs, you can burn multiple titles:chapters to 

make better use of the DVD. 
  

 DVDs Created with a Stand-Alone DVD Recorder 

DVDs created on a stand-alone DVD recorder often have one main menu and one 
or more titles.  It has been observed that in most DVD players, these types of 

DVDs will start with the first title when a PLAY command is received. Whether or 
not the DVD will continue through the disc, playing multiple titles in sequence is 
determined by the DVD recorder used to create the DVD.  The DVD recorder burns 

preset DVD settings and configuration information on the DVD during the 
finalization of the disc. The settings can vary, depending on the make and model of 
the DVD recorder. This formatting may impact playback operation. 

DVD PLAYER/RECORDER CONTROL METHODS 

 Infrared Control 

LEIGHTRONIX has made every attempt to offer support for low-cost DVD players, 
including working within the limitations of the DVD players themselves. Most low-
cost models offer only wireless infrared control. Infrared communication limits the 

control functionality to basic PLAY-STOP-RECORD commands. This is due to the 
fact that the DVD and the DVD player rely on interactive on-screen menus for 
selection of specific programs on the disc. An automation system simply cannot 

receive the visual prompts necessary to negotiate through various levels of menus 
(imagine operating a DVD player with a wireless remote while blindfolded!).  

 

 RS-232 Control 

RS-232 control is most often associated with commercial grade DVD players.  An 
RS-232 control port on a DVD player usually allows random access of DVD 

titles:chapter and in the case of multi-disc players, it allows a specific disc to be 
loaded.  RS-232 communication through LEIGHTRONIX PLUS-BUS control 
interfaces also provides device status. This allows the automation system to 

communicate with supported DVD players and properly achieve disc and 
title:chapter selection.  

SUPPORTED DVD PLAYERS AND RECORDERS 

LEIGHTRONIX maintains an extensive database of supported playback and recording 

devices, including consumer, commercial, and broadcast equipment.  Although many 
consumer models are supported, LEIGHTRONIX does not test operation with every 
model and operation is not guaranteed.   
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It is important that you fully understand the capabilities of the various technologies 
involved in your playback system before making a buying decision.  LEIGHTRONIX is 

ready to answer your automation system questions.  Please feel free to contact 
LEIGHTRONIX via email at sales@leightronix.com or call us at (800) 243-5589, 
Monday through Friday, 8:00 to 5:00 PM ET. 
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SLIDE, OVERLAY, AND BACKGROUND FILE SPECIFICATIONS 

Slides, overlays, and backgrounds may be created with any third-party graphic 

software, including Adobe Photoshop® and Corel Paint Shop®, as long as each is 
saved with the supported file format.  When creating slides, overlays, or backgrounds, 
keep in mind that PC monitors utilize a different pixel shape than television monitors.  

To prevent files from appearing stretched when translated from a PC to a TV, refer to 
the resolution information below. 

NOTE: Slides/overlays with resolutions larger than 1024 x 768 cannot be uploaded 

to a NEXUS series product. 

SLIDES 

 Recommended slide resolutions (pixels) 

Depending on your display requirements, slides for a NEXUS series system may 
be created in four different sizes.  Slides containing pictures and graphics should 
be created in a resolution of 720 x 540, 800 x 600, or 640 x 480 pixels.  For slides 

containing only text or that are not susceptible to aspect distortion (such as a solid 
background), use a resolution of 720 x 480 pixels.  

 Save slides as JPEG (.jpg) files.  Slide filenames may contain up to 27 characters 
(no spaces) in addition to the required “.jpg” extension. 

 If Photoshop is used to create a slide, ensure the color “ICC Profile” option is not 

selected when the slide is saved or a black screen will be displayed on air instead 
of your slide’s graphics/text. 

OVERLAYS 

 Recommended overlay resolutions (pixels)   

LEIGHTRONIX recommends creating overlays in a resolution of 720 x 540 pixels.  
Resolutions of 800 x 600 or 640 x 480 pixels are optional. 

 Save overlays as PNG (.png) files.  PNG files support transparency and allow 
overlay graphics and text to layer over digital programming without blocking the 

entire monitor screen.  Overlay filenames may contain up to 27 characters (no 
spaces) in addition to the required “.png” extension. 

SLIDE BACKGROUNDS 

Background files are used in the WebNEXUS slide editors for slide creation.  Upload 

to your WebNEXUS slide editor through the WinLGX Storage Manager window (see 
“Managing Storage of Video, Slide, and Overlay,” on page 328, for more details). 

 Recommended background resolutions (pixels) 

Images of any size resolution may be uploaded to a WebNEXUS slide editor, but 
keep in mind the editor’s slide creation area and save resolution is 720x540. 
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 Backgrounds may be saved as either as JPEG (.jpg) or PNG (.png) files.  

Background filenames may contain up to 27 characters (no spaces) in addition to 
the required “.jpg” or “.png” extension. 
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MPEG FILE SPECIFICATIONS 

MPEG RECORDER SPECIFICATIONS 

NOTE: Video being fed to the broadcast MPEG recorder must have stable sync.  
Input signals with copy protection are not recordable.  

The maximum recorded file length allowed by the NEXUS series is 23 hours, 59 

minutes, and 50 seconds.   

Digital video recording results are based on a combination of the user-defined 
recording presets and the quality of the input source.  In each new NEXUS series 

image file, the internal broadcast MPEG recorder is automatically configured for the 
recording presets named “Good,” “Better,” and “Best” shown in Illustration 1. 

Illustration 1, Broadcast MPEG Recorder Default Recording Presets 
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You may use the default recording presets or change the presets based on your 
recording needs.  When selecting your recording presets, consider how video bit rate, 

video resolution, and audio quality settings will affect the quality and file size of your 
recordings (refer to the following sections for more information).  Once you have 
selected your recording presets, create short files for playback on your NEXUS series 

system to test the quality of your presets. 

 Video Resolution 

The picture quality of your recorded video also depends on the selected video 
resolution.  The following lists the available options: 

 Half (352x480): choose the half screen picture size for the UltraNEXUS/NEXUS 

when recording files at a CBR or minimum VBR less than 4 Mb/s.  Files 

recorded at these rates contain fewer pixels, so the picture clarity increases 
when the pixels are packed into a smaller picture size. 

NOTE: The UltraNEXUS-SDI broadcast MPEG encoder does not record at 

half D1 resolution. 

 Full (720x480): choose the full screen picture size when recording files at a 

CBR or minimum VBR of 4 Mb/s and above.  Files recorded at higher bit rates 

contain enough pixels to still look sharp when the pixels are spread out over a 
larger picture size. 

 Video Bit Rate 

The size and overall quality of your file is directly related to the selected video bit 

rates.  Select either a constant bit rate (CBR) or variable bit rate (VBR) for your file 

recordings based on the following information.  Higher bit rates result in higher 
quality recordings, but keep in mind that your file sizes will be larger and you will be 
able to fit less video onto your hard drives.   

NOTE: MPEG recording does not improve the quality of your input sources.  

When recording a low quality source, use higher bit rate settings to 
record a digital file of equal quality.   

 Variable Bit Rate (VBR)  

When a VBR is used for recording, the MPEG recorder records most of the 
source at the selected minimum bit rate.  WinLGX allows you to select a 

minimum bit rate between 3.00-8.00Mb/s for the UltraNEXUS-SDI and 1.50-
8.00 Mb/s for the UltraNEXUS/NEXUS, at intervals of .10.  The poorest 
recording quality results at a minimum bit rate of 1.50 Mb/s and the best at 8.00 

Mb/s. 

The video maximum bit rate does not impact file size.  The MPEG recorder only 

records at the maximum bit rate when there is a lot of movement in the source 
and returns to the minimum bit rate when the movement decreases.  The 
maximum bit rate must be set at least 2 Mb/s above the minimum bit rate. 
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 Constant Bit Rate (CBR) 

Use constant bit rate (CBR) to record sources with little movement.  Table 1 

shows how many hours of video can be recorded by a NEXUS series server 
onto external hard drives at the selected constant video bit rates (CBR). The 

examples given in the table below are based on MPEG-2 encoding with full D1 
resolution (720x480) video and 224Kb/sec audio bit rate.  

Table 1, Hard Drive Storage Capacities at Selected CBRs  

Total Hard Drive 

Capacity 
Hours @ 4 Mb/s Hours @ 6 Mb/s Hours @ 8 Mb/s 

250 GB 122 83 62 

500 GB 244 166 125 

1 TB 489 332 251 

 UltraNEXUS-SDI Only: Audio Source 

From the “Record audio source” drop down, select the type of embedded or non-

embedded (“Analog” or “AES”) audio signal your system is setup to record.  

 “Analog”: corresponds to the analog audio inputs on the SDI’s back panel 

terminal blocks (see Table 6, Non-Embedded Audio Terminal Block 
Configurations, for analog audio wiring diagram) 

 “AES”: corresponds to the AES audio inputs on the SDI’s back panel terminal 
blocks (see Table 6, Non-Embedded Audio Terminal Block Configurations, for 
AES audio wiring diagram) 

 “Embedded 1-2”, “Embedded 3-4,” “Embedded 5-6,” and “Embedded 7-8”: if 
your audio is embedded within the SDI video signal, select the embedded audio 

channel pair that you want to record 

 Audio Quality Settings 

 Audio bit rate: select 192, 224, or 256 kb/s for sources with audio tracks or 192 

kb/s for sources with little or no audio. 

 Audio sample rate: if you intend to burn your MPEG recording to a DVD, select 

the 48k sample rate to ensure compatibility with DVD players.  Otherwise, 
select the 44.1k audio sample rate. 

 

ENCODING A BACKGROUND AUDIO FILE 

If you are encoding an audio MPEG file to play with a slide or slide show, use the 

lowest possible video bit rate and resolution to reduce the file’s size.   LEIGHTRONIX 
also recommends encoding the file with a solid-colored video display to further reduce 
the file’s size. 
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CREATING BROADCAST MPEG FILES WITH NON-LEIGHTRONIX SOURCES 

The NEXUS series supports MPEG-1 and MPEG-2 video encoding standards.  
LEIGHTRONIX recommends the following guidelines for broadcast MPEG video files 

created with any third party hardware or software to ensure optimal playback on either 
of the internal NEXUS series MPEG players: 

 Acceptable stream types: 

 MPEG-1 System Stream or MPEG-2 Program Stream (consisting of a single 
elementary video stream with an optional single elementary audio stream) 

NOTE: Transport stream is not possible. 

 Elementary video stream 

 Three video resolutions (pixels) are allowed.  Other resolutions are not supported. 

 352 x 240 (Horizontal x Vertical) 
 352 x 480  

 720 x 480 

 Picture rate must be 29.97 pictures per second. 

 A maximum bit rate of 10 Mb/s is allowed. Higher rates are not supported. 

 National TV Standards Committee (NTSC) with 4:3 aspect ratio required. 

 4:2:0 sampling format required.  (Main profile at Main or Low level,  10 Mb/s) 

 IBBP group of pictures (GOP) structure recommended for best quality (30 frame 
maximum GOP size). 

 Encode header information in stream every few seconds to aid in error recovery. 

 Audio, if present, must be encoded into the MPEG file using Audio layer II. 

 Audio may be encoded at a 32, 44.1, or 48KHz sampling frequency.  

LEIGHTRONIX recommends an audio sampling rate of 44.1 KHz for optimal 
performance. 

 MPEG filenames may contain up to 27 characters (no spaces) in addition to the 
required “.mpg” extension. 

  



NEXUS Series 

Introduction 

Page 42   LEIGHTRONIX, INC. 
WinLGX ver. 7.0.2.60  2018-06-08 
 

FILES OPTIMIZED FOR STREAMING VIDEO-ON-DEMAND 

The UltraNEXUS-SDI and UltraNEXUS VOD recorders create Internet-ready 

programming for viewing on PEG Central, the web media hosting and streaming 
video-on-demand service from LEIGHTRONIX.  Once you have enabled the VOD 
recorder in WebNEXUS (see “Enabling/Disabling VOD Recorder” on page 354), any 

video signal switched to the recorder will be turned into a digital file compatible with 
Internet streaming.  The VOD recording process varies slightly between the 
UltraNEXUS and UltraNEXUS-SDI as follows: 

 UltraNEXUS: The UltraNEXUS VOD recorder is hardwired to the broadcast 

MPEG recorder, so, once enabled from WebNEXUS, it will 
automatically receive any immediate or scheduled switch and 
control commands sent to the broadcast MPEG recorder.  The 

UltraNEXUS VOD recorder mirrors the broadcast MPEG 
recorder’s actions, automatically recording whatever the 
broadcast recorder does. 

 UltraNEXUS-SDI: The UltraNEXUS-SDI VOD MPEG recorder is wired separately 

from the broadcast MPEG recorder. To automatically mirror the 
broadcast recorder’s actions, UltraNEXUS-SDI users must 
connect a 1 input x 2 output distribution amp between the back 

panel’s MPEG recorder inputs and an external switcher or 
video source output.  If the UltraNEXUS-SDI VOD recorder is 
connected to a different switcher or video source output than 

the broadcast recorder, the same video source input will have 
to be switched to the VOD recorder through a control panel or 
scheduled switch event before the recording event starts. 

Files recorded by the VOD recorder are automatically placed into a streaming directory 

on one of your system’s attached USB drives not currently receiving a broadcast file 

recording.  Once recorded, the UltraNEXUS-SDI / UltraNEXUS then automatically 
transfers the VOD files by FTP to your streaming VOD website and deletes the files 
from their temporary storage location on your USB drive (contact LEIGHTRONIX for 

details on setting up a streaming VOD account).  Your streaming site waits for 
approval from an authorized user before making the files available for public viewing. 
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NEXUS SERIES FRONT PANELS 

Illustration 2, NEXUS Front Panel 

 

 

Illustration 3, UltraNEXUS Front Panel 

 

Illustration 4, UltraNEXUS-SDI Front Panel 

 

KEYPAD 

All of the NEXUS series products have four-button keypads, which are used to display 
status information and enter password-protected TCP/IP addresses.   

If you hold down a key for more than one second, it begins to scroll through all of the 
available options.  If you hold down the key for more than three seconds, it scrolls in 

turbo mode.  Release the key when the desired option is displayed. 

DISPLAY 

The NEXUS series server/controllers have high brightness, 24-character by 2 line 
vacuum fluorescent displays (VFD), which display status and password-protected 

TCP/IP address entry screens.   
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After the NEXUS series system has been booted up, press the up or down arrows on 

the server/controller’s keypad to display the following status screens: 

 Bios Date 

The bottom line of this screen displays the date of bios on the NEXUS series 
motherboard (see Illustration 5, Bios Date Status Screen). 

Illustration 5, Bios Date Status Screen 

 DVply Firmware Version 

The bottom line of this screen shows the DVply firmware version (see Illustration 6, 
DVply Status Screen). 

Illustration 6, DVply Status Screen 

 Serial Number and Firmware Version 

The bottom line of this screen displays the serial and firmware version of your 

NEXUS series system (see Illustration 7, Serial Number and Firmware Version 
Status Screen). 

Illustration 7, Serial Number and Firmware Version Status Screen 

 Firmware Date 

The bottom line of this screen displays the build date of the firmware currently 
loaded on your NEXUS series system (see Illustration 8, Firmware Date Status 
Screen). 

Illustration 8, Firmware Date Status Screen 

Fri Apr 15 12:00:00PM 

Bios Date: 10/26/04 

Fri Apr 15 12:00:00PM 

DVPly Ver: V1.1.0.0 

Fri Apr 15 12:00:00PM 

SN:030038 V20.3.0 F 
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 IP Address 

The bottom line of this screen displays your NEXUS system’s IP address (see 
Illustration 9, IP Address Status Screen). 

Illustration 9, IP Address Status Screen 

 Site ID 

The bottom line of this screen displays your site ID (see Illustration 10, Site ID 
Status Screen). 

Illustration 10, Site ID Status Screen 

 Schedule Status 

The bottom line of this screen displays the NEXUS series system’s schedule status 
(see Illustration 11, Schedule Status Screen).  If the schedule status screen shows 

“Active,” the last schedule sent to the NEXUS series system is actively running.  If 
the status screen shows “Halted,” the schedule on the NEXUS system is currently 
not active. 

Illustration 11, Schedule Status Screen 

 Internal Switcher Status 

The bottom line of this screen shows the internal switcher status (see Illustration 
12, Internal Switcher Status Screen).  The first number in each pair is the input 

Fri Apr 15 12:00:00PM 

FW Built: 08/17/04 

Fri Apr 15 12:00:00PM 

IP: 10:1:1:110 

Fri Apr 15 12:00:00PM 

ID:Leightronix UltraNEXUS  

Fri Apr 15 12:00:00PM 

Schedule Active 
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number and the second is the output number.  The triangle indicates the valid 
video status on the output (solid =valid video, hollow=lack of valid video). 

Illustration 12, Internal Switcher Status Screen 

 External Switcher Type/Status 

The bottom line of this screen displays the type and status of the external switcher 

connected to your NEXUS series system (see Illustration 13, External Switcher 
Status Screen). 

Illustration 13, External Switcher Status Screen 

 MPEG Playback Status 

The bottom line of this screen shows the MPEG playback status for each MPEG 
player (see Illustration 14, MPEG Playback Status Screen).  The playback time is 
indicated on the bottom line of the screen along with up to thirteen characters of 

the filename. 

Illustration 14, MPEG Playback Status Screen 

 Broadcast MPEG Recording Status 

The bottom line of this screen shows the recording status of the internal broadcast 
MPEG recorder (see Illustration 15, Broadcast MPEG Recorder Status Screen).  
The record time is indicated on the bottom line of the screen along with up to 

thirteen characters of the filename.  

Illustration 15, Broadcast MPEG Recorder Status Screen 

Fri Apr 15 12:00:00PM 

7$1  8$2  7$3  1@4   

Fri Nov 26 12:00:00PM 

  SW=PRO-16 (Com=Good) 

Fri Apr 15 12:00:00PM 

M1:0:00:00 filename.mpg 
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 UltraNEXUS-SDI / UltraNEXUS VOD Recorder Enabled/Disabled 

The bottom line of this screen shows whether the internal VOD recorder for the 

UltraNEXUS-SDI / UltraNEXUS is currently enabled or disabled (see Illustration 17, 
VOD Recorder Status Screen).   

Illustration 16, VOD Recorder Status Screen 

 UltraNEXUS-SDI / UltraNEXUS VOD Recording Status 

The bottom line of this screen shows the recording status of the internal VOD 
recorder for the UltraNEXUS-SDI / UltraNEXUS (see Illustration 17, VOD Recorder 
Status Screen).  The record time is indicated on the bottom line of the screen along 

with up to thirteen characters of the filename.  

Illustration 17, VOD Recorder Status Screen 

 

Fri Apr 15 12:00:00PM 

R:0:00:00 filename.mpg 

Fri Apr 15 12:00:00PM 

Streaming Enabled 

Fri Apr 15 12:00:00PM 

STR:0:00:00 filename 
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LEDS 

The NEXUS series front panels have four status, light-emitting diodes (LEDs), which 
give at-a-glance feedback on the most important server/controller conditions.  See 

Table 2, NEXUS Series Front Panel LEDs, on page 48 for a list of the status LEDs and 
their descriptions. 

Table 2, NEXUS Series Front Panel LEDs 

LED DESCRIPTION 

 

Video Lost: the top LED flashes red when the valid video sensor 

detects video is lost and nothing is “on air.”  Check video 
connections and the condition of your sources or switch to another 
input.   

If a fallback has been set, the NEXUS series will switch to the 
programmed fallback input for each output.  It blinks once with a 

switch.   

 

Schedule Active: the second LED glows green when a schedule 
is active and being scanned for events to execute.  If this LED is 

off, your schedule is suspended and no events will happen.   

 

Management: the third LED blinks yellow when a PC connection is 
made.  This lets an operator know that someone is connected to 

the NEXUS series system over the network, and that configuration, 
control, and/or schedule updates are being performed. 

 

Check Log: the bottom LED glows red if Severity 1 or 2 events 
have been added to the log since it was last downloaded. 
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ULTRANEXUS/NEXUS REAR PANEL 

The UltraNEXUS and NEXUS have the same rear panel, which includes the following 
(see Illustration 18, UltraNEXUS/NEXUS Rear Panel): 

Illustration 18, UltraNEXUS/NEXUS Rear Panel 

 

 A: 4 IR ports for control of LEIGHTRONIX-supported DVD and tape equipment 

 B: 2 DVply ports provide random disc access with title:chapter selection for two 

TASCAM (DV-D01U or DV-D6500) commercial grade DVD players     

 C: 2 Communication Ports 

 “COM 1”: connect a LEIGHTRONIX-supported external switcher with an 
input/output capacity of 4x4 (minimum) to 32x32 (max. for the NEXUS) 

or 250x250 (max. for the UltraNEXUS) 
  “COM 2”: use with LEITCH CSD-5300, ESE “Format A” or “Format D” 

Master Clock, or Host mode 

 D: PRO-BUS port for control of supported videotape, DVD, and GPI devices 

through LEIGHTRONIX PRO-BUS device control interfaces 

 E: 2 Ethernet ports with corresponding LED indicators 

 Ethernet Port 1: provides a high speed connection (10/100/1000 BASE-

T) to a TCP/IP network. Remotely control system and manage digital 
media using the provided WinLGX software.  

 Ethernet Port 2: reserved for the LEIGHTRONIX TOTAL SHARE 

network option for additional system channels and expanded local media 
storage. 

 F: 4 USB 2.0 ports for local digital video media storage 

 Internal Routing Switcher: fully integrated, video/audio routing switcher provides: 

 G: 6 BNC video input connectors 

 H: 3 BNC video output connectors 

 I: 6 dual RCA audio input connectors 

 J: 3 dual RCA audio output connectors 

 K: Power cord connector 



NEXUS Series 

Introduction 

Page 50   LEIGHTRONIX, INC. 
WinLGX ver. 7.0.2.60  2018-06-08 
 

ULTRANEXUS-SDI REAR PANEL 

The UltraNEXUS-SDI’s rear panel includes the following (see Illustration 19, 
UltraNEXUS-SDI Rear Panel): 

Illustration 19, UltraNEXUS-SDI Rear Panel 

 

 A: 4 IR ports for control of LEIGHTRONIX-supported DVD and videotape 
equipment 

 B: 2 DVply ports provide random disc access with title:chapter selection for two 

TASCAM (DV-D01U or DV-D6500) commercial grade DVD players     

 C: 2 Communication Ports 

 “COM 1”: connect a LEIGHTRONIX-supported external switcher with an 
input/output capacity of 4x4 (minimum) to 250x250 (maximum) 

  “COM 2”: use with LEITCH CSD-5300, ESE “Format A” or “Format D”  
Master Clock, or Host mode 

 D: PRO-BUS port for control of supported videotape, DVD, and GPI devices 
through LEIGHTRONIX PRO-BUS device control interfaces 

 E: 2 Ethernet ports with corresponding LED indicators 

 Ethernet Port 1: provides a high speed connection (10/100/1000 BASE-
T) to a TCP/IP network. Remotely control system and manage digital 

media using the provided WinLGX software.  
 Ethernet Port 2: reserved for the LEIGHTRONIX TOTAL SHARE 

network option for additional system channels and expanded local media 

storage. 

 F: 4 USB 2.0 ports for local digital video media storage  

 All-Digital Interface: features the following SD-SDI video inputs/outputs with 
support for embedded, digital AES, and analog audio connections: 

 G: BNC video output connector for MPEG Player 1 

 H:  BNC video input connector for the broadcast recorder 

 I:  BNC video output connector for MPEG Player 2 

 J:  BNC video input connector for the VOD recorder 
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 K: Audio output tension clamp terminal block for MPEG Player 1 

 L: Audio input tension clamp terminal blocks for the broadcast recorder 

 M: Audio output tension clamp terminal block for MPEG Player 2 

 N: Audio input tension clamp terminal blocks for the VOD recorder 

 O: Power cord connector 
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SERVER/CONTROLLER INSTALLATION & CONFIGURATION 

ABOUT THIS SECTION 

Use this section for step-by-step instructions on connecting your NEXUS series 
system wiring, including devices and Ethernet.  This section also includes information 

on entering your TCP/IP and serial settings through the front panel.  For an overview 
of the NEXUS series system installation process, refer to the installation quick guide 
included with your system. 

PACKING LIST 

Ensure your NEXUS series shipment box contains the following: 

 (1) UltraNEXUS-SDI, UltraNEXUS, or NEXUS Network Managed Video System 
Controller / Digital Video Server, as applicable 

 (1) LEIGHTRONIX Product Resource Disc 

 (1) Booklet of Quick Start Guides 

 (1) WinLGX Network Management Software 

 (1) Part #10-0311, AC Power Cord, 6 ft. 

 (1) Part #10-4856, CAT 5e Ethernet Cable, 7 ft. 

 (1) Part #10-5135, Infrared Transmitter Cable, 6 ft. 

 (1) Part #10-4421, DB9F to DB9F Routing Switcher Interface Cable, 10 ft. 

 (1) Part #10-2372, DB9F to DB9M Routing Switcher Interface Cable, 6 ft. 

 (1) Part #10-1688, DB9F to DB9M Routing Switcher Interface Cable, 6 ft. 
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INSTALLATION OVERVIEW 

USING THE ULTRANEXUS/NEXUS INTERNAL SWITCHER 

Figure 1 shows a sample connection scenario for the NEXUS using the 
server/controller’s internal switcher.  The setup also applies to the UltraNEXUS. 

The integrated video server in each UltraNEXUS and NEXUS provides two MPEG 
players and a broadcast MPEG recorder for encoding programs at adjustable, 
constant and variable bit rates.  The UltraNEXUS also includes a VOD recorder for 
creating files optimized for VOD streaming (see the note below).  The broadcast 

MPEG recorder is accessed through internal switcher Output 4 while MPEG Players 1 
and 2 are available through Inputs 7 and 8, respectively.  Once you have enabled the 

UltraNEXUS VOD recorder according to the “Enabling/Disabling VOD Recorder” 
WebNEXUS section on page 354, it will receive the same switch commands as the 
broadcast MPEG recorder.  The enabled VOD recorder mirrors the broadcast MPEG 

recorder’s operations, automatically recording when the MPEG recorder is activated to 
encode a program. 

NOTE: The UltraNEXUS’s VOD recorder is connected to Output 3.  Once you have 
enabled the VOD recorder in WebNEXUS, internal switcher Output 3 only 

receives switch commands sent to Output 4.  If you want to control Output 3 
independently of Output 4, disable the VOD recorder in WebNEXUS.  The 
VOD recorder may be re-enabled at any time. 

The UltraNEXUS/NEXUS internal switcher also provides inputs and outputs for 

external devices.  Three outputs are available for destination equipment and six inputs 
can be connected to source devices.  In Figure 1, the television monitor and two 
modulator destinations are connected to the outputs and a variety of video and audio 

sources (VCRs, DVD players, satellite or studio feeds, character generator, etc.) are 
connected to the inputs.   

External source devices receive control commands from the UltraNEXUS/NEXUS 
through the ePRO-BUS feature, external PRO-BUS interfaces, and the IR and DVply 

ports on the rear panel.  The UltraNEXUS ePRO-BUS feature uses the Ethernet 
network to send wireless PRO-BUS control commands to the LEIGHTRONIX 
PEGvault-SD digital recorder or LABvault-SD player/recorder.  External 

LEIGHTRONIX PRO-BUS interfaces connect supported input devices on a common 
wire to the UltraNEXUS/NEXUS’s rear panel PRO-BUS port and are available with 
infrared, mini-jack, and multi-pin connectors.  The integrated IR ports provide infrared 
control for LEIGHTRONIX-supported VCRs and DVD players, while the DVply ports 
provide chapter:title access control for select, commercial DVD players. 

Configuration and control of the UltraNEXUS/NEXUS and its connected devices are 
conducted through a 10/100/1000 BASE-T Ethernet connection. 
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Figure 1, Example of NEXUS System Using Internal Switcher 

   



NEXUS Series 

Server/Controller Installation & Configuration 

 

LEIGHTRONIX, INC.  Page 55 
2018-06-08  WinLGX ver. 7.0.2.60 
 

USING THE ULTRANEXUS-SDI NO SWITCH CONFIGURATION 

The UltraNEXUS-SDI video server provides two channels of MPEG playback and two 
channels of MPEG recording.  MPEG Players 1 and 2 are available through Outputs 1 

and 2, respectively.  The first channel of MPEG recording on Input 1 encodes 
programming for broadcast at adjustable, constant and variable bit rates, while the 
recorder on Input 2 optimizes programming for VOD streaming. Enable the VOD 

recorder from WebNEXUS according to “Enabling/Disabling VOD Recorder” on page 
354.     

NOTE: To automatically send the same video signal to the broadcast MPEG and 
VOD recorders through one scheduled or control panel record event, a 1 

input x 2 output distribution amp must be connected between the 
UltraNEXUS-SDI’s video/audio encoder inputs and an external video source. 

While supporting digital audio embedded within an SD-SDI signal, the UltraNEXUS-
SDI also accommodates non-embedded, balanced AES3 digital audio or balanced, 

two-channel analog audio.  Non-embedded audio sources/destinations are connected 
to the two audio playback terminal block outputs and two audio record terminal block 
inputs on the SDI system’s rear panel.  

Configuration and control of the UltraNEXUS-SDI and its connected devices are 

conducted through a 10/100/1000 BASE-T Ethernet connection.   
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USING AN EXTERNAL SWITCHER WITH AN ULTRANEXUS OR NEXUS 

The UltraNEXUS and NEXUS will accommodate supported external switchers, as 
shown in Figure 2, Example of NEXUS System with External Switcher.  The diagram 

also applies to the UltraNEXUS.  The NEXUS accommodates routing switchers with a 
maximum of 32x32, while the UltraNEXUS can support up to 250x250. 

The integrated video server in each UltraNEXUS and NEXUS provides two MPEG 
players and a broadcast MPEG recorder for encoding programs at adjustable, 

constant and variable bit rates.  The UltraNEXUS also includes a VOD recorder for 
creating files optimized for VOD streaming (see the note below).  When using an 

external switcher, the broadcast MPEG recorder is accessed through internal switcher 

Input 1 while MPEG Players 1 and 2 are available through internal switcher Outputs 1 
and 2, respectively.  Once you have enabled the UltraNEXUS VOD recorder according 
to the “Enabling/Disabling VOD Recorder” WebNEXUS section on page 354, it will 

receive the same video as the broadcast MPEG recorder.  The enabled VOD recorder 
mirrors the broadcast MPEG recorder’s operations, automatically recording when the 
MPEG recorder is activated to encode a program. 

NOTE: The UltraNEXUS’s VOD recorder is enabled/disabled from WebNEXUS. 

In Figure 2, the broadcast MPEG recorder is being utilized in pass-through mode, so 

any video recorded by the UltraNEXUS/NEXUS will also appear on a television 
monitor.  The video input of the television monitor is connected to one of the external 
switcher’s outputs while the monitor’s video output is connected to the 
UltraNEXUS/NEXUS internal switcher Input 1. 

External source devices receive control commands from the UltraNEXUS/NEXUS 
through external PRO-BUS interfaces, the IR and DVply ports on the rear panel, and, 
for the UltraNEXUS, the ePRO-BUS feature.  The UltraNEXUS ePRO-BUS feature 

uses the Ethernet network to send wireless PRO-BUS control commands to the 
LEIGHTRONIX PEGvault-SD digital recorder and other compatible devices.  External 
LEIGHTRONIX PRO-BUS interfaces connect supported input devices on a common 

wire to the UltraNEXUS/NEXUS’s rear panel PRO-BUS port and are available with 
infrared, mini-jack, and multi-pin connectors.  The UltraNEXUS/NEXUS integrated IR 
ports provide infrared control for LEIGHTRONIX-supported VCRs and DVD players, 

while the DVply ports provide chapter:title access control for select commercial DVD 
players. 

Configuration and control of the UltraNEXUS/NEXUS and its connected devices are 
conducted through a 10/100/1000 BASE-T Ethernet connection. 
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Figure 2, Example of NEXUS System with External Switcher 
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USING AN EXTERNAL SWITCHER WITH THE ULTRANEXUS-SDI  

The UltraNEXUS-SDI will accommodate supported external switchers, as shown in 
Figure 3, Example of UltraNEXUS-SDI System with External Switcher.  The 

UltraNEXUS-SDI can support routing switchers with up to 250 inputs x 250 outputs. 

The integrated video server in the UltraNEXUS-SDI provides two MPEG players and a 

broadcast MPEG recorder for encoding programs at adjustable, constant and variable 
bit rates.  The UltraNEXUS-SDI also includes a VOD recorder for creating files 

optimized for VOD streaming. Enable the VOD recorder according to the 
“Enabling/Disabling VOD Recorder” WebNEXUS section on page 354. 

NOTE: To automatically send the same video signal to the broadcast MPEG and 
VOD recorders through one scheduled or control panel record event, a 1 

input x 2 output distribution amp must be connected between the 
UltraNEXUS-SDI’s video/audio encoder inputs and an external switcher 
output.  If the UltraNEXUS-SDI VOD recorder is connected to a different 

switcher or video source output than the broadcast recorder, the same video 
source input will have to be switched to the VOD recorder through a control 
panel or scheduled switch event before the recording event starts. 

External source devices receive control commands from the UltraNEXUS-SDI through 

the ePRO-BUS feature, external PRO-BUS interfaces, and the IR and DVply ports on 
the rear panel.  The ePRO-BUS feature uses the Ethernet network to send wireless 
PRO-BUS control commands to the LEIGHTRONIX PEGvault-SD digital recorder and 

other compatible devices.  External LEIGHTRONIX PRO-BUS interfaces connect 
supported input devices on a common wire to the UltraNEXUS-SDI’s rear panel PRO-
BUS port and are available with infrared, mini-jack, and multi-pin connectors.  The 

UltraNEXUS-SDI’s integrated IR ports provide infrared control for LEIGHTRONIX-
supported VCRs and DVD players, while the DVply ports provide chapter:title access 
control for select commercial DVD players. 

Configuration and control of the UltraNEXUS-SDI and its connected devices are 

conducted through a 10/100/1000 BASE-T Ethernet connection. 
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Figure 3, Example of UltraNEXUS-SDI System with External Switcher  

   



NEXUS Series 

Server/Controller Installation & Configuration 

Page 60   LEIGHTRONIX, INC. 
WinLGX ver. 7.0.2.60  2018-06-08 
 

CONNECTING NEXUS/ULTRANEXUS SIGNAL WIRING  

Throughout the following instructions, refer to Illustration 18, UltraNEXUS/NEXUS 
Rear Panel. 

1. Rack mount your UltraNEXUS or NEXUS as follows, ensuring the ventilation holes 
on the side of the unit are not covered and adequate space is available behind the 
back panel for the USB drives. 

NOTES:  An optional bracket kit is available for supporting the back of a rack-

mounted NEXUS series system.  Contact LEIGHTRONIX for more 
information. 

 LEIGHTRONIX recommends leaving empty rack mounts above and 

below the UltraNEXUS/NEXUS.  The UltraNEXUS/NEXUS is not 
intended to have anything stacked on top of it. 

a. Insert the UltraNEXUS/NEXUS into the rack, aligning the holes of the 

Controller’s mounting bracket with those of the rack. 

b. Secure the UltraNEXUS/NEXUS to the rack with user-supplied rack screws.  

2. External Switchers Only: if using, connect a LEIGHTRONIX-supported external 

switcher with an input/output capacity of 4x4 (minimum) to 32x32 (maximum for the 

NEXUS) or 250x250 (maximum for the UltraNEXUS) to the “COM 1” port.  

NOTE: When an external switcher is connected to the UltraNEXUS/NEXUS, 

the internal switcher is disabled for use with external video devices.   

a. Configure your switcher according to the corresponding parameters listed in 

Table 3, Supported External Switchers and Parameters. This is necessary to 
ensure your switcher works with the UltraNEXUS/NEXUS. 

Table 3, Supported External Switchers and Parameters 

SUPPORTED SWITCHER OPTIONS SWITCHER SERIAL PARAMETERS 

AUTOPATCH 9600 baud, 8N1 (Level 1: Video, Level 0: 

All) 

Creator 9600 baud, 8N1 

EXTRON A (most common) 9600 baud, 8N1 

EXTRON B (ISS series) 9600 baud, 8N1 

KNOX  9600 baud, 8N1 

KRAMER 9600 baud, 8N1 

LEIGHTRONIX PRO-16 or NET-164 9600 baud (PRO-16 min. ver. 1.09, 2.03; 

NET-164 min. ver. 1.00.42) 

LEITCH 9600 baud, 8N1 
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SUPPORTED SWITCHER OPTIONS SWITCHER SERIAL PARAMETERS 

Pesa P1N Network N/A 

PESA Serial 9600 baud, 8N2 

SIERRA 9600 baud, 8N1 

SIGMA A 9600 baud, 8N1 

SIGMA B 9600 baud, 8N1 

UTAH A 38400 baud, 8N1 

UTAH B 1200 baud, 7E2 

UTAH Sandar 9600 baud, 7O1 
 

b. Perform the following steps to connect the external switcher to the internal 

UltraNEXUS/NEXUS MPEG players and recorder(s): 

 MPEG Player 1: connect the desired external video/audio switcher 

inputs to UltraNEXUS/NEXUS Video Output 1 and 
Audio Output 1. 

 MPEG Player 2: connect the desired external video/audio switcher 
inputs to UltraNEXUS/NEXUS Video Output 2 and 
Audio Output 2. 

 MPEG Broadcast 
Recorder: 

connect to the recorder through one of the following 
options: 

 Connect the desired external switcher video/audio 
outputs to UltraNEXUS/NEXUS Video Input 1 and 
Audio Input 1.  If desired, connect a monitor to 

UltraNEXUS/NEXUS Video Output 3 and Audio 
Output 3 to view any video being recorded. 

 Connect the video input of a monitor to one of 

your external switcher’s outputs and the monitor’s 
video output to UltraNEXUS/NEXUS Input 1.  Any 
video recorded by the UltraNEXUS/NEXUS 

MPEG recorder will also appear on the television 
monitor. 

 UltraNEXUS VOD 

Recorder: 

Once you have enabled the UltraNEXUS’s VOD 

recorder from WebNEXUS, it will automatically 
receive the same video sent to the broadcast MPEG 
recorder.   

c. Route any audio sources that you wish to play with your JPEG slides to any of 
the open audio inputs on the UltraNEXUS/NEXUS internal switcher. 

3. Route the video/audio from your VCRs, DVD players, studio/satellite feeds, 

character generator, etc. to the switcher input connectors.   
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4. Connect switcher output connectors to the desired destinations (such as 
modulators or television monitors).  

NOTE:  Internal Switcher Only—once you have enabled the VOD recorder from 

WebNEXUS, internal switcher Output 3 only receives switch commands 

sent to Output 4.  If you want to control Output 3 independently of Output 
4, disable the VOD recorder from WebNEXUS (see “Enabling/Disabling 
VOD Recorder” on page 354).  The VOD recorder may be re-enabled at 

any time. 

5. If using, connect your external devices to the following interfaces: 

 For uni-directional device control, the following options are available: 

 Attach up to four, LEIGHTRONIX-approved VCRs and/or DVD players to the 

integrated IR ports.  For information on supported VCRs and DVD players, 
contact LEIGHTRONIX. 

 Attach up to 16 PRO-BUS device interfaces in a daisy chain to the PRO-

BUS port and connect each interface to the corresponding VCRs and/or 
DVD players.  See “Appendix A: PRO-BUS Interface Connections,” on page 
463 for further installation instructions.   

NOTES: For organizational purposes, LEIGHTRONIX recommends 
performing the following: 

 a. Set each interface’s dip switches to assign each PRO-
BUS interface a device number from 01–16. Number the 
PRO-BUS interfaces consecutively, starting with “01” at 

the interface connected to the PRO-BUS port on the 
UltraNEXUS/NEXUS.   

 b. If possible, ensure each device’s switcher input numbers 
correspond to the device number of its PRO-BUS. 

 c. Document your entire PRO-BUS interface/device setup. 

 For bi-directional control of select DVD players with title:chapter access, you may 

use the included DVply cables to connect up to two TASCAM DV-D01U or DV-
D6500 DVD players to the DVply ports or, if you have purchased the DVD changer 

option, one supported DVD changer to “DVply 1” port.  Contact LEIGHTRONIX for 
more information on DVply control options. 

NOTE: The DVply ports can only be used to control 2 Tascam DVD players or 1 

supported DVD changer. 

6. If using, attach a LEITCH CDS-5300, ESE Master Clock, or C&A GPS-200 external 

time source to “COM 2.”  

7. Attach up to four, LEIGHTRONIX-approved USB hard drives to the USB ports.  

The NEXUS supports a total USB storage capacity of 1 TB, while each 
UltraNEXUS system can support up to 4 TB.  For more information on USB drives 
compatible with the UltraNEXUS/NEXUS, refer to www.leightronix.com or contact 

LEIGHTRONIX. 

http://www.leightronix.com/
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NOTES:  USB drives can be removed or installed only after the 

UltraNEXUS/NEXUS is shut down from its front panel.  Do not 
connect the drives to a PC for file management operations. 

  LEIGHTRONIX requires the use of two USB hard drives with an 
UltraNEXUS combined with PEG Central or other LEIGHTRONIX 

streaming service.  While one drive will work with the system, the 
drive will become increasingly fragmented as it receives broadcast 
and VOD streaming files from the UltraNEXUS dual encoders.   

8. Attach the included power cord to the power cord connecter on the back of the 

UltraNEXUS/NEXUS, and then plug it into an AC power source.  

 

CAUTION 

LEIGHTRONIX strongly recommends the use of an 

Uninterruptible Power Supply (UPS) with the 
UltraNEXUS/NEXUS and associated USB drives.  Damage 
from power loss or spikes is not covered under warranty. 

9. Turn on the UltraNEXUS/NEXUS by simultaneously pressing the right and left 

arrows on the front panel for one second. 

NOTE: Do not remove power to the UltraNEXUS/NEXUS or associated USB 
drives before turning the UltraNEXUS/NEXUS off in the same manner.   

The UltraNEXUS/NEXUS will automatically boot up and display the boot up 
progress screens shown in Illustration 20, Boot Progress Screens.  During startup, 
any saved UltraNEXUS/NEXUS settings and active schedule are implemented. 

Illustration 20, Boot Progress Screens 

 

 

10. Ensure that the corresponding USB drive LED on the rear panel is lit for each 

attached USB drive (see Table 4, USB Drive LED Descriptions). 

NOTE: Only NEXUS systems with serial numbers beginning with “070” or “030” 

have LEDs next to the USB ports. 

Main Power ON 

Now Booting ... 

Starting Up ... 
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Table 4, USB Drive LED Descriptions 

LED LABEL LED STATE CORRESPONDING USB DRIVE 

A ON USB Drive “D” is connected to the 

UltraNEXUS/NEXUS. 

OFF USB Drive “D” is not connected to the 
UltraNEXUS/NEXUS. 

B ON USB Drive “E” is connected to the 

UltraNEXUS/NEXUS. 

OFF USB Drive “E” is not connected to the 

UltraNEXUS/NEXUS. 

C ON USB Drive “F” is connected to the 
UltraNEXUS/NEXUS. 

OFF USB Drive “F” is not connected to the 
UltraNEXUS/NEXUS. 

D ON USB Drive “G” is connected to the 

UltraNEXUS/NEXUS. 

OFF USB Drive “G” is not connected to the 

UltraNEXUS/NEXUS. 

11. Proceed to “Configuring Ethernet Network Host Management,” on page 72, to 

configure UltraNEXUS/NEXUS for remote control through Ethernet network host 

management. 
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CONNECTING ULTRANEXUS-SDI SIGNAL WIRING  

Throughout the following instructions, refer to Illustration 19, UltraNEXUS-SDI Rear 
Panel. 

1. Rack mount your UltraNEXUS-SDI as follows, ensuring the ventilation holes on the 
side of the unit are not covered and adequate space is available behind the back 
panel for the USB drives. 

NOTES:  An optional bracket kit is available for supporting the back of a rack-
mounted NEXUS series system.  Contact LEIGHTRONIX for more 

information. 

 LEIGHTRONIX recommends leaving empty rack mounts above and 

below the UltraNEXUS-SDI.  The UltraNEXUS-SDI is not intended to 
have anything stacked on top of it. 

a. Insert the UltraNEXUS-SDI into the rack, aligning the holes of the 

server/controller’s mounting bracket with those of the rack. 

b. Secure the UltraNEXUS-SDI to the rack with user-supplied rack screws.  

2. If using, connect a LEIGHTRONIX-supported external switcher with an input/output 

capacity of 4x4 (minimum) to 250x250 (maximum) to the “COM 1” port.  Finish 
installing your switcher according to the following steps: 

NOTE: To use any of the external device control schemes (PRO-BUS, IR, 
DVply) and WinLGX external device scheduling/control panel features 

with an UltraNEXUS-SDI, both the UltraNEXUS-SDI and the video 

sources must be connected to an external switcher. 

a. Configure your switcher according to the corresponding parameters listed in 
Table 3, Supported External Switchers and Parameters. This is necessary to 

ensure your switcher works with the UltraNEXUS-SDI. 

NOTE: Contact the routing switcher manufacturers listed below for help 

in selecting specific models. 

Table 5, Supported External Switchers and Parameters 

SUPPORTED SWITCHER OPTIONS SWITCHER SERIAL PARAMETERS 

AUTOPATCH 9600 baud, 8N1 (Level 1: Video, Level 0: All) 

Creator 9600 baud, 8N1 

EXTRON A (most common) 9600 baud, 8N1 

EXTRON B (ISS series) 9600 baud, 8N1 

KNOX  9600 baud, 8N1 

KRAMER 9600 baud, 8N1 

LEIGHTRONIX PRO-16 or NET-164 9600 baud (PRO-16 min. ver. 1.09, 2.03; 
NET-164 min. ver. 1.00.42) 
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SUPPORTED SWITCHER OPTIONS SWITCHER SERIAL PARAMETERS 

LEITCH 9600 baud, 8N1 

PESA P1N Network N/A 

PESA Serial 9600 baud, 8N2 

SIERRA 9600 baud, 8N1 

SIGMA A 9600 baud, 8N1 

SIGMA B 9600 baud, 8N1 

UTAH A 38400 baud, 8N1 

UTAH B 1200 baud, 7E2 

UTAH Sandar 9600 baud, 7O1 

b. Route the video/audio from any VCRs, DVD players, studio/satellite feeds, 
character generator, etc. to the switcher input connectors.  If desired, connect 

your external devices to the following interfaces: 

 For uni-directional device control, the following options are available: 

 Attach up to four, LEIGHTRONIX-approved VCRs and/or DVD players to 
the integrated IR ports.  For information on supported VCRs and DVD 

players, contact LEIGHTRONIX. 
 Attach up to 16 PRO-BUS device interfaces in a daisy chain to the PRO-

BUS port and connect each interface to the corresponding VCRs and/or 

DVD players.  See “Appendix A: PRO-BUS Interface Connections,” on 
page 463 for further installation instructions.   

NOTES: For the best organization, LEIGHTRONIX recommends 
performing the following: 

 a. Set each interface’s dip switches to assign each PRO-

BUS interface a device number from 01–16. Number the 
PRO-BUS interfaces consecutively, starting with “01” at 
the interface connected to the PRO-BUS port on the 

UltraNEXUS-SDI.   
 b. If possible, ensure each device’s switcher input numbers 

correspond to the device number of its PRO-BUS. 

 c. Document your entire PRO-BUS interface/device setup. 

 For bi-directional control of select DVD players with title:chapter access, 

you may use the included DVply cables to connect up to two TASCAM 
DV-D01U or DV-D6500 DVD players to the DVply ports or, if you have 

purchased the DVD changer option, one supported DVD changer to 
“DVply 1” port.  Contact LEIGHTRONIX for more information on DVply 
control options. 

NOTE: The DVply ports can only be used to control 2 Tascam DVD 
players or 1 supported DVD changer.  
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c. Connect switcher output connectors to the desired destinations (such as 
modulators or television monitors). 

3. Connect video cables to the UltraNEXUS-SDI’s MPEG players as follows: 

 MPEG Player 1: connect UltraNEXUS-SDI Video Output 1 to the desired 
destination or switcher input. 

 MPEG Player 2: connect UltraNEXUS-SDI Video Output 2 to the desired 
destination or switcher input. 

4. Connect video to the UltraNEXUS-SDI’s broadcast and VOD MPEG recorders 

through one of the following options: 

 1 external switcher or source video output for both recorders: to simultaneously 
record the same content with the broadcast and VOD recorders through one 
WinLGX schedule event or control panel command, connect a 1 x 2 distribution 

amp between one of your switcher or source’s video outputs and UltraNEXUS-
SDI Inputs 1 and 2.   

 1 external switcher or source video output for each recorder: connect broadcast 
recorder Input 1 and VOD recorder Input 2 to separate switcher or source video 

outputs.  Note that when connected to a different output than the broadcast 
recorder, a separate WinLGX switch event or control panel command must be 
used to switch the same video source input to the VOD recorder before the 

record event is started. 

5. Your UltraNEXUS-SDI audio connections are determined by the type of audio 

signals you wish to record and play out, as described below: 

 Embedded Digital Audio (SMPTE 272M): part of your SD-SDI digital video 
signal, no additional audio connections are needed to play or record this type of 

audio signal. 

 Non-Embedded Audio Signals: the UltraNEXUS-SDI supports both AES3 

digital audio (IEC 60958 Type 1 Balanced) and two-channel analog balanced 
audio signals.  The UltraNEXUS-SDI comes equipped with four audio terminal 
blocks for playing/recording your non-embedded audio signals (see Illustration 
21).  

Illustration 21, Audio Terminal Blocks on Rear Panel of UltraNEXUS-SDI 

 

To play/record any of the UltraNEXUS-SDI’s supported, non-embedded audio 
signals, connect your non-embedded audio signal wiring according to the following 
steps: 

Audio Output 

Terminal Block 1  

for MPEG Player 1 

Audio Input  

Terminal Block 1  

for the MPEG Broadcast Recorder 

Audio Output 

Terminal Block 2  

for MPEG Player 2 

Audio Input  

Terminal Block 2  

for the MPEG VOD Recorder 
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NOTE: The UltraNEXUS-SDI supports an audio wiring gauge range of 18 
(maximum) to 28 (minimum) AWG. 

a. Prepare your audio wiring for connection to the terminal blocks by stripping 

approximately a 1/4 inch of shield off the end of each wire.  Twist each wire’s 
individual strands together to prevent separation. 

Illustration 22, Example of Wire Prepared for an UltraNEXUS-SDI Terminal Block 

 

b. Perform the following steps for each MPEG player and/or recorder that you 

want to use with non-embedded audio (refer to Illustration 21, Audio Terminal 
Blocks on Rear Panel of UltraNEXUS-SDI). 

i. With your fingers, gently grasp the desired terminal block on the 
UltraNEXUS-SDI’s rear panel and pull to separate the block from the 
server/controller. 

ii. Secure each of your prepared audio wires in their appropriate terminals as 
follows, referring to Table 6 for each wire’s placement on the terminal block: 

Table 6, Non-Embedded Audio Terminal Block Configurations 

AES3  

Terminal Block Configuration 

Two-Channel Analog  

Terminal Block Configuration 

  

 

 
 

Terminals 

Shield Stripped from 

End of Wire 

NOTE: The AES3 audio 

configuration uses 
only one of either 

common grounds. 
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AES3  

Terminal Block Configuration 

Two-Channel Analog  

Terminal Block Configuration 

Illustration 23, Example of AES Terminal 
Block Wiring 

 

Illustration 24, Example of Two-Channel 
Analog Terminal Block Wiring 

 

(1) Using a slotted, pocket clip screwdriver with a maximum tip width of 

2.5mm and thickness of .4mm, open the terminal’s tension clamp by 
inserting the screwdriver tip into the clamp’s corresponding tension 

release slot (see Illustration 25 for an example of slot and clamp 
locations).  Firmly push the screwdriver into the slot until the clamp 
inside the terminal slides open (see Illustration 26). 

Illustration 25, Tension Clamp Release Slot on an UltraNEXUS-SDI Terminal Block 

 

Illustration 26, Screwdriver Inserted into Tension Clamp Release Slot 

 

Terminal 

Tension Clamp 

Tension Clamp Release Slot 

(highlighted to illustrate) 
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(2) Insert the audio wire into its corresponding terminal until it is touches 
the bottom. 

(3) While holding the wire in place, pull the screwdriver from the slot.  The 
wire should now be clamped into place and should not fall out of the 

terminal if gently tugged. 

(4) Repeat steps 5.b.ii(1)–(3) for each of the remaining terminals in your 

audio terminal block configuration. 

iii. Push the wired terminal block back into its slot on the rear panel of the 

UltraNEXUS-SDI (see Illustration 27 for an example).  The block only fits 
one way into its holder on the rear panel. 

Illustration 27, Example of Audio Terminal Block Wired for Analog and Connected to Rear Panel 

 

6. If using, attach a LEITCH CDS-5300 or ESE Master Clock external time source to 

“COM 2.”  

7. Attach up to four, LEIGHTRONIX-approved USB hard drives to the USB ports.  
The UltraNEXUS-SDI system can support up to 4 TB.  For more information on 

USB drives compatible with the UltraNEXUS-SDI, refer to www.leightronix.com or 
contact LEIGHTRONIX. 

NOTES:  USB drives can be removed or installed only after the UltraNEXUS-
SDI is shut down from its front panel.  Do not connect the drives to 
a PC for file management operations. 

  LEIGHTRONIX requires the use of two USB hard drives with an 

UltraNEXUS-SDI combined with the LEIGHTRONIX PEG Central 
video-on-demand streaming service.  While one drive will work with 

the system, the drive will become increasingly fragmented as it 

http://www.leightronix.com/
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receives broadcast and VOD streaming files from the UltraNEXUS-
SDI dual encoders.   

8. Attach the included power cord to the power cord connector on the back of the 

UltraNEXUS-SDI, and then plug it into an AC power source.  

 

CAUTION 

LEIGHTRONIX strongly recommends the use of an 

Uninterruptible Power Supply (UPS) with the UltraNEXUS-SDI 
and associated USB drives.  Damage from power loss or 
spikes is not covered under warranty. 

9. Turn on the UltraNEXUS-SDI by simultaneously pressing the right and left arrows 

on the front panel for one second. 

NOTE: Do not remove power to the UltraNEXUS-SDI or associated USB drives 
before turning the UltraNEXUS-SDI off in the same manner.   

The UltraNEXUS-SDI will automatically boot up and display the boot up progress 
screens shown in Illustration 20, Boot Progress Screens.  During startup, any 
saved UltraNEXUS-SDI settings and active schedule are implemented. 

Illustration 28, Boot Progress Screens 

 

 

10. Proceed to “Configuring Ethernet Network Host Management,” on page 72, to 

configure UltraNEXUS-SDI for remote control through Ethernet network host 
management. 

 

Main Power ON 

Now Booting ... 

Starting Up ... 
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CONFIGURING ETHERNET NETWORK HOST MANAGEMENT 

NOTES:  Your PC must have a Windows 2000/XP/Vista/7 operating system in 

order to run WinLGX software (see “WinLGX Minimum System 
Requirements,” on page 85 for further details). 

  Each NEXUS series system requires the following ports: 
 23 (Telnet) 
 21 (FTP Control Connection) 

 20 (FTP Data) 
 80 (HTTP - WebNexus) 
 2000 (UDP): needed for UltraNEXUS/UltraNEXUS-SDI ePRO-BUS 

control  
 50001 (Web Program Guide): this port can be changed from the 

NEXUS front panel.  See “Editing Web Schedule Port,” on page 81, 

for instructions. 
  If you will be connecting to your NEXUS series system remotely, the 

following ways can be used to set up your router to access your NEXUS 
system.  Keep in mind that more than one method can be used, such as 
VPN for WinLGX access and port forwarding for program guide access.  

Consult your network administrator and router manual before 
implementing any of the following methods. 

 The preferred method is using Virtual Private Networking (VPN) to 

gain access to the network from outside.  You would then run 

WinLGX and connect to the NEXUS system as if you were local to it. 

 Another method is to use PC control software such as PCAnywhere® 

or GoToMyPC® to take control of the WinLGX PC from outside the 
network. 

 Ports 80 and/or 50001 only: use port forwarding in your firewall 
router to give public access to Ports 80 and/or 50001.  Public access 
to Port 50001 is required when you want to embed the NEXUS 

program guide on your own website (see “on page 402).  Port 80 
should be made publically available when you want to access 
WebNEXUS from public IP addresses on the Internet.   

Port forwarding requires an external, public IP address which is 
configured in the router to have the desired ports forwarded to the 

NEXUS system’s internal IP Address. 

Do not use port forwarding to make the other ports for your NEXUS 

system remotely available, as it allows anyone to connect to your 
NEXUS system and then attempt to log in.  Some advanced routers 
can limit external connections to a certain address range, providing 

protection.    
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Each NEXUS series server/controller is designed to interact with a host PC through a 

10/100/1000 BASE-T Ethernet TCP/IP Network.  Two of the most common connection 
scenarios are outlined below. 

NOTE: In order to share one external routing switcher between multiple NEXUS 
series server/controllers, your NEXUS system and PC must be networked 
together. 

CONNECTING NEXUS SYSTEM TO AN EXISTING ETHERNET NETWORK 

1. Obtain the following from your technical support personnel or network administrator 
and enter into the front panel of your NEXUS series system (see “Configuring Front 
Panel Settings,” on page 76): 

 IP address 

 Subnet mask 

 Gateway address 

2. Using a straight-through RJ-45 Ethernet cable, connect the NEXUS system’s left 

Ethernet port (labeled “1”) to a 10/100/1000 BASE-T hub or switch on the TCP/IP 
network. 

3. Ensure the PC from which you wish to control your NEXUS series system has 
been configured and attached to the TCP/IP network. 

4. Ensure your NEXUS system and PC have been properly configured for Ethernet 

network access (see “Confirming Ethernet Network Configuration,” on page 74). 

CONNECTING A NEXUS SYSTEM DIRECTLY TO A PC VIA ETHERNET 

1. If necessary, install and configure a 10/100/1000 BASE-T Ethernet Network 
Interface Card (NIC) on the PC.  Refer to the NIC documentation and technical 

support for help in getting the NIC operational. 

2. Obtain your PC’s TCP/IP networking IP address and subnet mask as follows: 

a. Click on the Windows “Start” menu. 

b. Open the “Run” dialog box and type “command.” Click “OK” or press “Enter” on 
your keyboard to open the command.com window. 

c. Type in “IPconfig” at the C:\ prompt of the command.com window to reveal your 
PC’s IP and subnet mask address. 

3. Enter the following IP and subnet mask addresses into the front panel of your 

NEXUS series system (see “Configuring Front Panel Settings,” on page 76): 

 IP address: one number above your PC’s IP address (for example, if your PC’s 

IP address is 10.255.9.15, set your server/controller’s IP address to 
10.255.9.16) 

 Subnet mask: your PC’s subnet mask address 

4. Using a cross-over RJ-45 Ethernet cable (not a standard cable), connect the 
NEXUS system to the PC’s network interface card (NIC). 
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5. Ensure your NEXUS system and PC have been properly configured for Ethernet 
network access (see “Confirming Ethernet Network Configuration,” on page 74). 

CONFIRMING ETHERNET NETWORK CONFIGURATION 

Once your NEXUS system and PC have been configured for Ethernet access, ensure 
the Ethernet LEDs on the rear panel of your Controller are lit (see Table 7, Ethernet 
LED Indicators and Descriptions). 

Table 7, Ethernet LED Indicators and Descriptions 

LED POSITION STATE DESCRIPTION 

Right Off Ethernet connection speed is 10Mb/s. 

Yellow Ethernet connection speed is 100Mb/s. 

Amber Ethernet connection speed is 1000Mb/s. 

Left Off Ethernet link not established. 

Steady on 
yellow 

Ethernet link established.  The NEXUS series system is 
not transmitting on the network.  

Blinking 
yellow 

Ethernet link established.  The NEXUS series system is  
transmitting on the network. 
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TURNING A NEXUS SERIES SYSTEM ON/OFF 

Turn a NEXUS series system on/off by simultaneously pressing the right and left 

arrows on the front panel for one second. 

NOTE: Do not remove power to the NEXUS system or associated USB drives 

before completing a front panel shutdown. 
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CONFIGURING FRONT PANEL SETTINGS 

NOTE: All crucial configuration information, such as user information, schedule 
information, time, and network information are stored in battery backed or 

flash memory.  Thus the NEXUS series system configuration is protected in 
the instance of an extended power failure. 

ENTERING PASSWORD 

1. From the front panel of your NEXUS series server/controller, press the right arrow 

key from any one of the status screens to display the password entry screen (see 
Illustration 29, Password Entry Screen).   

Illustration 29, Password Entry Screen 

 

2. Press five-key password.   

NOTE: The factory-default password is five right arrow keys.  To change the 
front panel password, refer to “Changing Front Panel Password,” on 
page 114. 

3. If the password entered is correct, the NEXUS system’s configuration menu will be 
displayed (see Illustration 30, Configuration Menu Screen).   

Illustration 30, Configuration Menu Screen 

If an incorrect password is entered, the display returns to the status screens.  The 

configuration menu allows you to activate optional features and edit the following 
NEXUS series system settings: 

 TCP/IP addresses: see “Editing TCP/IP Network Addresses,” on page 76 

 Shared Switch: see “Editing Shared Switcher IP Address,” on page 79 

 Serial port: see “Selecting Serial Port Settings,” on page 79 

 Web schedule port: “Editing Web Schedule Port,” on page 80  

 FTP TCP buffer size: see “Editing FTP TCP Buffer Size,” on page 82 

EDITING TCP/IP NETWORK ADDRESSES 

IP Address 

Using arrow keys 

Enter Password:***** 

CONFIG MENU (Use `/ˆ) 

Edit XXXX               ~ 
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Obtain IP address from your technical support personnel or network administrator.   
See Table 8, Editing IP Address from Front Panel, for editing instructions. 

NOTE: If you wish to use the UltraNEXUS/UltraNEXUS-SDI ePRO-BUS option to 

control a PEGvault-SD or LABvault-SD digital recorder, a static IP address is 
required for your NEXUS series server/controller. 

Table 8, Editing IP Address from Front Panel 

IP ADDRESS CONFIGURATION STEPS CORRESPONDING SCREEN DISPLAYS 

1. From the “CONFIG MENU” screen, press “↑” or 

“↓” to proceed to “Edit unit IP Address.”  

2. Press “→” to select “Edit unit IP Address.”  
 

3. Press “→” or “←” to position the underscore 

under the editable fields and press “↑” or “↓” to 

edit the values. 

4. Press “→” past all of the editable fields to enter 

the next screen.   

 

5. Either press “→” again to save your changes or 

“←” to abort changes. 

 

NOTE: Unit must be powered down and then powered back up to apply any NEXUS series 
system address changes (simultaneously press “←” and “→” for one second to turn off 
and repeat to turn back on). 

 
Subnet Mask 

Obtain subnet mask address from your support personnel or network administrator.   

See Table 9, Editing Subnet Mask from Front Panel, for editing instructions.   

NOTE: If you are sharing one external routing switcher between multiple NEXUS 

series server/controllers, enter the same subnet mask into the front panel of 
each NEXUS system. 

Table 9, Editing Subnet Mask from Front Panel 

SUBNET MASK CONFIGURATION STEPS CORRESPONDING SCREEN DISPLAYS 

1. From the “CONFIG MENU” screen, press “↑” or 

“↓” to proceed to “.”  

2. Press “→” to select “Edit unit Subnet Mask.”  
 

3. Press “→” or “←” to position the underscore 

under the editable fields and press “↑” or “↓” to 

edit the values.  

CONFIG MENU (USE `/ˆ) 

Edit unit IP Address  ~ 

Enter new IP Address 

  0.  0.  0.   0    ~ 

Press right arrow to confirm IP 

Address_     

CONFIG MENU (USE `/ˆ) 

Edit unit Subnet Mask  ~ 

Enter new Subnet Mask 

   0.   0.   0.   0.  
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SUBNET MASK CONFIGURATION STEPS CORRESPONDING SCREEN DISPLAYS 

4. Press “→” to enter next screen.   

5. Either press “→” again to save your changes or 

“←” to abort changes. 

 

NOTE: Unit must be powered down and then powered back up to apply any NEXUS series 
system address changes (simultaneously press “←” and “→” for one second to turn off 

and repeat to turn back on). 

 
Gateway Address 

Obtain gateway address from your technical support personnel or network 
administrator.  See Table 10, Editing Gateway Address from Front Panel, for editing 

instructions. 
NOTE: If you are sharing one external routing switcher between multiple NEXUS 

series server/controllers, enter the same gateway address into the front 

panel of each NEXUS system. 

Table 10, Editing Gateway Address from Front Panel 

GATEWAY ADDRESS CONFIGURATION STEPS CORRESPONDING SCREEN DISPLAYS 

1. From the “CONFIG MENU” screen, press “↑” or 

“↓” to proceed to “Edit unit Gateway Addr.”  

2. Press “→” to select “Edit unit Gateway Addr.”  
 

3. Press “→” or “←” to position the underscore 

under the editable fields and press “↑” or “↓” to 

edit the values. 

4. Press “→” to enter next screen.   

 

5. Either press “→” again to save your changes or 

“←” to abort changes. 

 

NOTE: Unit must be powered down and then powered back up to apply any NEXUS series 
system address changes (simultaneously press “←” and “→” for one second to turn off 

and repeat to turn back on). 

Press right arrow to confirm 

Subnet Mask_            

CONFIG MENU (USE `/ˆ) 

Edit unit Gateway Addr ~ 

Enter new Gateway 

  0.  0.  0.   0       ~ 

Press right arrow to confirm 

Gateway_        
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EDITING SHARED SWITCHER IP ADDRESS 

If you are sharing an external routing switcher between multiple NEXUS series 
systems, enter the IP address of the NEXUS system connected directly to the switcher 

into the front panel of each additional NEXUS system.  See Table 11, Editing Shared 
Switcher Configuration from Front Panel, for editing instructions. 

Table 11, Editing Shared Switcher Configuration from Front Panel 

SHARED SWITCH CONFIGURATION STEPS CORRESPONDING SCREEN DISPLAYS 

1. From the “CONFIG MENU” screen, press “↑” or 

“↓” to proceed to “Edit shared switcher IP.”  

2. Press “→” to select “Edit shared switcher IP.”  
 

3. Press “→” or “←” to position the underscore 

under the editable fields and press “↑” or “↓” to 

edit the values. 

4. Press “→” past all of the editable fields to enter 

the next screen.   

 

5. Either press “→” again to save your changes or 

“←” to abort changes.  If you press “→” to 

accept the change, the UltraNEXUS/NEXUS 

automatically performs a partial reboot and 

completes the change. 

 

SELECTING SERIAL PORT SETTINGS 

See Table 12, Selecting Serial Port Settings from Front Panel, for editing instructions 
and Table 13, Serial Port Options, for a descriptive list of the different serial port 
options available for your NEXUS system. 

Table 12, Selecting Serial Port Settings from Front Panel 

SERIAL PORT CONFIGURATION STEPS CORRESPONDING SCREEN DISPLAYS 

1. From the “CONFIG MENU” screen, press “↑” or 

“↓” to proceed to “Edit Serial Port Use.”  

2. Press “→” to select “Edit Serial Port Use.”  
 

3. Press “→” or “←” to position the underscore 

under the editable fields and press “↑” or “↓” to 

edit the values. 

4. Press “→” to enter next screen.   

 

NOTE: Refer to Table 13 for serial port selection 

options. 

CONFIG MENU (USE `/ˆ) 

Edit shared switcher IP ~ 

Enter new Shared SW IP 

  0.  0.  0.   0   ~ 

Press right arrow to         

Confirm shared SW IP    ~ 

CONFIG MENU (USE `/ˆ) 

Edit Serial Port Use  ~ 

COM2 

CSD-5300        ~ 
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SERIAL PORT CONFIGURATION STEPS CORRESPONDING SCREEN DISPLAYS 

5. Either press “→” again to save your changes or 

“←” to abort changes. 

 

NOTE: Unit must be powered down and then powered back up to apply any NEXUS series 
system serial port change (simultaneously press “←” and “→” for one second to turn off 

and repeat to turn back on). 

Table 13, Serial Port Options 

SERIAL PORT OPTION DESCRIPTION 

Host Enables serial host management 

ESE Clock Enables NEXUS series server/controller to receive clock information from 
an ESE “Format A” or “Format D” master clock every second 

CSD-5300 Enables NEXUS series server/controller to receive clock information from 
a LEITCH CSD-5300 master clock once an hour and whenever the 

NEXUS system is powered up 

GPS-200 Enables NEXUS series server/controller to receive clock information from 
a C&A GPS-200 master clock 

Tri-Messenger Custom option—contact LEIGHTRONIX for further details. 

SHARING EXTERNAL TIME CLOCK WITH MULTIPLE NEXUS SERIES SERVERS 

Up to ten NEXUS series servers can be synchronized to the clock time on one 

external master clock.  The NEXUS series servers that you wish to synchronize to the 
master clock’s time must be networked together by configuring each server with the 
same subnet mask address (see “Editing TCP/IP Network Addresses” on page 76).  If 

you have more than ten NEXUS series servers, you can create up to nine additional 
groups consisting of ten NEXUS series servers to one master clock per group, for a 
total of one hundred NEXUS series servers and ten master clocks. 

Connect your external master clock to the serial port on one of your NEXUS series 

servers and then configure the serial port for master clock usage (see “Selecting Serial 
Port Settings” on page 79).  The NEXUS series server connected to the master clock 
will broadcast the master clock’s time to all NEXUS series servers in its group. 

To configure each NEXUS series server for time synchronization, you will need to 

specify whether the server is sending or receiving the master clock time and enter the 
same group number into the front panel of each NEXUS series server in the group 
according to Table 14, Editing “Time Settings” Options from Front Panel, for editing 
instructions. 

Press right arrow to confirm port 

config._   
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Table 14, Editing “Time Settings” Options from Front Panel 

TIME SETTING CONFIGURATION STEPS CORRESPONDING SCREEN DISPLAYS 

1. From the “CONFIG MENU” screen, press “↑” or 

“↓” to proceed to “Edit Time Settings.”  

2. Press “→” to select “Edit Time Settings.”  
 

3. Press “↑” or “↓” to change the “Time Mode” 

setting.  Select the “Server” option if the NEXUS 

series server is connected to your external 

master clock or “Client” if the NEXUS series 

server is receiving master clock time from the 

connected NEXUS series server. 

4. Press “→” to edit the “Group” field.   

 

5. Press “↑” or “↓” to change the “Group #,” being 

certain to use the same group number for the 

NEXUS series servers sharing the same master 

clock (maximum of ten NEXUS series servers 

per master clock). 

6. Either press “→” again to save your changes or 

“←” to abort changes. 

 

NOTE: Unit must be powered down and then powered back up to apply any NEXUS series 
system time setting change (simultaneously press “←” and “→” for one second to turn 
off and repeat to turn back on). 

EDITING WEB SCHEDULE PORT 

Each NEXUS series system uses Port 50001 as the default for the online program 

guide.  If you have already assigned this port number, select a different, unassigned 
port number for the online program guide.  See Table 15, Editing Web Schedule Port 
from Front Panel, for editing instructions. 

Table 15, Editing Web Schedule Port from Front Panel 

WEB SCHED PORT CONFIGURATION STEPS CORRESPONDING SCREEN DISPLAYS 

1. From the “CONFIG MENU” screen, press “↑” or 

“↓” to proceed to “Edit Web Schedule Port.”  

2. Press “→” to select “Edit Web Schedule Port.”  
 

3. Press “→” or “←” to position the underscore 

under the editable fields and press “↑” or “↓” to 

edit the values.  

CONFIG MENU (USE `/ˆ) 

Edit Time Settings ~ 

TIME MODE    GROUP # 

Off       1 

CONFIG MENU (USE `/ˆ) 

Edit Web Schedule Port ~ 

Enter new Web Sched Port 

50001           ~ 

TIME MODE    GROUP # 

Server      1 
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WEB SCHED PORT CONFIGURATION STEPS CORRESPONDING SCREEN DISPLAYS 

4. Press “→” to enter next screen.   

5. Either press “→” again to save your changes or 

“←” to abort changes. 

 

NOTE: Unit must be powered down and then powered back up to apply any NEXUS series 
system web schedule port change (simultaneously press “←” and “→” for one second to 

turn off and repeat to turn back on). 

EDITING FTP TCP BUFFER SIZE 

The NEXUS FTP buffer size setting helps to control the rate at which data is 

transferred to and from the NEXUS series system via WinLGX or third-party FTP 
software.  The buffer size setting defaults to 16 kilobytes, but may be adjusted down to 
4 KB or up to 64 KB.  If your network equipment can handle a higher rate, edit the 

setting to 32 or 64 KB for faster transfer times.  See Table 16, Editing FTP Buffer Size 
from Front Panel, for editing instructions. 

Table 16, Editing FTP Buffer Size from Front Panel 

FTP BUFFER SIZE CONFIGURATION STEPS CORRESPONDING SCREEN DISPLAYS 

1. From the “CONFIG MENU” screen, press “↑” or 

“↓” to proceed to “Edit FTP TCP Buff Size.”  

2. Press “→” to select “Edit FTP TCP Buff Size.”  
 

3. Press “→” or “←” to position the underscore 

under the editable field and press “↑” or “↓” to 

edit the value. 

4. Press “→” to apply change and enter reboot 

message screen or “←” to abort.   

 

NOTE: Unit must be powered down and then powered back up to apply any NEXUS series 
system FTP buffer size change (simultaneously press “←” and “→” for one second to 

turn off and repeat to turn back on). 

 
 
 

  

Press right arrow to confirm Web 

Sched Port_   

CONFIG MENU (USE `/ˆ) 

Edit FTP TCP Buff Size ~ 

FTP TCP Buffer Size: 

16 kbytes           ~ 
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SOFTWARE INSTALLATION & CONFIGURATION 

ABOUT THIS SECTION 

This section introduces the NEXUS series system management software, WinLGX, 

and provides instructions on how to enter the configuration settings necessary to 
control your NEXUS system through the software.  For an overview of how to install 
WinLGX and enter your configuration settings, refer to the WinLGX Installation & 

Configuration Quick Guide included with your NEXUS series system.  Your NEXUS 

series system configuration properties define your switch type, any IR port settings, 
and MPEG recording presets along with your system’s internal/external video devices 

and the media resources you wish to play on the devices.  The configuration 
properties must be entered into the current image file before you can go on to creating 
a schedule of events (refer to the next section, “Software Operation,” starting on page 

214, to learn how to create a schedule).  Each NEXUS system image file holds your 
schedule events along with your system, device, and library resource 
properties.  To avoid reentering your configuration information every time you create 

a new schedule, save an image once you have entered the system, device, and library 
properties and before entering any schedule events.  Open and rename this saved 
image each time you wish to create a new schedule. 
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WINLGX MINIMUM SYSTEM REQUIREMENTS 

For the best results while operating WinLGX, LEIGHTRONIX recommends using a 16-

Bit color display adapter at 1024x768 plus the following, based on your operating 
system: 

NOTE: WinLGX does not have to be continuously running on your PC for standard 
NEXUS series system operation.   

Microsoft Windows 2000 (SP4) or XP Microsoft Windows Vista/7 

1.0 GHz or faster processor 1.6 GHz or faster processor 

512 MB of RAM (1 GB recommended) 1 GB of RAM (2 GB recommended) 
 

INSTALLING WINLGX SOFTWARE 

NOTE: The following steps were written for Windows 7 and 8 operating systems, and 

may vary for earlier versions. 

1. Place the LEIGHTRONIX Product Resource Disc in your DVD drive.  A web page 

should automatically load in your default web browser.   

If the web page does not load, perform the following steps: 

a. Open the Windows “Computer” folder. 

b. Right click on your DVD drive and select “Click to display main menu.” 

2. From the LEIGHTRONIX web page, click the button for your NEXUS series server 
product.  This will load a new page with content specifically for your system.   

3. From your NEXUS series server’s web page, click on the “WinLGX Software” link.  

If the file does not automatically download, choose the save file option when 
prompted. 

4. Navigate to where the WinLGX installer (“WinLGX v* Installer.EXE”) was saved on 
your computer or network. 

5. Right click the WinLGX installer and choose the run as administrator option to start 

the installation.  Follow the prompts to complete setup. 

6. As WinLGX installs, a succession of two additional installation windows will be 

displayed.  Refer to the following for a description of each window and installation 
guidelines: 

 Microsoft Visual C++ library window 

This window is used to install the Microsoft Visual C++ runtime components 
needed to run WinLGX on your computer or network.  Click the “Repair” button 

if you are using a version of WinLGX starting with 6 or less (for ex., WinLGX 
version 6.0.1.48).  If you are already running WinLGX 7 or greater, click the 
“Cancel” button on the bottom of the popup window. 
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NOTE: Choosing “Cancel” does not stop the WinLGX installation process, 
which will continue as a background operation.  

 VLC media player setup wizard  

VLC media player is necessary in order to use the WinLGX software preview 
and confidence monitor features (for more information on these features, see 

“Using Instant Video Preview Monitor to Display MPEG Files within WinLGX” on 
page 230 and “Monitoring an MPEG File Recording” on page 321).  If you do 
not intend to use the WinLGX software monitor features, you may opt out of the 

VLC installation process by clicking the “Cancel” button on the bottom of the 
setup wizard.  If you choose to install VLC media player, but do not want the 
player to be automatically chosen for playback of your audio and other types of 

media files on your computer, deselect “Audio Files” and “Other” under the “File 
type associations” settings during installation. 

7. Click “Finish” to close the WinLGX setup wizard and return to Windows. 
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CHANGING WINLGX APPEARANCE (THEMES)  

WinLGX provides the option for changing the appearance or “theme” of its menu bars, 
tabs, and even the entire interface window.  To customize the WinLGX interface:  

NOTE: The “Skins and Themes” options are not available when you are connected 
to your NEXUS series server/controller. 

1. Go to the “View” drop down menu and select “Themes and Colors.” 

2. On the "Themes and Colors" window, click the "Skins and Themes" tab if it is not 

already selected (see Illustration 31). 

Illustration 31, "Skins and Themes" Tab Window 

 

3. Click to choose a different interface, menu bar, and/or tab theme (see Illustration 
32). To return to the WinLGX default appearance, just select the "Default" button 

for each theme that was changed. 

 

 

Themes for 

WinLGX Tabs 

Themes for Entire 

WinLGX Interface 

Themes for 

WinLGX Menu Bars 
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Illustration 32, Example of Custom WinLGX Interface Theme 

 

4. Once you are finished with your changes, either click the “Done” button or the close 

icon in the upper right corner of the pop-up window. 

 



NEXUS Series 

Software Installation & Configuration 

LEIGHTRONIX, INC.  Page 89 
2018-06-08  WinLGX ver. 7.0.2.60 
 

ADDING / DELETING NEXUS LOCATIONS IN THE SITE MANAGER 

Use the WinLGX “Site Manager” window to manage your NEXUS series 
server/controller’s network IP address information.  WinLGX uses each server’s IP 
address to locate the server and send/receive the server’s system information.  
Manage the IP address listing of your NEXUS series server/controllers as follows: 

ADDING NEXUS SERIES IP ADDRESSES 

1. If not already open, click “Site manager” in the “Tools” menu or the  icon on the 
main toolbar to open the “Controller Site Manager” window shown in Illustration 33. 

Illustration 33, “Controller Site Manager” Window 
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2. Click “Add” on the “Controller Site Manager” window (see Illustration 33) to open 

the “Add new controller” window shown in Illustration 34.  Complete the following 

fields: 

Illustration 34, “Add New” Window 

 

 “IP Address”: enter the IP address displayed on the NEXUS series server’s 
front panel.  This address can be viewed from the front panel by pressing the up 
or down arrows until the IP Address is shown.   

NOTE: Do not enter 255.255.255.255 in the “IP Address” field. 

 Enter your user account name in the “User” field. 

 Enter your password in the “Password” field. 

NOTES:  Your username and password may only contain letters and 
numbers. 

 If you have not changed the username and password from the 
factory defaults, they are as follows: 

FACTORY-DEFAULT USERNAME AND PASSWORD FOR NEXUS SERIES  

 “USER” FIELD: “ADMIN” IN LOWER-CASE LETTERS 

 “PASSWORD” FIELD: THE LAST SIX DIGITS OF YOUR NEXUS SERIES SERVER’S 

SERIAL #   

NOTE:  ENTER ANY LETTERS IN UPPER CASE. 
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3. Click “Find.”  If you are adding the correct IP address, your server’s site ID, 

location, serial number, and time zone displays in the “Add new” window. 

NOTE: If this is the first time your NEXUS series server has been added to the 
site manager database, the following information will be displayed: 

 “Site ID”: name of the product 

 “Location”: “undefined” 

 “Serial Number”: your NEXUS series server’s serial number 

 “Time Zone”: your time zone 

Illustration 35, “Add New” Window 

 

4. Click “OK” to enter your NEXUS series server in the site manager database or 

“Cancel” to abort entry.   

5. If applicable, repeat steps 2–4 for each additional NEXUS series server in your 

system. 

DELETING NEXUS SERIES IP ADDRESSES FROM SITE MANAGER 

Click “Site manager” in the “Tools” menu or the  icon on the main toolbar to open 
the “Controller Site Manager” window shown in Illustration 33.  Perform the following 
steps: 

1. Highlight the NEXUS series IP address you wish to delete. 

2. Click “Delete” to display the delete confirmation box.  Click “OK” to delete the 
NEXUS series IP address from the site manager location.   
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3. Click “OK” at the bottom of the “Site Manager” window to save your changes to the 
database, or click “Cancel” to discard your changes. 
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CONNECTING TO YOUR NEXUS SERIES SERVER/CONTROLLER 

Before you can start controlling your NEXUS series system(s), you must f irst connect 
to each of your NEXUS series server/controllers.  This allows WinLGX to locate the 

server/controller(s) you wish to operate and enables the software to send your settings 
and commands to each connected NEXUS series system. 

1. Open the WinLGX “Site Manager” window (see Illustration 42) by performing one of 

the following:   

 Select “Site manager” in the “Tools” menu 

 Click the  icon on the toolbar 

Illustration 36, “Site Manager” Window 

 

2. Once the WinLGX “Controller Site Manager” is open, you should see a list of your 
NEXUS series systems.  If not, refer back to “Adding / Deleting NEXUS Locations 
in the Site Manager,” on page 89. 

3. If desired, reorder your NEXUS series server listing.  Clicking on any column 

header in the “Site Manager” sorts the associated information in ascending order, 
while clicking the header again sorts the list in descending order. 

4. Connect as follows (see Illustration 42): 
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NOTE: The WinLGX title bar on the main window states whether or not you are 
connected. 

a. Select one or more IP addresses.  You may select up to eight IP addresses by 
holding down your keyboard “Ctrl” key and clicking each address with the left 

mouse button.     

b. Log in with the username and password given to you by the NEXUS system 

administrator.  To simultaneously log into multiple servers, all of the selected IP 
addresses must have the same username and password. 

NOTE: Connect to multiple NEXUS series servers with different usernames 
and passwords by logging in separately to each controller. 

If the username and password have not been changed from the factory 
defaults, enter the following: 

NEXUS SERIES FACTORY-DEFAULT USERNAME AND PASSWORD 

 “USER” FIELD: “ADMIN” IN LOWER-CASE LETTERS 

 “PASSWORD” FIELD: THE LAST SIX DIGITS OF YOUR NEXUS SYSTEM’S 

SERIAL # 

NOTE:  ENTER ANY LETTERS IN UPPER CASE. 

 

NOTES:  Only letters and numbers may be used in your username and 

password. 

  Logins are case sensitive. 

 If the correct characters are not entered, an error message will 

be displayed. 

  An administrator can assign various degrees of rights to each 
username, so not all menu items or functions may be available 
to a user. 

  The last six digits of your NEXUS series server’s serial number 
are viewable from the front panel (see “Configuring Front Panel 

Settings,” on page 76) and a sticker on the back of your NEXUS 
series server. 

c. Click “Connect” or press “Enter” to connect to the chosen NEXUS series 

server/controller(s) and close the login dialog box.  Once you are connected, a 
tab appears for each NEXUS series server/controller on the main window 

beneath the toolbar.  If you logged into more than one NEXUS series system, 
switch between the server/controllers by clicking on the NEXUS product tabs on 
the main window. 
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CREATING NEW NEXUS IMAGE FILES 

Before you get started entering your system settings into WinLGX, create and save a 
NEXUS system image file.  NEXUS system image files hold your system, device, and 

library resource properties as well as your schedule events.  NEXUS image files have 
a .nmg file extension (for ex., schedule.nmg). 

NOTE: To open a saved NEXUS image file, go to “Opening a Saved Image File,” on 
page 220. 

1. WinLGX automatically opens with an empty image file loaded.  If you need to clear 
any settings, select “New” under the “File” menu. 

2. Select “Save as/Export” in the “File” menu to open the window shown in Illustration 

120, “Save As” Window.”  

Illustration 37, “Save As” Window 

 

3. From the “Save in” drop down box at the top of the window, navigate to the folder 
where you want to save the NEXUS series image file.   

4. Type a name for the image in the “File name” field.   

5. Ensure the “Controller Image (*.nmg)” option has been selected in the “Save as 
type” field. 
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6. Click “Save” to save the image under the entered name or “Cancel” to abort the 
“Save as.”   

7. As you enter your configuration settings according to the “Configuring WinLGX” 

section starting on page 97, periodically save your settings in your image file by 

selecting “Save” from the “File” menu or clicking the  toolbar button. 
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CONFIGURING WINLGX 

ABOUT THE MAIN WINDOW COMPONENTS 

Icons to run the WinLGX software are installed on the Windows desktop and in the 

“Start Menu\Programs\Leightronix, Inc.” folder.  Choosing either of these icons opens 
the WinLGX main window shown in Illustration 38. 

Illustration 38, WinLGX Main Window 

 
The components of the main window are as follows: 

 Product Tab(s): a tab appears for each WinLGX connection so that users with 
more than one NEXUS series server/controller can switch between product 

views in WinLGX.  Each product view is self-contained, allowing users to enter 
separate configuration and scheduling information for each NEXUS series 
server/controller. 

 Schedule View: window for program event scheduling 
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 Channel Output Tabs: each tab corresponds to an output on your switcher or 

NEXUS series server/controller and is selected in combination with a day tab to 
create a scheduling window 

 Day Tabs: each tab corresponds to a day of the week and is selected in 
combination with a channel output tab to create a scheduling window 

 View Change Tabs: change the main window on the WinLGX interface.  The 
“Schedule” tab displays the scheduling window (show in Illustration 38) and the 

“Overlay Templates” tab displays the grid and toolbar options for creating 
graphic/text overlay templates. 

 Configuration folders window: contains the “System Configuration,” 
“Devices,” and “Library” folders 

 Resources window: displays the resource icons for the folder selected in the 

configuration folders window 

 Resource properties window:  displays the properties of the resource 

selected in the resources window 

 Title bar: displays the program name and connection status, as well as buttons 

for minimizing, restoring/maximizing, and closing WinLGX. 

 Menu bar: contains drop-down menus of WinLGX operations (see Illustration 
39, Menu Bar and Table 17, Menu Bar Items). 

Illustration 39, Menu Bar 

 

Table 17, Menu Bar Items 

MENU ITEM FUNCTION 

“File” 

 

Click on this menu item to display the following options: 

 “New”: returns window to default settings and removes any user 

scheduling settings (see page 95) 

 “Open”: opens file selection window for selecting image files (see page 
220) 

 “Open as New”: opens file selection window to open an image file with 

a blank schedule (see page 222) 

 “Close”: disconnects WinLGX from NEXUS series server/controller on 

currently selected product tab 

 “Close all”: disconnects WinLGX from all connected NEXUS series 

servers/controllers 

 “Save”: saves a NEXUS series image that was previously saved as a 
file or opens file window for saving a NEXUS series image under a 

user-specified name and folder (see page 225) 

 “Save as/Export”: opens file window for saving a NEXUS series image 

under a user-specified name and folder (see page 225) 

 “Send”: select to send a NEXUS series image with a schedule to the 
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MENU ITEM FUNCTION 

NEXUS series server/controller (see page 301) 

 “Send all”: sends currently open image files to their corresponding 
NEXUS series servers/controllers with one click (see page 301) 

 “Receive”: select to receive image from the connected NEXUS series 
server/controller (see page 223) 

 “Receive all”: downloads image files from each of the currently 

connected NEXUS series servers/controllers with one click (see page 
223) 

 “Get log”: select to obtain log file from the connected NEXUS series 
server/controller (see page 337) 

 “Page setup”: opens window to configure schedule printout (see page 

118) 

 “Print setup”: opens window to configure the printer and paper settings 

(see page 119) 

 “Print”: click to select template and then print schedule (see page 302) 

 “Exit”: closes WinLGX program (see page 218) 

“Edit” Click on this menu item to display the following options (see 
“Scheduling/Editing/Deleting All Events,” starting on page 239): 

 “Edit”: use to edit an event in the schedule  

 “Edit switchback”: when an event or channel switchback is selected, 
this option displays the “Channel Switchback Editor” window.  The 

switchback editor allows users to quickly change the inputs assigned 
to the channel switchbacks (see page 299) 

 “Cut”: select to remove an event from a schedule and send to 
WinLGX’s clipboard 

 “Copy”: select to copy an event in the schedule to WinLGX’s clipboard 

 “Paste”: select to paste a copied event into the schedule 

 “Delete”: select to remove an event from a schedule 

 “Select All”: select all events on the selected channel and 
day/WinLGX-LT tab configuration’s schedule event window  

“View”  Check the following options to display the corresponding toolbar, window, 

or schedule columns (see page 103): 

 “Schedule Columns”: displays a window that allows you to show and 
hide the schedule columns of your choice 

 “Status Bar”: allows you to hide/show the WinLGX status bar 

 “System Configuration”: allows you to hide/show the “System 

Configuration View” window 

 “Resource”: allows you to hide/show the “Resource View” window 
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MENU ITEM FUNCTION 

 “Properties”: allows you to hide/show the “Properties” window 

 “Reset views”: returns the “System Configuration View,” “Resource View,” 

and “Properties” windows to their default positions and sizes on the main 
window 

 “Themes and colors”: displays pop-up window with options for changing 

the WinLGX interface appearance (themes) as well as the schedule and 
control panel colors (see “Changing WinLGX Appearance (Themes),” on 

page 87 and “Configuring WinLGX Interface Colors,” on page 107) 

“Tools” Click on this menu item to display the following options: 

 “Control Panel”: opens control panel window (see “Using Control Panel 
to Perform Immediate Device and Switch Actions,” beginning on page 

306) 

 “Controller”: opens window for configuring site information, setting 

clock, performing firmware updates, and rebooting (see page 114) 

 “Set front panel password”: opens window for setting front panel 

password (see page 114) 

 “Export/Print Templates”: opens window for creating templates that 
determine which schedule information is exported or printed (see page 

116) 

 “User defined data”: opens window for configuring user-defined 

schedule event columns (see page 121) 

 “Storage Manager”: opens window for managing MPEG videos, JPEG 

slides, and overlays (see page 328) 

  “Site Manager”: opens window for adding or deleting NEXUS series 

locations (see page 93) 

 “User accounts”: opens window for configuring user account settings 
(see page 110) 

 “Web Interface”: opens the WebNEXUS login prompt for the connected 
NEXUS series server/controller IP address (see page 352) in your 

default web browser 

  “Total Backup”: opens window for saving and restoring MPEG videos, 

slides, and NEXUS series system information (see page 446) 

 “System tools”:  
 “Switchback editor”: provides access to the “Channel Switchback 

Editor” window.  The switchback editor allows users to quickly 
change the inputs assigned to channel switchbacks (see page 299) 

 “Sync Library Resources”: checks NEXUS series image files for 
library resources and schedule events referencing MPEG files no 
longer on the NEXUS series system’s storage device(s) (see page 

299) 

 “Preferences”: opens window for configuring WinLGX main window 

components, including time format, sorting filter for library resource 
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MENU ITEM FUNCTION 

items, and display of schedule columns (see page 124) 

“Help”  “Leightronix Support Center”: opens the LEIGHTRONIX Support Center 

in your default web browser.  Support Center provides manuals, tutorials, 
training videos, and software and firmware updates for your NEXUS 

series server. 

 “WebEx”: opens the LEIGHTRONIX WebEx portal in your default Web 

browser.  LEIGHTRONIX uses WebEx with customers for training and 
technical support. 

 Click on “About WinLGX” to display a window with the WinLGX version 

number (see “Displaying WinLGX Version Number,” on page 215). 

 Main Toolbar: contains icons for some of the most frequently used operations 

(see Illustration 40 and Table 18, Toolbar Items). 

Illustration 40, Main Toolbar 

   

Table 18, Toolbar Items 

TOOLBAR BUTTON FUNCTION 

 
Opens file selection window for selecting image files (see “Opening a 
Saved Image File” on page 220) 

 
Opens file selection window for opening an image file with a blank 

schedule (see “Opening an Image File as New,” on page 222)   

 

Saves a NEXUS series image that was previously saved as a file or 

opens file window for saving a NEXUS series image under a user-
specified name and folder (see “Saving NEXUS Series Image Files,” 
on page 225) 

 

Opens window for selecting preferences on WinLGX’s appearance 

and select operations (see “Setting WinLGX Viewing and 
Communication Preferences,” beginning on 124) 

 
Displays control panel window (see “Using Control Panel to Perform 
Immediate Device and Switch Actions,” beginning on page 306)  

 
Sends an image file to the connected NEXUS series server/controller 

(see “Sending NEXUS Series Image Files,” on page 301) 

 

Receives image from the connected NEXUS series server/controller 

(see “Receiving Image Files from the Connected NEXUS Series 
Server/Controller(s)” beginning on page 223) 
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TOOLBAR BUTTON FUNCTION 

 

Checks NEXUS series image files for library resources and schedule 

events referencing MPEG files no longer on the NEXUS series 
system’s storage device(s) (see “Checking Schedule and Library 
Resources for Missing MPEG Files” on page 299) 

 

Displays window for managing JPEG slides, MPEG videos, and 

overlays (see “Managing Storage of Video, Slide, and Overlay Files,” 
on page 328) 

 
Obtains log file from the connected NEXUS series server/controller 

(see “Retrieving Log Files,” on page 337) 

 
Opens application for saving and restoring MPEG videos, slides, and 

NEXUS series system information (see “Total Backup ,” on page 446) 

 

Displays window for adding or deleting NEXUS series 

servers/controllers network locations (IP addresses) to WinLGX (see 
“Adding / Deleting NEXUS Locations in the Site Manager,” on page 
89) 

 
Displays window for selecting an export/print template (see “Printing 

Schedules from WinLGX,” on page 302) 

 Opens the WebNEXUS login screen in your default web browser 

 Displays a window with the WinLGX version number (see page 215) 
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CONFIGURING THE MAIN WINDOW COMPONENTS 

 Product Tabs: you can click to close each of your product tabs.  Simply click on a 

tab with the right mouse button and select “Close.”  In the pop-up window that 
opens, select “Yes” to indicate you want to disconnect from the selected product.  

 Close Icon: to remove a view window from the WinLGX interface, click the close 
icon on the window’s toolbar (see Illustration 41).  To display the window again, go 
to the “View” menu and select “Reset views.” 

Illustration 41, View Window Close Option 

 

 Hiding/Displaying Windows and Schedule Columns through the “View” Menu  

The “View” menu, shown in Illustration 42, may be used to hide or show the 
schedule column headings and status bar, as well as display hidden/closed 

“System Configuration,” “Resource,” and “Properties” windows.   

Illustration 42, “View” Menu 

 

 
 To show/hide the WinLGX status bar, click on “Status Bar” in the “View” menu 

to hide it on the main window or uncheck item to display it.   
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 To show hidden/closed “System Configuration,” “Resource,” or “Properties” 
windows, click on the desired window in the “View” menu to display it on the 
main window.   

 To return the “System Configuration,” “Resource,” and “Properties” view 
windows to their default positions on the main window, select “Reset views” in 
the “View” menu. 

 To show/hide schedule columns, click on “Schedule Columns” in the “View” 

menu or the “Schedule” tab under “Preferences” in the “Tools” menu (see 
“Setting WinLGX Viewing and Communication ,” on page 124).  Note that the 
“Day Tab Columns” listing corresponds to the columns on the schedule 

window’s day tabs and the “WinLGX-LT” listing corresponds to the columns in 
the schedule’s WinLGX-LT tab (see Illustration 43, Schedule Columns Selection 
Menu).  Perform the following steps: 

Illustration 43, Schedule Columns Selection Menu 

 

1. Show/hide columns as follows: 

 Click to check column headings you want to show on the schedule 
window and uncheck columns you want to hide 

 Click the “All” button to display all of the columns on the 

corresponding schedule windows  
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 Click the “None” button to remove all columns on the corresponding 

schedule windows  
2. When all selections have been made, click “OK” to display changes on 

schedule or “Cancel” to abort changes. 

 Moving Windows  

The “System Configuration,” “Resources,” and “Properties” windows may be 

moved to any location on the main window by clicking on the windows’ title bars 
and dragging the windows to the desired position on the WinLGX interface.  To re-
dock the windows, click on the windows’ title bars and drag to the far right side of 
the main window. 

 Rearranging Schedule Column Headings 

To rearrange the order of the schedule column headings, click on the desired 
heading and drag it to the beginning of the heading you would like it to displace.  
The displaced heading will shift to the right of the newly positioned heading. 

 Resizing Schedule Column Widths 

To resize a column heading, move the mouse pointer over the right-side border of 
the column you wish to resize.  When the pointer changes to the resize arrows 

symbol (see Illustration 44, Resizing Schedule Column), you may perform one of 
the following: 

Illustration 44, Resizing Schedule Column 

 

 Drag the column border to the desired width. 

 Double click to resize the column so it is only wide enough to accommodate the 
column’s largest field item. 

 Using Subfolders to Organize “Library” Folder Resources 

 Creating library subfolders 

1. Right click in the configuration folders window and select “New” in the right-
click menu that appears. 

2. A new subfolder will be displayed under the “Library” folder.  To rename the 
subfolder, right click on its name and select “Rename” in the right-click menu 
that appears.  Enter a new folder name. 

Resize Arrows 

Symbol 
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 Adding existing library resources to subfolders 

Right click on a library resource icon and select “Move to” in the menu that 
appears to display the window shown in Illustration 45.  Display the “Library” 

folder’s subfolders by either clicking on the “+” next to the folder icon or 
checking the “Expand all” box. 

Illustration 45, "Select Destination Folder" Window 

 

 Adding new library resources to a subfolder 

Select the desired “Library” subfolder in the configuration folders window and 
create a new library resource in the “Resources View” window. 

 Deleting a library subfolder 

Right click on the desired library subfolder and select “Delete” in the menu that 
appears. 
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CONFIGURING WINLGX INTERFACE COLORS 

From the “View” drop down menu, select “Themes and Colors” to display the 

corresponding window.  Perform the following tasks from the window’s three color 
selection tabs.  Click “Done” on the bottom of the “Themes and Colors” window to 
save changes you have made in any of the tabs and close the window. 

Schedule Colors Tab 

Click the “Schedule Colors” tab and choose the text and background colors shown in 

Illustration 46 for the following elements on the “Schedule” and ”Overlay Template” 
windows:  

Illustration 46, “Schedule Colors” Tab 

 

 Event rows in the “Schedule” and “Overlay Templates” views 

 Selected events in the “Schedule” and “Overlay Templates” views  

 Channel switchbacks (SWB) 

 Filled channel switchbacks (SWB) 

 “Event Properties” window fields available for editing 

 “Event Properties” window fields not available for editing 

 “Playlist” library resource events 

Colors of 
Alternating 

Events in 
“Schedule” View  

Colors of “Event 

Properties” Window 
Fields Available for 

Editing 

Colors of  

 “Event Properties” 
Window Fields Not 

Available for Editing 

Colors of Selected 
Events in “Schedule” 

View 

Colors Used to Highlight 
Schedule Events with 

MPEG Files Not in 
USB/NAS Storage 

Colors of Channel 
Switcbacks (SWB) 

Colors of Channel  
Switchbacks (SWB) 

Filled with “Playlist” 

Resources 

Colors of Filled 

Channel 
Switchbacks (SWB)  

Colors of 

“Playlist“ Library 
Resource Events  

Colors of 
Alternating Events 

in “Overlay” View 

Color of Selected Events 
in “Overlay” View  

Toggles the Schedule 

Grid Lines On/Off  
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Control Panel Colors Tab 

Click the “Control Panel Colors” tab (see Illustration 47, “Control Panel Colors” Tab 
Window) and choose the text and background colors for the NEXUS series control 

panel. 

Illustration 47, “Control Panel Colors” Tab Window 

 
 

Colors Shown on 
the “List” View 

Colors Shown 
on the 

“Buttons” View 
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Other Colors Tab 

Click the “Other Colors” tab (see Illustration 48, “Other Colors” Tab Window) and 
choose the text and background colors for the “Overlay Graphic Editor” window (see 

Illustration 49) used when creating overlay library resources. 

Illustration 48, “Other Colors” Tab Window 

 
 

Illustration 49, “Overlay Graphic Editor” Window Colors 

 

Inactive 
Background Color 

Active 

Background Color 
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SETTING USER ACCOUNT RIGHTS (INCLUDING WINLGX PASSWORD 
CHANGES) 

1. Select “User accounts” in the “Tools” menu to open the “User Accounts” window 

(see Illustration 50).  

NOTE: This menu item will only become enabled upon login for users with 

“Administrator” rights. 

Illustration 50, “User Accounts” Window 

 

2. WinLGX and WebNEXUS user rights are described in Table 19, User Control and 
Configuration Rights (see page 112) and Table 20, User File Access Rights (see 
page 113).  Perform any of the following according to the steps below: 

 Add a user account 

 Edit a user account 

 Delete a user account 

NOTE: All functions controllable from the NEXUS series server/controller’s front 
panel are only restricted by the front panel password. 

3. When finished configuring user information, exit the “User Accounts” window by 
clicking the “Close” button. 

 Add a user account 

a. Click “Add.” 

b. Enter new username and password. 
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NOTES:  Logins are case sensitive. 

  Your username and password may only contain letters and 
numbers. 

c. Select the user rights you want the user to be able to access as follows: 

 Click the “All” button to select all of the “Control and configuration” user 
rights. 

 Click the “None” button to deselect all of the “Control and configuration” 
user rights, except “System Status.” 

NOTE: The “System Status” right is automatically given to each user 
and may not be deselected. 

 Individually select the rights you want the user to possess by checking 

the corresponding user rights boxes.  To deselect a right, uncheck it by 
clicking on its box. 

d. Click “Ok” to send the new user settings to the NEXUS series 
server/controller or “Cancel” to abort the addition. 

 Edit a user account 

NOTE: When editing the “admin” user account, only the password may be 
changed. 

a. Highlight the desired username and click “Edit.” 

b. If desired, change username and/or password. 

c. Select the user rights you want the user to be able to access as follows: 

 Click the “All” button to select all of the “Control and configuration” user 
rights. 

 Click the “None” button to deselect all of the “Control and configuration” 
user rights, except “System Status.” 

NOTE: The “System Status” right is automatically given to each user 
and may not be deselected. 

 Individually select the rights you want the user to possess by checking 
and unchecking the corresponding user rights boxes.  

d. Click “Ok” to send the new user settings to the NEXUS series 
server/controller or “Cancel” to abort the edit. 

 Delete a user account 

NOTE: All slides uploaded under the user account will be deleted from the 
NEXUS series server/controller along with the account. 

a. Highlight the desired username and click “Delete.” 

b. In the dialog box that appears, click “Yes” to delete user or “No” to abort the 
change.  
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Table 19, User Control and Configuration Rights 

USER RIGHTS DESCRIPTIONS 

“Administrator (user 
accounts, 

firmware)” 

 WinLGX: allows user to change user account rights, front 

panel password, and volume names and perform firmware 
updates 

 WebNEXUS: allows user to perform emergency messaging, 

Virtual Channel, and program guide functions; set up file 
transfer destinations and record settings as well as record 

MPEG files; transfer MPEG files; view log files; manage 
system settings 

“Automatic slide 

authorization” 

Causes any slides uploaded or created by the user to be 

automatically approved for display  

“Device (play, 

rewind, stop)” 

Allows user to cause a device to play, rewind, or stop 

“Device (record)” Allows user to cause a device to record 

“MPEG/Slide 

control (play)” 

Allows user to play an MPEG file or display a slide from the 

Control Panel; also, allows user to schedule a slide or slide 
show 

“MPEG/Slide 

control 
(record/setup)” 

 WinLGX: allows user to record MPEG files from the Control 

Panel  

 WebNEXUS: allows user to set up file transfer destinations 

and record settings as well as record MPEG files  

“Schedule control” Allows user to stop or run a schedule  

“Site identity 
configuration” 

Allows user to edit the NEXUS series site name and location 
and reboot the server/controller 

“Slide 

Administrator” 
 WinLGX: allows user to authorize slides for display in slide 

shows and create emergency messages 

 WebNEXUS: allows user to perform slide management 
within all user folders and authorize slides for display in slide 

shows; perform emergency messaging and program guide 
functions 

“Switcher control” Allows user to perform switches from control panel 

“Switcher and serial 
configuration” 

Not used 

“System 

configuration 
(control/clock)” 

Allows user to set clock from the “Controller” window under the 

“Tools” menu 



NEXUS Series 

Software Installation & Configuration 

LEIGHTRONIX, INC.  Page 113 
2018-06-08  WinLGX ver. 7.0.2.60 
 

USER RIGHTS DESCRIPTIONS 

“System status” This is a default right that allows all users to view the NEXUS 

series server/controller status from the Control Panel 

“TCP/IP 
configuration” 

Allows user to set up the TCP/IP addresses 

 

Table 20, User File Access Rights 

USER RIGHTS DESCRIPTIONS 

“No file access”  WebNEXUS: user allowed to perform JPEG slide 

management functions (add, edit, rename, delete) within his 
remote user folder 

 WinLGX: user prevented from performing the following: 

 Sending and receiving NEXUS series image files 

 Opening the “Storage manager” window (see “Managing 

Storage of Video,” on page 328, for more information on 
the “Storage manager” window).   

 Accessing current log files 

“Receive only”  WebNEXUS: user allowed to perform JPEG slide 

management functions (add, edit, rename, delete) within his 
remote user folder; user may transfer files from NEXUS 
series system storage areas to configured file destinations  

 WinLGX: user prevented from sending NEXUS series image 
files and moving/copying JPEG slides and MPEG files from 

one storage device to another  

“Send and receive”  WebNEXUS: user allowed to perform all JPEG slide 

management functions (add, edit, rename, delete) within his 
remote user folder; user may transfer files from NEXUS 
series system storage areas to configured file destinations 

 WinLGX: user allowed to send slides, PNG overlays, and 

MPEG videos to NEXUS series server/controllers, but not 
image (schedule) files; user prevented from renaming and 
deleting files on the remote storage devices 
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USER RIGHTS DESCRIPTIONS 

“Send, receive, 

rename and delete” 
 WebNEXUS: user allowed to perform all JPEG slide 

management functions (add, edit, rename, delete) within his 
remote user folder ; user may transfer files from NEXUS 

series system storage areas to configured file destinations 

 WinLGX: user allowed to perform all software functions, 

including sending and receiving NEXUS series images 
(schedules) and renaming and deleting slides, PNG 
overlays, and MPEG files on the remote storage devices 

 
CHANGING FRONT PANEL PASSWORD 

1. Select “Set front panel password” in the “Tools” menu to open the window shown in 
Illustration 51. 

Illustration 51, “Set Front Panel Password” Window 

 

2. Click on a combination of five arrows for the new front panel password. 

3. Click “Set” to accept new password or “Clear” to cancel. 

4. Click “Done” to close the “Set Front Panel Password” window. 

CONFIGURING SITE INFORMATION, CLOCK, UPDATING FIRMWARE, AND 
REBOOTING 

1. In the “Tools” menu, choose “Controller” to open the window shown in Illustration 

52, “Controller” Window. 
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Illustration 52, “Controller” Window 

 

2. Use the “Controller” window to set the following configuration maintenance 

settings.  After clicking “Set,” “Update,” or the “Reboot” button, you will be 
prompted for confirmation to perform the action on the connected NEXUS series 
server/controller.  Clicking “Yes” opens a box showing location name, action status, 

progress bar, and connection and action attempt counts.  An “action completed” 
box appears when finished.  If the action appears to be stalled or if you would like 
to interrupt the action, click the “Cancel” button. 

 Site name 

Click on the “Site name” field and enter an alias into the field.  Click “Set” to 

make the change.  This name will appear on the Controller’s tab on the main 
window. 

 Site location 
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Click on the “Site location” field and enter the Controller’s location into the field.  
Click “Set” to make the change. 

 Time Zone 

Select the desired time zone from the list and click the “Set” button above the 
time zone field.  The list contains the standard Windows time zones for the 
United States.  If you would like the clock to automatically adjust for daylight 
savings time, check the corresponding box under the time zone field. 

 Clock 

Set your server/controller’s clock using one of the following methods: 

 Use your PC’s time: click the “Set” button to the right of the “PC Current 
time” field.  WinLGX uses the PC time, PC time zone, and Controller time 
zone to set the time, adjusting the time to account for zones crossed.  All of 
these items need to be correct for the set time to be accurate. 

 Enter the date and/or time in the “User time” date and time fields.  Either 
type or use each field’s drop down menu to enter the new date and/or time 
and click the “Set” button. 

 Firmware Update 

To perform a firmware update, refer to “Updating NEXUS Series 
Server/Controller and/or DVply Firmware,” on page 345. 

 Reboot   

To reboot the connected NEXUS series server/controller, click the “Reboot” 
button. 

3. Click “Close” to close the “Controller” configuration window. 

 

CREATING TEMPLATES FOR EXPORTING/PRINTING SCHEDULES 

Schedule templates allow you to determine which schedule information will be 
exported or printed.  Schedules can be exported into a comma delimited file format 
(.csv) (see “Exporting Schedules,” on page 304) or printed directly from WinLGX (see 
“Printing Schedules,” on page 302). 

1. Create a schedule template per the following steps:  
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a. Click “Export/Print templates” in the “Tools” menu to open the window shown in 
Illustration 53.  

Illustration 53, “Export/Print Templates” Window 

 

b. Select template display items as follows: 

NOTES:  The “Format” field is intended for future use and may only be set to 
“Report.” 

 Click “New” to clear all settings. 
` 

 Determine which event windows will be filtered for the schedule template:   

1. Check the boxes in “Day/WinLGX-LT” section to select the desired days 
or “WinLGX-LT.” 

2. Check the boxes in the “Channel” section to select the channel outputs 

that should be included for the selected days.   

NOTE: The channel list varies depending on your system switcher 
configuration.   

 Check the “Export/print switchbacks” checkbox to display channel 

switchbacks between programs.   

 Check “Export/print all records” to include all events in the selected event 

windows.   

NOTE: This function overrides any export or print values set to “No” in the 

device and library resource and event properties. 
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 Specify the schedule column information you want the template to add to 

your printouts and exported files as follows: 

NOTE: No schedule event information will be added to your printouts or 
files unless columns are added to the “Used” box.  

 Add a field to the “Used” list by double clicking a field item in the 
“Available” list or selecting it and clicking “>>.” The fields in the “Used” 
list will be printed/exported in the selection order listed.   

 To add a field in a specific order within the “Used” list, highlight the 
“Used” display item you would like to display the new field before.  
Double click a field item in the “Available” list or select it and click “>>.” 

The new field is added above the selected field (select the blank field at 
the bottom to add a field to the end of the list). 

 Remove a “Used” field, by double clicking it or selecting it and clicking 

“<<.” 

c. Click “Save” to save the template to a file.   

2. To revise a template: 

a. Click “Export/Print templates” in the “Tools” menu to open the window shown in 
Illustration 53, “Export/Print Templates” Window. 

b. Click “Load.”  In the “Select Export/Print Template” window that appears, 
browse for the desired template and open.  The filename will then appear in the 

“Template” box at the top of the “Export/Print Templates” window.   

c. Click “Save” to open the “Save Export/Print Template” window.  Click the “Save” 

button and then “yes” to overwrite the template file. 

3. Click “Done” when finished to close the “Export/Print Templates” window. 

CONFIGURING PAGE LAYOUTS FOR SCHEDULES PRINTED FROM WINLGX 

The following steps allow you to determine the page layout of schedules printed 
directly from WinLGX.   

1. Select “Page Setup” in the “File” menu to open the box shown in Illustration 54, 
“Page Setup” Window, and configure the schedule printout according to the 

following options: 
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Illustration 54, “Page Setup” Window 

 

 “Print Header information” section: check the items you want to appear at the 

top of the printout.  “Program version” refers to the top two lines shown in 
Illustration 55, Example of a Schedule Header. 

Illustration 55, Example of a Schedule Header 

WinLGX  Version 1.01.20                                                          Page 1 

Copyright © 2005,  LEIGHTRONIX, INC. 

Image Filename: UltraNEXUS/NEXUS.nmg 

Template Filename: nxs.xpt 

Today is: Mon Apr 18 13:02:33 2005 

  “Print Record information” section: check the items you want to appear above 
the schedule data.   

 “Field names” shows the column headers.   
 “Separator bar” inserts a line of dashes. 

 “Print Font” section: choose the font size and weight (normal/bold). 

2. Click “OK” to save your settings or “Cancel” to close the window without saving. 

CONFIGURING PRINTER AND PAPER SETTINGS FOR SCHEDULES PRINTED 
FROM WINLGX 

1. Selecting “Print Setup” in the “File” menu opens the box shown in Illustration 56, 

“Print Setup” Window, which allows you to configure the printer and paper settings 
as follows:   
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Illustration 56, “Print Setup” Window 

 

 “Printer” section: choose the desired printer from a list of your PC’s available 

printers.  When a printer is chosen, its status appears below the “Name” field.   

 “Properties” button”: click to open a window specific to the printer, so that 

detailed printer settings can be made. 

 “Paper” section: choose the size and source tray of the paper.   

 “Orientation” section: choose to print in portrait or landscape mode.  If your 

printing template has many fields (columns) chosen, you may want to print in 

“Landscape” mode to fit it all from left to right.  Print in “Portrait” mode if you 
don’t have many fields (columns) and want to fit more events on a page.  

 “Network” button: click to open a network printing window so that you can attach 

to and print to a network printer, if it is not already in the upper list.  

2. Click “OK” to save your settings or “Cancel” to close the window without saving. 
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CREATING CUSTOM SCHEDULE COLUMNS 

The 11 generic “Field Name” schedule columns allow you to categorize program 
events in your schedule.  Users may assign each of these columns a new heading 

along with a list of menu options for classifying each event under your custom 
headings on the schedule. Using the “User Defined Resource Data” window, shown in 
Illustration 58, rename and add menu items to the desired field columns as follows: 

Illustration 57, Example of Schedule with Custom Schedule Columns 

1. Click “User defined data” under the “Tools” menu to open the window shown in 
Illustration 58. 

Illustration 58, “User Defined Resource Data” Window 
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2. Select the fields displayed on your schedule as follows: 

 To show all fields, ensure the “Show all field names” box is checked.  

 To hide all fields, ensure the “Show all field names” box is unchecked. 

 To hide one or more fields, uncheck the “Show” box next to the each field you 

would like to hide. 

3. Click on the field which you would like to rename.  In the “Edit Field Options” 
window that appears (see Illustration 59), perform the following: 

Illustration 59, “Edit Field Options” Window 

 

a. Enter a new schedule heading into the “Menu title” field. 

b. Add a list of menu options that will be used to define schedule events for the 

custom column.  The number of menu items that may be added corresponds to 
the number of options shown over each section of field names on the window. 

 Add new menu items: click the “Add” button to display the “Add menu item” 
window (see Illustration 60).  Enter the desired menu item and click “OK” to 

add to the “Menu item” drop down list or “Cancel” to abort the change. 

Illustration 60, “Add Menu Item” Window 
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 Edit menu items: select the desired menu item from the drop down list and 

click the “Edit” button to display the “Edit menu item” window (see Illustration 
61).  Enter a new menu item and click “OK” to change the “Menu item” drop 
down list or “Cancel” to abort the change. 

Illustration 61, “Edit Menu Item” Window 

 

 Delete menu items: select the desired menu item from the drop down list 
and click the “Delete” button to display a confirmation window (see 

Illustration 62).  Click “Yes” to change the “Menu item” drop down list or “No” 
to abort the change. 

Illustration 62, Menu Item Delete Confirmation Box 

 

4. Click “OK” to accept changes or “Cancel” to abort all editing changes made in the 
“Edit Field Options” window and return to the “User Defined Data” window. 

5. Click “OK” to accept or “Cancel” to abort all field changes and close the “User 

Defined Data” window. 
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SETTING WINLGX VIEWING AND COMMUNICATION PREFERENCES 

In the “Tools” menu, choose “Preferences” to open the “Preferences” window.  
Perform the following tasks from the window’s five tabs.  Click “OK” on the bottom of 

the “Preferences” window to save changes you have made in any of the tabs or 
“Cancel” to discard them. 

Application Tab 

Click the “Application” tab (see Illustration 63, “Application” Tab) and perform any of 
the following: 

Illustration 63, “Application” Tab 

 

 “Default controller type”: select a default controller type from the drop down 
menu.  When opened, WinLGX will automatically display the window settings 
for the selected controller type.  This allows you to create and save image files 

when you are not connected to your controller. 
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 “Set schedule to current day on file load”: this preference causes WinLGX 

to select the current day tab when a NEXUS series image file is loaded 

 “Sync library resources when sending or receiving image”: when this 
option is selected, WinLGX automatically checks NEXUS series image files for 
library resources and schedule events referencing MPEG files no longer on the 

NEXUS series system’s storage device(s) (see “Checking Schedule and Library 
Resources for Missing MPEG Files” on page 299 for more details).  The check 
is triggered when the WinLGX open, receive, and send image file operations 

are performed. 

 “How to indicate when a tab has data”: to highlight which of your day and 
channel output tabs contain schedule events, select either the “Asterisk” or 

“Parentheses” indicator options.  The default is “None.” 

 “24 hour time format”: select to change WinLGX to a 24 hour (military) time 
format.  If left unselected, WinLGX defaults to a 12 hour (A.M./P.M.) time format.   

NOTE: This does NOT change the time format on the front of your NEXUS 
series server/controller.  

 “Load image from controller after connect/login”: selecting this option 
causes the image file last sent to the NEXUS series server/controller to be 

loaded after the user connects to the system through WinLGX. 

 “Use passive FTP”: if your firewall is blocking your schedule and MPEG files, 

check this option and then resend the files to your NEXUS series 
server/controller.    

 “Hide event editor when dropping library objects”: if selected, an event 
properties window will not be displayed when a library item is dragged onto any 

of the schedule’s day tabs unless you are holding down the keyboard “Alt” key.  

 “Show WinLGX-LT tab in the schedule window”: select this box to display 

the corresponding tab at the bottom of the schedule window.  Refer to 
“WinLGX-LT Tab” on page 235 for more information on this tab. 

 “Show jpg edit files option in Storage Manager”: checking this option 
causes the “Show Edit Files” option to appear on the Storage Manager window 

when the “Slides” file type is selected.  When selected, the “Show Edit Files” 
option causes the Storage Manager to list the .fie files for any slides originally 
created in a WebNEXUS slide editor.  When slide .jpg files are transferred with 

their .fie files off of your NEXUS series server, you have the option later of re-
uploading the slide files back onto a NEXUS series server for editing in 
WebNEXUS.  Refer to “Transferring Graphic/Text Layers with Slides Created in 

a WebNEXUS Slide Editor,” on page 335, for more information on slide .fie files. 

 “Default single slide length”: type or use the up/down arrows to specify the 

number of seconds WinLGX will automatically place in the “length” field for a 
slide library resource or schedule event after a slide filename is selected.  The 
default display length may be changed to a value of 5–90 seconds.  You may 
edit the “length” values for each of your single slide library resources or 
schedule events. 
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 “Frame rounding threshold (frames)”: type or use the up/down arrows to set 

a rounding threshold from 5–29 frames (the default value is 5 frames).  This 
option allows you to control the playback duration of your MPEG files based on 
the last milliseconds of video/audio frames (1 second of an MPEG file = 30 

frames).  Once the threshold value is set, the MPEG player will round the 
playback duration of any files with frames equal to or greater than the threshold 
up to the nearest second.  If the number of frames at the end of a file is less 

than the threshold value, the file’s playback duration will be trimmed down to 
the nearest second.   

 “Apply to all channel switchbacks”: when a digital library resource is 
dragged onto a channel switchback and the “Apply to all switchbacks” option is 
checked (see page 297 for more information on filling channel switchbacks), the 

following will occur based on which of the options below is selected: 

 “By the day”: adds resources to channel switchbacks between scheduled 

program events on the selected channel output’s day tab 

 “By the week”: adds resources to channel switchbacks between scheduled 
program events on all of the selected channel output’s day tabs  

 “Default control panel switch layout (for 256 or fewer crosspoints)”: if you 
are using an external routing switcher that has a total of 256 or less input/output 

crosspoints (to obtain your total crosspoints, multiply your switcher’s inputs by 
its outputs), then you may choose to display your inputs/outputs on the WinLGX 
Control Panel as either “Buttons” or in a “List.”  Those with an external switcher 

having more than 256 crosspoints will automatically see their inputs/outputs in 
the “List” view on the Control Panel.  Refer to “Performing Forced Switches and 
Viewing Switcher Status” on page 308 for more details on both options. 

 Under “Total Backup application folder,” define where the NEXUS series 

Total Backup software application is installed by entering a file path or browsing 
to it with the yellow folder icon.  Setting this preference enables you to open the 
program from within WinLGX with the Total Backup icon or menu item. 

 Under “Log viewer,” click the button to the right of the log viewer field to select 
a software program for viewing your NEXUS series log files. 
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Event Editor Tab 

Each event properties window for a device or library resource item may be configured 
to show different fields under a “minimum” and “maximum” view.  During scheduling, 

you may toggle between these views by selecting and deselecting the “Maximum 
view” checkbox on the event properties dialog (refer to Illustration 64). 

Illustration 64, Example of Event Properties Window 

 
 

Maximum View 
Selected 
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To configure the field views for your device and library event properties windows, click 
the “Event Editor” tab (see Illustration 65, “Event Editor” Tab Window) and perform the 

following: 

Illustration 65, “Event Editor” Tab Window 

 

1. Under “Format type,” select the format of the device/library event properties 

window you would like to configure. 

2. Perform any of the following options: 

 “Restore defaults” button: click to return the selected format’s minimum and 
maximum views to the factory default settings. 

 “Minimum view” column 

 Click the desired boxes to select/deselect individual event property fields.  A 
checkmark indicates the corresponding field will appear in the minimum view 
for the event properties dialog. 
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 “All” button: click to show all fields within the minimum view for the event 
properties dialog.  

 “None” button: click to hide all fields within the minimum view for the event 
properties dialog. 

  “Maximum view” column 
 Click the desired boxes to select/deselect individual event property fields.  A 

checkmark indicates the corresponding field will appear in the maximum 
view for the event properties dialog. 

 “All” button: click to show all fields within the maximum view for the event 

properties dialog.  
 “None” button: click to hide all fields within the maximum view for the event 

properties dialog. 
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Preview Monitor Tab 

WinLGX includes preview monitor windows for displaying MPEG video files prior to 
scheduled or immediate playback, during clip editing, and as files are recorded.  Set 

up and control the operation of these software monitors by clicking the “Preview 
Monitor” tab (see Illustration 66, “Preview Monitor” Tab) and performing any of the 
following: 

Illustration 66, “Preview Monitor” Tab 

 

 “Clip editor playback”: choose “Software monitor” to view and edit clips 
with the WinLGX video clip editor or “Hardware monitor” if you would prefer 
during editing to view your video clips on an external monitor attached to 

your NEXUS series system. 

 “Default hardware playback device”: if using an external hardware 
monitor to view clips during editing, use this option to either select a default 

MPEG player to display clips (choose “MPEG Player 1” or “MPEG Player 2”) 
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or to display a window allowing you to select an MPEG player at the start of 
each clip editing process (choose “Ask”).   

 “MPEG preview playback”: choose one of the following options for 
previewing your MPEG video library resources in the WinLGX instant video 
preview monitor: 

 “Context menu only”: video library resources may only be displayed in 
the instant video preview monitor by by right clicking on a resource and 

choosing the “View resource” option.   

 “Double-click filename”: video library resources can be displayed in 

the instant video preview monitor by either double clicking a resource or 
by right clicking on a resource and choosing the “View resource” option. 

 “Remember screen size and position”: causes the WinLGX video clip editor 
and instant video preview monitors to display in the last place and size they 

were changed to 

 “Timecode display”: causes the selected video clip’s total time length as well 
as the current playback time to be displayed on the WinLGX video clip editor 

and instant video preview monitors. 

 “Forward and Reverse jump value”: allows you to set the WinLGX video clip 
editor and instant video preview monitors’ forward and reverse buttons so they 

move the current playback indicator in increments of anywhere from one to 
ninety seconds.  

 “Record playback delay”: specify how long (five to ninety seconds) after a 
recording begins before the resulting file will display on the WinLGX confidence 

monitor. 

 “Video driver interface”: leave this option set to “Auto-detect,” unless you find 
the WinLGX preview monitors will not display your MPEG videos.  In that case, 

try the other options until you find the one compatible with your computer’s 
video card. 

 “VLC Application Folder”: VLC media player must be installed on the 

computer running WinLGX if you wish to display MPEG videos in the WinLGX 
preview monitor windows.  If WinLGX states that it cannot find the VLC media 
player when you open a preview monitor window, first ensure that VLC player is 

installed on your computer.  If the VLC player is not installed, download the free 
program from the Internet.  Once installation has been verified or completed, 
find your computer’s file path for the folder containing the VLC executable file 

(“vlc.exe”).  Enter your file path into the “VLC Application Folder” field (for 
example, C:\Program Files\VideoLAN\VLC). 
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Resource Library Tab 

Click the “Resource Library” tab (see Illustration 67, "Resource Library" Tab) and 
check the “‘Show in program guide’” property to automatically populate the 

corresponding fields when creating MPEG playback library resources (go to page 184 
for more information on creating MPEG library resources).   

Illustration 67, "Resource Library" Tab 
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Resource View Tab 

Click the “Resource View” tab (see Illustration 68, “Resource View” Tab Window) and 
configure the length library resource sorting filter for your library resource items.  Your 

custom length sorting options appear when you right click in the library resource 
window and choose “Show icons by”/”Length”/your length presets (see for example). 

Illustration 68, “Resource View” Tab Window 
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Illustration 69, Library Resource Length Sorting Options 
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Schedule Tab 

Click the “Schedule” tab (see Illustration 70, “Schedule” Tab Window) and show/hide 
columns in the “Schedule” view.  Note that the “Day Tab Columns” listing corresponds 

to the columns on the schedule’s day tabs and the “WinLGX-LT” listing corresponds to 
the columns on the schedule’s WinLGX-LT tab.  Perform the following steps: 

Illustration 70, “Schedule” Tab Window 

 

1. Select the columns displayed on your schedule as follows: 

 To show all columns in the corresponding schedule tab, click the “All” button.  

 To hide all columns in the corresponding tab, click the “None” button. 

 To hide one or more columns in the corresponding tab, uncheck the boxes next 
to the columns you would like to hide. 

2. When all changes have been made, click “OK” to display changes on schedule or 
“Cancel” to abort changes. 

 



NEXUS Series 

Software Installation & Configuration 

Page 136   LEIGHTRONIX, INC. 
WinLGX ver. 7.0.2.60  2018-06-08 
 

CONFIGURING THE SWITCH TYPE OF A NEXUS SERIES SYSTEM 

In order to control your system’s inputs and outputs from WinLGX, you will need to 
specify the switch type setup of your NEXUS series system.  Your switch type setup 

indicates whether your destinations and sources are directly wired to your NEXUS 
series server/controller or connected through one of a wide range of supported, third 
party external switchers.     

Click on the “System Configuration” folder on the right side of the schedule editor 

window to display the NEXUS series “System Configuration” windows.  Click on the 
“Switch” icon and complete the “Properties” fields for the switch type that applies to 
your NEXUS series system.  Each switch type and its properties are described in the 

following subsections: 

 “UltraNEXUS and NEXUS Internal Switcher Configuration” on page 137 

 “UltraNEXUS-SDI No Switch Configuration” on page 141 

 “External Switcher Configuration” on page 143 

 “Shared Switcher Configuration” on page 147 

NOTE: Input and output label, description, and icon assignments are optional. 
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UltraNEXUS and NEXUS Internal Switcher Configuration 

The WinLGX “Internal” switch type is for setups using the UltraNEXUS or NEXUS 
system’s built-in switcher.  Refer to Illustration 71, UltraNEXUS/NEXUS Internal Switch 
Type Windows throughout the “Internal Switcher Configuration” section. 

NOTE: The UltraNEXUS-SDI does not have an internal switcher. 

Illustration 71, UltraNEXUS/NEXUS Internal Switch Type Windows 

 

 “Switch type”:  select “Internal.” 

 Input Settings 

In the “Input” field, select an input and complete the following settings: 

NOTE: Any combination of the following characters may be used for labels and 

descriptions: 
 

0 1 2 3 4 5 6 7 8 9 

/ # $ ‘ ( ) * - . : < > [ ] _ { | } 

A B C D E F G H I J K L M N O P Q R S T U V W X Y Z 

a b c d e f g h i j k l m n o p q r s t u v w x y z 
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 “Label”: type the label you would like to appear on the corresponding Control 
Panel input button (up to 10 characters total—the number of characters that fit 
will depend on the case and characters you choose). 

 “Description”: type the description (up to 32 characters total) you would like to 
appear when your mouse cursor moves over the corresponding Control Panel 
input button. 

 “Icon”:  select an icon to represent the selected input in the Control Panel 
window. 

 Output Settings 

In the “Output” field, select an output and complete the following settings: 

NOTE: Any combination of the following characters may be used for labels and 
descriptions: 

 
0 1 2 3 4 5 6 7 8 9 

/ # $ ‘ ( ) * - . : < > [ ] _ { | } 

A B C D E F G H I J K L M N O P Q R S T U V W X Y Z 

a b c d e f g h i j k l m n o p q r s t u v w x y z 

 

 “Label”: type the label you would like to appear on the corresponding Control 
Panel output button, schedule editor window channel output tab, and the web 

program guide (up to 10 characters total—the number of characters that fit will 
depend on the case and characters you choose). 

 “Description”: type the description (up to 32 characters total) you would like to 
appear when your mouse cursor moves over the corresponding Control Panel 
output icon and schedule editor window channel output tab. 

 “Icon”:  select an icon to represent the selected output in the Control Panel 
window. 

 “Switchback Input”: select one of your inputs or “Virtual Channel” as the video 
source you would like WinLGX to automatically switch to the selected output at 

the end of a scheduled event.  During scheduling, the switchback input may be 
changed in the event properties window. 

NOTE:  If you would like to be able to switch to the “Virtual Channel” 

default playlists between programs, ensure “Yes” has been 
selected in the “Virtual Channel” field. 

  The Virtual Channel default playlists are tied to the first two 
WinLGX channel output tabs, with Virtual Channel 1 

corresponding to the first WinLGX channel output tab and Virtual 
Channel 2 on the second channel output tab (see Illustration 72). 
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Illustration 72, Virtual Channel WinLGX Tab Assignments 

 

 “Fallback Enable”:  you may configure loss-of-video fallback settings from the 
“Fallback Enable” field for Outputs 1–3 as follows: 

1. Select “No” to disable the loss-of-video fallback for the selected output.  

2. Select “Yes” to enable loss-of-video fallback and display the “Delay” field.  If 

video is lost on the selected output, the configured switchback input will 

display on the output.  Delay can be set from 1–99 seconds.  This means 
that if valid video is lost from that output and not restored within its “Delay” 
time, the switchback video source will be switched to the selected output. 

 Channel Output Tab Assignments 

The UltraNEXUS/NEXUS internal switcher’s four outputs are represented by 
channel output tabs on the left side of the schedule window.  WinLGX automatically 
assigns Output 1 to Channel 1, Output 2 to Channel 2, and so on. 

You have the option of changing the default channel output tab assignments for 
Outputs 1–3 as follows: 

NOTES:  Output 4 is tied to the UltraNEXUS/NEXUS broadcast MPEG 
recorder and is represented by the “Sch Rec” tab. 

  UltraNEXUS only: the VOD recorder is internally connected to 

Output 3.  Once the VOD recorder is enabled from WebNEXUS, 
Output 3 only receives switch commands sent to Output 4.  The 
VOD recorder may also be disabled from WebNEXUS in order to 

control Output 3 independently of Output 4.  See 
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“Enabling/Disabling VOD Recorder” on page 354, for the 
corresponding how-to steps. 

1. In the “Channel” field, select the channel number for the output you want to 

reassign.   

2. From the “Output” drop down menu, select “None.” 

3. Select a new channel from the “Channel” field drop down menu. 

4. Select the newly unassigned output from the “Output” drop down menu.  The 
change will be reflected by the channel output tabs on the schedule window. 

 Hide/Show Channel Output Tabs on Schedule Window 

The “Visible” field under “Channel” gives you the option to hide channel output tabs 
on your WinLGX schedule window.  From the “Channel” drop down box, select the 

channel tab you would like to hide and then select “No” from the “Visible” drop 
down box.  To display the tab, again select the channel and then choose “Yes” 
under “Visible.” 

 Virtual Channel 

“Yes” enables both Virtual Channel default playlists for use as switchback/fallback 
inputs in a schedule, while “No” disables Virtual Channels for this purpose.   

NOTE: If enabled, you will only be able to schedule UltraNEXUS/NEXUS MPEG 
Player 1 on the first WinLGX channel output tab and MPEG Player 2 on 

the second channel output tab (see Illustration 72). 
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UltraNEXUS-SDI No Switch Configuration 

UltraNEXUS-SDI systems not connected to an external switcher are represented by 
the WinLGX “No Switch” switch type.  Refer to Illustration 73, UltraNEXUS-SDI Switch 
Type Window throughout the “UltraNEXUS-SDI No Switch Configuration” section. 

Illustration 73, UltraNEXUS-SDI Switch Type Window 

 

 “Switch type”:  if not already selected, choose “No Switch.” 

 Channel Tab Assignments 

The UltraNEXUS-SDI’s two MPEG players and broadcast MPEG recorder are 

represented by channel tabs on the left side of the schedule window.  WinLGX 
automatically assigns Output 1 to Channel 1, Output 2 to Channel 2, and broadcast 
MPEG recorder Input 1 to Channel 3.   
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You have the option of changing the default channel tab assignments for Channels 
1–3 as follows: 

NOTES:  Channel 3 is tied to the UltraNEXUS-SDI broadcast MPEG 
recorder and is represented by the “Sch Rec” tab. 

  The VOD recorder is internally connected to Input 2.  To schedule 
the VOD recorder under a “No Switch” switch type, a 1 x 2 

distribution amp must be connected between a video source and 
your UltraNEXUS-SDI recorder inputs.  Once the VOD recorder is 
enabled for recording from WebNEXUS (see “Enabling/Disabling 

VOD Recorder” on page 354), it will automatically record the 
same content as the broadcast recorder and then transfer the 
resulting streaming VOD quality file to your LEIGHTRONIX 

streaming services account.  Contact LEIGHTRONIX for more 
information on setting up a streaming VOD account.   

1. In the “Channel” field, select the channel number for the output you want to 
reassign.   

2. From the “Output” drop down menu, select “None.” 

3. Select a new channel from the “Channel” field drop down menu. 

4. Select the newly unassigned output from the “Output” drop down menu.  The 

change will be reflected by the channel output tabs on the schedule window. 

 Hide/Show Channel Output Tabs on Schedule Window 

The “Visible” field under “Channel” gives you the option to hide channel tabs on 
your WinLGX schedule window.  From the “Channel” drop down box, select the 
channel tab you would like to hide and then select “No” from the “Visible” drop 

down box.  To display the tab, again select the channel and then choose “Yes” 
under “Visible.” 

 Virtual Channel 

“Yes” enables both Virtual Channel default playlists for use as switchback inputs in 
a schedule, while “No” disables Virtual Channels for this purpose.   

NOTE: If enabled, you will only be able to schedule UltraNEXUS-SDI MPEG 
Player 1 on the first WinLGX channel output tab and MPEG Player 2 on 

the second channel output tab (see Illustration 72). 
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External Switcher Configuration 

Refer to Illustration 74, External Switcher Windows, throughout the “External Switcher 
Configuration” section. 

Illustration 74, External Switcher Windows 

 

 “Switch type”:  select the choice that matches your external switcher and complete 
the following steps: 

 Non-LEIGHTRONIX external switchers only: enter the number of levels in the 
“Levels” field (video, audio left, audio right, etc.). 

NOTES:  Consult your switcher’s manual to determine how many levels 
should be assigned. 

  Pesa switchers automatically send level information to the 
NEXUS series server/controller. 

 “Status rate (sec)” field: use to configure the interval at which the NEXUS series 
server/controller polls the external switcher for output status information.  The 
range is 0 – 60 seconds, where 0 means never poll.  The default is 2 seconds. 
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 To ensure your switcher works with the NEXUS series server/controller, set 
your switcher’s serial parameters according to Table 3, Supported External 

Switchers and Parameters on page 60 (refer to your switcher’s manual for 
further instructions).    

 Input Settings 

In the “Input” field, select an input (the number of available inputs matches the 
capabilities of the switch type selected) and complete the following settings: 

NOTE: Any combination of the following characters may be used for labels and 

descriptions: 
 

0 1 2 3 4 5 6 7 8 9 

/ # $ ‘ ( ) * - . : < > [ ] _ { | } 

A B C D E F G H I J K L M N O P Q R S T U V W X Y Z 

a b c d e f g h i j k l m n o p q r s t u v w x y z 

 

 “Label”: type the label you would like to appear on the corresponding Control 

Panel input button (up to 10 characters total—the number of characters that fit 
will depend on the case and characters you choose). 

 “Description”: type the description (up to 32 characters total) you would like to 
appear when your mouse cursor moves over the corresponding Control Panel 
input button. 

 “Icon”:  select an icon to represent the selected input in the Control Panel 
window. 

 Non-LEIGHTRONIX external switchers only: enter the switcher’s first and last 
input values into the “First” and “Last” input fields.     

 Output Settings 

In the “Output” field, select an output (the number of available outputs matches the 
capabilities of the switch type selected) and complete the following settings: 

NOTE: Any combination of the following characters may be used for labels and 
descriptions: 

 
0 1 2 3 4 5 6 7 8 9 

/ # $ ‘ ( ) * - . : < > [ ] _ { | } 

A B C D E F G H I J K L M N O P Q R S T U V W X Y Z 

a b c d e f g h i j k l m n o p q r s t u v w x y z 

 

 “Label”: type the label you would like to appear on the corresponding Control 
Panel output button, schedule editor window channel output tab, and the web 

program guide (up to 10 characters total—the number of characters that fit will 
depend on the case and characters you choose). 
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 “Description”: type the description (up to 32 characters total) you would like to 
appear when your mouse cursor moves over the corresponding Control Panel 
output icon and schedule editor window channel output tab. 

 “Icon”:  select an icon to represent the selected output in the Control Panel 
window. 

 Non-LEIGHTRONIX external switchers only: enter the switcher’s first and last 
output values. 

 “Switchback Input”: select one of your inputs or “Virtual Channel” as the video 

source you would like WinLGX to automatically switch to the selected output at 
the end of a scheduled event.  During scheduling, the switchback input may be 
changed in the event properties window. 

NOTE:  If you would like to be able to switch to the “Virtual Channel” 

default playlists between programs, ensure “Yes” has been 
selected in the “Virtual Channel” field. 

  The Virtual Channel default playlists are tied to the first two 

WinLGX channel output tabs, with Virtual Channel 1 
corresponding to the first WinLGX channel output tab and Virtual 
Channel 2 on the second channel output tab (see Illustration 72). 

 Channel Output Tab Assignments 

An external switcher configuration can have up to 16 outputs represented by 
channel output tabs on the left side of the schedule window.  WinLGX automatically 

assigns Output 1 to Channel 1, Output 2 to Channel 2, and so on.  WinLGX allows 
you to change the default channel-output assignments according to the following 
steps.  This is especially useful if you have a large switcher, as you can choose 

which 16 outputs that you’d like to automate for scheduling.   

NOTES:  The highest numbered channel output tab is automatically 
assigned to the NEXUS series broadcast MPEG recorder.  You 

may reassign the NEXUS series broadcast MPEG recorder to any 
of your switcher’s available outputs. 

  The UltraNEXUS-SDI and UltraNEXUS VOD recorders must be 
enabled for recording from WebNEXUS.  See “Enabling/Disabling 
VOD Recorder” on page 354, for the corresponding how-to steps.  

The resulting streaming VOD quality files will then be automatically 
transferred to your LEIGHTRONIX streaming services account.  
Contact LEIGHTRONIX for more information on setting up a 
streaming VOD account. 

  UltraNEXUS only:  the UltraNEXUS VOD recorder automatically 

captures the same content recorded by the broadcast MPEG 
recorder.  
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  UltraNEXUS-SDI only: the UltraNEXUS-SDI VOD recorder is 

internally connected to Input 2.  To automatically record the same 
content as the broadcast MPEG encoder, a 1 x 2 distribution amp 

must be connected between a video source and your UltraNEXUS-
SDI recorder inputs.  If the UltraNEXUS-SDI VOD recorder is 
connected to a different switcher or video source output than the 

broadcast recorder, the same video source input will have to be 
switched to the VOD recorder through a control panel or scheduled 
switch event before the recording event starts. 

1. In the “Channel” field, select the channel number you would like to reassign to a 

different output. 
2. Perform one of the following: 

 Select Output 17 or higher from the “Output” drop down menu 

 Associate one of Outputs 1–16 with the channel by first unassigning the 
output according to the steps below: 

a. In the “Channel” field, select the channel number for the output you want to 
reassign.   

b. From the “Output” drop down menu, select “None.” 

c. In the “Channel” field, select the channel number you would like to 
reassign to the output. 

d. Select the newly unassigned output from the “Output” drop down menu.  

The change will be reflected by the channel output tabs on the schedule 
window. 

 Hide/Show Channel Output Tabs on Schedule Window 

The “Visible” field under “Channel” gives you the option to hide channel output tabs 
on your WinLGX schedule window.  From the “Channel” drop down box, select the 

channel tab you would like to hide and then select “No” from the “Visible” drop 
down box.  To display the tab, again select the channel and then choose “Yes” 
under “Visible.” 

 Virtual Channel 

“Yes” enables both Virtual Channel default playlists for use as switchback inputs in 
a schedule, while “No” disables Virtual Channels for this purpose.   

NOTE: To use the Virtual Channel switchback feature during scheduling, you will 
need to configure and schedule your NEXUS series system’s MPEG 

Players 1 and 2 on the first two WinLGX channel output tabs (see 
Illustration 72). 
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Shared Switcher Configuration 

The “Shared Switch” type allows users to share one external routing switcher between 
multiple UltraNEXUS/NEXUS server/controllers.  Use the following steps to configure 

each UltraNEXUS/NEXUS not directly connected to the external switcher it is sharing 
(refer to Illustration 75, Shared Switcher Properties, throughout this section).  Follow 
the “External Switcher Configuration” section on page 143 to configure the 
UltraNEXUS/NEXUS directly connected to the external switcher.  

Illustration 75, Shared Switcher Properties 

 

 Switch Type: select “Shared Switch” from the switch type drop down menu.  

WinLGX treats the “Shared SW” switch type as an external switcher.  Complete the 
following properties: 

 “Levels”: ignore, as WinLGX does not use this setting for the shared switch type 

 “Status rate (sec)”: set to specify how often the UltraNEXUS/NEXUS polls the 
UltraNEXUS/NEXUS directly connected to the routing switcher for switcher 

status information.  The range is 0 – 60 seconds, with the default set to 2 
seconds.  Do not select 0, as this means never poll.  

 Input Settings 

In the “Input” field, select an input (the number of available inputs matches the 
capabilities of the switch type selected) and complete the following settings: 
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NOTE: Any combination of the following characters may be used for labels and 
descriptions: 

 
0 1 2 3 4 5 6 7 8 9 

/ # $ ‘ ( ) * - . : < > [ ] _ { | } 

A B C D E F G H I J K L M N O P Q R S T U V W X Y Z 

a b c d e f g h i j k l m n o p q r s t u v w x y z 

 

 “Label”: type the label you would like to appear on the corresponding Control 
Panel input button (up to 10 characters total—the number of characters that fit 
will depend on the case and characters you choose). 

 “Description”: type the description (up to 32 characters total) you would like to 
appear when your mouse cursor moves over the corresponding Control Panel 
input button. 

 “Icon”:  select an icon to represent the selected input in the Control Panel 
window. 

 “First” and “Last” input fields: to allow access to all inputs connected to the 
routing switcher, enter the switcher’s first and last input values.  If you would 
like the shared UltraNEXUS/NEXUS to only control a dedicated range of inputs 

on the routing switcher, enter the first and last input values for the dedicated 
range.  Dedicating a range of inputs would help to prevent users from showing 
the wrong programming on the shared UltraNEXUS/NEXUS.       

 Output Settings 

In the “Output” field, select an output (the number of available outputs matches the 
capabilities of the switch type selected) and complete the following settings: 

NOTE: Any combination of the following characters may be used for labels and 
descriptions: 

 
0 1 2 3 4 5 6 7 8 9 

/ # $ ‘ ( ) * - . : < > [ ] _ { | } 

A B C D E F G H I J K L M N O P Q R S T U V W X Y Z 

a b c d e f g h i j k l m n o p q r s t u v w x y z 

 

 “Label”: type the label you would like to appear on the corresponding Control 
Panel output button, schedule editor window channel output tab, and the web 

program guide (up to 10 characters total—the number of characters that fit will 
depend on the case and characters you choose). 

 “Description”: type the description (up to 32 characters total) you would like to 
appear when your mouse cursor moves over the corresponding Control Panel 
output icon and schedule editor window channel output tab. 

 “Icon”:  select an icon to represent the selected output in the Control Panel 
window. 
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 “First” and “Last” output fields: to allow access to all outputs connected to the 
routing switcher, enter the switcher’s first and last output values.  If you would 

like the shared UltraNEXUS/NEXUS to only control a dedicated range of 
outputs on the routing switcher, enter the first and last output values for the 
dedicated range. 

 “Switchback Input”: select one of your inputs or “Virtual Channel” as the video 

source you would like WinLGX to automatically switch to the selected output at 
the end of a scheduled event.  During scheduling, the switchback input may be 
changed in the event properties window. 

NOTE:  If you would like to be able to switch to the “Virtual Channel” 

default playlists between programs, ensure “Yes” has been 
selected in the “Virtual Channel” field. 

  The Virtual Channel default playlists are tied to the first two 

WinLGX channel output tabs, with Virtual Channel 1 
corresponding to the first WinLGX channel output tab and Virtual 
Channel 2 on the second channel output tab (see Illustration 72). 

 Channel Output Assignments  

An external routing switcher can have up to 16 outputs represented by channel 

output tabs on the left side of the schedule window.  WinLGX automatically assigns 
Output 1 to Channel 1, Output 2 to Channel 2, and so on.  WinLGX allows you to 
change the default channel-output assignments according to the following steps.  

This is especially useful if you have a large switcher, as you can choose which 16 
outputs that you’d like to automate for scheduling. 

NOTES:  The highest numbered channel output tab is automatically 

assigned to the UltraNEXUS/NEXUS broadcast MPEG recorder.  
You may reassign the UltraNEXUS/NEXUS broadcast MPEG 
recorder to any of your switcher’s available outputs. 

  Once enabled from WebNEXUS, the UltraNEXUS VOD recorder 

also receives switch commands sent to the broadcast MPEG 
recorder. 

1. In the “Channel” field, select the channel number you would like to reassign to a 
different output. 

2. Perform one of the following: 

 Select Output 17 or higher from the “Output” drop down menu. 

 Associate one of Outputs 1–16 with the channel by first unassigning the 
output according to the steps below: 

a. In the “Channel” field, select the channel number for the output you want 

to reassign.   
b. From the “Output” drop down menu, select “None.” 
c. In the “Channel” field, select the channel number you would like to 

reassign to the output. 
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d. Select the newly unassigned output from the “Output” drop down menu.  
The change will be reflected by the channel output tabs on the schedule 
window. 

 Hide/Show Channel Output Tabs on Schedule Window 

The “Visible” field under “Channel” gives you the option to hide channel output tabs 
on your WinLGX schedule window.  From the “Channel” drop down box, select the 

channel tab you would like to hide and then select “No” from the “Visible” drop 
down box.  To display the tab, again select the channel and then choose “Yes” 
under “Visible.” 

 Virtual Channel 

“Yes” enables both Virtual Channel default playlists for use as switchback inputs in 

a schedule, while “No” disables Virtual Channels for this purpose.   

NOTE: To use the Virtual Channel switchback feature during scheduling, you will 

need to schedule UltraNEXUS/NEXUS MPEG Players 1 and 2 on the 
first two WinLGX channel output tabs (see Illustration 72). 
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CONFIGURING NEXUS SERIES IR PORT PROPERTIES 

NOTE: The “UltraNEXUS-SDI” switch type does not make use of IR control or other 
device control schemes such as PRO-BUS and DVply. 

Click on the “System Configuration” folder on the right side of the schedule editor 

window to display the NEXUS series “System Configuration View” windows.  Click on 
the “Internal IR Interface” icon and complete the “Properties View” fields for each IR 
port as follows (see Illustration 76, “System Configuration View” IR Port Windows): 

Illustration 76, “System Configuration View” IR Port Windows 

 

1. IR Port: configure each IR port for a VCR or DVD input device by selecting the 
corresponding format from each IR port field’s drop down list. 

2. “Manufacturer”: choose the corresponding, LEIGHTRONIX-supported 
manufacturer for each input device format (see Table 21, IR Port Configuration 

Options, for a list of the LEIGHTRONIX-supported VCR/DVD manufacturers). 
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Table 21, IR Port Configuration Options 

DEVICE MANUFACTURER MODES 

VCR JVC  10 Bit  

 16 Bit A (typical for most JVC VCRs) 

VCR Panasonic Default—no selection 

VCR Sony  VCR1 

 VCR2 

 VCR3 

 Institutional 

DVD Panasonic 

 

NOTE: Both modes support Panasonic DVD record 
functionality. 

 1 PLAY 

 2 PLAY: a play command from the NEXUS series 

server/controller is transmitted as two playback 
commands to the DVD player.  Some DVD 
players need 2 plays to wake up and play from 

standby, while others increase playback speed if 
a second play is received. 

DVD Pioneer  Player: issues commands for Pioneer DVD 

players 

 Player/Recorder: issues commands for Pioneer 

DVD player/recorders 

DVD Sony  2 STOP/2 PLAY: issues two stops and two play 

commands to ensure DVDs always start from the 
beginning  

 2 PLAY: issues two play commands to ensure 

DVDs resume from where they were last stopped 

DVD Tascam Default—no selection 

3. “Type”: configure each IR port to match the connected device’s communication 

mode.  Refer to Table 21, IR Port Configuration Options, for a list of the 
LEIGHTRONIX-supported VCR/DVD manufacturers and their corresponding 

communication modes. 

NOTE: Some of the LEIGHTRONIX-supported VCRs and DVDs are capable of 

communicating in different modes to allow multiple devices to be 
controlled by a single remote control.  The device mode is often indicated 
by a mode switch on the device’s front panel.  If your device’s mode is 

unknown, try each setting in the “Type” drop down list until control is 
achieved.   
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CONFIGURING BROADCAST MPEG RECORDING PRESETS 

Click on the “System Configuration” folder on the right side of the schedule editor 
window to display the NEXUS series “System Configuration View” windows.  Click on 

the “Internal MPEG Recorder” icon and complete the “Properties View” fields for each 
record preset according to the following steps (see Illustration 77, “System 
Configuration View” Internal Broadcast MPEG Recorder Windows).  For more 

information on recording a broadcast-quality MPEG file, refer to “MPEG File 
Specifications,” on page 38. 

Illustration 77, “System Configuration View” Internal Broadcast MPEG Recorder Windows 

 

 “Record Preset x”: if desired, click in the field and enter a new name for the preset. 
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 “Video resolution”: 

 UltraNEXUS/NEXUS: select “Half (352x480)” or “Full (720x480)” resolution from 
the drop down list 

 UltraNEXUS-SDI: “Full (720x480)” resolution 

NOTE: The UltraNEXUS-SDI does not record at “Half (352x480)” 
resolution. 

 “Bitrate type”: select “CBR” for constant bit rate or “VBR” for variable bit rate. 

 If you selected “VBR,” the “Min video bitrate” and “Max video bitrate” fields will 

be displayed: click on the fields and use the up/down arrows to set your 
minimum and maximum video bitrates as follows.  WinLGX requires that an 
increment of two be left between the bit rates. 

o UltraNEXUS/NEXUS: select a minimum of at least 1.50 Mb/sec and a 
maximum of up to 10.00 Mb/sec 

o UltraNEXUS-SDI: select a minimum of at least 3.00 Mb/sec and a maximum 
of up to 10.00 Mb/sec 

 If you selected “CBR,” the “Video bitrate” field will be displayed.  Click on the 
field and use the up/down arrows to set the video bit rates as follows: 

o UltraNEXUS/NEXUS: select a minimum of at least 1.50 Mb/sec and a 
maximum of up to 8.00 Mb/sec 

o UltraNEXUS-SDI: select a minimum of at least 3.00 Mb/sec and a maximum 
of up to 8.00 Mb/sec 

 “Record audio source” (UltraNEXUS-SDI Only): 

From the “Record audio source” drop down, select the type of embedded or non-
embedded (“Analog” or “AES”) audio signal your system is setup to record.  

 “Analog”: corresponds to the analog audio inputs on the SDI’s back panel 
terminal blocks (see Table 6, Non-Embedded Audio Terminal Block 

Configurations, for analog audio wiring diagram) 

 “AES”: corresponds to the AES audio inputs on the SDI’s back panel terminal 

blocks (see Table 6, Non-Embedded Audio Terminal Block Configurations, for 
AES audio wiring diagram) 

 “Embedded 1-2”, “Embedded 3-4,” “Embedded 5-6,” and “Embedded 7-8”: if 
your audio is embedded within the SDI video signal, select the embedded audio 
channel pair that you want to record 

 “Audio bitrate”:  

 UltraNEXUS/NEXUS: select 192 or 224 kb/sec from the drop down list 

 UltraNEXUS-SDI: select 192, 224, or 256 kb/sec from the drop down list 

 “Audio sample rate”: select 44.1 or 48 kHz from the drop down list. 
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EDITING INTERNAL MPEG PLAYER AND RECORDER DEVICE RESOURCE 
PROPERTIES 

Each NEXUS series WinLGX configuration automatically displays icons for its two 
internal MPEG players and broadcast MPEG recorder in the “Resources View” window 

for the “Devices” folder (see Illustration 78, “Devices” Window).  The following steps 
describe how to change the optional settings for the NEXUS series systems’ built-in 
devices:  

1. Click on the “Devices” folder on the right side of the schedule editor window to 

display the “Devices” window (refer to Illustration 78, “Devices” Window). 

Illustration 78, “Devices” Window  

 

2. In the “Resource View,” click on the desired UltraNEXUS/NEXUS internal device 

icon to reveal the corresponding properties fields.  

 
MPEG Players 

 “Title”: if desired, click on “Title” field and enter new alias. 

 “Format”: displays currently selected device type. 
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 “Icon”: if desired, click on the “Icon” field button and select a new icon to represent 
the selected player or recorder. 

 External switcher configurations only: under “Input,” choose the external 
switcher input connected to the selected MPEG player’s output on the rear panel of 
your NEXUS series system.  Output 1 on the rear panel of each NEXUS series 

server/controller is tied to MPEG Player 1, while Output 2 is assigned to MPEG 
Player 2.  Selecting an input number removes it from the input list. 

 “Assigned Channel/Output”: the function of this property depends on whether or not 

the “Virtual Channel” switchback feature has been enabled in the “Switcher 
Configuration” properties (see “Configuring the Switch Type of a NEXUS Series 
System,” on page 136 for more details).  The following outlines both scenarios: 

 Virtual Channel Switchback Feature Enabled: you can only schedule each 

MPEG player on its assigned channel/output.  If you are using the 
UltraNEXUS/NEXUS internal switcher, MPEG Player 1 is automatically 
assigned to Output 1 and MPEG Player 2 is tied to Output 2.  For those using 

external switcher configurations or the “UltraNEXUS-SDI” switch type, 
select the output you would like to display playback from each NEXUS series 
MPEG player from the “Assigned Channel/Output” drop down menu. 

 Virtual Channel Switchback Feature Disabled: you may assign a channel 
output to each NEXUS series MPEG player to automate device selection for 

MPEG library resources during scheduling.  Whenever an MPEG library 
resource is dragged onto the selected MPEG player’s assigned channel/output, 
the player will automatically appear in the library resource’s “Device” field.   

 “Setup time”: if desired, indicate how long after the selected player receives a 
PLAY command that picture and/or sound is produced. 

 “Print”: select “Yes” to enable all of the resource’s event records for printing.  If “No” 
is selected, then you can enable printing as follows: 

1. Individual event records: select “Yes” in the “Print” field of each event properties  

window that appears during scheduling of the resource. 

2. All of the resource’s event records: check the “Export/print all records” option 
under the “Export/Print Templates” window. 

 “Export”: select “Yes” to allow all of the resource’s event records to be exported 
into comma delimited or Microsoft Excel® formats.  If “No” is selected, then you can 
enable the export function as follows: 

1. Individual event records: select “Yes” in the “Export” field of each event 
properties window that appears during scheduling of the resource. 

2. All of the resource’s event records: check the “Export/print all records” option 
under the “Export/Print Templates” window. 
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VOD Recorder—UltraNEXUS-SDI / UltraNEXUS only 

The UltraNEXUS-SDI and UltraNEXUS VOD recorders must be enabled for recording 
from WebNEXUS.  See “Enabling/Disabling VOD Recorder” on page 354, for the 

corresponding how-to steps.  The resulting streaming VOD quality files will then be 
automatically transferred to your LEIGHTRONIX streaming services account (contact 
LEIGHTRONIX for more information on setting up a streaming VOD account).  Once 

enabled, your system setup will determine the operation of the VOD recorder as 
follows: 

 UltraNEXUS: The UltraNEXUS VOD recorder is hardwired to the broadcast 
MPEG recorder, so it will automatically receive any immediate 
or scheduled switch and control commands sent to the 

broadcast MPEG recorder.  The UltraNEXUS VOD recorder 
mirrors the broadcast MPEG recorder’s actions, automatically 
recording whatever the broadcast recorder does. 

 UltraNEXUS-SDI: VOD MPEG recorder Input 2 is wired separately from the 

broadcast MPEG recorder Input 1 on the UltraNEXUS-SDI’s 
rear panel. To automatically record the same content as the 
broadcast MPEG recorder, a 1 x 2 distribution amp must be 

connected between an external switcher or video source output 
and your UltraNEXUS-SDI recorder inputs.  If the UltraNEXUS-
SDI VOD recorder is connected to a different switcher or video 

source output than the broadcast recorder, the same video 
source input will have to be switched to the VOD recorder 
through a control panel or scheduled switch event before the 
recording event starts. 
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Broadcast MPEG Recorder 

 “Title”: if desired, click on “Title” field and enter new alias. 

 “Format”: displays currently selected device type. 

 “Icon”: if desired, click on the “Icon” field button and select a new icon to represent 
the selected player or recorder. 

 External switcher configurations only: select a “Record Channel” that 

corresponds to the external switcher output connected to NEXUS series switcher 
Input 1 (see Illustration 79, Broadcast MPEG Recorder Channel Output Tab 
Configuration). 

NOTE: WinLGX automatically completes this field with the output assigned to 
the highest numbered channel under “System Configuration.” 

Illustration 79, Broadcast MPEG Recorder Channel Output Tab Configuration 

 
 “Video Quality”: if desired, select an MPEG recording quality mode for your 

recording events.  This mode may be changed for each recording event action—

see “Internal Broadcast MPEG Recorder Device Resource,” starting on page 265, 
for more details.  

 “Record overwrite”: if desired, select one of the following: 
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 “Always”: prompts WinLGX to automatically record over an existing file with the 
same name.  

 “Create unique”: if an existing filename is entered, WinLGX automatically 

records the file under the first 14 characters of the original filename followed by 
“yy/mm/dd-hh/mm/ss” (yy/mm/dd is the file record date specified as year/month/ 
day and hh/mm/ss is the file record time in hours/minutes/seconds).   

The “Record overwrite” option may be changed for each recording event action—

see “Internal Broadcast MPEG Recorder Device Resource,” starting on page 265, 
for more details. 

 “Print”: select “Yes” to enable all of the resource’s event records for printing.  If “No” 
is selected, then you can enable printing as follows: 

1. Individual event records: select “Yes” in the “Print” field of each event properties 
window that appears during scheduling of the resource. 

2. All of the resource’s event records: check the “Export/print all records” option 
under the “Export/Print Templates” window. 

 “Export”: select “Yes” to allow all of the resource’s event records to be exported 
into comma delimited or Microsoft Excel® formats.  If “No” is selected, then you can 
enable the export function as follows: 

1. Individual event records: select “Yes” in the “Export” field of each event 
properties window that appears during scheduling of the resource. 

2. All of the resource’s event records: check the “Export/print all records” option 
under the “Export/Print Templates” window. 
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CREATING EXTERNAL DEVICE RESOURCES 

A device resource must be created for each VCR, DVD player, and any other external 
device attached to your NEXUS series server/controller.  Creating a device causes a 
new set of user-configurable information fields to be displayed in the “Properties” 

window.  The NEXUS series system uses this information to identify your external 
device.  Create external device resources as follows: 

NOTES:  An external device is any source (input) controlled by a PRO-BUS, IR,  
DVply, or switch interface. 

  UltraNEXUS-SDI only: to use any of the external device control 
schemes and WinLGX external device scheduling/Control Panel 
features with an UltraNEXUS-SDI, both the UltraNEXUS-SDI and the 
video sources must be connected to an external switcher. 

1. Click on the “Devices” folder on the right side of the schedule editor window to 

display the “Devices View” window (refer to Illustration 80, New Device Properties). 

Illustration 80, New Device Properties  

 

2. Right click in the “Resource View” window and select “New” to display the device 

type menu.  Select a device type to add a new device to the window (see 

Illustration 80, New Device Properties). 
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3. Complete the “Properties” fields for the selected device format: 

 “DVD Device Resources,” on page 161 

 “Tape Device Resources,” on page 163 

 “Switch Resources,” on page 165 

 “GPI Output Device Resources,” on page 167 

DVD Device Resources 

Right click in “Resource View” and select “DVD” to display the DVD properties fields 
shown in Illustration 81, DVD Device Event Properties Window.  Refer to Table 22, 
DVD Device Properties, for a description of the editable DVD device resource 
properties. 

Illustration 81, DVD Device Event Properties Window 

 

Table 22, DVD Device Properties 

FIELD DESCRIPTION 

Title Allows a name of up to 31 characters to be entered. 
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FIELD DESCRIPTION 

Format Select one of the following device formats from the drop down list: 

 DVD 

 DVply 

Icon Select the desired icon to represent your library item.   

1. Open the icon selection window by selecting the “Icon” field and 
clicking the button that appears.   

2. Select the desired icon. 

3. Double click icon or click “OK.”  Click “Cancel” to abort selection. 

Input Choose the switcher input number to which the device is connected.  If the 
device is not connected to a switcher input, select “<None>.”  Assigning an 
input to a device removes the input number from the input list.     

Preferred 

Channel/ 
Output 

You may assign a channel output to your device to automate device 

selection for same-type library resources during scheduling.  Whenever a 
library resource of the same format is dragged onto this device’s preferred 
playback channel, this device will automatically appear in the library 
resource’s “Device” field.   

Interface Select either “PRO-BUS (PB),” “Internal IR (IR),” or “DVply (DV)” as the 
method being used to control the device. 

Device Select the number of the device control interface your device is connected 

to. When a device number is chosen, it is removed from the “Device” list.  
Choices are: 

 1–16 for PRO-BUS 

 1–4 for IR 

 1–2 for DVply 

NOTE: Ensure assigned device number reflects actual PRO-BUS 

interface connected to input device.  A PRO-BUS interface only 
responds to those PRO-BUS commands which contain its 
address. 

Setup time If desired, indicate how long after the device receives a “PLAY” command 

that picture and/or sound is produced. 

Print Select “Yes” to enable all of the resource’s event records for printing.  If “No” 

is selected, then you can enable printing as follows: 

 Individual event records: select “Yes” in the “Print” field of each event 

properties window that appears during scheduling of the resource. 

 All of the resource’s event records: check the “Export/print all 

records” option under the “Export/Print Templates” window. 

Export Select “Yes” to allow all of the resource’s event records to be exported into 
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FIELD DESCRIPTION 

comma delimited or Microsoft Excel® formats.  If “No” is selected, then you 

can enable the export function during scheduling for all or individual playlist 
resources. 

Tape Device Resources 

Right click in “Resource View” and select “TAPE” to display the tape properties fields 
shown in Illustration 82, Tape Device Event Properties Window.  Refer to Table 23, 

Tape Device Properties, for a description of the editable tape device resource 
properties. 

Illustration 82, Tape Device Event Properties Window 

 

Table 23, Tape Device Properties 

FIELD DESCRIPTION 

Title Allows a name of up to 31 characters to be entered. 

Format Select one of the following device formats from the drop down list: 

 ¾” 

 8mm 
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FIELD DESCRIPTION 

 Beta SP 

 DV (digital video device) 

 DVCPRO (Panasonic digital video device) 

 DVCAM (Sony digital video device) 

 HI-8mm 

 S-VHS 

 VHS 

Icon Select the desired icon to represent your library item.   

1. Open the icon selection window by selecting the “Icon” field and 
clicking the button that appears.   

2. Select the desired icon. 

3. Double click icon or click “OK.”  Click “Cancel” to abort selection. 

Input Choose the switcher input number to which the device is connected.  If the 

device is not connected to a switcher input, select “<None>.”  Assigning an 
input to a device removes the input number from the input list.     

Preferred 

Channel/ 
Output 

You may assign a channel output to your device to automate device 

selection for same-type library resources during scheduling.  Whenever a 
library resource of the same format is dragged onto this device’s preferred 
playback channel, this device will automatically appear in the library 
resource’s “Device” field.   

Interface Select either “PRO-BUS (PB)” or “Internal IR (IR)” as the method being used 
to control the device. 

Device Select the number of the device control interface your device is connected 

to. When a device number is chosen, it is removed from the “Device” list.  
Choices are: 

 1–4 for IR 

 1–16 for PRO-BUS 

NOTE: Ensure assigned device number reflects actual PRO-BUS 

interface connected to input device.  A PRO-BUS interface 
only responds to those PRO-BUS commands which 
contain its address. 

Setup time If desired, indicate how long after the device receives a PLAY command that 

picture and/or sound is produced. 

Print Select “Yes” to enable all of the resource’s event records for printing.  If “No” 

is selected, then you can enable printing as follows: 

 Individual event records: select “Yes” in the “Print” field of each event 

properties window that appears during scheduling of the resource. 

 All of the resource’s event records: check the “Export/print all 



NEXUS Series 

Software Installation & Configuration 

LEIGHTRONIX, INC.  Page 165 
2018-06-08  WinLGX ver. 7.0.2.60 
 

FIELD DESCRIPTION 

records” option under the “Export/Print Templates” window. 

Export Select “Yes” to allow all of the resource’s event records to be exported into 

comma delimited or Microsoft Excel® formats.  If “No” is selected, then you 
can enable the export function as follows: 

 Individual event records: select “Yes” in the “Export” field of each 

event properties window that appears during scheduling of the 
resource. 

 All of the resource’s event records: check the “Export/print all 
records” option under the “Export/Print Templates” window. 

 
Switch Resources 

Right click in “Resource View” and select “SWITCH” to display the switch properties 

fields shown in Illustration 83, Switch Event Properties Window.  Refer to Table 24, 
Switch Event Properties, for a description of the editable switch resource properties. 

Illustration 83, Switch Event Properties Window 
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Table 24, Switch Event Properties 

FIELD DESCRIPTION 

Title Allows a name of up to 31 characters to be entered. 

Format Choose one of the following switch types: 

 External CG 

 IRD 

 Switch 

 Studio  

Icon Select the desired icon to represent your library item.   

1. Open the icon selection window by selecting the “Icon” field and 
clicking the button that appears.   

2. Select the desired icon. 

3. Double click icon or click “OK.”  Click “Cancel” to abort selection. 

Input Choose the switcher input number to which the device is connected.  If the 

device is not connected to a switcher input, select “<None>.”  Assigning an 
input to a device removes the input number from the input list.     

Preferred 
Channel/ 

Output 

You may assign a channel output to your device to automate device 
selection for same-type library resources during scheduling.  Whenever a 

library resource of the same format is dragged onto this device’s preferred 
playback channel, this device will automatically appear in the library 
resource’s “Device” field.   

Interface “Switch (SW)” is automatically assigned. 

Device The device numbers for switch resources are automatically assigned. 

Print Select “Yes” to enable all of the resource’s event records for printing.  If “No” 

is selected, then you can enable printing as follows: 

 Individual event records: select “Yes” in the “Print” field of each event 
properties window that appears during scheduling of the resource. 

 All of the resource’s event records: check the “Export/print all 
records” option under the “Export/Print Templates” window. 

Export Select “Yes” to allow all of the resource’s event records to be exported into 

comma delimited or Microsoft Excel® formats.  If “No” is selected, then you 
can enable the export function as follows: 

 Individual event records: select “Yes” in the “Export” field of each 

event properties window that appears during scheduling of the 
resource. 

 All of the resource’s event records: check the “Export/print all 
records” option under the “Export/Print Templates” window. 
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GPI Output Device Resources 

Right click in “Resource View” and select “GPI” to display the GPI properties fields 
shown in Illustration 84, GPI Event Properties Window.  Refer to Table 25, GPI Event 
Properties, for a description of the editable GPI resource properties. 

Illustration 84, GPI Event Properties Window 

 

Table 25, GPI Event Properties 

FIELD DESCRIPTION 

Title Allows a name of up to 31 characters to be entered. 

Format Select “GPI” from the drop down list. 

Icon Select the desired icon to represent your library item.   

1. Open the icon selection window by selecting the “Icon” field and 
clicking the button that appears.   

2. Select the desired icon. 

3. Double click icon or click “OK.”  Click “Cancel” to abort selection. 



NEXUS Series 

Software Installation & Configuration 

Page 168   LEIGHTRONIX, INC. 
WinLGX ver. 7.0.2.60  2018-06-08 
 

FIELD DESCRIPTION 

Input Choose the switcher input number to which the device is connected.  If the 

device is not connected to a switcher input, select “<None>.”  Assigning an 
input to a device removes the input number from the input list.     

Interface “PRO-BUS (PB)” is automatically assigned. 

Device Assign a PRO-BUS interface number, 1-16, to the GPI from the drop down 
list. 

Print Select “Yes” to enable all of the resource’s event records for printing.  If “No” 

is selected, then you can enable printing as follows: 

 Individual event records: select “Yes” in the “Print” field of each event 
properties window that appears during scheduling of the resource. 

 All of the resource’s event records: check the “Export/print all 

records” option under the “Export/Print Templates” window. 

Export Select “Yes” to allow all of the resource’s event records to be exported into 
comma delimited or Microsoft Excel® formats.  If “No” is selected, then you 

can enable the export function as follows: 

 Individual event records: select “Yes” in the “Export” field of each 

event properties window that appears during scheduling of the 
resource. 

 All of the resource’s event records: check the “Export/print all 
records” option under the “Export/Print Templates” window. 

 
 

ULTRANEXUS/ULTRANEXUS-SDI ONLY: CREATING EPRO-BUS-CONTROLLED 
DEVICE RESOURCES 

TheUltraNEXUS/UltraNEXUS-SDI ePRO-BUS control feature uses your Ethernet 

network rather than additional wiring to send start/stop RECORD commands to up to 
16 remote or locally connected PEGvault-SD or LABvault-SD digital video recorders.  
To use, create an ePRO-BUS resource for each PEGvault-SD or LABvault-SD digital 

video recorder that will be receiving PRO-BUS control commands from your 
UltraNEXUS system.  Create and configure ePRO-BUS-controlled resources as 
follows: 

NOTE: Ensure that you have assigned each PEGvault-SD/LABvault-SD recorder’s IP 
address to a PRO-BUS address number in WebNEXUS (see the 

“UltraNEXUS/UltraNEXUS-SDI Only: Configuring ePRO-BUS Setttings” 
section on page 442 for more details). 

1. Click on the “Devices” folder on the right side of the schedule editor window to 
display the “Devices View” window (refer to Illustration 80, New Device Properties). 
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Illustration 85, New Device Properties  

 

2. Right click in the “Resource View” window and select “New” to display the device 

type menu.  Select either the “DVD” or “Tape” device type to add a new device 
resource to the window (see Illustration 85, New Device Properties). 

3. Complete the properties fields shown in Illustration 86, ePRO-BUS Resource 

Properties Window according to Table 26, ePRO-BUS Resource Properties. 
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Illustration 86, ePRO-BUS Resource Properties Window 

 

Table 26, ePRO-BUS Resource Properties 

FIELD DESCRIPTION 

Title Enter a name of up to 31 characters. 

Format Leave at the default setting 

Icon Select the desired icon to represent your library item.   

1. Open the icon selection window by selecting the “Icon” field and clicking 

the button that appears.   

2. Select the desired icon. 

3. Double click icon or click “OK.”  Click “Cancel” to abort selection. 

Input Select “<None>,” as the device is not connected to a switcher input.      
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FIELD DESCRIPTION 

Preferred 

Channel/ 
Output 

Select “<None>.” 

Interface Select “PRO-BUS (PB)” for the method being used to control the device. 

Device Select the PRO-BUS address number that was chosen for the PEGvault-

SD/LABvault-SD device in the WebNEXUS ePRO-BUS configuration 
window (see the “UltraNEXUS/UltraNEXUS-SDI Only: Configuring ePRO-
BUS Setttings” section on page 442 for more details). When a number is 

chosen, it is removed from the “Device” list.   

NOTE: Each PEGvault-SD or LABvault-SD will only respond to those 
PRO-BUS commands which contain its address number. 

Setup time Not used 

Print Select “Yes” to enable all of the resource’s event records for printing.  If “No” 
is selected, then you can enable printing as follows: 

 Individual event records: select “Yes” in the “Print” field of each event 
properties window that appears during scheduling of the resource. 

 All of the resource’s event records: check the “Export/print all 

records” option under the “Export/Print Templates” window. 

Export Select “Yes” to allow all of the resource’s event records to be exported into 
comma delimited or Microsoft Excel® formats.  If “No” is selected, then you 

can enable the export function during scheduling for all or individual playlist 
resources. 
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CREATING OVERLAYS 

Quickly and conveniently enhance your digital programming with graphic and text 
message overlays.  In just a few steps, schedule MPEG clips and programs, slides, 

and slide shows to display with your station icon, “coming up next” program messages, 
community event reminders, holiday greetings, or any other announcements of your 
choosing.   

You can create up to 25 overlay templates, with each template holding up to 10, 

individual overlay library resources.  During scheduling of digital video media, you then 
have the option of selecting an overlay template to accompany the media during 
playback.  Each overlay resource in the template will display in the assigned order for 

10 percent of the scheduled digital program (subtract 60 seconds for the safe area 
buffers from the total length of the program before calculating the 10 percent display 
length).  To create an overlay template and then add it to a digital program, 
perform the following three steps: 

Step 1: Create Individual Overlays 

Add individual overlay resources to each overlay template to form a custom overlay 
listing that may be reused for a variety of digital programs.  Assign to each overlay 
library resource the properties for a partial or full screen PNG and, if desired, enter a 

series of up to 12, two-line text messages that you would like displayed with the 
graphic.     

NOTE: Overlay library resources utilize “.png” files, which allow an image to contain 
transparent areas.  This allows your overlay to float over rather than block 
the programming on your MPEG players. 

Either use one of the included graphics or upload your own .png overlay through the 
“Storage Manager” window per “Managing Storage of Video, Slide, and Overlay,” on 
page 328. 

To create a library resource for an overlay, click the “Library” folder and then right click 

in the “Resource View” window and select “New.”  Select “Overlay” under “Format” in 
the “Properties View” window and then complete the remaining properties described in 
Table 27, referring to Illustration 87 throughout. 
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Illustration 87, Overlay Library Resource Properties 

 
 

Table 27, Overlay Library Resource Properties 

FIELD DESCRIPTION 

Title Enter a unique and descriptive name, up to 31 characters. 

Format Select “Overlay” from the drop down list. 

Icon Select the desired icon to represent your library item.   

1. Open the icon selection window by selecting the “Icon” field and clicking 
the button that appears.   

2. Select the desired icon. 

3. Double click icon or click “OK.”  Click “Cancel” to abort selection. 

Page 

count 

Displays pages added through the “Graphic/Text” field’s “Overlay Graphic 
Editor” window. 

Page 

dwell time 

Displays selection made in the “Graphic/Text” field’s “Overlay Graphic Editor” 
window. 
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FIELD DESCRIPTION 

Graphic 

/Text 

Select a graphic image and, if desired, add a text message as follows: 

1. Select the “Graphic/Text” field and click the right-hand button to open the 

“Overlay Graphic Editor” window shown in Illustration 88. 

Illustration 88, “Overlay Graphic Editor” Window 

 

2. Select a graphic from the “Overlay file” list. 

3. Use the “Overlay text” window to add a sequence of up to 12, two-line 
messages to the lower third position of the overlay screen.  Beneath the 

overlay preview window, the buttons numbered 1–12 correspond to 
separate text message pages on the overlay.  Each button turns green 
when you move the text cursor to the corresponding page.  Enter text on 

each message page as follows: 

 Click the “Coming up next” and/or “Current date/time” buttons to 

automatically enter the corresponding text. 

 Type up to two lines of the default 22 pt, bold Ligurino text. The 

bottom line of text on each page is positioned on the overlay just 

above the safe title guideline.  Move to each new line of text by 
pressing “Enter” on your keyboard. 

4. Select from the “Page dwell time” drop down list to specify a display time 

between 8-90 seconds for each of your messages. When displayed, your 
messages will fade from one to another on the selected overlay. 

5. Click “OK” to close the “Overlay Graphic Editor” window. 

 
Step 2: Create Overlay Template 

Create a customized listing of up to ten overlays according to the following steps.   

1. Select the “Overlay Templates” tab view on the main WinLGX window. 
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2. Add an overlay template to the template listing by clicking the  icon and 
assigning a title in the “Create overlay template” box that appears (see Illustration 
89, Add Overlay Template).  Click “OK” to create template or cancel to abort.  Click 

the  icon to rename the overlay template. 

Illustration 89, Add Overlay Template 

 
 

3. Drag up to ten overlay library resources into the desired segments on the overlay 

template and click “OK” in each overlay properties box that appears.   

NOTE: In order to preserve your digital program’s beginning and ending 
graphics, each template has 30 second safe area boundaries. 

The display length of each segment is based on the length of the digital program 
the overlay template is scheduled to accompany.  To obtain the display length, 

subtract 60 seconds (the total length of the “safe area” buffers) from the total length 
of the digital program and divide the remainder by ten.  For example, if the 
“WEEKDAY LINEUP” overlay template shown in Illustration 90 is selected to 

display with an hour-long MPEG video, the “Road Construction” overlay would 
display for 5 minutes and 54 seconds.   
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Illustration 90, Adding Overlays to Template 

 
 

Step 3: Add an Overlay Template to a Digital Program 

Display overlay templates with digital programming in either of two ways:  

NOTE: Overlay templates must be paired with digital programs at least 65 seconds 

in length. 

 When Creating Digital Library Resources 

Assign an overlay template to a digital program when creating a digital library 
resource.  Every time the digital library resource is scheduled, the overlay 

template will display with it. 

 During Scheduling 

When a digital resource is added to the schedule, you may select an overlay 

template or edit the assigned template. 

Road Construction 

Overlay 
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CREATING LIBRARY RESOURCES 

Use the “Library View” windows to create library resources for drag and drop 
scheduling of frequently aired programs.  Then just add properties for a specific MPEG 

video, slide, tape, disc, or switch action to each new library resource.  Before 
scheduling library resources for external devices, ensure you have created resources 
for the corresponding devices that each library resource will be played or recorded on 
(see “Creating External Device Resources,” starting on page 160).   

Create library resources as follows:   

1. Click on the “Library” folder on the right side of the schedule editor window to 
display the library view (see Illustration 91, “Library View” Windows). 

Illustration 91, “Library View” Windows 

2. Right-click in the “Resource View” window and select “New” in the context menu to 
insert an undefined, new resource in the window (see Illustration 92, New Library 
Resource Windows). 
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Illustration 92, New Library Resource Windows 

 

3. Complete the “Properties” fields for one of the following library resources: 

 “Tape and DVD Library Resources,” on page 179 

 “Switch Library Resources,” on page 182 

 “MPEG Library Resources,” on page 184 

 “MPEG Loop Library Resources,” on page 191 

 “Graphic/Text Overlay Library Resources,” on page 172 

 “Slide Library Resources,” on page 196 

 “Slide Show Library Resources,” on page 200 

 “Onscreen Program Guide Library Resources,” on page 204 

 “MPEG File/Slide Playlist Library Resources,” on page 208 

 “Virtual Channel (VC) List Library Resources,” on page 210  
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Tape and DVD Library Resources 

Create library resources containing properties for device media such as videotapes 
and DVDs.  Click the “Library” folder and then right click in the “Resource View” 

window and select “New.”  Select a tape or DVD “Format” in the “Properties” window 
and then edit the remaining properties described in Table 28, referring to Illustration 93 
throughout.   

Illustration 93, Example of DVD Library Resource Properties 

 

Table 28, Tape and DVD Library Resource Properties 

FIELD DESCRIPTION 

Title Enter a unique and descriptive name, up to 31 characters 
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FIELD DESCRIPTION 

Format Choose one of the following DVD or tape media formats: 

 ¾” 

 8mm 

 Beta SP 

 DV (digital video device)  

 DVCPRO (Panasonic digital video device) 

 DVCAM (Sony digital video device) 

 DVD 

 HI-8mm 

 S-VHS 

 VHS 

Show in 
program 

guide 

Select “Yes” from the drop down list to include the scheduled resource 
on onscreen program guides (see “Onscreen Program Guide Library 

Resources,” on page 204) and the web program guide (see “Viewing 
Web Program Guide” on page 402).  The scheduled resource will be 
listed according to its event start time and the text entered into the 

“Comment” field.   

Comment Enter a unique and descriptive name with up to 31 characters to 

represent the resource on the onscreen and web program guides.    
The text entered in the “Title” field is automatically placed in the 
“Comment” field, but may be changed.  

Disc number Supported DVD Changer only: indicate the disc’s number position 
within the DVD device. 

Title:Chapter DVply-controlled DVD devices only: enter the title and/or chapter 

location on the DVD from which you would like events scheduled with 
the resource to start. 

Icon Select the desired icon to represent your library item.   

1. Open the icon selection window by selecting the “Icon” field and 
clicking the button that appears.   

2. Select the desired icon. 

3. Double click icon or click “OK.”  Click “Cancel” to abort selection. 

Length Enter the on-air length of the program medium. 

Preroll If desired, enter a length of time to indicate the amount of unwanted 

video (black, etc.) at the start of the program that you do not want 
playing on air. 

Reset If desired, enter time the playback device will be busy and unavailable 

for scheduling after the end of the program.  It is typically the rewind 
time. 
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FIELD DESCRIPTION 

Media ID If desired, assign a library tracking number. 

Field Name 
1–11 

If desired, select the user-defined column field items that pertain to the 
new library item. 

Print Select “Yes” to enable all of the resource’s event records for printing.  If 

“No” is selected, then you can enable printing as follows: 

 Individual event records: select “Yes” in the “Print” field of each 
event properties window that appears during scheduling of the 

resource. 

 All of the resource’s event records: check the “Export/print all 

records” option under the “Export/Print Templates” window. 

Export Select “Yes” to allow all of the resource’s event records to be exported 

into comma delimited or Microsoft Excel® formats.  If “No” is selected, 
then you can enable the export function as follows: 

 Individual event records: select “Yes” in the “Export” field of 
each event properties window that appears during scheduling of 

the resource. 

 All of the resource’s event records: check the “Export/print all 

records” option under the “Export/Print Templates” window. 
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Switch Library Resources 

Create switch library resources containing properties for switch inputs, such as studio 
feeds or external character generators (CG).  Click the “Library” folder and then right 

click in the “Resource View” window and select “New.”  Select a switch input type 
under “Format” in the “Properties” window and then edit the remaining properties 
described in Table 29, referring to Illustration 94 throughout. 

Illustration 94, Example of Switch Library Resource Properties 

 

Table 29, Switch Library Resource Properties 

FIELD DESCRIPTION 

Title Enter a unique and descriptive name, up to 31 characters 
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FIELD DESCRIPTION 

Format Choose one of the following switch types: 

 External CG 

 IRD 

 Switch 

 Studio  

Show in 
program guide 

Select “Yes” from the drop down list to include the scheduled 
resource on onscreen program guides (see “Onscreen Program 

Guide Library Resources,” on page 204) and the web program guide 
see “Viewing Web Program Guide” on page 402).  The scheduled 
resource will be listed according to its event start time and the text 

entered into the “Comment” field.   

Comment Enter a unique and descriptive name with up to 31 characters to 
represent the resource on the onscreen and web program guides.    

The text entered in the “Title” field is automatically placed in the 
“Comment” field, but may be changed.  

Icon Select the desired icon to represent your library item.   

1. Open the icon selection window by selecting the “Icon” field and 
clicking the button that appears.   

2. Select the desired icon. 

3. Double click icon or click “OK.”  Click “Cancel” to abort 
selection. 

Length Enter the on-air length of the program medium. 

Media ID If desired, assign a library tracking number. 

Field Name 1–

11 

If desired, select the user-defined column field items that pertain to 

the new library item. 

Print Select “Yes” to enable all of the resource’s event records for printing.  

If “No” is selected, then you can enable printing as follows: 

 Individual event records: select “Yes” in the “Print” field of 

each event properties window that appears during scheduling 
of the resource. 

 All of the resource’s event records: check the “Export/print all 
records” option under the “Export/Print Templates” window. 

Export Select “Yes” to allow all of the resource’s event records to be 

exported into comma delimited or Microsoft Excel® formats.  If “No” 
is selected, then you can enable the export function as follows: 

 Individual event records: select “Yes” in the “Export” field of 

each event properties window that appears during scheduling 
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FIELD DESCRIPTION 

of the resource. 

 All of the resource’s event records: check the “Export/print all 

records” option under the “Export/Print Templates” window. 
 

MPEG Library Resources 

Create MPEG file library resources containing properties for MPEG video files that will 
be displayed on the NEXUS series system’s internal MPEG players.  Click the 
“Library” folder and then right click in the “Resource View” window and select “New.”  

Select “MPEG” under “Format” in the “Properties” window and then edit the remaining 
properties described in Table 30, referring to Illustration 95 throughout. 

Illustration 95, MPEG Library Resource Properties 
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Table 30, MPEG Library Resource Properties 

FIELD DESCRIPTION 

Title Enter a unique and descriptive name, up to 31 characters. 

Format Select “MPEG” from the drop down list. 

Show in program 
guide 

Select “Yes” from the drop down list to include the scheduled 
resource on onscreen program guides (see “Onscreen Program 

Guide Library Resources,” on page 204) and the web program guide 
(see “Viewing Web Program Guide” on page 402).  The scheduled 
resource will be listed according to its event start time and the text 

entered into the “Comment” field.   

Comment Enter a unique and descriptive name with up to 31 characters to 
represent the resource on the onscreen and web program guides.    

The text entered in the “Title” field is automatically placed in the 
“Comment” field, but may be changed.  

Icon Select the desired icon to represent your library item.   

1. Open the icon selection window by selecting the “Icon” field and 
clicking the button that appears.   

2. Select the desired icon. 

3. Double click icon or click “OK.”  Click “Cancel” to abort 
selection. 

Video filename Use the “Video filename” field to select the appropriate filename for 
the source as follows:  

1. Select the “Video filename” field.  Click the ellipsis button to 
open the “Select File” window.  

2. Select a USB drive from the “Storage device” drop down list 
to display the drive’s stored MPEG files. 

3. To display a file’s properties and view the clip before 
completing the selection, either right click on the file or click 
“Properties” to display the instant video preview monitor 

window (see Illustration 96, Instant Video Preview Monitor).  
For more information on the preview monitor, go to the “Using 
Instant Video Preview Monitor to Display MPEG Files within 
WinLGX” section on page 230. 
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FIELD DESCRIPTION 

Video filename 

(continued) 
Illustration 96, Instant Video Preview Monitor 

 

4. Perform one of the following: 

 Enter a filename for a file that will be recorded and played 

within the same schedule: 

NOTE: The MPEG recording library resource is 

scheduled for recording through the MPEG 
device resource.  Refer to “Internal Broadcast 
MPEG Recorder Device Resources” on page 265 
for further instructions.   

a. Type a filename in the “Name” field. 

b. In the “Length” field, enter the record time for the file. 

c. From the “Select file” dialog, click “OK” to accept 
filename or “Cancel” to abort. 

 Select the filename of a pre-recorded file through one of 
the following methods: 

 Double-click the desired file to automatically accept 
selection and close “Select file” window.  

 Click to select the desired file. From the “Select file” 
dialog, click “OK” to accept selection or “Cancel” to 
abort. 



NEXUS Series 

Software Installation & Configuration 

LEIGHTRONIX, INC.  Page 187 
2018-06-08  WinLGX ver. 7.0.2.60 
 

FIELD DESCRIPTION 

Storage device The USB drive containing the MPEG file is automatically displayed 
once the MPEG filename is selected. 

In point /  

Out point  

(in 
HH:MM:SS:FF, 
where 

FF=frames) 

To specify where in the selected file you would like playback to 

begin and end, use the “In point” and “Out point” fields.  Either type 
the desired file start and end times into the fields or click either 

field’s ellipsis button to open the clip editor.  The clip editor that is 
displayed depends on whether the “hardware” or “software” monitor 
option is chosen for clip editor playback (see page 130 for preview 

monitor settings).  Follow the set of steps below that corresponds to 
your monitor choice.  

Software Monitor 

The WinLGX video clip editor combines clip editing controls with a 
preview window for quick and convenient clip editing that does not 

interrupt programming playback on your NEXUS series server’s 
MPEG players.  To use this option, ensure the “Software Monitor” 
option is selected on the “Preview Monitor” tab in the “Preferences” 
window. 

Illustration 97, WinLGX Video Clip Editor with Preview Monitor 

 

1. If desired, adjust the volume control.  Audio is set to the lowest 
level by default. 
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FIELD DESCRIPTION 

In point /  

Out point  

(in 
HH:MM:SS:FF, 
where 

FF=frames) 

2. Ensure each point you wish to set has a green checkmark next 

to its time field.  

3. If in and out points have already been set (there will be time 

values in the corresponding fields), you can use the seek  in 

and  out point buttons to move the playback bar to those 

points in the clip. 

4. Specify the clip’s playback in and out points using one of the 

following methods: 

 Click the  button to start playing the file and click the  

set in point button and  set out point button at the desired 

spots.  If you would like the clip to restart each time the end is 

reached, click the  loop button. 

 Drag the playback bar to the desired spot and click the  

set in point or  set out point button. 

 Click the  or  button to move between groups of 

pictures (GOPs) in the MPEG file and click the  set in point 

or  set out point button. 

 Click the  or  button to move forward or back in the 

MPEG file by the number of seconds specified on the 
“Preview Tab” of the “Preferences” window.  When you reach 

the desired point in the file, click the  set in point or  set 
out point button. 

Once the in and out points are selected, their begin and end time 

values will be displayed in the corresponding fields, and the total 
length of time from in to out point will be shown in the “Duration” 
field. 

NOTE: When you seek the current in or out point on the playback 
bar, you will notice a slight discrepancy between the 

current time displayed above the playback bar and the in or 
out point field values.  Clip playback between your in and 
out points will be as shown on the clip editor’s preview 

monitor. 

Hardware Monitor 

WinLGX displays the control panel clip editor if you are choosing to 

play back your clips during editing on a monitor attached to your 
NEXUS series server, and “Hardware Monitor” is selected on the 
“Preview Monitor” tab in the “Preferences” window.   
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FIELD DESCRIPTION 

1. Specify the clip’s playback in and out points using one of the 

following methods: 

NOTE: If you did not specify a default MPEG player for clip 

editing under “Tools”/”Preferences/Preview Monitor” 
(see page 130 for further instructions), WinLGX asks 
you to select the MPEG 1 or 2 clip editor. If the selected 

or default MPEG player is currently playing a file, 
WinLGX allows you to stop playback and continue with 
the clip editing process or select the other MPEG player.   

 Click the  button to start playing the file and click the 

 or  button at the desired spot. 

 Drag the playback bar to the desired spot and click the 

 or  button. 

 Click the  or  button to move between groups of 

pictures (GOPs) in the MPEG file and click the  or 

 button. 

2. Close the clip creation control panel and add changes to library 

resource by clicking the  button. 

Length Automatically displayed once the MPEG filename is selected.  This 
length may be changed to a value between 10 seconds and 4 hours. 

Video bit rate Automatically displayed once the MPEG filename is selected. 

Video bit rate 
type 

Automatically displayed once the MPEG filename is selected. 

Audio sample 
rate 

Automatically displayed once the MPEG filename is selected. 

Overlay If desired, select one of the overlay templates created in the 

“Overlay Templates” view.  The graphic and text message overlays 
that are part of the selected template will then display with the 

program.   

Media ID If desired, assign a library tracking number. 

Field Name 1–11 If desired, select the user-defined column field items that pertain to 

the new library item. 
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FIELD DESCRIPTION 

Print Select “Yes” to enable all of the resource’s event records for printing.  

If “No” is selected, then you can enable printing as follows: 

 Individual event records: select “Yes” in the “Print” field of 
each event properties window that appears during scheduling 

of the resource. 

 All of the resource’s event records: check the “Export/print all 

records” option under the “Export/Print Templates” window. 

Export Select “Yes” to allow all of the resource’s event records to be 

exported into comma delimited or Microsoft Excel® formats.  If “No” 
is selected, then you can enable the export function as follows: 

 Individual event records: select “Yes” in the “Export” field of 
each event properties window that appears during scheduling 
of the resource. 

 All of the resource’s event records: check the “Export/print all 

records” option under the “Export/Print Templates” window. 
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MPEG Loop Library Resources 

Create MPEG loop library resources containing properties for MPEG video files that 
will be repeatedly displayed on the UltraNEXUS/NEXUS internal MPEG players.  Each 

MPEG loop library resource displays the selected MPEG video file for a specified 
number of times or loops.  Click the “Library” folder and then right click in the 
“Resource View” window and select “New.”  Select “MPEG Loop” under “Format” in 

the “Properties” window and then edit the remaining properties described in Table 31, 
referring to Illustration 98 throughout. 

Illustration 98, MPEG Loop Library Resource Properties 
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Table 31, MPEG Loop Library Resource Properties 

FIELD DESCRIPTION 

Title Enter a unique and descriptive name, up to 31 characters. 

Format Select “MPEG” from the drop down list. 

Show in 
program 

guide 

Select “Yes” from the drop down list to include the scheduled resource 
on onscreen program guides (see “Onscreen Program Guide Library 

Resources,” on page 204) and the web program guide (see “Viewing 
Web Program Guide” on page 402).  The scheduled resource will be 
listed according to its event start time and the text entered into the 

“Comment” field.   

Comment Enter a unique and descriptive name with up to 31 characters to 
represent the resource on the onscreen and web program guides.  The 

text entered in the “Title” field is automatically placed in the “Comment” 
field, but may be changed.  

Icon Select the desired icon to represent your library item.   

1. Open the icon selection window by selecting the “Icon” field and 
clicking the ellipsis button that appears.   

2. Select the desired icon. 

3. Double click icon or click “OK.”  Click “Cancel” to abort selection. 

Video 

filename 

Use the “Video filename” field to select the appropriate filename for the 
source as follows:  

1. Select the “Video filename” field.  Click the ellipsis button to open 
the “Select File” window.  

2. Select a USB drive from the “Storage device” drop down list to 
display the drive’s stored MPEG files. 

3. To display a file’s properties and view the clip before completing 
the selection, either right click on the file or click “Properties” to 
display the instant video preview monitor window (see Illustration 

99).  For more information on the preview monitor, go to the 
“Using Instant Video Preview Monitor to Display MPEG Files 
within WinLGX” section on page 230. 
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FIELD DESCRIPTION 

Video 

filename 
Illustration 99, Instant Video Preview Monitor 

 

4. Perform one of the following: 

 Enter a filename for a file that will be recorded and played 

within the same schedule: 

NOTE: The MPEG recording library resource is scheduled 

for recording through the MPEG device resource.  
Refer to “Internal Broadcast MPEG Recorder Device 
Resources” on page 265 for further instructions.   

a. Type a filename in the “Name” field. 

b. In the “Length” field, enter the record time for the file. 

c. From the “Select file” dialog, click “OK” to accept filename 
or “Cancel” to abort. 

 Select the filename of a pre-recorded file through one of the 
following methods: 

 Double-click the desired file to automatically accept 
selection and close “Select file” window.  

 Click to select the desired file. From the “Select file” dialog, 
click “OK” to accept selection or “Cancel” to abort. 
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FIELD DESCRIPTION 

Length The file length is automatically displayed once the MPEG filename is 

specified.  To specify the number of times or length of time you would 
like the file to loop, perform the following: 

1. Select the “Length” field and then click the ellipsis button to 
display the “MPEG Loop Calculator” (see Illustration 100).  

Illustration 100, MPEG Loop Calculator 

 

2. Enter the number of times you would like the file to loop in the 
“Loop count” field and/or enter a length of time, up to 24 hours, in 

the “Loop length” field. 

Storage 
device 

The USB drive containing the MPEG file is automatically displayed 
once the MPEG filename is selected. 

Video bit rate Automatically displayed once the MPEG filename is selected. 

Video bit rate 

type 

Automatically displayed once the MPEG filename is selected. 

Audio 

sample rate 

Automatically displayed once the MPEG filename is selected. 

Overlay If desired, select one of the overlay templates created in the “Overlay 
Templates” view.  The graphic and text message overlays that are part 

of the selected template will then display with the program.   

Media ID If desired, assign a library tracking number. 

Field Name 

1–11 

If desired, select the user-defined column field items that pertain to the 

new library item. 

Print Select “Yes” to enable all of the resource’s event records for printing.  If 
“No” is selected, then you can enable printing as follows: 

 Individual event records: select “Yes” in the “Print” field of each 

event properties window that appears during scheduling of the 
resource. 

 All of the resource’s event records: check the “Export/print all 
records” option under the “Export/Print Templates” window. 
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FIELD DESCRIPTION 

Export Select “Yes” to allow all of the resource’s event records to be exported 

into comma delimited or Microsoft Excel® formats.  If “No” is selected, 
then you can enable the export function as follows: 

 Individual event records: select “Yes” in the “Export” field of 

each event properties window that appears during scheduling of 
the resource. 

 All of the resource’s event records: check the “Export/print all 
records” option under the “Export/Print Templates” window. 

 
Slide Library Resources 

Slide library resources contain properties for JPEG slides that will be displayed on the 

NEXUS series system’s internal MPEG players.  Before creating a slide library 
resource, upload the desired slide into a NEXUS series user folder(s) through the 
WinLGX Storage Manager window or WebNEXUS: 

 WinLGX Storage Manager: refer to “Managing all Digital Files,” on page 330. 

 WebNEXUS interface: see the “Uploading Slides to a NEXUS Series 
Server/Controller” section on page 370 to learn how to upload slides through 

WebNEXUS. 

To create a library resource for a slide, click the “Library” folder and then right click in 

the “Resource View” window and select “New.”  Select “Slide” under “Format” in the 
“Properties” window and then complete the remaining properties described in Table 
32, referring to Illustration 101 throughout. 

NOTE: The NEXUS series systems ship with sample slides under “ADMIN” and a 
variety of background slides available to all user accounts.  Sample slides 
are provided to demonstrate possible usages for the digital messaging 

feature.  Users may create their own slide shows by adding text and 
graphics to the included template backgrounds. 
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Illustration 101, Slide Library Resource Properties 

 

Table 32, Slide Library Resource Properties 

FIELD DESCRIPTION 

Title Enter a unique and descriptive name, up to 31 characters. 

Format Select “Slide” from the drop down list. 
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FIELD DESCRIPTION 

Icon Select the desired icon to represent your library item.   

1. Open the icon selection window by selecting the “Icon” field and 
clicking the button that appears.   

2. Select the desired icon. 

3. Double click icon or click “OK.”  Click “Cancel” to abort selection. 

Slide 

filename 

Use the “Slide filename” field to select the appropriate slide filename 

for the source as follows: 

1. Select the “Filename” field and click the button that appears to 
open the “Select Slide” window (see Illustration 102, “Select Slide” 
Window). 

Illustration 102, “Select Slide” Window 

 

2. Select a username from the “Users” drop down list to display the 
JPEG slides in the corresponding remote user folder. 

3. Select a slide as follows: 

 Double-click the desired file to accept selection and close 
“Select slide” window.  

 Select the desired file and click “OK” to accept or “Cancel” to 
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FIELD DESCRIPTION 

abort selection. 

User folder Automatically displayed once the slide is selected. 

Length The default slide length specified in the “Application” tab of the 
“Preferences” window is automatically displayed once the slide 

filename is selected (see page 124 for more information), but may be 
edited to any value greater than 5 seconds. 

Background If desired, select an audio source to play with your slide file display.  

Under the “Background audio input” field, perform one of the following: 

 Select “from MPEG” to play the audio from an MPEG file.  Load 

an MPEG file using the “MPEG filename” field that appears.   

 NEXUS/UltraNEXUS only: select an audio input on the internal 

switcher. 

 UltraNEXUS-SDI only: select the type of audio signal your SDI 

system has been wired to record:  
 “Analog”: corresponds to the analog audio inputs on the 

SDI’s back panel terminal blocks (see Table 6, Non-

Embedded Audio Terminal Block Configurations, for analog 
audio wiring diagram) 

 “AES”: corresponds to the AES audio inputs on the SDI’s 

back panel terminal blocks (see Table 6, Non-Embedded 
Audio Terminal Block Configurations, for AES audio wiring 
diagram) 

 “Embedded 1-2,” “Embedded 3-4,” “Embedded 5-6,” and 

“Embedded 7-8”: if your audio is embedded within the SDI 
video signal, select the embedded audio channel pair that 
you want to record 

Overlay If desired, select one of the overlay templates created in the “Overlay 
Templates” view.  The graphic and text message overlays that are part 

of the selected template will then display with the program.   

Media ID If desired, assign a library tracking number. 

Field Name 

1–11 

If desired, select the user-defined column field items that pertain to the 

new library item. 

Print Select “Yes” to enable all of the resource’s event records for printing.  If 
“No” is selected, then you can enable printing as follows: 

 Individual event records: select “Yes” in the “Print” field of each 

event properties window that appears during scheduling of the 
resource. 

 All of the resource’s event records: check the “Export/print all 
records” option under the “Export/Print Templates” window. 
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FIELD DESCRIPTION 

Export Select “Yes” to allow all of the resource’s event records to be exported 

into comma delimited or Microsoft Excel® formats.  If “No” is selected, 
then you can enable the export function as follows: 

 Individual event records: select “Yes” in the “Export” field of 

each event properties window that appears during scheduling of 
the resource. 

 All of the resource’s event records: check the “Export/print all 
records” option under the “Export/Print Templates” window. 

 

Slide Show Library Resources 

Slide show library resources contain properties for sequences of JPEG slides that will 
be displayed on the NEXUS series system’s internal MPEG players.  The slides 
displayed in a slide show are the slides within each of the selected user account 
folder(s).   

Before creating a slide show library resource, upload the desired slides into a NEXUS 
series user folder(s) and enable/authorize each slide for display in slide shows through 
the WinLGX Storage Manager window or WebNEXUS: 

 WinLGX Storage Manager: refer to “Managing all Digital Files,” on page 330. 

 WebNEXUS interface: see the “Uploading Slides to a NEXUS Series 

Server/Controller” on page 370 to learn how to upload slides through 
WebNEXUS and “Approving Slides for Display in Slide Shows” on page 390 for 
instructions on how to enable the slide for display. 

If the slide was not uploaded by a user with the “Automatic slide authorization” or 

“Slide administrator” user right, it must also be authorized for display in slide shows by 
the “admin” user account or a user with the “Slide administrator” right (see “Enabling 
and Authorizing Slides for Display in Slide Shows” on page 332 or “Approving Slides 

for Display in Slide Shows,” on page 390. 

To create a library resource for a slide, click the “Library” folder and then right click in 

the “Resource View” window and select “New.”  Select “Slide Show” under “Format” in 
the “Properties” window and then complete the remaining properties described in 
Table 33, referring to Illustration 103 throughout. 

NOTE: Each NEXUS series server/controller ships with sample slides under 
“ADMIN” and a variety of background slides available to all user accounts.  
Sample slides are provided to demonstrate possible usages for the digital 

messaging feature.  Users may create their own slides by adding text and 
graphics to the included template backgrounds. 
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Illustration 103, Slide Show Library Resource Properties 

 
 

Table 33, Slide Show Library Resource Properties 

FIELD DESCRIPTION 

Title Enter a unique and descriptive name, up to 31 characters. 

Format Select “Slide Show.” 
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FIELD DESCRIPTION 

Show in 

program 
guide 

Select “Yes” from the drop down list to include the scheduled resource 

on onscreen program guides (see “Onscreen Program Guide Library 
Resources,” on page 204) and the web program guide (see “Viewing 

Web Program Guide” on page 402).     

Comment Enter a unique and descriptive name with up to 31 characters to 
represent the resource on the onscreen and web program guides.    

The text entered in the “Title” field is automatically placed in the 
“Comment” field, but may be changed.  

Icon Select the desired icon to represent your library item.   

1. Open the icon selection window by selecting the “Icon” field and 
clicking the button that appears.   

2. Select the desired icon. 

3. Double click icon or click “OK.”  Click “Cancel” to abort selection. 
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FIELD DESCRIPTION 

User list Select one or more usernames to display the JPEG slides in the 

corresponding remote user folders as follows: 

NOTE: Create a default slide to display in case the selected user 
folder is empty or does not contain approved slides (refer to 
“Creating a Default Slide,” on page 387). 

1. Select the “User list” field and click the button that appears to 

open the user selection window shown in Illustration 104, “User 
list” Window. 

NOTE: The NEXUS series systems ship with sample slides 
under “ADMIN” and a variety of background slides 
available to all user accounts.   

Illustration 104, “User list” Window 

 

2. Select the desired username(s) as follows: 

 Click the “All” button to select all usernames. 

 Click the “None” button to deselect all usernames. 

 Individually select usernames by clicking on the desired 

username boxes. 

3. Click “OK” to accept selections or “Cancel” to abort. 

Length Edit to the desired run time for the entire slide show.  Each slide within 
the slide show will automatically display for 10 seconds at a time.  The 

display duration for each slide may be changed from the WebNEXUS 
interface (see “Adding Slide Show Settings to Slide Metadata388,” on 
page 387). 
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FIELD DESCRIPTION 

Background If desired, select an audio source to play with your slide file display.  

Under the “Background audio input” field, perform one of the following:  

 Select “from MPEG” to play the audio from an MPEG file.  Load 

an MPEG file using the “MPEG filename” field that appears.   

 NEXUS/UltraNEXUS only: select an audio input on the internal 
switcher. 

 UltraNEXUS-SDI only: select the type of audio signal your SDI 

system has been wired to record:  
 “Analog”: corresponds to the analog audio inputs on the 

SDI’s back panel terminal blocks (see Table 6, Non-

Embedded Audio Terminal Block Configurations, for analog 
audio wiring diagram) 

 “AES”: corresponds to the AES audio inputs on the SDI’s 

back panel terminal blocks (see Table 6, Non-Embedded 
Audio Terminal Block Configurations, for AES audio wiring 
diagram) 

 “Embedded 1-2,” “Embedded 3-4,” “Embedded 5-6,” and 

“Embedded 7-8”: if your audio is embedded within the SDI video 
signal, select the embedded audio channel pair that you want to 
record  

Overlay If desired, select one of the overlay templates created in the “Overlay 

Templates” view.  The graphic and text message overlays that are part 
of the selected template will then display with the program.   

Media ID If desired, assign a library tracking number. 

Field Name 
1–11 

If desired, select the user-defined column field items that pertain to the 
new library item. 

Print Select “Yes” to enable all of the resource’s event records for printing.  If 

“No” is selected, then you can enable printing as follows: 

 Individual event records: select “Yes” in the “Print” field of each 
event properties window that appears during scheduling of the 

resource. 

 All of the resource’s event records: check the “Export/print all 

records” option under the “Export/Print Templates” window. 

Export Select “Yes” to allow all of the resource’s event records to be exported 

into comma delimited or Microsoft Excel® formats.  If “No” is selected, 
then you can enable the export function as follows: 

 Individual event records: select “Yes” in the “Export” field of 
each event properties window that appears during scheduling of 

the resource. 

 All of the resource’s event records: check the “Export/print all 
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FIELD DESCRIPTION 

records” option under the “Export/Print Templates” window. 

 
Onscreen Program Guide Library Resources 

Create dynamic onscreen program guide resources that layer the most current 

schedule events over JPEG slide backgrounds (see Illustration 105 for an example of 
a program guide).  Once a program guide event is executed, up to ten of the upcoming 
programs on the selected channel output tab are displayed on the selected slide.  

Each program on the guide is listed according to its event start time and “Comment” 
text in the default font size, color, and style shown in Illustration 105. 

Illustration 105, Example of Onscreen Program Guide 

 
 

 

To create a library resource for a program guide, click the “Library” folder and then 
right click in the “Resource View” window and select “New.”  Select “Program Guide” 
under “Format” in the “Properties” window and then edit the remaining properties 

described in Table 34, referring to Illustration 106 throughout. 

JPEG Slide 

Program 

Guide 
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Illustration 106, Program Guide Library Resource Properties 

 
 

Table 34, Program Guide Library Resource Properties 

FIELD DESCRIPTION 

Title Enter a unique and descriptive name, up to 31 characters. 
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FIELD DESCRIPTION 

Format Select “Program Guide” from the drop down list. 

Icon Select the desired icon to represent your library item.   

1. Open the icon selection window by selecting the “Icon” field and 
clicking the button that appears.   

2. Select the desired icon. 

3. Double click icon or click “OK.”  Click “Cancel” to abort selection. 

Slide 
filename 

Use the “Slide filename” field to select the appropriate slide filename 
for the source as follows: 

1. Select the “Filename” field and click the button that appears to 
open the “Select Slide” window (see Illustration 107, “Select Slide” 

Window). 

Illustration 107, “Select Slide” Window 

 

2. Select a username from the “Users” drop down list to display the 

JPEG slides in the corresponding remote user folder. 

3. Select a slide as follows: 

 Double-click the desired file to accept selection and close 
“Select slide” window.  

 Select the desired file and click “OK” to accept or “Cancel” to 
abort selection. 

User folder Automatically displayed once the slide is selected. 
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FIELD DESCRIPTION 

Length Automatically displayed once the slide file is selected, but may be 

edited to any value greater than 5 seconds. 

Background If desired, select an audio source to play with your slide file display.  

Under the “Background audio input” field, perform one of the following:  

 Select an audio input. 

 Select “from MPEG” to play the audio from an MPEG file.  Load 

an MPEG file using the “MPEG filename” field that appears.   

Overlay If desired, select one of the overlay templates created in the “Overlay 

Templates” view.  The graphic and text message overlays that are part 
of the selected template will then display with the program.  

Media ID If desired, assign a library tracking number. 

Field Name 

1–11 

If desired, select the user-defined column field items that pertain to the 

new library item. 

Print Select “Yes” to enable all of the resource’s event records for printing.  If 

“No” is selected, then you can enable printing as follows: 

 Individual event records: select “Yes” in the “Print” field of each 

event properties window that appears during scheduling of the 
resource. 

 All of the resource’s event records: check the “Export/print all 

records” option under the “Export/Print Templates” window. 

Export Select “Yes” to allow all of the resource’s event records to be exported 
into comma delimited or Microsoft Excel® formats.  If “No” is selected, 

then you can enable the export function as follows: 

 Individual event records: select “Yes” in the “Export” field of 

each event properties window that appears during scheduling of 
the resource. 

 All of the resource’s event records: check the “Export/print all 
records” option under the “Export/Print Templates” window. 
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MPEG File/Slide Playlist Library Resources 

Create MPEG file/slide playlist library resources containing properties for multiple 
digital media files that will be displayed on the NEXUS series system’s internal MPEG 

players.  Playlist resources allow users to simultaneously schedule one or more MPEG 
files and/or JPEG slides.  Click the “Library” folder and then right click in the “Resource 
View” window and select “New.”  Select “Playlist” under “Format” in the “Properties” 

window and then edit the remaining properties described in Table 35, referring to 
Illustration 108 and Illustration 109 throughout. 

Illustration 108, Playlist Library Resource Properties 

 

Illustration 109, “Playlist Editor” Window 

 



NEXUS Series 

Software Installation & Configuration 

LEIGHTRONIX, INC.  Page 209 
2018-06-08  WinLGX ver. 7.0.2.60 
 

Table 35, Playlist Library Resource Properties 

FIELD DESCRIPTION 

Title Enter a unique and descriptive name, up to 31 characters. 

Format Select “Playlist.” 

Icon Select the desired icon to represent your library item.   

1. Open the icon selection window by selecting the “Icon” field and 
clicking the button that appears.   

2. Select the desired icon. 

3. Double click icon or click “OK.”  Click “Cancel” to abort selection. 

Resource list Select the “Resource list” field and click the button that appears to 
open the “Playlist Editor” window shown in Illustration 109 and perform 
the following steps: 

1. Under “Library View,” click on the library folder to display the 
resource you would like to add to the playlist. 

2. Select the desired resource under “Resource View.” 

3. Click the “Add” button to add resource to the “Playlist” window. 

4. Repeat steps for each additional resource you would like to place 
in the playlist. 

5. Use any of the following options to edit playlist: 

 To remove an item from the playlist, highlight the resource and 

click the “Delete” button. 

 To remove all items from the playlist, click the “Clear All” 

button and select “Yes” in the dialog that appears or “No” to 
abort the operation. 

 To reorder playlist, highlight a resource and click the “Up” 
and/or “Down” buttons to move resource into new playlist 
position. 

6. Click “OK” to create playlist resource or “Cancel” to abort 
changes. 

Length Displays total length of library resources added to playlist. 

Playlist Displays filename and length of each library resource added to playlist. 
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Virtual Channel (VC) List Library Resources 

Virtual Channel library resources allow you to use your Virtual Channel playlist files as 
scheduled programming.  Before you can create a Virtual Channel library resource, 

you must first create one or more Virtual Channel playlist files in WebNEXUS (see 
“Creating/Modifying Virtual Channel Playlists,” on page 424).  Click the “Library” folder 
and then right click in the “Resource View” window and select “New.”  Select “VC List” 

under “Format” in the “Properties” window and then edit the remaining properties 
described in Table 35, referring to Illustration 108 and Illustration 109 throughout. 

Illustration 110, VC List Library Resource Properties 

 

Table 36, Playlist Library Resource Properties 

FIELD DESCRIPTION 

Title Enter a unique and descriptive name, up to 31 characters. 

Format Select “VC List.” 
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FIELD DESCRIPTION 

Icon Select the desired icon to represent your library item.   

1. Open the icon selection window by selecting the “Icon” field and 
clicking the button that appears.   

2. Select the desired icon. 

3. Double click icon or click “OK.”  Click “Cancel” to abort selection. 

VC List 

Filename 

Click the ellipsis button to open the “Select Virtual Channel” popup 

window.  Single click to select a Virtual Channel playlist file from the 
listing and click “OK” to add the file to your library resource’s properties 
or “Cancel” to abort.  

Length Defaults to the total length of all resources in the playlist, but may be 

changed to any length of time up to 23 hours:59 minutes:59 seconds.  
If a longer length is specified, the playlist will repeat in order, and if 
less, not all of the playlist resources will be displayed.   

Media ID If desired, assign a library tracking number. 

Field Name 

1–11 

If desired, select the user-defined column field items that pertain to the 

new library item. 

Print Select “Yes” to enable all of the resource’s event records for printing.  If 
“No” is selected, then you can enable printing as follows: 

 Individual event records: select “Yes” in the “Print” field of each 
event properties window that appears during scheduling of the 

resource. 

 All of the resource’s event records: check the “Export/print all 

records” option under the “Export/Print Templates” window. 

Export Select “Yes” to allow all of the resource’s event records to be exported 

into comma delimited or Microsoft Excel® formats.  If “No” is selected, 
then you can enable the export function as follows: 

 Individual event records: select “Yes” in the “Export” field of 
each event properties window that appears during scheduling of 

the resource. 

 All of the resource’s event records: check the “Export/print all 

records” option under the “Export/Print Templates” window. 
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EXPORTING MPEG LIBRARY RESOURCES  

When you have finished creating your library resources, you have the option of 
exporting any MPEG library resource properties into resource files (.res) on your 

NEXUS series system’s USB and NAS storage devices.  Resource files are useful for 
quickly importing library resource properties into a new NEXUS series image file and, 
if saved on a NAS storage device, are accessible to any NEXUS series server in your 
system.  To export library resources into a resource file, perform the following: 

NOTES:  Only MPEG library resource properties can be exported into a 

resource file.   

  Only the library resource properties are exported into a resource file.  

The MPEG files remain in their current storage locations. 

1. Right click on the “Library” configuration folder containing the library resources you 

wish to export and select “Export” from the pop-up menu (see Illustration 111) to 

display the “Export MPEG Resource” window (see Illustration 112).  Resource files 
may only be exported on a folder by folder basis. 

Illustration 111, Library "Export" Option 

 

Illustration 112, "Export MPEG Resource" Window 
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2. If the selected library folder contains resources for MPEG videos on more than one 
USB or NAS device, you will see a list of storage devices at the top of the “Export 

MPEG Resource” window (see Illustration 112).  Single click to select the storage 
device containing the MPEG files in the library resources you wish to export.  To 
export all of your MPEG library resources, you will need to create a separate export 

file for each storage device. 

3. If you wish to overwrite an existing resource file, single click to select the file in 

“Resource Files” listing.  Click the “Export” button and, if saving a new resource file, 
enter an alphanumeric filename without spaces into the “Export resource” window 

(see Illustration 113).  Click “Ok” to upload the file to the selected storage device or 
“Cancel” to abort. 

Illustration 113, "Export Resource" Library Resource Filename 

 

4. When the resource file has been uploaded to the selected NEXUS series USB or 

NAS storage device, click “Ok” when you are prompted. 

5. If desired, repeat the steps in this section for each set of library resources in the 
folder referencing MPEG videos on your other storage devices. 
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SOFTWARE OPERATION 

ABOUT THIS SECTION 

Introduced in the previous section, the tabs, icons, and menu items for the WinLGX 

schedule view will now be explained in greater detail.  The first part of this section 
teaches you how to use the schedule view components to add events to your NEXUS 
series image files for automated playback and recording.  The system, device, and 

library (media) properties must be entered into the current image file before event 
scheduling can occur (see “Software Installation & Configuration,” starting on page 84, 
for instructions).  To create a schedule, simply drag and drop your device and library 

icons onto the schedule view and then complete the corresponding event properties 
windows.  For an outline of the scheduling process, refer to the WinLGX Scheduling 
Quick Guide included with your NEXUS series system.  This section also shows you 

how to use the WinLGX control panel for the times you wish to immediately perform 
switching and device control or start/stop a schedule. 

At the end of this section, you will learn how to manage the storage of any digital 
videos on your NEXUS series system’s external storage devices and digital slides 

uploaded to the NEXUS system’s internal memory.  With the WinLGX “Storage 
Manager” window, you can delete, move, and copy MPEG videos, slides, and overlays 
between your local (PC) and remote storage areas.  To protect these same files 

against loss, you will also learn how to backup your NEXUS system’s internal memory 
and external USB drives with the Total Backup program. 
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PERFORMING GENERAL WINLGX OPERATIONS 

OPENING WINLGX AND CONNECTING TO NEXUS SERIES 
SERVER/CONTROLLER 

1. Double click the WinLGX desktop icon.  The login window shown in Illustration 114 
automatically appears when WinLGX is opened or when you click one of the 

following: 

 Select “Site manager” in the “Tools” menu 

 Click the  icon on the toolbar 

Illustration 114, “Site Manager” Window 

 

2. If desired, reorder your IP address listing.  Clicking on any column header in the 
“Site Manager” sorts the associated information in ascending order, while clicking 

the header again sorts the list in descending order. 

3. Connect as follows (see Illustration 114, “Site Manager” Window): 

NOTE: The WinLGX title bar on the main window states whether or not you are 

connected. 

a. Select one or more IP addresses.  You may select up to eight IP addresses by 

holding down your keyboard “Ctrl” key and clicking each address with the left 
mouse button.     
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b. Log in with the username and password given to you by the NEXUS series 
system administrator.  To simultaneously log into multiple servers, all of the 
selected IP addresses must have the same username and password. 

NOTE: Connect to multiple NEXUS series server/controllers with different 
usernames and passwords by logging in separately to each system. 

If the username and password have not been changed from the factory 
defaults, enter the following: 

NEXUS SERIES FACTORY-DEFAULT USERNAME AND PASSWORD 

 “USER” FIELD: “ADMIN” IN LOWER-CASE LETTERS 

 “PASSWORD” FIELD: THE LAST SIX DIGITS OF YOUR NEXUS SYSTEM’S 

SERIAL # 

NOTE:  ENTER ANY LETTERS IN UPPER CASE. 

 

NOTES:  Only letters and numbers may be used in your username and 
password. 

  Logins are case sensitive. 

 If the correct characters are not entered, an error message will 
be displayed. 

  An administrator can assign various degrees of rights to each 
username, so not all menu items or functions may be available 

to a user. 

  The last six digits of your NEXUS series server/controller’s serial 

number are viewable from the front panel (see “Configuring 
Front Panel Settings,” on page 76) and a sticker on the back of 
your NEXUS series server/controller. 

c. Click “Connect” or press “Enter” to connect to the chosen NEXUS series 
server/controller(s) and close the login dialog box.  Once you are connected, a 

tab appears for each NEXUS series server/controller on the main window 
beneath the toolbar.   

d. If you logged into more than one NEXUS series system, switch between the 
servers by clicking on the product tabs on the main window.  
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DISPLAYING WINLGX VERSION NUMBER 

Select “About WinLGX” in the “Help” menu or click the  main toolbar icon to open a 
window with the WinLGX version number.  Click on the window to close it. 

Illustration 115, About WinLGX Window 
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DISCONNECTING FROM A NEXUS SERIES SERVER/CONTROLLER 

To disconnect WinLGX from your NEXUS series system, perform the following steps: 

NOTE: The NEXUS system will continue to operate while disconnected from 
WinLGX. 

1. Select “Site manager” in the “Tools” menu or click the  icon on the toolbar to 
open the “Site Manager” window shown in Illustration 114. 

2. Select the NEXUS series address(es) you would like to disconnect.  If you want to 

disconnect from more than one address, hold down your keyboard “Ctrl” key and 
click on each address with the left mouse button. 

3.  Click the “Disconnect” button.  A box will appear asking whether or not you would 
like to disconnect from the current NEXUS series location(s).  Click “Yes” to 

disconnect or “No” to remain connected.   

EXITING WINLGX 

To disconnect from your NEXUS series server/controller(s) and close the WinLGX 
software, perform the following steps: 

NOTE: The NEXUS system will continue to operate while disconnected from 
WinLGX.  

1. Select “Exit” in the “File” menu or click the  in the upper right corner of the main 
window.   

2. If an image file has not been saved for one of the connected NEXUS series 
server/controllers, the dialog box shown in Illustration 116 appears and asks if you 

want to save the changes.  Select one of the following options: 

Illustration 116, WinLGX Exit Dialog Box 
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 Save to disk: click “Yes” to open the “Save As” window.  Once you browse to 

the desired file path and save your changes (see “Saving NEXUS Series Image 
Files,” on page 225), WinLGX will automatically close.  

 Save to controller: click “Yes” to send the image file to the NEXUS series 

server/controller.  Once the send is complete, the server/controller will contain 
and execute the schedule and WinLGX will automatically close.   

 Save to disk and controller: click “Yes” to open the “Save As” window.  Once 

you browse to the desired file path and save your changes (see “Sending 
NEXUS Series Image Files,” on page 301), WinLGX will send the image file to 

the NEXUS series server/controller.  Once the send is complete, the NEXUS 
system will contain and execute the schedule and WinLGX will automatically 
close.   

 Select “No” to discard any changes made since the last save and close 
WinLGX. 

 Select “Cancel” to prevent WinLGX from closing and keep the current image file 
open. 
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OPENING NEXUS SERIES IMAGE FILES 

Each NEXUS series image file (.nmg) holds your schedule events along with 

your system, device, and library resource properties.  The “Software Installation & 
Configuration” section, starting on page 84, describes how to define these 
configuration properties.  The image file’s configuration properties must be entered 
into the current image file before event scheduling can occur.    

NOTE: If you have not yet created a NEXUS series image file, go to “Creating New 
NEXUS Image Files,” on page 95. 

If an unsaved image is open in WinLGX when you attempt to open another image, a 
dialog box (see Illustration 116) appears and asks if you want to save the changes.  
Select one of the following options: 

 Save to disk: click “Yes” to open the “Save As” window.  Browse to the desired 
file path and save your changes (see “Saving NEXUS Series Image Files,” on 

page 225).  

 Save to controller: click “Yes” to send the image file to your NEXUS series 
system.  Once the send is complete, the NEXUS series system will contain and 

execute the schedule.   

 Save to disk and controller: click “Yes” to open the “Save As” window.  Once 

you browse to the desired file path and save your changes (see “Saving 
NEXUS Series Image Files,” on page 225), WinLGX will send the image file to 
the NEXUS series system.  Once the send is complete, the NEXUS system will 

contain and execute the schedule.   

 Select “No” to discard any changes made since the last save and close 

WinLGX. 

 Select “Cancel” to prevent WinLGX from closing and keep the current image file 
open. 

 
Open a NEXUS series image file according to one of the following subsections: 

 “Opening a Saved Image File,” on page 220 

 “Opening an Image File as New,” on page 222 

 “Receiving Image Files from the Connected NEXUS Series 

Server/Controller(s),” on page 223 

 “Associating NEXUS Series Image Files with WinLGX,” on page 224 

OPENING A SAVED IMAGE FILE 

An image file contains any data that was entered and saved in the schedule and 
system, device, and library properties windows.  Open a saved image file as follows: 

1. Select “Open” in the “File” menu or click the  icon on the main toolbar to open 

the file selection window shown in Illustration 117.   
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Illustration 117, Open Image File Window 

 

NOTE: If your image file was saved without the Virtual Channel feature enabled 

and the image file contains MPEG events scheduled on the first two 
channel output tabs, WinLGX will display a “schedule fixup” message.   

 No external switcher configurations will be given the option to 
automatically enable the Virtual Channel feature and assign MPEG 

players to the first two channel output tabs.  Be aware that all MPEG 
events on the first channel output tab will then be changed to display 
on MPEG Player 1 and all events on the second channel output tab 
will display on MPEG Player 2. 

 External switcher users who would like to use the Virtual Channel 

feature must manually make the necessary image changes.  Assign 
channels to the MPEG players, change existing MPEG events on the 
first two channel output tabs to display on the assigned MPEG 
players, and then enable the Virtual Channel feature. 

2. Ensure the “Controller Image (*.nmg)” option has been selected in the “Files of 
type” field. 

3. Select an image file folder from the “Look in” drop down box at the top of the 
window.   

4. Single click a .nmg file to select it and click “Open” or double click the file.  The 

image file data is then loaded into WinLGX.   
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5. As you enter/edit your schedule events according to the “Scheduling Events” 
section starting on page 232, periodically save your settings in an image file as 

described in “Saving NEXUS Series Image Files,” on page 225. 

OPENING AN IMAGE FILE AS NEW 

Opening a previously saved image file as new causes WinLGX to load any system, 
device, and library configuration properties contained within the file.  Any schedule 

events will not be imported.  

1. Select “Open as new” in the “File” menu or click the  icon on the main toolbar to 

open the file selection window shown in Illustration 118, Open Image File as New 
Window.   

Illustration 118, Open Image File as New Window 

 

2. Ensure the “Controller Image (*.nmg)” option has been selected in the “Files of 

type” field. 

3. Select an image file folder from the “Look in” drop down box at the top of the 

window.     

4. Single click a .nmg file to select it and click “Open” or double click the file.  The 
image file data minus the schedule is then loaded into WinLGX as an unnamed file.    

5. As you enter/edit your schedule events according to the “Scheduling Events” 

section starting on page 232, periodically save your settings in an image file as 
described in “Saving NEXUS Series Image Files,” on page 225. 
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RECEIVING IMAGE FILES FROM THE CONNECTED NEXUS SERIES 
SERVER/CONTROLLER(S) 

An image received from a connected NEXUS series server/controller contains any 
schedule events and system, device, and library properties last sent to the server.   

1. Download the last image file sent to one or more of your NEXUS series 
server/controllers as follows: 

 One server: ensure the server’s product tab is selected and choose “Receive” in 

the “File” menu or click its  icon on the main toolbar.  A dialog box will ask 

whether you want to receive the image currently loaded on the connected 
NEXUS series server.  Click “Yes” to complete the receive and display the 

status box shown in Illustration 119. 

Illustration 119, Image Status Window 

Progress Bar

 

 Multiple servers: from any of the product tabs, select “Receive all” in the 

“File” menu.  Click “Yes” when prompted to download each connected 
server/controller’s image file into WinLGX.  You will see a status box like the 
one shown in Illustration 119 for each image that is downloaded. 

NOTE: If your image file was saved without the Virtual Channel feature 
enabled and the image file contains MPEG events scheduled on the 

first two channel output tabs, WinLGX will display a “schedule fixup” 
message.   

 No external switcher configurations will be given the option to 
automatically enable the Virtual Channel feature and assign MPEG 
players to the first two channel output tabs.  Be aware that all 

MPEG events on the first channel output tab will then be changed to 
display on MPEG Player 1 and all events on the second channel 
output tab will display on MPEG Player 2. 

 External switcher users who would like to use the Virtual Channel 
feature must manually make the necessary image changes.  Assign 

channels to the MPEG players, change existing MPEG events on 
the first two channel output tabs to display on the assigned MPEG 
players, and then enable the Virtual Channel feature. 

2. As you enter/edit your schedule events according to the “Scheduling Events” 

section starting on page 232, periodically save your settings in an image file as 
described in “Saving NEXUS Series Image Files,” on page 225. 
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ASSOCIATING NEXUS SERIES IMAGE FILES WITH WINLGX 

Associating an NEXUS series image (.nmg) files with WinLGX enables you to double 
click on an image file and have it automatically open in WinLGX.  Perform the following 
procedure: 

1. Browse to a NEXUS series image (.nmg) file on your file storage area.   

2. Right click on the NEXUS series image file and choose "Open with" or "Open." 

3. Choose "Select the program from a list." 

4. Browse to and choose the WinLGX executable file path.   

5. Check the "Always use ..." checkbox and click "OK." 
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SAVING NEXUS SERIES IMAGE FILES 

Save a copy of your current image file to your PC or network through one of the 

following options: 

 “Save” Option 

If a NEXUS series image has not been saved to your PC or network or has been 
modified, the “Save” option becomes enabled.  Select “Save” from the “File” menu 

or click the  toolbar button.   

 If the NEXUS series image already has a local filename, visible in the title bar 
(WinLGX – filename.nmg), the “Save” option saves the loaded image to that 
name without prompting, overwriting the old file.   

 If the image does not have a local filename, “Save” opens the “Save as” box 

shown in Illustration 120, allowing a name and file path to be specified. 

 “Save as” Option 

The “Save as” option allows you to save a NEXUS series image under a new 
filename.  Select “Save as” in the “File” menu to open the window shown in 
Illustration 120, “Save As” Window, and perform the following steps:  

Illustration 120, “Save As” Window 
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1. From the “Save in” drop down box at the top of the window, navigate to the folder 
where you want to save the NEXUS series image file.   

2. Type a name for the image in the “File name” field.   

3. If you plan to re-open this file in WinLGX, ensure the “Controller Image (*.nmg)” 

option has been selected in the “Save as type” field. 

4. Click “Save” to save the image under the entered name or “Cancel” to abort the 

“Save as.”  If you enter a name of a file that already exists, WinLGX will ask you if 
you want to overwrite it. 
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IMPORTING MPEG LIBRARY RESOURCES 

If your MPEG library resource properties have been exported into one or more 
resource files (see “Exporting MPEG Library Resources” on page 212 for information 

on exporting MPEG library resource properties), simply upload the resources into your 
current NEXUS series image file as follows: 

1. Right click on the “Library” configuration folder you wish to import MPEG library 
resource properties into and select “Import” from the pop-up menu (see Illustration 

121) to display the “Import MPEG Resource” window (see Illustration 122).  
Resource files may only be imported on a folder by folder basis. 

Illustration 121, Library "Import" Option 

 

Illustration 122, "Import MPEG Resource" Window 

 

2. If more than one device is shown in the “Storage Device” listing on the “Import 

MPEG Resource” window (see Illustration 122, "Import MPEG Resource" Window), 
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single click to select the storage device containing the resource files with the library 
resource properties you wish to import.   

3. If more than one resource file exists, single click to select the file with the library 

resources you wish to import (see Illustration 123). 

Illustration 123, Selecting File on "Import MPEG Resource" Window 

 

4. Click the “Import” button to start importing the resources or “Done” to cancel the 

operation and close the “Import MPEG Resource” window. 

5. After clicking the “Import” button, click “Yes” when prompted to import the file’s 

MPEG library resource properties or “No” to abort. 

6. When the MPEG library resource properties have been imported, click “Ok” when 
you are prompted.  The imported library resources will be shown in the “Resource 

View” (see Illustration 124 for an example). 

Illustration 124, Imported Library Resources 
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7. If you wish to import MPEG library resource properties from additional resource 

files, repeat steps 1–6.  
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USING INSTANT VIDEO PREVIEW MONITOR TO DISPLAY MPEG 

FILES WITHIN WINLGX 

WinLGX gives you the option to preview the MPEG files on your remote (USB and/or 
NAS devices) and local (PC, network) storage areas through its instant video preview 
monitor window.  Conveniently access the instant video preview monitor when you are 

scheduling an MPEG device or library resource, choosing an MPEG file for immediate 
display through the control panel, or using the Storage Manager window to manage 
your MPEG videos.   

Access the instant video preview monitor (see Illustration 125) from any of the 
following: 

 Storage Manager window 

 Double click an MPEG file 

 Right click an MPEG file and select “View” from the right-click menu 

 “Select File” window (available when initiating playback from control panel, 

scheduling MPEG device resources, and creating library resources):  

 Right click on MPEG file 

 Single click an MPEG file and click the “Properties” button 

 Library Resource View Window 

 Double click a library resource 

 Right click a library resource and select “View Resource” from right-click menu 

IMPORTANT! VLC media player must be installed on the computer running WinLGX 
if you wish to display MPEG videos in the WinLGX preview monitor 

windows.  If WinLGX states that it cannot find the VLC media player 
when you open a preview monitor window, first ensure that VLC 
player is installed on your computer.  If VLC player is not installed, 

download the free program from the Internet.  Once installation has 
been verified or completed, find your computer’s file path for the 
folder containing the VLC executable file (“vlc.exe”).  Open the 

WinLGX “Preferences” window, select the “Preview Monitor” tab, and 
enter your file path into the “VLC Application Folder” field (for 
example, C:\Program Files\VideoLAN\VLC). 

The instant video preview monitor includes controls for managing playback of the 

selected MPEG file.  Refer to the following for more information on each of the controls 

labeled in Illustration 125, Preview Monitor Controls: 
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Illustration 125, Preview Monitor Controls 

 

 Scrub Bar Slider: click and drag with your mouse pointer to go forward or 
backward in  the video 

 Jump Reverse Button: single click to move back in the video by the number of 
seconds specified on the “Preview Monitor” tab of the “Preferences” window (see 

page 130 for more details).  The default number is 10 seconds. 

 Play/Pause Button: click to toggle between pause and playback of the video 

 Step Forward Button: moves the video one frame forward each time it is clicked 

 Jump Forward Button: single click to move back in the video by the number of 

seconds specified on the “Preview Monitor” tab of the “Preferences” window (see 
page 130 for more details).  The default number is 10 seconds. 

 Close Window Red X Icon: closes preview monitor window when clicked 

 Volume Control: click and drag the volume control slider to adjust video’s volume.  
The volume control defaults to no audio. 

 Mute Button: click the mute button to toggle between silenced and restored audio. 

 File Properties: provides the name, length, video bit rate, audio sample rate, and 
storage device of the selected MPEG file 

NOTE: The MPEG file’s properties are only displayed when the preview monitor 
is accessed from the “Select File” window. 

 Resize Window Control: use to expand or shrink the size of the preview monitor 

window. 
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SCHEDULING EVENTS 

The “Schedule” window, shown in Illustration 126, with a sample schedule loaded, is 
where an event schedule is created.   

Illustration 126, Schedule Window 
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ABOUT SCHEDULE WINDOW COMPONENTS 

Product Tabs 

For each server/controller you are logged into, a separate tab appears on the main 
window.  Click on a tab to display the corresponding product view and then enter your 
scheduling information for the selected server/controller. 

Schedule View 

The “Schedule” view displays the channel output tabs, day tabs, WinLGX-LT tab, and 
schedule columns.  Add your events to this window. 

Overlay Templates View 

The “Overlay Templates” view displays the overlay template creation icons and the 
program segments available for your individual overlay resources.  Use this window to 
create overlay templates for your digital media resources. 

Illustration 127, "Overlay Templates" View in WinLGX 

 

Channel Output Tabs 

 Channel output tabs: use to schedule events that contain switches to the selected 
tab’s assigned output.   

NOTE: The number of outputs, labels, and channel/output assignments are 
entered in the “System Configuration View” (see “Configuring the Switch 
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Type of a NEXUS Series System,” on page 136).  On external switchers, 
WinLGX only allows scheduling on up to 16 channel output tabs. 

 Internal UltraNEXUS/NEXUS Switcher and “UltraNEXUS-SDI” switch type Only: 

use “Sch Rec” tab to schedule MPEG recorder events. 

Day Tabs 

Day tabs are used to schedule events on specified days.  The day tabs perform output 
and device conflict checking across all of the channel tabs, so that an output or a 
device can never have more than one event scheduled at the same time.   

Each event contains all of the starting and ending actions for a program, and thus uses 
up a block of time for the length of the program.  WinLGX orders these blocks 
vertically in the schedule window, one row per event, so that for a particular output on 
a particular day, you can see the day’s 24 hours divided into programs. 

 Locked Events 

If an event is locked, it has a fixed time entered by the user.  This allows it to be 

scheduled away from the end of the previous event or away from the beginning 
of the day.  If this is done, a channel switchback is indicated between the 
events, or at the beginning of the day.  Each channel switchback equals the 

length of time separating the preceding event from the next scheduled event.  
Channel switchbacks appear in a different color (yellow by default). 

 Unlocked Events 

An unlocked event’s time is assigned by WinLGX to coincide with the ending 
time of the event above it.  This time is not fixed and will be adjusted by 

WinLGX if events above the unlocked events are inserted, deleted, moved, or 
modified. If an added or edited event’s time or length causes it to overlap an 
unlocked event, the unlocked event will move downward in the schedule if it 
can. 

NOTE: If adding, editing, or deleting an event causes two events to conflict, an error 
message appears.  If the added/edited event is one of the conflicting events, 
the event it conflicts with is listed, the error is described, and the outcome is 

given.  If the added/edited/deleted event is not one of the conflicting events, 
the two conflicting events are listed, the error is described, and the outcome 
is given.  Use this information to correct the conflict. 
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WinLGX-LT Tab 

The WinLGX-LT tab has its own date/day and time entry and does not assign blocks of 
time in a linear fashion like the day tabs (see Illustration 128). 

NOTES:  The WinLGX-LT tab does not prevent two events from 
occupying the same time. 

  To display the WinLGX-LT tab on the bottom of your schedule 
window, select the “Show WinLGX-LT tab in the schedule window” 
option on the “Application” tab of the Tools\Preferences window. 

Illustration 128, WinLGX-LT Tab Event Window 

The WinLGX-LT tab is useful in the following situations: 

 External Switcher Configuration Only: schedule device or library resources 
attached to external switcher outputs outside the range of the 16 channel output 
tabs. 

 When you would like to use the same event on multiple days, schedule the 
event on the WinLGX-LT tab once and avoid having to recreate or copy the 
event on multiple day tabs.  

 If you would like to create a schedule that encompasses more than the next 
seven days, use the WinLGX-LT tab and schedule according to date. 

 

WinLGX-LT Tab 
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 Schedule a device-only event without a switch on the WinLGX-LT tab to test a 

device-only event action before sending it to the destination or to perform 
nonplayback events such as recording. 

 

Channel and Day/WinLGX-LT Tab Configurations 

Each pair of channel and day tabs displays its own event window.  In addition, the 
WinLGX-LT tab displays a single event window, regardless of the channel.  Selecting 
one of the channel output tabs merely causes its output to be the default when adding 

an event, with the ability to select a different output.  The channel output tabs will 
appear as follows based on the switcher configuration (see Table 37, Controller Tab 
Configurations).   

NOTE: On the UltraNEXUS/NEXUS internal switcher, Output 4, labeled as “Sch 

Rec,” is automatically assigned to the internal broadcast MPEG recorder.  
For external switchers and the “UltraNEXUS-SDI” switch type, the highest 
numbered channel output tab is automatically assigned to the internal 
broadcast MPEG recorder. 

Table 37, Controller Tab Configurations 

SWITCHER CHANNEL OUTPUT TABS # OF EVENT WINDOWS 

Internal and External, 
LEIGHTRONIX PRO-

16/NET-164 

Output 1–Output 4 
29 event windows (4 channels x 7 days 
+ 1 WinLGX-LT tab) 

External, Non-
LEIGHTRONIX Switcher 

Output 1–Output 16 
113 event windows (16 channels x 7 
days + 1 WinLGX-LT tab) 

 
Schedule Columns 

The schedule window columns display the events’ fields, giving all the information and 
actions of the event.  When the schedule window contains an event, the columns can 
be moved and resized by dragging the headers and header boundaries.  A horizontal 

scroll bar at the bottom of the window is used to view all of the columns.  For a listing 
of the fields, see Table 38, Schedule Columns. 

Table 38, Schedule Columns 

FIELD DESCRIPTION 

Time  Program’s scheduled time: reflects time of any initial switch and the 
beginning of the program time block.  If the event time is fixed (locked), this 

field will also contain a thumbtack symbol .   

Title  Name of the event.  The title may be assigned in the resource’s “Title” field 

either when the resource is configured or when it is added to the schedule.  If 
the event consists of a channel switchback, the field shows which user-
configured input or video source switchback will be displayed during the 

unscheduled time slot. 
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FIELD DESCRIPTION 

Interface/ 

Device  

Number and name of the event’s interface and corresponding device, if any. 

Format  Format selected for the device or library resource in the “Properties” window. 

Input  Number and name of the device or switch input that will be taken to the 

output at the scheduled time (shown in “Time” field). 

Output  Number and name of the output the initial input switches to at the schedule 

time (shown in “Time” field). 

Channel  Number and name of the channel in which the event resides. 

Disc Number Disc number of a DVply program event. 

Title/Chap  Disc title and chapter of a DVply program event. 

Setup  Time the device takes to produce video and/or sound after receiving a PLAY 

command. 

Preroll  Indicates amount of unwanted video (black, etc.) at the beginning of the 
program.   

In point If assigned, indicates an MPEG video’s playback starting point 

Out point If assigned, indicates an MPEG video’s playback ending point  

Length  Length of the program block and the time between initial and ending 

switches, if any.  WinLGX subtracts “End” from “Time” to obtain the “Length” 
value. 

Reset  Time the device is busy and unavailable for scheduling after the end of the 

block (“End”), usually due to rewind time. 

Start CMD  Device command that occurs initially at “Start” (usually “Play” or “Cue/Play” 

for DVply controlled devices). 

End CMD  Device command that occurs at “End” (usually “Stop” or “Rewind”). 

Switchback  Indicates the input that is switched to the event’s channel output following 

the “End” command.  Back to back events have the “End” time of the first 
event equal to the “Time” of the second event.  This puts the first event’s 

switchback at the same time as the second event’s initial switch.  If this 
occurs, the NEXUS series system cancels the switchback. 

Start  Indicates time of the initial device command.   WinLGX subtracts “Setup” 

plus “Preroll” from “Time” to obtain the “Start” value, which is the start time of 
the device command.  “Start” is not included in the time block used for 
vertical positioning within the schedule. 

 For a typical DVply event, the time progression is as follows:  

1. At the time shown in the schedule “Start” field, a CUE command is 
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FIELD DESCRIPTION 

issued. 

2. The event waits for “Setup” to complete and then issues a PLAY 
command.   

3. The event then waits for “Preroll” to complete before performing initial 
switch.   

 For all other events, the time progression is as follows:   

1. At the time shown in the “Start” field, a PLAY command is issued. 
2. The event waits for “Setup” and “Preroll” to complete before performing 

the initial switch.   

End  Indicates end of the program block, end time of the device command, and 

switchback, if any.  WinLGX adds “Length” to “Time” to obtain “End” value. 

Filename (1) Displays the filename of the chosen MPEG or slide file. 

Storage 

Device (1) 

Indicates the storage device of the chosen MPEG file or user list for a slide 

file. 

Record 

Preset 

Displays the title of the selected record preset for an MPEG recording event. 

Overwrite Displays the selected file overwrite option for an MPEG recording event. 

Record CC 

data 

Indicates whether or not an MPEG recording event will capture any closed 

caption data from the source. 

Filename (2) Displays the filename of the MPEG file chosen as the audio background for a 

slide or slide show event. 

Storage 
Device (2) 

Indicates the storage device of the MPEG file chosen as the audio 
background for a slide or slide show event. 

Audio Input Indicates the audio input selected for a slide or slide show event. 

Print  Determines if the event will be included in a print operation. 

Export  Determines if the event will be included in an export operation. 

No VOD File Indicates whether or not a video-on-demand streaming file will be recorded 

for an UltraNEXUS/UltraNEXUS-SDI MPEG record event 

Overlay Indicates whether or not a template of slide overlays has been selected to 

accompany playback of an MPEG video, slide, or slide show 

Streaming 

export 

Reserved for future use. 

Show in 
program 

guide 

Indicates whether or not an event will be shown on a program guide and the 
Internet schedule display screen 

Comment  Used to enter an event comment up to 31 characters. 
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FIELD DESCRIPTION 

Media ID Assigned by user as a library tracking number. 

Field Name 
(1–11) 

Schedule column headings that may be assigned by user. 

SCHEDULING/EDITING/DELETING ALL EVENTS 

Scheduling an Event on a Day/Channel Output Event Window 

1. Select a scheduling event window as follows: 

a. Click the desired day tab to select the day you want the event to occur. 

b. Select one of the following channel tabs: 

 MPEG recording events only: select the “Sch Rec” tab for an internal or 

“UltraNEXUS-SDI” switcher configuration or the channel output tab assigned 
to the broadcast MPEG recorder in an external switcher configuration (see 
“Editing Internal MPEG Player and Recorder Device Resource,” on page 
155 for more information on configuring channel output tabs). 

 Channel output tab 

2. Drag an icon from the “Device” or “Library” “Resource View” into the selected event 
window.  This opens an “Event properties” box with editable event information like 

the one shown in Illustration 129, Day/Channel Output Event Properties Box. 

Illustration 129, Day/Channel Output Event Properties Box 
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3. To add or change the event information, click on each of the desired editable fields 
(described on pages 249–298) and enter the new information.  An icon can be 

dragged and dropped into a day/channel output event window in the following five 
ways: 

 Empty Window—the event is locked and given the initial time of 12:00 A.M. 
(Unless a previous day’s event overlaps midnight, in which case, its “End” time 
is used.) 

 Initial Channel Switchback—if an event is dragged onto a channel switchback at 
the start of the day (1st row), it is locked and given the initial time of 12:00 A.M.  
(Unless a previous day’s event overlaps midnight, in which case, its “End” time 
is used.) 

 Any Other Channel Switchback—the event is initially unlocked, with a time 
equal to the “End” time of the previous event. 

 On Top of an Unlocked Event—the new event is initially unlocked and given the 

time of the event on which it was dragged.  The existing event is pushed 
downward and out of the way if possible.  If not, an error box appears.  
Dragging an icon on top of a locked event instantly generates an error. 

 Below the Bottom Event—the event is initially unlocked, with a time equal to the 
“End” time of the previous event. 
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Scheduling an Event on the WinLGX-LT Event Window 

NOTE: To display the WinLGX-LT tab on the bottom of your schedule window, 
select the “Show WinLGX-LT tab in the schedule window” option on the 

“Application” tab of the Tools\Preferences window. 

1. Click the “WinLGX-LT” tab to open the corresponding event window.   

2. Drag an icon from the “Device” or “Library” “Resource View” onto the WinLGX-LT 

event window.  This opens an event properties box like the one shown in 
Illustration 130, WinLGX-LT Event Properties Box.   

Illustration 130, WinLGX-LT Event Properties Box 

 

3. To add or change the event information, click on each of the desired editable fields 

(described on pages 249–286) and enter the new information.  The WinLGX-LT 
event properties box is the same as the event edit box displayed for the 
day/channel output event windows with the following exceptions. 

 There is no Lock/Unlock checkbox; you must enter a time for each event.   

 If an output assignment is desired, the output must be selected from the 
“Output” field drop down menu.   

 A date and/or day(s) must be selected as follows: 
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NOTE: If a date is selected, the event happens on that date.  If days are 
selected, the event happens on those days.  If both are selected, the 
event happens on the selected date and days. 

a. To select a date, change “Absolute date” to “Yes.”  A date field appears below 
to allow date entry.   

b. To enter a day, change the desired day field(s) to “Yes.”  These fields can be 
toggled quickly by double clicking on the day name. 

4. If desired, you may edit the properties of a device or library resource and then 
apply those changes to any events added to the WinLGX-LT event window by 
performing the following steps: 

a. Select the desired device or library resource icon. 
b. Click on the desired editable resource fields in the “Properties” window and 

make the changes.  

c. WinLGX displays a dialog box that gives you the option to merge the resource 
editing changes into each event in the WinLGX-LT event window that was 
created from the same resource. 

 
Copying/Cutting/Pasting an Event 

To move or replicate an event or group of events to another location on the schedule, 
perform the following steps: 

1. Select the desired event(s) using one of the following options: 

 Highlight an individual event. 

 Hold down your keyboard’s “Ctrl” key and highlight multiple events. 

 Highlight all events on an event window by selecting “Select All” from the “Edit” 
menu or the right-click menu or simultaneously pressing your keyboard’s “Ctrl” 
and “A” keys. 

2. Copy, cut (if you wish to move event), and paste by selecting the function you wish 
to perform from either the “Edit” menu or the right-click pop-up menu.   

3. In the “Event Properties” box that appears once the paste has been completed, 
click “Ok” if one event was pasted or “Ok to all” if more than one event was pasted.   

NOTE: If the event(s) is pasted onto a channel switchback of a shorter duration 
than the event(s) itself, WinLGX will display a dialog asking whether or 

not you would like to trim/discard the ending playlist items to fit the 
channel switchback or cancel the operation. 

Editing an Event 

To edit an event in the schedule, double click event, right click event and choose “Edit” 
in the right-click menu, or select “Edit” from the “Edit” menu.  Edit the event information 

in the “Event properties” box that appears.  To add or change the event information, 
click on each of the desired editable fields (described on pages 249–286) and enter 
the new information. 



NEXUS Series 

Software Operation 

LEIGHTRONIX, INC.  Page 243 
2018-06-08  WinLGX ver. 7.0.2.60 
 

Deleting an Event 

If the first event in the schedule window is deleted, the next event is locked in place, if 
necessary.  If any other event is deleted, any unlocked events immediately below it will 

float up until they rest against the event above (unless this causes a device conflict, in 
which case the first unlocked event will be locked in place).   

To delete an event(s), perform the following steps: 

1. Select the desired event(s) using one of the following options: 

 Highlight an individual event. 

 Hold down your keyboard’s “Ctrl” key and highlight multiple events. 

 Highlight all events on an event window by selecting “Select All” from the “Edit” 

menu or the right-click menu or simultaneously pressing your keyboard’s “Ctrl” 
and “A” keys. 

2. Press the “Delete” key, right click event and choose “Delete” in the right-click 

menu, or select “Delete” from the “Edit” menu.  You will be prompted for 
confirmation before the event is deleted.  If you selected multiple events, one of the 
following dialog boxes is displayed: 

 If you selected a list of events that includes non-playlist events, the dialog 
shown in Illustration 131 appears.  Perform one of the following options: 

Illustration 131, Delete Dialog Box 

 
 

 “Delete this event?”: click “OK” to delete the current selection in a list of 
selected events.  

 “Delete all events?”: click “OK” to simultaneously delete all of the selected 

events.   
 “Skip this event?”: click “OK” to keep the current selection in a list of 

selected events. 
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 If you only selected a playlist of events, the dialog shown in Illustration 132 
appears.  Perform one of the following options: 

Illustration 132, Playlist Delete Dialog Box 

 
 

 “Delete this event?”: click “OK” to delete the current selection in the 
playlist.  

 “Delete entire playlist?”: click “OK” to simultaneously delete the entire 
playlist.  

 “Delete entire playlist in all switchbacks?”: this option will be enabled if the 

selected playlist was added to a channel switchback.  Click “OK” to 
simultaneously delete all instances of the playlist from the selected 
channel output’s channel switchbacks. 
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Replacing Library Resource Events 

By performing the following steps, you can replace one or more schedule events 
created with the same library resource with any library resource of the same format: 

NOTE: WinLGX considers MPEG videos, JPEG slides, and JPEG slide shows to be 
the same format.  

1. If you would like to change your library resource before using it to replace event(s), 
select the library resource in the “Resource View” window and then edit its 
resource properties. 

2. Drag a library resource onto a same-format library resource event you would like to 

replace.  The event properties window for the library resource will open, displaying 
a “Replace” button on the bottom of the window (see Illustration 133).   

Illustration 133, "Replace" Button on Event Properties Window 

 

3. If desired, edit the properties of the library resource. 

4. Click the “Replace” button to open the “Find and Replace” window shown in 

Illustration 134.  This window gives you a variety of options for replacing the 
selected event or all schedule events like the selected one with the dragged library 
resource.   

5. To make a replacement, click one of the replacement buttons on the bottom of the 

“Find and Replace” window.  The replacement buttons are described in Illustration 
134.     
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NOTE: If your library resource is too long for the schedule time slot, you will be 
given the option to trim the resource to fit or cancel the replacement. 

Illustration 134, "Find and Replace" Window 

 
 

If you plan to replace multiple instances of the selected event, pay attention to the 
indicators above the replacement buttons on the “Find and Replace” window.  The 

indicators give a quick overview of how many instances of the selected event exist 
throughout your schedule.  Here is a quick description of each indicator: 

 “Day/Ch: x of x:” the second “x” indicates how many instances of the selected 
library resource event exist on the current day tab and channel output tab 

window, while the first “x” shows how many of the events have been replaced 
on the same window 

 “Ch: x of x:” the second “x” indicates how many instances of the selected library 

resource event exist on the current channel output tab windows, while the first 
“x” shows how many of the events have been replaced on the same windows 

 “Sch: x of x:” the second “x” indicates how many instances of the selected 
library resource event exist on all of the day and channel output tab windows, 

while the first “x” shows how many of the events have been replaced on the 
same windows 
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Inserting Library Resource Events 

By performing the following steps, you can insert a library resource into the time slot of 
an unlocked library resource event of the same format.  The inserted event will take 

the start time of the event onto which it was dragged.  Unlocked events below the 
inserted event will be automatically pushed downward in the schedule by an amount of 
time equal to the length of the inserted event.   

NOTES:  WinLGX considers MPEG videos, JPEG slides, and JPEG slide shows 
to be the same format. 

  If there are locked events above and/or below the selected event, the 
desired time slot may not be long enough to accommodate the dragged 
library resource.   

 If there is not a channel switchback between the selected event and 

a locked event, the “Insert” button will be unavailable on the 
resource’s “Event Properties” window.   

 If there is a short channel switchback between the selected event 

and a locked event, you will be given the option of trimming the 
resource to fit the available time slot or cancelling the insert. 

1. If you would like to change your library resource before inserting it in your 
schedule, select it in the “Resource View” window and then edit its resource 
properties. 

2. Drag a library resource onto an unlocked library resource event of the same format.  
The event properties window for the library resource will open. If there is enough 
time available to accommodate the new resource’s length, an “Insert” button will be 
displayed on the bottom of the window (see Illustration 135).   

Illustration 135, "Insert" Button on Event Properties Window 
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3. If desired, edit the properties of the library resource. 

4. Click the “Insert” button to assign the selected event’s start time to the dragged 
library resource event.  All unlocked events below the inserted event will shift 

downward in the schedule by an amount of time equal to the length of the inserted 
event.  
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SCHEDULING/EDITING DEVICE RESOURCES 

Adding or editing device resource events opens windows like the examples shown in 
this section.  Editable event fields are highlighted in each event properties window.  
Click “OK” to submit the event or “Cancel” to abort the add/edit.   

DVD Device Resources 

Dragging a DVD device resource onto the schedule reveals a box like the one in 
Illustration 136, DVD Device Event Properties Window.  Refer to Table 39, Editable 
DVD Device Event Properties, for a description of the editable event properties. 

Illustration 136, DVD Device Event Properties Window 

 

Table 39, Editable DVD Device Event Properties 

FIELD DESCRIPTION 

Lock Box At the top of the event properties window, check the “Lock” box to lock 
the event or uncheck it to unlock the event.  Locking an event causes 

the “Time” field to become enabled, allowing the user to enter a fixed 
execution time for the event.  Unlocking an event disables the “Time” 
field, causing WinLGX to assign a time to the event that starts at the 

end of the event above it in the schedule. 

Title Allows a name up to 31 characters to be typed. 
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FIELD DESCRIPTION 

Device Ensure you have selected the device you wish to schedule. 

Setup time If desired, indicate how long after the device receives a PLAY 
command that picture and/or sound is produced. 

Disc number Supported DVD Changer only: select a disc for playback. 

Title:Chapter 

 

DVply only: enter the DVD title and chapter from which you would like 

the event to begin.  Title:Chapter is the program location on the disc. 

Length Enter duration of the event. 

Preroll  Enter as needed.  Indicates amount of video at start of a program that 
you do not want playing on air.   

Reset time Enter time the playback device will be busy and unavailable for 

scheduling after the end of the program. 

Time If the event is locked, the event “Time” can be modified.  This is the 

scheduled “On-Air“ time of the event. 

Command 
(Event start) 

Choose from the following commands:  “PLAY,” “CUE/PLAY 
CHAPTER,” or “RECORD.”  It will almost always be “PLAY” or 

“CUE/PLAY” for DVply format.     

Command 
(Event end) 

Choose from the following commands:  “STOP,” “REWIND,” “PAUSE,” 
or “<None>.”  

NOTE: If you are controlling your DVD device with a PRO-BUS 
interface, check your interface manual and switches to 

determine the actions performed by the “REWIND” and 
“STOP” commands.  By default, “REWIND” does a DVD full 
stop (back to beginning), and “STOP” stops the DVD at the 

current location. 

Switchback 
input 

If desired, select a video source to be taken to the output at the end of 
the event.  

Show in 
program 

guide 

Select “Yes” from the drop down list to include the scheduled resource 
on onscreen program guides (see “Onscreen Program Guide Library 

Resources,” on page 204) and the web program guide (see “Viewing 
Web Program Guide” on page 402).  The scheduled resource will be 
listed according to its event start time and the text entered into the 

“Comment” field.   

Comment Enter a unique and descriptive name with up to 31 characters to 
identify the resource on program guides.  The text entered in the “Title” 

field is automatically placed in the “Comment” field, but may be 
changed.  

Media ID Assign as a library tracking number. 
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FIELD DESCRIPTION 

Field Name 

1–x 

Schedule column headings you may assign. 

Print Select “Yes” to enable the resource’s event record for printing.  If “No” 

is selected, then you can enable printing for all of the resource’s event 
records by checking the “Export/print all records” option under the 
“Export/Print Templates” window.  

Export Select “Yes” to allow the resource’s event record to be exported into 

comma delimited or Microsoft Excel® formats.  If “No” is selected, then 
you can enable the export function for all of the resource’s event 

records by checking the “Export/print all records” option under the 
“Export/Print Templates” window. 

Maximum 

view 

Each event properties window for a device or library resource item may 

be configured to show different fields under a “minimum” and 
“maximum” view (for instructions, see “Event Editor Tab” on page 128).  
To toggle between these views, select and deselect the “Maximum 

view” checkbox. 
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Tape Device Resources 

Dragging a tape device resource onto the schedule reveals a box like the one in 
Illustration 137, Tape Device Event Properties Window.  Refer to Table 40, Editable 
Tape Device Properties, for a description of the editable event properties. 

Illustration 137, Tape Device Event Properties Window 

 

Table 40, Editable Tape Device Properties 

FIELD DESCRIPTION 

Lock box At the top of the event properties window, check the “Lock” box to lock the 

event or uncheck it to unlock the event.  Locking an event causes the “Time” 
field to become enabled, allowing the user to enter a fixed execution time for 
the event.  Unlocking an event disables the “Time” field, causing WinLGX to 

assign a time to the event that starts at the end of the event above it in the 
schedule. 

Title Allows a name of up to 31 characters to be entered. 

Device Ensure you have selected the device you wish to schedule. 

Setup time If desired, indicate how long after the device receives a PLAY command that 
picture and/or sound is produced. 

Length This must be entered to indicate the duration of the event. 
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FIELD DESCRIPTION 

Preroll  Enter as needed.  Indicates amount of video at start of a program that you 

do not want playing on air.   

Reset time Enter time the playback device will be busy and unavailable for scheduling 

after the end of the program.  It is typically the rewind time. 

Time If the event is locked, the event “Time” can be modified.  This is the 
scheduled “On-Air” time of the event. 

Event Start— 

Command 

Choose either the “PLAY” or “RECORD” command.  It will almost always be 

“PLAY.” 

Event End— 

Command 

Choose from the following commands:  “STOP,” “REWIND,” or “<None>.”  It 

will usually be “REWIND” or “STOP.” 

Switchback 

input  

If desired, select a video source to be taken to the output at the end of the 

event. 

Show in 
program 

guide 

Select “Yes” from the drop down list to include the scheduled resource on 
onscreen program guides (see “Onscreen Program Guide Library 

Resources,” on page 204) and the web program guide (see “Viewing Web 
Program Guide” on page 402).  The scheduled resource will be listed 
according to its event start time and the text entered into the “Comment” 

field.   

Comment Enter a unique and descriptive name with up to 31 characters to identify the 
resource on program guides.  The text entered in the “Title” field is 

automatically placed in the “Comment” field, but may be changed.  

Media ID Assign as a library tracking number. 

Field Name 

1–x 

Schedule column headings you may assign. 

Print Select “Yes” to enable the resource’s event record for printing.  If “No” is 
selected, then you can enable printing for all of the resource’s event records 

by checking the “Export/print all records” option under the “Export/Print 
Templates” window.  

Export Select “Yes” to allow the resource’s event record to be exported into comma 

delimited or Microsoft Excel® formats.  If “No” is selected, then you can 
enable the export function for all of the resource’s event records by checking 

the “Export/print all records” option under the “Export/Print Templates” 
window. 

Maximum 

view 

Each event properties window for a device or library resource item may be 

configured to show different fields under a “minimum” and “maximum” view 
(for instructions, see “Event Editor Tab” on page 128).  To toggle between 
these views, select and deselect the “Maximum view” checkbox.  
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Switch Device Resources 

Dragging a switch device resource onto the schedule reveals a box in Illustration 138, 
Switch Device Event Properties Window.  Refer to Table 41, Editable Switch Device 
Event Properties, for a description of the editable event properties. 

Illustration 138, Switch Device Event Properties Window 

 

Table 41, Editable Switch Device Event Properties 

FIELD DESCRIPTION 

Lock Box At the top of the event properties window, check the “Lock” box to lock 

the event or uncheck it to unlock the event.  Locking an event causes 
the “Time” field to become enabled, allowing the user to enter a fixed 
execution time for the event.  Unlocking an event disables the “Time” 

field, causing WinLGX to assign a time to the event that starts at the 
end of the event above it in the schedule. 

Title Allows a name up to 31 characters to be typed. 

Device Ensure you have selected the device you wish to schedule. 

Length Enter duration of the event. 

Time If the event is locked, the event “Time” can be modified.  This is the 

scheduled “On-Air“ time of the event. 
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FIELD DESCRIPTION 

Switchback 

input 

If desired, select a video source to be taken to the output at the end of 

the event. 

Show in 

program 
guide 

Select “Yes” from the drop down list to include the scheduled resource 

on onscreen program guides (see “Onscreen Program Guide Library 
Resources,” on page 204) and the web program guide (see “Viewing 
Web Program Guide” on page 402).  The scheduled resource will be 

listed according to its event start time and the text entered into the 
“Comment” field.   

Comment Enter a unique and descriptive name with up to 31 characters to 

identify the resource on program guides.  The text entered in the “Title” 
field is automatically placed in the “Comment” field, but may be 
changed.  

Media ID Assign as a library tracking number. 

Field Name 

1–x 

Schedule column headings you may assign. 

Print Select “Yes” to enable the resource’s event record for printing.  If “No” 
is selected, then you can enable printing for all of the resource’s event 

records by checking the “Export/print all records” option under the 
“Export/Print Templates” window.  

Export Select “Yes” to allow the resource’s event record to be exported into 

comma delimited or Microsoft Excel® formats.  If “No” is selected, then 
you can enable the export function for all of the resource’s event 
records by checking the “Export/print all records” option under the 

“Export/Print Templates” window. 

Maximum 
view 

Each event properties window for a device or library resource item may 
be configured to show different fields under a “minimum” and 

“maximum” view (for instructions, see “Event Editor Tab” on page 128).  
To toggle between these views, select and deselect the “Maximum 
view” checkbox. 

 



NEXUS Series 

Software Operation 

Page 256   LEIGHTRONIX, INC. 
WinLGX ver. 7.0.2.60  2018-06-08 
 

GPI Output Device Resources 

Dragging a GPI device resource onto the schedule reveals a box in Illustration 139, 
GPI Output Device Event Properties Window.  Refer to Table 42, Editable GPI Output 
Device Event Properties, for a description of the editable event properties. 

Illustration 139, GPI Output Device Event Properties Window 

 

Table 42, Editable GPI Output Device Event Properties 

FIELD DESCRIPTION 

Lock Box At the top of the event properties window, check the “Lock” box to 

lock the event or uncheck it to unlock the event.  Locking an event 
causes the “Time” field to become enabled, allowing the user to 
enter a fixed execution time for the event.  Unlocking an event 

disables the “Time” field, causing WinLGX to assign a time to the 
event that starts at the end of the event above it in the schedule. 

Title Allows a name up to 31 characters to be typed. 

Device Ensure you have selected the device you wish to schedule. 

Length Enter the event duration.  

Time If the event is locked, the event “Time” can be modified.  This is the 

scheduled “On-Air“ time of the event. 
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FIELD DESCRIPTION 

Command Select a wire pair.  Depending on how you configured your GPI 

PRO-BUS interface’s dip switches (refer to your PRGPI PRO-BUS 
Interface Manual for more details), the wire pair selections in the 
drop down list: 

 Close the corresponding GPI output until a command is sent 
to close a different GPI output. 

Or 

 Pulse the corresponding GPI output closed for 750 mS.  

Media ID Assign as a library tracking number. 

Field Name 1–x Assign desired schedule column headings. 

Print Select “Yes” to enable the resource’s event record for printing.  If 

“No” is selected, then you can enable printing for all of the 
resource’s event records by checking the “Export/print all records” 
option under the “Export/Print Templates” window.  

Export Select “Yes” to allow the resource’s event record to be exported 

into comma delimited or Microsoft Excel® formats.  If “No” is 
selected, then you can enable the export function for all of the 

resource’s event records by checking the “Export/print all records” 
option under the “Export/Print Templates” window. 

Maximum view Each event properties window for a device or library resource item 

may be configured to show different fields under a “minimum” and 
“maximum” view (for instructions, see “Event Editor Tab” on page 
128).  To toggle between these views, select and deselect the 

“Maximum view” checkbox. 
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Internal MPEG Player Device Resources 

Dragging a NEXUS series MPEG player device resource onto the schedule reveals 
the window shown in Illustration 140, MPEG Player Event Properties Window.  Refer 

to Table 43, Editable MPEG Player Event Properties, for a description of the editable 
event properties. 

NOTE: Each MPEG player may only be scheduled on its assigned playback 
channels (see “Editing Internal MPEG Player and Recorder Device 

Resource,” on page 155, for more information on MPEG playback channel 
assignments). 

Illustration 140, MPEG Player Event Properties Window 

 
 

Table 43, Editable MPEG Player Event Properties 

FIELD DESCRIPTION 

Lock Box At the top of the event properties window, check the “Lock” box to 
lock the event or uncheck it to unlock the event.  Locking an event 

causes the “Time” field to become enabled, allowing the user to enter 
a fixed execution time for the event.  Unlocking an event disables the 
“Time” field, causing WinLGX to assign a time to the event that starts 
at the end of the event above it in the schedule. 
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FIELD DESCRIPTION 

Title Allows a name with up to 31 characters to be typed. 

Device If Virtual Channel has not been enabled in the switcher configuration 
properties, you may change the MPEG Player (1 or 2). 

Setup time If desired, indicate how long after the selected MPEG player is 

activated that picture and/or sound is produced. 

Reset If desired, enter time the MPEG player will be busy and unavailable 

for scheduling after the end of the program.   

Filename Use the “Filename” field to select the appropriate filename for the 
source as follows:  

1. Select the “Filename” field.  Click the ellipsis button to open the 
“Select File” window.  

2. Depending on the type of resource you wish to schedule, click the 
“Slide” or “Video” tab. 

3. Perform the set of steps below that corresponds to your resource 
selection: 

 Slide: select a user folder from the drop down list.  If desired, 
select an audio source to play with your slide.  Under the 
“Background Audio Input” field, perform one of the following: 

 Select “From MPEG” to play audio from an MPEG file. 
Choose an MPEG file using the “MPEG filename” field.   

 NEXUS/UltraNEXUS only: select an audio input attached 
to the internal switcher. 

 UltraNEXUS-SDI only: select the type of audio signal your 
SDI system has been wired to record:  

o “Analog”: corresponds to the analog audio inputs on the 
SDI’s back panel terminal blocks (see Table 6, Non-
Embedded Audio Terminal Block Configurations, for 

analog audio wiring diagram) 
o “AES”: corresponds to the AES audio inputs on the 

SDI’s back panel terminal blocks (see Table 6, Non-

Embedded Audio Terminal Block Configurations, for 
AES audio wiring diagram) 

o “Embedded 1-2”, “Embedded 3-4,” “Embedded 5-6,” and 

“Embedded 7-8”: if your audio is embedded within the 
SDI video signal, select the embedded audio channel 
pair that you want to record 

 Video: complete the following steps: 

1. Select a USB drive from the “Storage device” drop down 
list to display the drive’s stored MPEG files. 

2. Perform one of the following: 
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FIELD DESCRIPTION 

 Enter a filename for a file that will be recorded and 

played within the same schedule: 

NOTE: The MPEG recording library resource is 
scheduled for recording through the MPEG 
device resource.  Refer to “Internal Broadcast 

MPEG Recorder Device Resources” on page 
265 for further instructions.   

a. Type a filename in the “Name” field. 

b. In the “Length” field, enter the record time for the file. 

c. From the “Select file” dialog, click “OK” to accept 
filename or “Cancel” to abort. 

 Select the filename of a pre-recorded file through one 
of the following methods listed below.  To display a 
file’s properties and view the clip before completing the 

selection, either right click on the file or click 
“Properties” to display the instant video preview 
monitor.  For more information on the preview monitor, 

go to the “Using Instant Video Preview Monitor to 
Display MPEG Files within WinLGX” section on page 
230. 

o Double-click the desired file to automatically accept 
selection and close the “Select file” window.  

o Click to select the desired file. From the “Select file” 
dialog, click “OK” to accept selection or “Cancel” to 

abort. 

3. If desired, specify where you would like playback to begin 

and end with the “In point” and “Out point” fields.  Either 
type the desired file start and end times into the fields or 
click either field’s ellipsis button to open the clip editor.  The 

clip editor that is displayed depends on whether the 
“hardware” or “software” monitor option is chosen for clip 
editor playback (see page 130 for preview monitor 

settings).  Follow the set of steps below that corresponds to 
your monitor choice. 

Software Monitor 

The WinLGX video clip editor combines clip editing controls 
with a preview window for quick and convenient clip editing 
that does not interrupt programming playback on your 

NEXUS series server’s MPEG players.  To use this option, 
ensure the “Software Monitor” option is selected on the 
“Preview Monitor” tab in the “Preferences” window. 
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FIELD DESCRIPTION 

Illustration 141, WinLGX Video Clip Editor with Preview Monitor 

 

a. If desired, adjust the volume control.  Audio is set to 
the lowest level by default. 

b. Ensure each point you wish to set has a green 
checkmark next to its time field. 

c. If in and out points have already been set (there will 
be time values in the corresponding fields), you can 

use the seek  in and  out point buttons to move 
the playback bar to those points in the clip. 

d. Specify the clip’s playback in and out points using one 
of the following methods: 

 Click the  button to start playing the file and 

click the  set in point button and  set out 

point button at the desired spots.  If you would like 
the clip to restart each time the end is reached, 

click the  loop button. 

 Drag the playback bar to the desired spot and click 

the  set in point or  set out point button. 
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FIELD DESCRIPTION 

 Click the  or  button to move between 

groups of pictures (GOPs) in the MPEG file and 

click the  set in point or  set out point button. 

 Click the  or  button to move forward or back 

in the MPEG file by the number of seconds 
specified on the “Preview Monitor” tab of the 
“Preferences” window.  Once you have reached 

the desired point in the file, click the  set in 

point or  set out point button. 

Once the in and out points are selected, their begin and 
end time values will be displayed in the corresponding 
fields, and the total length of time from in to out point will 

be shown in the “Duration” field. 

NOTE: When you seek the current in or out point on the 

playback bar, you will notice a slight discrepancy 
between the current time displayed above the 
playback bar and the in or out point field values.  
Clip playback between your in and out points will 
be as shown on the clip editor’s preview window. 

Hardware Monitor 

WinLGX displays the control panel clip editor if you are 
choosing to play back your clips during editing on a monitor 

attached to your NEXUS series server, and “Hardware 
Monitor” is selected on the “Preview Monitor” tab in the 
“Preferences” window. 

a. Specify the clip’s playback in and out points using one 

of the following methods: 

NOTE: If you did not specify a default MPEG player 

for clip editing under 
“Tools”/”Preferences/Preview Monitor” (see 
page 130 for further instructions), WinLGX 

asks you to select the MPEG 1 or 2 clip 
editor. If the selected or default MPEG player 
is currently playing a file, WinLGX allows you 

to stop playback and continue with the clip 
editing process or select the other MPEG 
player. 

 Click the  button to start playing the file and 

click the  or  button at the 
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FIELD DESCRIPTION 

desired spot. 

 Drag the playback bar to the desired spot and click 

the  or  button. 

 Click the  or  button to move between groups 
of pictures (GOPs) in the MPEG file and click the 

 or  button. 

b. Close the clip creation control panel and add changes 

to library resource by clicking the  
button. 

Length The length of the file is automatically entered into this field, but it may 

be changed as follows: 

 MPEG files:  enter a value between 6 seconds and 23 
hours:59 minutes:59 seconds 

 Slide files:  enter a value greater than 5 seconds 

Time If the event is locked, the event start “Time” can be modified.  This is 

the scheduled “On-Air” time of the event. 

Command 
(Event start) 

The “PLAY” command is automatically displayed.    

Command 
(Event end) 

Choose between “STOP” and “<None>.”    It will almost always be 
“STOP.”  

Switchback 

input 

If desired, select a video source to be taken to the output at the end 

of the event. 

Overlay If desired, select one of the overlay templates created in the “Overlay 

Templates” view (see “Creating Overlays” on page 172).  The 
graphic and text message overlays that are part of the selected 
template will then display with the program.  Each overlay resource in 

the template will display in the listed order for ten percent of the total 
length of the scheduled digital program. 

Show in 

program guide 

Select “Yes” from the drop down list to include the scheduled 

resource on onscreen program guides (see “Onscreen Program 
Guide Library Resources,” on page 204) and the web program guide 
(see “Viewing Web Program Guide” on page 402).  The scheduled 

resource will be listed according to its event start time and the text 
entered into the “Comment” field.   
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FIELD DESCRIPTION 

Comment Enter a unique and descriptive name with up to 31 characters to 

identify the resource on program guides.  The text entered in the 
“Title” field is automatically placed in the “Comment” field, but may be 

changed.  

Media ID Assign as a library tracking number. 

Field Name 1–

x 

Schedule column headings you may assign. 

Print Select “Yes” to enable the resource’s event record for printing.  If 
“No” is selected, then you can enable printing for all of the resource’s 

event records by checking the “Export/print all records” option under 
the “Export/Print Templates” window.  

Export Select “Yes” to allow the resource’s event record to be exported into 

comma delimited or Microsoft Excel® formats.  If “No” is selected, 
then you can enable the export function for all of the resource’s event 

records by checking the “Export/print all records” option under the 
“Export/Print Templates” window. 

Maximum view Each event properties window for a device or library resource item 

may be configured to show different fields under a “minimum” and 
“maximum” view (for instructions, see “Event Editor Tab” on page 
128).  To toggle between these views, select and deselect the 

“Maximum view” checkbox. 
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Internal MPEG Recorder Device Resource 

Dragging the NEXUS series MPEG recorder device resource onto the schedule 
reveals the box in Illustration 142, MPEG Recorder Event Properties Window.  Refer 

to Table 44, Editable MPEG Recorder Event Properties, for a description of the 
editable event properties.  

UltraNEXUS-SDI / 
UltraNEXUS Only: 

Once you have enabled the VOD recorder from WebNEXUS, 
the VOD recorder for the UltraNEXUS or an UltraNEXUS-SDI 
installed with a distribution amp will automatically receive the 

same switch and control commands sent to the broadcast 
MPEG recorder.  The VOD recorder files will be encoded at bit 
rates optimized for streaming. 

NOTE: When creating MPEG files, first create a short test file for playback on your 

NEXUS series system.  Use this test file to verify video playback 
compatibility with your LEIGHTRONIX system and to check your encoding 

audio level settings.  Verify that your audio levels match the audio levels 
from other NEXUS series sources.  Once you have determined the proper 
MPEG recorder settings, make note of them for use during future recording 
sessions. 

If you would like to play an MPEG file within the same schedule it was recorded, 
create and schedule an MPEG library resource with the same filename and length 
given to the MPEG recording event.  See “MPEG Library Resources” on page 184 for 

further instructions on creating an MPEG library resource.  The library resource will be 
available for playback once the MPEG recording event ends. 

Illustration 142, MPEG Recorder Event Properties Window 
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Table 44, Editable MPEG Recorder Event Properties 

FIELD DESCRIPTION 

Lock At the top of the event properties window, check the “Lock” box to lock 

the event or uncheck it to unlock the event.  Locking an event causes 
the “Time” field to become enabled, allowing the user to enter a fixed 
execution time for the event.  Unlocking an event disables the “Time” 

field, causing WinLGX to assign a time to the event that starts at the 
end of the event above it in the schedule. 

Add to 

Library 

The “Add to library” option causes WinLGX to automatically create a 

library playback resource for the recording event.  This library resource 
may be used to schedule a playback event with the recorded MPEG 
file.  To enable this option, check the “Add to library” box at the bottom 

of the event properties window.  The “Add to library folder” window 
shown in Illustration 143 will display.  Select the library folder you 
would like to contain the library resource and click “OK.” 

NOTES:  WinLGX will not create a library resource for a file that 

possesses the same video filename and length as a 

pre-existing library resource. 

  If the new file possesses the same title as another 

resource, but has a different video filename and/or 
length, WinLGX will copy the new file to the library with 
a numbered increment added to its title.  For example, 

if this is the first time you have reused the title of a pre-
existing library resource, WinLGX will add the new file 
to the library under the name “title01.” 

Illustration 143, “Add to library folder” Window 

 

Title Allows a name up to 31 characters to be typed. 

Input Select the input signal you want the MPEG recorder to record. 
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FIELD DESCRIPTION 

Device Ensure MPEG recorder is selected. 

Setup time If desired, indicate how long after the selected MPEG recorder is 
activated that recording starts. 

Reset If desired, enter time the MPEG recorder will be busy and unavailable 

for scheduling after the end of the program. 

Record 

Preset 

Select one of the three recording settings configured under “System 

Configuration.” 

Record 

Overwrite 

Select “Always” to automatically record over an existing file with the 

same name or “Create Unique” to record a file entered under an 
existing MPEG filename with the first 14 characters of the original 
filename followed by “yy/mm/dd-hh/mm/ss” (yy/mm/dd is the file record 

date specified as year/month/ day and hh/mm/ss is the file record time 
in hours/minutes/seconds). 

Record CC 

data 

Select “Yes” to capture any closed caption data from the source.  

Closed captions are hidden in the video signal and decoded for display 
on televisions with built-in decoders or televisions connected to 
external decoders. 

Create VOD 

file 

UltraNEXUS/UltraNEXUS-SDI only: this option allows you to override 

the VOD recorder enable/disable feature in WebNEXUS (see 
“Enabling/Disabling VOD Recorder,” on page 354, for more details).  If 

the VOD recorder has been enabled in WebNEXUS, selecting “No 
VOD” stops the VOD recorder from creating a VOD file. Changing this 
option to “Use Web” will cause the VOD recorder to operate according 

to its WebNEXUS enable/disable setting.  

MPEG 
Filename 

Perform one of the following: 

 Enter up to 27 characters to create a new filename for the 

recording event.   

 If you created a playback library resource for the MPEG file to 
be recorded, enter the exact filename used for the library 

resource.   

Storage 
device 

Select the storage device you would like to hold your recorded file. 

Length Enter recording duration of up to 23 hours:59 minutes:59 seconds.  If 
you created an MPEG library resource for the MPEG file to be 

recorded, enter the same time duration used for the library resource.  

Time If the event is locked, the event “Time” can be modified.  This is the 
scheduled “On-Air“ time of the event. 
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FIELD DESCRIPTION 

Command 

(Event start) 

The “RECORD” command is automatically displayed. 

Command 

(Event end) 

Choose either “STOP” or “<None>.”  It will almost always be “STOP.”   

Switchback 
input 

If desired, select a video source to be taken to the output at the end of 
the event. 

Show in 

program 
guide 

Select “Yes” from the drop down list to include the scheduled resource 

on onscreen program guides (see “Onscreen Program Guide Library 
Resources,” on page 204) and the web program guide (see “Viewing 

Web Program Guide” on page 402).  The scheduled resource will be 
listed according to its event start time and the text entered into the 
“Comment” field.   

Comment Enter a unique and descriptive name with up to 31 characters to 
identify the resource on program guides.  The text entered in the “Title” 

field is automatically placed in the “Comment” field, but may be 
changed.  

Media ID Assign as a library tracking number. 

Field 1–x Schedule column headings you may assign. 

Print Select “Yes” to enable the resource’s event record for printing.  If “No” 
is selected, then you can enable printing for all of the resource’s event 

records by checking the “Export/print all records” option under the 
“Export/Print Templates” window.  

Export Select “Yes” to allow the resource’s event record to be exported into 

comma delimited or Microsoft Excel® formats.  If “No” is selected, then 
you can enable the export function for all of the resource’s event 
records by checking the “Export/print all records” option under the 

“Export/Print Templates” window. 

Maximum 
view 

Each event properties window for a device or library resource item may 
be configured to show different fields under a “minimum” and 

“maximum” view (for instructions, see “Event Editor Tab” on page 128).  
To toggle between these views, select and deselect the “Maximum 
view” checkbox. 



NEXUS Series 

Software Operation 

LEIGHTRONIX, INC.  Page 269 
2018-06-08  WinLGX ver. 7.0.2.60 
 

ULTRANEXUS/ULTRANEXUS-SDI ONLY: SCHEDULING/EDITING EPRO-BUS-
CONTROLLED DEVICE RESOURCES 

Adding or editing an ePRO-BUS record schedule event for your remote or locally 

connected LEIGHTRONIX PEGvault-SD or LABvault-SD recorder opens an event 
properties window containing editable properties.  Edit the properties for your remote 
or local ePRO-BUS record event according to the following subsections, clicking “OK” 
to submit the event or “Cancel” to abort the add/edit. 

NOTE: ePRO-BUS record events can only be scheduled on the WinLGX-LT 
tab.  If the WinLGX-LT tab is not displayed at the bottom of your schedule 
window, go to the “Tools”/“Preferences” menu option and select “Show 
WinLGX-LT tab” option on the “Application” tab. 

Remote ePRO-BUS-Controlled Devices 

A remote ePRO-BUS-controlled device is a PEGvault-SD or LABvault-SD that has 
been added to the same TCP/IP network as your UltraNEXUS system.  This allows 
you to start and stop recording on a PEGvault-SD or LABvault-SD that is in a different 

location than your UltraNEXUS system.  Perform the following steps to schedule or 
edit a remote ePRO-BUS resource event: 

1. Select the WinLGX-LT tab on the bottom of the scheduling window.  If you do not 

see this tab, go to the “Tools”/”Preferences”/”Applications” tab and select the 

“Show WinLGX-LT tab” option. 

2. Open the ePRO-BUS record “Event Properties” window (see Illustration 144, 

Remote ePRO-BUS Record Event Properties Window) by either adding or editing 
the ePRO-BUS record event. To add a new ePRO-BUS-controlled remote record 

event, drag the desired ePRO-BUS-controlled device resource onto the schedule 
window.  To edit, double click the ePRO-BUS event row on the schedule.  

Illustration 144, Remote ePRO-BUS Record Event Properties Window 
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3. Complete or edit the event properties fields according to Table 45, Editable 
Remote ePRO-BUS Record Event Properties.  Some of the fields will vary, 

depending on whether you used a “DVD” or “Tape” format to create your ePRO-
BUS resource. 

Table 45, Editable Remote ePRO-BUS Record Event Properties 

FIELD DESCRIPTION 

Lock Box At the top of the event properties window, check the “Lock” box to lock 

the event or uncheck it to unlock the event.  Locking an event causes 
the “Time” field to become enabled, allowing the user to enter a fixed 
execution time for the event.  Unlocking an event disables the “Time” 

field, causing WinLGX to assign a time to the event that starts at the 
end of the event above it in the schedule. 

Title Allows a name up to 31 characters to be typed. 

Device Ensure this field displays the PRO-BUS address number that was 

chosen for the PEGvault-SD/LABvault-SD device in the WebNEXUS 
ePRO-BUS configuration window (see the “UltraNEXUS/UltraNEXUS-

SDI Only: Configuring ePRO-BUS Setttings” section on page 442 for 
more details). 

Setup time Not used 

Output Select “<None>.” 

Disc number Not used 

Title:Chapter 

 

Not used 

Length Enter duration of the event in hours:minutes:seconds. 

Preroll  Not used 

Reset time Not used 

Event Date 
and/or Days 

Select an absolute date and/or days that you want to event to occur. 

Time If the event is locked, the event “Time” can be modified.  This is the 

scheduled “On-Air“ time of the event. 

Command 

(Event start) 

Select “RECORD.” 

Command 

(Event end) 

Choose “STOP.” 

Switchback 
input 

Not used 

Show in Not used 
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FIELD DESCRIPTION 

program 

guide 

Comment Not used 

Media ID Assign as a library tracking number. 

Field Name 

1–x 

Schedule column headings you may assign. 

Print Select “Yes” to enable the resource’s event record for printing.  If “No” 

is selected, then you can enable printing for all of the resource’s event 
records by checking the “Export/print all records” option under the 

“Export/Print Templates” window.  

Export Select “Yes” to allow the resource’s event record to be exported into 
comma delimited or Microsoft Excel® formats.  If “No” is selected, then 

you can enable the export function for all of the resource’s event 
records by checking the “Export/print all records” option under the 
“Export/Print Templates” window. 

Maximum 

view 

Each event properties window for a device or library resource item may 

be configured to show different fields under a “minimum” and 
“maximum” view (for instructions, see “Event Editor Tab” on page 128).  

To toggle between these views, select and deselect the “Maximum 
view” checkbox. 

Local ePRO-BUS-Controlled Devices 

A local ePRO-BUS-controlled device is a PEGvault-SD or LABvault-SD that has been 
directly wired to an output on your UltraNEXUS system’s internal or external switcher.  

Connecting a PEGvault-SD or LABvault-SD to your switcher provides you with another 
way to record your UltraNEXUS system’s external device resources.  Perform the 
following steps to schedule or edit a local ePRO-BUS record event: 

NOTE: The UltraNEXUS-SDI should be connected to an external switcher when 
creating local ePRO-BUS record events. 

1. Select the WinLGX-LT tab on the bottom of the scheduling window.  If you do not 

see this tab, go to the “Tools”/”Preferences”/”Applications” tab and select the 
“Show WinLGX-LT tab” option. 

2. In order to capture playback from an UltraNEXUS external device resource, the 

video source must be scheduled on the external switcher output connected to your 

PEGvault-SD or LABvault-SD.  For information on scheduling a video switch 
resource, refer to “Scheduling/Editing Device Resources,” starting on page 249 and 
“Scheduling/Editing Library Resources,” starting on page 275.  This step may be 

performed from either the day tabs or the WinLGX-LT tab, but the latter is 
recommended for consistency. 
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3. Open the ePRO-BUS record “Event Properties” window (see Illustration 145, Local 

ePRO-BUS Record Event Properties Window) by either adding or editing the 

ePRO-BUS record event. To add a new event, drag the desired ePRO-BUS-
controlled device resource onto the schedule window.  To edit, double click the 
ePRO-BUS event row on the schedule.     

Illustration 145, Local ePRO-BUS Record Event Properties Window 

 

4. Complete or edit the properties fields according to Table 46, Editable Local ePRO-
BUS Record Event Properties.  Some of the fields will vary, depending on whether 
you used a “DVD” or “Tape” format to create your ePRO-BUS resource. 

Table 46, Editable Local ePRO-BUS Record Event Properties 

FIELD DESCRIPTION 

Lock Box At the top of the event properties window, check the “Lock” box to lock 

the event or uncheck it to unlock the event.  Locking an event causes 
the “Time” field to become enabled, allowing the user to enter a fixed 

execution time for the event.  Unlocking an event disables the “Time” 
field, causing WinLGX to assign a time to the event that starts at the 
end of the event above it in the schedule. 

Title Allows a name up to 31 characters to be typed. 
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FIELD DESCRIPTION 

Device Ensure this field displays the ePRO-BUS address number assigned to 

the device you wish to control. 

Setup time Not used 

Output Select “<None>.” 

Disc number Not used 

Title:Chapter 

 

Not used 

Length Enter duration of the event in hours:minutes:seconds. 

Preroll  Not used 

Reset time Not used 

Event Date 
and/or Days 

Select an absolute date and/or days that you want to event to occur. 

Time If the event is locked, the event “Time” can be modified.  This is the 

scheduled “On-Air“ time of the event. 

Command 

(Event start) 

Select “RECORD.” 

Command 

(Event end) 

Choose “STOP.” 

Switchback 
input 

Not used 

Show in 

program 
guide 

Not used 

Comment Not used 

Media ID Assign as a library tracking number. 

Field Name 

1–x 

Schedule column headings you may assign. 

Print Select “Yes” to enable the resource’s event record for printing.  If “No” 

is selected, then you can enable printing for all of the resource’s event 
records by checking the “Export/print all records” option under the 
“Export/Print Templates” window.  

Export Select “Yes” to allow the resource’s event record to be exported into 

comma delimited or Microsoft Excel® formats.  If “No” is selected, then 
you can enable the export function for all of the resource’s event 

records by checking the “Export/print all records” option under the 
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FIELD DESCRIPTION 

“Export/Print Templates” window. 

Maximum 

view 

Each event properties window for a device or library resource item may 

be configured to show different fields under a “minimum” and 
“maximum” view (for instructions, see “Event Editor Tab” on page 128).  

To toggle between these views, select and deselect the “Maximum 
view” checkbox. 
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SCHEDULING/EDITING LIBRARY RESOURCES 

Adding or editing a library resource event opens windows like the examples shown in 
this section.  Editable event fields are highlighted in each event properties window.  
Click “OK” to submit the event or “Cancel” to abort the add/edit. 

Tape and DVD Library Resources 

Dragging a tape or DVD library resource onto the schedule reveals a box like 
Illustration 146, Example of DVD Media Event Properties Window.  Refer to Table 47, 
Editable Tape and DVD Device Media Event Properties, for a description of the 

editable event properties. 

Illustration 146, Example of DVD Media Event Properties Window 

 

Table 47, Editable Tape and DVD Device Media Event Properties 

FIELD DESCRIPTION 

Lock Box At the top of the event properties window, check the “Lock” box to lock 

the event or uncheck it to unlock the event.  Locking an event causes 
the “Time” field to become enabled, allowing the user to enter a fixed 
execution time for the event.  Unlocking an event disables the “Time” 

field, causing WinLGX to assign a time to the event that starts at the 
end of the event above it in the schedule. 

Device Allows a same format device to be chosen.  Its associated input and 
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FIELD DESCRIPTION 

device control interface (PRO-BUS or DVply) will each appear in the 

“Input” and “Device” fields. 

Time If the event is locked, the event “Time” can be modified.  This is the 
scheduled “On-Air“ time of the event. 

Command 

(Event start) 

Choose either the “PLAY” or “RECORD” command.  It will nearly 

always be “PLAY.”   

Command 

(Event end) 

Choose from the following commands:  “STOP,” “REWIND,” or 

“<None>.”  It will usually be “REWIND” or “STOP.”   

NOTE: If you are controlling your DVD device with a PRO-BUS 

interface, check your interface manual and switches to 
determine the actions performed by the “REWIND” and 
“STOP” commands.  By default, “REWIND” does a DVD full 

stop (back to beginning), and “STOP” stops the DVD at the 
current location. 

Switchback 

input 

If desired, select a video source to be taken to the output at the end of 

the event. 

Show in 

program 
guide 

Select “Yes” from the drop down list to include the scheduled resource 

on onscreen program guides (see “Onscreen Program Guide Library 
Resources,” on page 204) and the web program guide (see “Viewing 
Web Program Guide” on page 402).  The scheduled resource will be 

listed according to its event start time and the text entered into the 
“Comment” field.   

Comment Enter a unique and descriptive name with up to 31 characters to 

identify the resource on program guides.  The text entered in the “Title” 
field is automatically placed in the “Comment” field, but may be 
changed.  

Print Select “Yes” to enable the resource’s event record for printing.  If “No” 

is selected, then you can enable printing for all of the resource’s event 
records by checking the “Export/print all records” option under the 

“Export/Print Templates” window.  

Export Select “Yes” to allow the resource’s event record to be exported into 
comma delimited or Microsoft Excel® formats.  If “No” is selected, then 

you can enable the export function for all of the resource’s event 
records by checking the “Export/print all records” option under the 
“Export/Print Templates” window. 

Maximum 

view 

Each event properties window for a device or library resource item may 

be configured to show different fields under a “minimum” and 
“maximum” view (for instructions, see “Event Editor Tab” on page 128).  

To toggle between these views, select and deselect the “Maximum 
view” checkbox. 
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Switch Library Resources 

Dragging a switch library resource onto the schedule reveals a box like Illustration 147, 
Switch Event Properties Window.  Refer to Table 48, Editable Switch Event Properties, 
for a description of the editable event properties. 

Illustration 147, Switch Event Properties Window 

 

Table 48, Editable Switch Event Properties 

FIELD DESCRIPTION 

Lock Box At the top of the event properties window, check the “Lock” box to lock 

the event or uncheck it to unlock the event.  Locking an event causes 
the “Time” field to become enabled, allowing the user to enter a fixed 
execution time for the event.  Unlocking an event disables the “Time” 

field, causing WinLGX to assign a time to the event that starts at the 
end of the event above it in the schedule. 

Device Allows a same format device to be chosen.  Its associated interface 

and input will appear in the corresponding fields. 

Time If the event is locked, the event “Time” can be modified.  This is the 
scheduled “On-Air” time of the event. 

Switchback 

input 

If desired, select a video source to be taken to the output at the end of 

the event. 
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FIELD DESCRIPTION 

Show in 

program 
guide 

Select “Yes” from the drop down list to include the scheduled resource 

on onscreen program guides (see “Onscreen Program Guide Library 
Resources,” on page 204) and the web program guide (see “Viewing 

Web Program Guide” on page 402).  The scheduled resource will be 
listed according to its event start time and the text entered into the 
“Comment” field.   

Comment Enter a unique and descriptive name with up to 31 characters to 

identify the resource on program guides.  The text entered in the “Title” 
field is automatically placed in the “Comment” field, but may be 

changed.  

Print Select “Yes” to enable the resource’s event record for printing.  If “No” 
is selected, then you can enable printing for all of the resource’s event 

records by checking the “Export/print all records” option under the 
“Export/Print Templates” window.  

Export Select “Yes” to allow the resource’s event record to be exported into 

comma delimited or Microsoft Excel® formats.  If “No” is selected, then 
you can enable the export function for all of the resource’s event 
records by checking the “Export/print all records” option under the 

“Export/Print Templates” window. 

Maximum 
view 

Each event properties window for a device or library resource item may 
be configured to show different fields under a “minimum” and 

“maximum” view (for instructions, see “Event Editor Tab” on page 128).  
To toggle between these views, select and deselect the “Maximum 
view” checkbox. 
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Slide Library Resources 

To preview a slide library resource before scheduling, either double click the resource 
or right click on the file and select “View Resource” to display the file in the WinLGX 

preview monitor window.  To close the window, click the red “x” icon in the corner. 

Dragging a slide library resource onto the schedule reveals a box like Illustration 148, 

JPEG Slide Event Properties Window.  Refer to Table 49, Editable JPEG Slide Library 
Event Properties, for a description of the editable event properties. 

Illustration 148, JPEG Slide Event Properties Window 

 

Table 49, Editable JPEG Slide Library Event Properties 

FIELD DESCRIPTION 

Lock Box At the top of the event properties window, check the “Lock” box to lock 
the event or uncheck it to unlock the event.  Locking an event causes 

the “Time” field to become enabled, allowing the user to enter a fixed 
execution time for the event.  Unlocking an event disables the “Time” 
field, causing WinLGX to assign a time to the event that starts at the 

end of the event above it in the schedule. 

Device If Virtual Channel has not been enabled in the switcher configuration 
properties, you may change the MPEG Player (1 or 2).  Its associated 

input will appear in the “Input” field.   
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FIELD DESCRIPTION 

Length The default slide length specified in the “Application” tab of the 

“Preferences” window is automatically displayed once the slide 
filename is selected (see page 124 for more information), but may be 

edited to any value greater than 5 seconds. 

Time If the event is locked, the event “Time” can be modified.  This is the 
scheduled “On-Air“ time of the event. 

Command 

(Event start) 

The PLAY command is automatically displayed.   

Command 

(Event end) 

Choose “STOP” or “<None>.”  It will nearly always be “STOP.” 

Switchback 

input 

If desired, select a video source to be taken to the output at the end of 

the event. 

Overlay If desired, select one of the overlay templates created in the “Overlay 
Templates” view (see “Creating Overlays” on page 172).  The graphic 

and text message overlays that are part of the selected template will 
then display with the program.  Each overlay resource in the template 
will display in the listed order for ten percent of the total length of the 

scheduled digital program. 

Comment Enter a descriptor with up to 31 characters to display on schedule. 

Print Select “Yes” to enable the resource’s event record for printing.  If “No” 

is selected, then you can enable printing for all of the resource’s event 
records by checking the “Export/print all records” option under the 
“Export/Print Templates” window.  

Export Select “Yes” to allow the resource’s event record to be exported into 

comma delimited or Microsoft Excel® formats.  If “No” is selected, then 
you can enable the export function for all of the resource’s event 

records by checking the “Export/print all records” option under the 
“Export/Print Templates” window. 

Maximum 

view 

Each event properties window for a device or library resource item may 

be configured to show different fields under a “minimum” and 
“maximum” view (for instructions, see “Event Editor Tab” on page 128).  
To toggle between these views, select and deselect the “Maximum 

view” checkbox. 
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Slide Show Library Resources 

Dragging a slide show library resource onto the schedule reveals a box like Illustration 
149, JPEG Slide Show Event Properties Window.  Refer to Table 50, Editable JPEG 

Slide Show Library Event Properties, for a description of the editable event properties. 

NOTE: Slides must be enabled and authorized in the Storage Manager or 

WebNEXUS before they will appear in slide shows (see “Enabling and 
Authorizing Slides for Display in Slide Shows,” on page 333, and 

“Approving Slides for Display in Slide Shows,” on page 390). 

Illustration 149, JPEG Slide Show Event Properties Window 

 

Table 50, Editable JPEG Slide Show Library Event Properties 

FIELD DESCRIPTION 

Lock Box At the top of the event properties window, check the “Lock” box to lock 

the event or uncheck it to unlock the event.  Locking an event causes 
the “Time” field to become enabled, allowing the user to enter a fixed 
execution time for the event.  Unlocking an event disables the “Time” 

field, causing WinLGX to assign a time to the event that starts at the 
end of the event above it in the schedule. 
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FIELD DESCRIPTION 

Device If Virtual Channel has not been enabled in the switcher configuration 

properties, you may change the MPEG Player (1 or 2).  Its associated 
input will appear in the “Input” field.   

User list If desired, edit the user list to change the corresponding slide 

selections.  

Length Enter the display duration for the slide show.  Each slide within the 

slide show will automatically display for 10 seconds at a time.  The 
display duration for each slide may be changed from the WebNEXUS 
interface (see “Adding Slide Show Settings to Slide Metadata,” on page 

388). 

Time If the event is locked, the event start “Time” can be modified.  This is 
the scheduled “On-Air” time of the event. 

Command 
(Event start) 

Choose “PLAY” or “STOP.”  It will nearly always be “PLAY.”   

Command 

(Event end) 

Choose “STOP” or “<None>.”  It will nearly always be “STOP.” 

Switchback 

input 

If desired, select a video source to be taken to the output at the end of 

the event. 

Overlay If desired, select one of the overlay templates created in the “Overlay 
Templates” view (see “Creating Overlays” on page 172).  The graphic 

and text message overlays that are part of the selected template will 
then display with the program.  Each overlay resource in the template 
will display in the listed order for ten percent of the total length of the 

scheduled digital program. 

Show in 
program 

guide 

Select “Yes” from the drop down list to include the scheduled resource 
on onscreen program guides (see “Onscreen Program Guide Library 

Resources,” on page 204) and the web program guide (see “Viewing 
Web Program Guide” on page 402).  The scheduled resource will be 
listed according to its event start time and the text entered into the 

“Comment” field.   

Comment Enter a unique and descriptive name with up to 31 characters to 
identify the resource on program guides.  The text entered in the “Title” 

field is automatically placed in the “Comment” field, but may be 
changed.  

Print Select “Yes” to enable the resource’s event record for printing.  If “No” 

is selected, then you can enable printing for all of the resource’s event 
records by checking the “Export/print all records” option under the 
“Export/Print Templates” window.  
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FIELD DESCRIPTION 

Export Select “Yes” to allow the resource’s event record to be exported into 

comma delimited or Microsoft Excel® formats.  If “No” is selected, then 
you can enable the export function for all of the resource’s event 

records by checking the “Export/print all records” option under the 
“Export/Print Templates” window. 

Maximum 

view 

Each event properties window for a device or library resource item may 

be configured to show different fields under a “minimum” and 
“maximum” view (for instructions, see “Event Editor Tab” on page 128).  
To toggle between these views, select and deselect the “Maximum 

view” checkbox. 
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Program Guide Library Resources 

Dragging a program guide library resource onto the schedule reveals a box like 
Illustration 150, Program Guide Event Properties Window.  The program guide will 

display up to ten of the upcoming events scheduled on the same channel output. Refer 
to Table 51, Editable Program Guide Library Event Properties, for a description of the 
editable event properties. 

Illustration 150, Program Guide Event Properties Window 

 

Table 51, Editable Program Guide Library Event Properties 

FIELD DESCRIPTION 

Lock Box At the top of the event properties window, check the “Lock” box to lock 
the event or uncheck it to unlock the event.  Locking an event causes 

the “Time” field to become enabled, allowing the user to enter a fixed 
execution time for the event.  Unlocking an event disables the “Time” 
field, causing WinLGX to assign a time to the event that starts at the 

end of the event above it in the schedule. 

Device Allows you to select internal NEXUS series MPEG player 1 or 2.  Its 
associated input will appear in the “Input” field.   

Length If desired, edit the event duration. 
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FIELD DESCRIPTION 

Time If the event is locked, the event “Time” can be modified.  This is the 

scheduled “On-Air“ time of the event. 

Command 

(Event start) 

The PLAY command is automatically displayed.   

Command 
(Event end) 

Choose “STOP” or “<None>.”  It will nearly always be “STOP.” 

Switchback 

input 

If desired, select a video source to be taken to the output at the end of 

the event. 

Overlay If desired, select one of the overlay templates created in the “Overlay 

Templates” view (see “Creating Overlays” on page 172).  The graphic 
and text message overlays that are part of the selected template will 

then display with the program.  Each overlay resource in the template 
will display in the listed order for ten percent of the total length of the 
scheduled digital program. 

Print Select “Yes” to enable the resource’s event record for printing.  If “No” 

is selected, then you can enable printing for all of the resource’s event 
records by checking the “Export/print all records” option under the 

“Export/Print Templates” window.  

Export Select “Yes” to allow the resource’s event record to be exported into 
comma delimited or Microsoft Excel® formats.  If “No” is selected, then 

you can enable the export function for all of the resource’s event 
records by checking the “Export/print all records” option under the 
“Export/Print Templates” window. 

Maximum 

view 

Each event properties window for a device or library resource item may 

be configured to show different fields under a “minimum” and 
“maximum” view (for instructions, see “Event Editor Tab” on page 128).  

To toggle between these views, select and deselect the “Maximum 
view” checkbox. 
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MPEG Library Resources 

To preview an MPEG library resource’s video before scheduling the resource, either 
double click the resource or right click on the file and select “View Resource” to display 

the file in the WinLGX instant video preview monitor.  For more information on the 
preview monitor, go to the “Using Instant Video Preview Monitor to Display MPEG 
Files within WinLGX” section on page 230. 

Dragging an MPEG library resource onto the schedule reveals a box like Illustration 

151, MPEG Library Event Properties Window.  Refer to Table 52, Editable MPEG 
Library Event Properties, for a description of the editable event properties. 

Illustration 151, MPEG Library Event Properties Window 

 

Table 52, Editable MPEG Library Event Properties 

FIELD DESCRIPTION 

Lock Box At the top of the event properties window, check the “Lock” box to 

lock the event or uncheck it to unlock the event.  Locking an event 
causes the “Time” field to become enabled, allowing the user to enter 
a fixed execution time for the event.  Unlocking an event disables the 

“Time” field, causing WinLGX to assign a time to the event that starts 



NEXUS Series 

Software Operation 

LEIGHTRONIX, INC.  Page 287 
2018-06-08  WinLGX ver. 7.0.2.60 
 

FIELD DESCRIPTION 

at the end of the event above it in the schedule. 

Device If Virtual Channel has not been enabled in the switcher configuration 

properties, you may change the MPEG Player (1 or 2). Its associated 
input will appear in the “Input” field.   

In point / 

Out point 
(in 

HH:MM:SS:FF, 
where 
FF=frames) 

To specify where in the selected file you would like playback to begin 

and end, use the “In point” and “Out point” fields.  Either type the 
desired file start and end times into the fields or click either field’s 

ellipsis button to open the clip editor.  The clip editor that is displayed 
depends on whether the “hardware” or “software” monitor option is 
chosen for clip editor playback (see page 130 for preview monitor 

settings).  Follow the set of steps below that corresponds to your 
monitor choice.  

Software Monitor 

The WinLGX video clip editor combines clip editing controls with a 
preview window for quick and convenient clip editing that does not 

interrupt programming playback on your NEXUS series server’s 
MPEG players.  To use this option, ensure the “Software Monitor” 
option is selected on the “Preview Monitor” tab in the “Preferences” 
window. 

Illustration 152, WinLGX Video Clip Editor with Preview Monitor 
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FIELD DESCRIPTION 

1. If desired, adjust the volume control.  Audio is set to the lowest 

level by default. 

2. Ensure each point you wish to set has a green checkmark next to 

its time field.  

3. If in and out points have already been set (there will be time 

values in the corresponding fields), you can use the seek  in 

and  out point buttons to move the playback bar to those 

points in the clip. 

4. Specify the clip’s playback in and out points using one of the 
following methods: 

 Click the  button to start playing the file and click the  

set in point button and  set out point button at the desired 

spots.  If you would like the clip to restart each time the end is 

reached, click the  loop button. 

 Drag the playback bar to the desired spot and click the  set 

in point or  set out point button. 

 Click the  or  button to move between groups of 

pictures (GOPs) in the MPEG file and click the  set in point 

or  set out point button. 

 Click the  or  button to move forward or back in the 

MPEG file by the number of seconds specified on the 

“Playback Tab” of the “Preferences” window.  Click the  set 

in point or  set out point button. 

Once the in and out points are selected, their begin and end time 

values will be displayed in the corresponding fields, and the total 
length of time from in to out point will be shown in the “Duration” field. 

NOTE: When you seek the current in or out point on the playback 
bar, you will notice a slight discrepancy between the current 
time displayed above the playback bar and the in or out 

point field values.  Clip playback between your in and out 
points will be as shown on the clip editor’s preview window. 

Hardware Monitor 

WinLGX displays the control panel clip editor if you are choosing to 
play back your clips during editing on a monitor attached to your 
NEXUS series server, and “Hardware Monitor” is selected on the 
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FIELD DESCRIPTION 

“Preview Monitor” tab in the “Preferences” window.   

1. Specify the clip’s playback in and out points using one of the 

following methods: 

NOTE: If you did not specify a default MPEG player for clip 

editing under “Tools”/”Preferences/Preview Monitor” (see 
page 130 for further instructions), WinLGX asks you to 
select the MPEG 1 or 2 clip editor. If the selected or 

default MPEG player is currently playing a file, WinLGX 
allows you to stop playback and continue with the clip 
editing process or select the other MPEG player.   

 Click the  button to start playing the file and click the 

 or  button at the desired spot. 

 Drag the playback bar to the desired spot and click the 

 or  button. 

 Click the  or  button to move between groups of 

pictures (GOPs) in the MPEG file and click the  or 

 button. 

2. Close the clip creation control panel and add changes to library 

resource by clicking the  button. 

Length The MPEG file library resource length is automatically entered, but it 

may be edited to a value between 6 seconds and 23 hours:59 
minutes:59 seconds. 

Time If the event is locked, the event start “Time” can be modified.  This is 

the scheduled “On-Air“ time of the event. 

Command 

(Event start) 

The “PLAY” command is automatically displayed.   

Command 

(Event end) 

Choose “STOP” or “<None>.”  It will nearly always be “STOP.” 

Switchback 
input 

If desired, select a video source to be taken to the output at the end 
of the event. 

Overlay If desired, select one of the overlay templates created in the “Overlay 

Templates” view (see “Creating Overlays” on page 172).  The 
graphic and text message overlays that are part of the selected 

template will then display with the program.  Each overlay resource in 
the template will display in the listed order for ten percent of the total 
length of the scheduled digital program. 
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FIELD DESCRIPTION 

Show in 

program guide 

Select “Yes” from the drop down list to include the scheduled 

resource on onscreen program guides (see “Onscreen Program 
Guide Library Resources,” on page 204) and the web program guide 

(see “Viewing Web Program Guide” on page 402).  The scheduled 
resource will be listed according to its event start time and the text 
entered into the “Comment” field.   

Comment Enter a unique and descriptive name with up to 31 characters to 

identify the resource on program guides.  The text entered in the 
“Title” field is automatically placed in the “Comment” field, but may be 

changed.  

Print Select “Yes” to enable the resource’s event record for printing.  If 
“No” is selected, then you can enable printing for all of the resource’s 

event records by checking the “Export/print all records” option under 
the “Export/Print Templates” window.  

Export Select “Yes” to allow the resource’s event record to be exported into 

comma delimited or Microsoft Excel® formats.  If “No” is selected, 
then you can enable the export function for all of the resource’s event 
records by checking the “Export/print all records” option under the 

“Export/Print Templates” window. 

Maximum view Each event properties window for a device or library resource item 
may be configured to show different fields under a “minimum” and 

“maximum” view (for instructions, see “Event Editor Tab” on page 
128).  To toggle between these views, select and deselect the 
“Maximum view” checkbox. 
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MPEG Loop Library Resources 

Dragging an MPEG loop library resource onto the schedule reveals a box like 
Illustration 153.  Refer to Table 53, Editable MPEG Loop Library Event Properties, for 

a description of the editable event properties. 

Illustration 153, MPEG Loop Event Properties Window 

 

Table 53, Editable MPEG Loop Library Event Properties 

FIELD DESCRIPTION 

Lock Box At the top of the event properties window, check the “Lock” box to 

lock the event or uncheck it to unlock the event.  Locking an event 
causes the “Time” field to become enabled, allowing the user to enter 
a fixed execution time for the event.  Unlocking an event disables the 

“Time” field, causing WinLGX to assign a time to the event that starts 
at the end of the event above it in the schedule. 

Device If Virtual Channel has not been enabled in the switcher configuration 

properties, you may change the MPEG Player (1 or 2).  Its 
associated input will appear in the “Input” field.   
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FIELD DESCRIPTION 

Length To change the number of times or length of time you would like the 

file to loop, perform the following: 

1. Select the “Length” field and then click the ellipsis button to 
display the “MPEG Loop Calculator” (see Illustration 100, MPEG 
Loop Calculator).  

2. Enter the number of times you would like the file to loop in the 
“Loop count” field and/or enter a length of time, up to 24 hours, 

in the “Loop length” field. 

Time If the event is locked, the event start “Time” can be modified.  This is 
the scheduled “On-Air“ time of the event. 

Command 

(Event start) 

The “PLAY” command is automatically displayed.   

Command 

(Event end) 

Choose “STOP” or “<None>.”  It will nearly always be “STOP.” 

Switchback 

input 

If desired, select a video source to be taken to the output at the end 

of the event. 

Overlay If desired, select one of the overlay templates created in the “Overlay 
Templates” view (see “Creating Overlays” on page 172).  The 

graphic and text message overlays that are part of the selected 
template will then display with the program.  Each overlay resource in 
the template will display in the listed order for ten percent of the total 

length of the scheduled digital program. 

Show in 
program guide 

Select “Yes” from the drop down list to include the scheduled 
resource on onscreen program guides (see “Onscreen Program 

Guide Library Resources,” on page 204) and the web program guide 
(see “Viewing Web Program Guide” on page 402).  The scheduled 
resource will be listed to its event start time and the text entered into 

the “Comment” field.   

Comment Enter a unique and descriptive name with up to 31 characters to 
identify the resource on program guides.  The text entered in the 

“Title” field is automatically placed in the “Comment” field, but may be 
changed.  

Print Select “Yes” to enable the resource’s event record for printing.  If 

“No” is selected, then you can enable printing for all of the resource’s 
event records by checking the “Export/print all records” option under 
the “Export/Print Templates” window.  
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FIELD DESCRIPTION 

Export Select “Yes” to allow the resource’s event record to be exported into 

comma delimited or Microsoft Excel® formats.  If “No” is selected, 
then you can enable the export function for all of the resource’s event 

records by checking the “Export/print all records” option under the 
“Export/Print Templates” window. 

Maximum view Each event properties window for a device or library resource item 

may be configured to show different fields under a “minimum” and 
“maximum” view (for instructions, see “Event Editor Tab” on page 
128).  To toggle between these views, select and deselect the 

“Maximum view” checkbox. 
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MPEG File/Slide Playlist Resources 

Dragging a playlist of MPEG files and/or JPEG slides onto the schedule reveals an 
event properties window for each item in the playlist (see Illustration 154 for an 

example).  Perform either of the options below:  

NOTE: If the playlist resource is dragged into a program interval between events 

with a shorter time duration than the playlist itself, WinLGX will display a 
dialog asking whether or not you would like to trim/discard the ending 
playlist items to fit the channel switchback or cancel the operation.   

Illustration 154, Playlist Event Properties Window 

 

 Change the editable fields for each resource item according to the tables 
referenced below.  Click “Ok” after changing or reviewing each resource or 
“Cancel” to abort entire operation. 

 Slide: see Table 49 on page 279 

 Slide Show: see Table 50 on page 281 

 MPEG File: see Table 52 on page 286  

 Looped MPEG File: see Table 53 on page 291 

 Click “Ok to all” to enter all playlist resource properties into the schedule without 

editing or “Cancel” to abort entire operation. 
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VC List Library Resources 

Dragging a VC list library resource onto the schedule reveals a box like Illustration 
155, VC List Event Properties Window.  Refer to Table 54, Editable VC List Library 

Event Properties, for a description of the editable event properties. 

Illustration 155, VC List Event Properties Window 

  

Table 54, Editable VC List Library Event Properties 

FIELD DESCRIPTION 

Lock Box At the top of the event properties window, check the “Lock” box to lock 

the event or uncheck it to unlock the event.  Locking an event causes 
the “Time” field to become enabled, allowing the user to enter a fixed 

execution time for the event.  Unlocking an event disables the “Time” 
field, causing WinLGX to assign a time to the event that starts at the 
end of the event above it in the schedule. 

Length The length assigned to the VC list library resource may be changed to 

any length of time up to 23 hours:59 minutes:59 seconds.  If the 
combined length of the resources in the Virtual Channel playlist is less 

than the time in the length field, the resources will be replayed in order 
(looped) as needed to fill the remaining time. 
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Time If the event is locked, the event “Time” can be modified.  This is the 

scheduled “On-Air“ time of the event. 

Command 

(Event start) 

The PLAY command is automatically displayed.   

Command 
(Event end) 

Choose “STOP” or “<None>.”  It will nearly always be “STOP.” 

Switchback 

input 

If desired, select a video source to be taken to the output at the end of 

the event. 

Comment Enter a description with up to 31 characters to display on schedule. 

Print Select “Yes” to enable the resource’s event record for printing.  If “No” 
is selected, then you can enable printing for all of the resource’s event 

records by checking the “Export/print all records” option under the 
“Export/Print Templates” window.  

Export Select “Yes” to to allow the resource’s event record to be exported into 

a comma separated values (.csv) format.  If “No” is selected, then you 
can enable the export function for all of the resource’s event records by 
checking the “Export/print all records” option under the “Export/Print 

Templates” window. 

Maximum 
view 

Each event properties window for a device or library resource item may 
be configured to show different fields under a “minimum” and 

“maximum” view (for instructions, see “Event Editor Tab” on page 128).  
To toggle between these views, select and deselect the “Maximum 
view” checkbox. 
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CHANGING CHANNEL SWITCHBACKS 

Adding Digital Video Library Resources to Channel Switchbacks 

WinLGX gives you the option to use digital video library resources (MPEG videos, 
JPEG slides and slide shows, and slide/video playlists) to automatically fill time 
between all programs on the selected channel output within your schedule.  The 

bottom of the WinLGX schedule window includes a “Channel switchback count” that 
keeps track of the total number of unscheduled time slots between programs on the 
selected channel output tab (see see Illustration 156). 

To add a resource to a switchback, drag a digital library resource onto a channel 

switchback and check the “Apply to all switchbacks” option on the resource’s event 
properties window before clicking “Ok” (see Illustration 156 and Illustration 157). 
Whether you selected “By the day” or “By the week” on the “Application” tab of the 

“Preferences” window will determine if the channel switchbacks will be filled on just the 
selected channel output’s day tab or all of the channel’s day tabs (see the “Application” 
tab section of the “Setting WinLGX Viewing and Communication Preferences,” on 

page 124). 

NOTE: If the library resource is shorter in duration than your channel switchbacks, 

the default channel switchback input will be switched to the channel output 
for the time remaining after the resource displays.  You may add multiple 
library resources to your channel switchbacks. 

Illustration 156, Digital Library Resource Dragged onto Channel Switchback 

 

“Apply to all 

switchback” option 

Channel 

Switchback Counter 

Schedule 
Event 

Counter 

Virtual Channel 

Feature Indicator 
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Illustration 157, Digital Library Resource Apply to all Switchbacks Option 

 

 

“Apply to all 
switchback” 

Option 
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Changing Channel Switchback Inputs 

The “Channel Switchback Editor” (see Illustration 158), under the WinLGX 
“Tools”/”System Tools” menu, provides a quick way to change the inputs selected to 

switch to your channel outputs between programs.  Change the switchback inputs on 
each of your channel/day tab windows to the “Virtual Channel” feature or any of your 
external inputs.  Perform the following steps: 

Illustration 158, "Channel Switchback Editor" 

 

1. Select “Switchback editor” under “Tools”/”System Tools” to open the “Channel 

Switchback Editor” (see Illustration 158). 

2. Select the channel output/day tab schedule window containing the switchback 

inputs you would like to change by selecting a channel output under “Channel” and 
a day under “Day of week.”  You may select “All” under “Day of week” to select all 

schedule windows for the channel output. 

3. Under “Replace all,” select the switchback input you would like to change.  

4. Use the “With” drop down menu to select a new switchback input. 

5. Click “OK” to make the changes or “Cancel” to abort. 

CHECKING SCHEDULE AND LIBRARY RESOURCES FOR MISSING MPEG FILES 

Ensure your image files’ schedule events and library resources do not contain MPEG 
files that have been removed from your NEXUS series system’s remote storage 
devices (USB hard drives and NAS) as described below:  

1. If you have not already done so, open a NEXUS series image file in WinLGX. 

2. Click the  sync icon on the main toolbar or choose the “Tools”/”System 
tools”/”Sync Library Resources” menu item.  Those events containing missing 

MPEG files are highlighted in the schedule and a “Sync Library Resources” box 
pops up to report the total number of schedule events and each library resource 
containing MPEG files no longer available on the NEXUS series storage device(s).  

Perform any of the following from the pop-up window: 

 Delete library resources and corresponding schedule events: empty library 

resources and their schedule events may be removed from the NEXUS series 
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image file by selecting each resource in the “Sync Library Resources” window 
and then clicking the “Delete” button.  When prompted, click “Yes” to delete the 

library resource and any events scheduled with the resource or “No” to abort.  

 Update status report on pop-up window: if modifications are made to the 

schedule and/or library resources while the “Sync Library Resources” window is 
open, click the “Refresh” button to update the pop-up window.   

 Close pop-up window: click “Done” to close the window. 

Illustration 159, Synced Schedule 
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SENDING NEXUS SERIES IMAGE FILES 

To activate a schedule of event actions, send an image file to each connected NEXUS 
series server/controller as follows: 

NOTE: Users must have “Send, receive, rename and delete” rights in order to send 

an image file to a NEXUS series system (refer to “Setting User Account 

Rights (Including WinLGX Password Changes),” on page 110, for more 
information on user rights).   

1. Send an image file to one or more of the currently connected server/controllers 

according to the following steps: 

 One server/controller: ensure the server/controller’s product tab is selected and 

choose “Send” in the “File” menu or click its  icon on the main toolbar.  A 
dialog box will ask whether you want to send the tab’s currently open image to 

the connected NEXUS series server/controller.  Click “Yes” to complete the 
send and open the status box shown in Illustration 160. 

 Multiple server/controllers: from any of the product tabs, select “Send all” in the 
“File” menu.  Click “Yes” when prompted to send each open image to its 

server/controller.  You will see a status box like the one shown in Illustration 
160 for each image file. 

Illustration 160, “Send image” Status Box 

 

NOTE: To interrupt the send, click the “Cancel” button.  If the send action 

appears to be stalled, cancel it and check your default location IP 
address and your network connections. 

2. Once each transfer is completed, the NEXUS series system(s) will contain and 
execute the scheduled events.   



NEXUS Series 

Software Operation 

Page 302   LEIGHTRONIX, INC. 
WinLGX ver. 7.0.2.60  2018-06-08 
 

PRINTING SCHEDULES FROM WINLGX 

Perform the following steps to print the current schedule from WinLGX: 

1. Create a print template to select the desired schedule information for printing (see 

“Creating Templates for Exporting/Printing Schedules,” on page 116).  

2. Determine the page layout of your schedule printout (see “Configuring Page 

Layouts For Schedules Printed from WinLGX,” on page 118).  

3. Select “Print” in the “File” menu or click the  icon on the main toolbar to open the 

template selection window shown in Illustration 161. 

Illustration 161, “Select Export/Print Template” Window 

   

4. Choose the desired template from the “File name” list in the “Select Export/Print 
Template” Window (see Illustration 161) and click “Open,” or double click the 
template file to open the “Print” window.  Click “Cancel” to abort the print. 

5. In the “Print” window, configure the printer and copy settings according to the 

following steps. Click “OK” to print or “Cancel” to abort the print. 

NOTE: You may have already performed these steps through the “Print Setup” 

window.  See “Configuring Printer and Paper Settings for Schedules 
Printed from WinLGX,” on page 119. 

 “Printer” section: lets you choose the desired printer from a list of your PC’s 

available printers.  When a printer is chosen, its status appears below the 
printer “Name” field. 
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 “Properties” button: click to open a window specific to the printer, so that 

detailed printer settings can be made. 

 “Print range” is fixed at “All.”   

 “Copies” section: choose the number of schedule copies you wish to print.  If 

you choose more than one, checking “Collate” causes the printer to print each 
copy’s pages together and in order.  If “Collate” is unchecked, all of the first 

pages will be printed together, the second pages will be printed together, etc. 



NEXUS Series 

Software Operation 

Page 304   LEIGHTRONIX, INC. 
WinLGX ver. 7.0.2.60  2018-06-08 
 

EXPORTING SCHEDULES INTO COMMA SEPARATED VALUES 
(CSV) FILES 

Perform the following steps to export schedules into a comma delimited format: 

1. Ensure the schedule you wish to export is currently open in WinLGX (see “Opening 

NEXUS Series Image Files,” on page 220). 

2. If you have not already done so, create a template (see “Creating Templates for 

Exporting/Printing Schedules,” on page 116). 

3. Select “Save as” in the “File” menu to open the window shown in Illustration 162, 

which allows you to export the loaded schedule as a comma separated values file 
(.csv) as follows: 

Illustration 162, “Save As” Window 

 

a. Select a folder in the “Save in” field.   

b. Type a name for the exported file in the “File name” field.  If you leave the 
extension off, WinLGX puts it on for you.   

NOTE: If you enter a name of a file that already exists, WinLGX will ask you 
if you want to overwrite it. 

c. Select the .csv export format in the “Save as type” drop down menu.   

d. Click “Save” to open the template selection window shown in Illustration 163, 
“Select Export/Print Template” Window.  To apply a template to your schedule 
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information, select the desired template and either click “Open” or double click 
the template file to create the export schedule .csv file.  The file can then be 

opened in your database program. 

Illustration 163, “Select Export/Print Template” Window 
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USING CONTROL PANEL TO PERFORM IMMEDIATE DEVICE AND 
SWITCH ACTIONS 

Use the Control Panel to perform unscheduled control actions, such as starting and 
stopping a schedule loaded on the NEXUS series system, switching an input to a 

different output, and controlling your playback, recording, and contact closure interface 
devices.   

1. Open the Control Panel window (see Illustration 164) by clicking “Control Panel” 

under the “Tools” menu or  icon on the main toolbar.   

NOTE: The switcher and external device information displayed in the control 
panel depends on the switcher configuration (see “Configuring the 
Switch Type of a NEXUS Series System,” on page 136) and the external 

device configurations (see “Creating External Device Resources,” on 
page 160). 

Illustration 164, Control Panel Window 
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2. If desired, sort the device icons by right clicking in the “Devices” column and 
selecting one of the sorting filters in the right-click menu that appears (see 

Illustration 165, Control Panel Device Sorting Menu). 

Illustration 165, Control Panel Device Sorting Menu 

 

3. Perform any of the following steps: 

 Start/stop a schedule (see page 307). 

 Force a switch and view switcher status (see page 308). 

 Select a device in the “Devices” column and refer to one of the following sets of 
control steps: 

 “Controlling Internal MPEG Players 1 and 2,” on page 309 

 “Controlling Internal MPEG Recorder(s),” on page 318 

 “Controlling External Devices,” on page 323 

4. When finished, click “Close” to exit the Control Panel. 

STOP/START A SCHEDULE 

Once an image file with a schedule of events has been sent to the NEXUS series 
server/controller (see “Sending NEXUS Series Image” on page 301), you may use the 
stop/start schedule button on the bottom of the Control Panel window (see Illustration 
164, Control Panel Window) to perform the following: 

 Stop the currently running schedule by clicking the “Stop Schedule” button. 

 Restart the current schedule by clicking the “Start Schedule” button. 
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PERFORMING FORCED SWITCHES AND VIEWING SWITCHER STATUS 

Immediately switch one of your inputs to an output by using the “Switch” portion of the 
Control Panel.  If you are using an external switcher with more than 256 input/output 

crosspoints, your inputs/outputs will automatically be displayed in the list view.  For 
those with 256 or fewer input/output crosspoints, the “Switch” will be configured 
according to the option selected on the “Application” tab of the “Preferences” window 
(see page 124 for more details). 

“Buttons” View 

On the “Switch” section of the Control Panel window (see Illustration 166, Control 
Panel “Switch” “Buttons” View, for an example), locate the output you want to switch 
your input to and then click the input button in the corresponding row. 

Illustration 166, Control Panel “Switch” “Buttons” View 

 

The input button will turn green when clicked if the switch is valid or red if the switch is 
invalid.  To the right of each output icon is a box showing the currently selected input.  
If the input selection box is split, this indicates that a breakaway audio input source 

has been selected to accompany the video.  Green means valid video present, gray 
indicates no valid video, while red indicates an invalid switch.   

“List” View 

To switch an input to an output from the “List” view (see Illustration 167, Control Panel 
“Switch” "List" View), single click on an input and then the output you wish to switch it 

to.  When you have both an input and output highlighted, click the “Take” button to 
make the switch.  The “Current Input” column will then change to show the input has 
been routed to the output.  If valid video is present, you will see “Yes” in the “Valid” 

column of the selected output.  Any breakaway audio source accompanying the video 
will be indicated in the “Break Away” column.  
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Illustration 167, Control Panel “Switch” "List" View  

 

CONTROLLING INTERNAL MPEG PLAYERS 1 AND 2 

Select either the MPEG player 1 or 2 icon in the Control Panel window’s “Device” list 
and click the “Play” tab to display the corresponding device control panel (see 
Illustration 168, MPEG Player Control Panel).  

Illustration 168, MPEG Player Control Panel 

 

The following is a list of the operations that may be performed: 

 “Queuing a File” on page 310 

 “Looping an MPEG File” on page  313 

  “Playing a File” on page 313 

 “Queuing the Next File” on page 313 

 “Displaying a Slide with Audio from an MPEG File” on page 313 

 “Stopping a File” on page 314 

 “Pausing a File” on page 314 

“Play” 

Tab 



NEXUS Series 

Software Operation 

Page 310   LEIGHTRONIX, INC. 
WinLGX ver. 7.0.2.60  2018-06-08 
 

 “Creating a Library Clip Resource” on page 314 

 “Activating the Virtual Channels” on page 316 

 “Selecting and Displaying Virtual Channel Playlist Files” on page 316  

Queuing a File 

Open the “Select File” window for either JPEG slides or MPEG video files as follows: 

 MPEG video files:  

1. Click the ellipsis button next to “Queued Video File” to open the “Select File” 
video window (see Illustration 169, “Select File” Video Window).   

Illustration 169, “Select File” Video Window 

 
 

2. Select the storage device containing the desired MPEG video file from the 
“Storage device” drop down list. 
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3. To display a file’s properties and view the clip before completing the 
selection, either right click on the file or click “Properties” to display the 

instant video preview monitor.  For more information on the preview monitor 
window, go to the “Using Instant Video Preview Monitor to Display MPEG 
Files within WinLGX” section on page 230. 

4. Select the desired file by double-clicking or highlighting the file and clicking 
“OK.”  The MPEG player control panel will then display the properties of the 

selected file under “Queued Video File” (see Illustration 170, Queued MPEG 
Video File Properties).  

NOTE: Click “Cancel” to abort any selections and close the “Select File” 

video window. 

Illustration 170, Queued MPEG Video File Properties 
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 JPEG slides:  

1. Click the ellipsis button next to “Queued Slide” to open the “Select File” slide 

window (see Illustration 171, “Select File” Slide Window).   

Illustration 171, “Select File” Slide Window 

 

2. Select the desired username from the “Users” drop down list to display the 
desired slides. 

3. Select the desired file by double-clicking or highlighting the file and clicking 
“OK.”  The MPEG player control panel will then display the properties of the 
selected file under “Queued Slide” (see Illustration 172, Queued JPEG 
Slide).  

NOTE: Click “Cancel” to abort any selections and close the “Select File” 
slide window. 

Illustration 172, Queued JPEG Slide  
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Looping an MPEG File 

Click the “Loop” checkbox to set up an MPEG file for repeat playback.  Once the   

button is clicked, the file will play over and over, from beginning to end, until the  
button is clicked or a scheduled event occurs. 

Playing a File 

Click the  button under “Audio/Video” for an MPEG file or “Slide” for a JPEG slide 
to play the most recently queued file.  The activated file moves into the current position 

on the control panel.  While an MPEG file is playing, the counter displays the file 
playback time in HH:MM:SS:FF (FF=frames).  The counter displays “**” in the FF or 
frames place holder during playback (furthest to the right) (see Illustration 173), 
showing the current frame number when the file is paused. 

Illustration 173, MPEG File Counter 

 

Queuing the Next File  

While a file is playing, another file may be loaded into the “Queued Video File” position 
(see “Queuing a File” on page 310 and Illustration 174, Queued and Currently Playing 

Files). 

NOTE: Clicking the   button while another file is playing will cause the queued 
file to override the current file and begin playing. 

Illustration 174, Queued and Currently Playing Files 

 

Displaying a Slide with Audio from an MPEG File 

1. Ensure the “Synced” box is checked. 

2. Ensure that the desired MPEG file and JPEG slide have been queued (see 
“Queuing a File” on page 310 for more information). 

3. Control the synced files as follows from either the “Audio/Video” or “Slide” controls: 
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 Click the  button to simultaneously activate the MPEG file and JPEG slide. 

 To stop both files, click the  button. 

 To pause the audio track from the MPEG file, click the  button. 

 
Stopping a File 

Click the  button under “Audio/Video” for an MPEG file or “Slide” for a JPEG slide 
to stop a file.  Stopping a file unloads it from the “Current Video File” position.  

Pausing an MPEG File 

Click the  button under “Audio/Video” to pause an MPEG file in the “Current Video 
File” position.  When an MPEG file is paused, the counter displays the current frame 
number in the FF or frames place holder (furthest to the right) (see Illustration 175).  

To reactivate the file, click the  button again. 

Illustration 175, MPEG File Counter with Frame Number Displayed 

 
Creating a Library Clip Resource 

Use the MPEG Player 1 or 2 clip creation panel to create a library resource for a clip of 

an MPEG file. 
 

1. Click the “Clip” tab to display the clip creation panel (see Illustration 176). 

Illustration 176, MPEG Player Clip Creation Panel 
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2. Load the file you would like to use to create a clip according to the following steps:  

a. Click the button next to “Storage device” to display the “Select File” window 
(see Illustration 177). 

Illustration 177, “Select File” Window 

 

b. Select the storage device containing the desired MPEG video file from the 

“Storage device” drop down list. 

c. To display a file’s properties and view the clip before completing the selection, 

either right click on the file or click “Properties” to display the instant video 
preview monitor.  For more information on the preview monitor, go to the “Using 
Instant Video Preview Monitor to Display MPEG Files within WinLGX” section 

on page 230. 

d. Single click on the desired file to highlight it and either double click or click “OK” 

on the bottom of the window to finish loading the file. 
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3. Specify the clip’s playback start point using one of the following methods: 

 Click the  button to start playing the file and click the  button at 

the desired spot. 

 Drag the playback bar to the desired spot and click the  button. 

 Click the  or  button to move between groups of pictures (GOPs) in the 

MPEG file and click the  button. 

4. Specify the clip’s playback end point using one of the methods outlined above for 

selecting an in point and click the  button. 

5. To move to the selected in point and/or out point, click the  or  button. 

6. Preview the clip before airing by clicking the  button. 

7. Once you have specified the desired in and out points, create a new library item for 

the clip by clicking the “Add to library” button to display the “Add to library folder” 
window (see Illustration 178) and performing the following steps: 

Illustration 178, “Add to library folder” Window 

 

a. Select the library folder in which the corresponding MPEG file library resource 

will be created. 

b. If desired, rename the clip in the “Resource name” field. 

c. Click “OK” to add the clip to the library or “Cancel” to abort the changes. 

 
Activating the Default Virtual Channel Playlists 

Before a Virtual Channel’s default “Current” playlist will display, the Virtual Channel 
must be activated through a schedule event or the Control Panel’s 

 button.  Select the Virtual Channel’s MPEG player in the 
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“Devices” column and then just click the  button to display the 
playlist currently saved in the Virtual Channel’s default “Current” playlist preset.   
 
Selecting and Displaying Virtual Channel Playlist Files 

Virtual Channel playlist files can be displayed from the WinLGX control panel 
according to the following steps.   

1. Select the MPEG player you want to display the playlist file’s digital resources in 
the “Devices” column. 

2. Click the ellipsis button next to the “Force Start Virtual Channel” button to display 

the "Select Virtual Channel List" Window shown in Illustration 179.   

Illustration 179, "Select Virtual Channel List" Window 

 

3. Select a Virtual Channel playlist as follows: 

 Double-click the desired file to accept selection and close “Select Virtual 
Channel List” window.  

 Select the desired file and click “OK” to accept or “Cancel” to abort selection.  

Once a playlist file selection is made, the playlist will immediately display. 
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CONTROLLING INTERNAL MPEG RECORDER(S) 

NOTE: Scheduled MPEG record events will interrupt any MPEG record and ingest 
operations started from the Control Panel.  The scheduled record will occur, 
but the Control Panel recording will be stopped.  

Select the MPEG recorder icon in the control panel window’s “Device” list to display 
the corresponding recorder control panel (see Illustration 180, MPEG Recorder 
Control Panel).  Refer to the following steps: 

Illustration 180, MPEG Recorder Control Panel 

 

1. Select the MPEG file recording parameters: 

a. Check the “Record CC data” box to capture any closed caption data from the 
source during recording.  Closed captions are hidden in the video signal and 

decoded for display on televisions with built-in decoders or televisions 
connected to external decoders. 

b. UltraNEXUS/UltraNEXUS-SDI only: the “No VOD file” option allows you to 
override the VOD recorder enable/disable feature in WebNEXUS (see 
“Enabling/Disabling VOD Recorder,” on page 354, for more details).  If the VOD 

recorder has been enabled in WebNEXUS, checking this box stops the VOD 
recorder from creating a VOD file. Unchecking this option will cause the VOD 
recorder to operate according to its WebNEXUS enable/disable setting. 

NOTE: An enabled VOD recorder on the UltraNEXUS or an UltraNEXUS-SDI 
installed with a distribution amp will automatically receive the same 
switch and control commands sent to the broadcast MPEG recorder.  

The VOD recorder files will be encoded at bit rates optimized for 
streaming. 

c. Select one of the following record overwrite options: 

 “Never”: WinLGX does not allow a file entered with an existing filename to 

record and displays an error message  

 “Always”: WinLGX records over an existing file with the same name 

NOTE: Selecting the “Always” option disables the “Add to library” option. 
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 “Create unique”: if an existing filename is entered, WinLGX automatically 

records the file under the first 14 characters of the original filename followed 
by “yy/mm/dd-hh/mm/ss” (yy/mm/dd is the file record date specified as 
year/month/ day and hh/mm/ss is the file record time in 

hours/minutes/seconds) 

d. Select the volume of the drive on which you would like to store the recorded file 

from the “Storage Device” drop down list. 

e. Under “File,” enter up to 27 characters (no spaces) for the filename. 

f. Select one of the user-defined record presets for the desired recording quality.  
See “Configuring Broadcast MPEG Recording Presets,” on page 152 for more 

information on defining the recording quality settings. 

g. If you would like a library resource for the MPEG file added to the “Library” tab 

window, select the “Add to library” option.  Once the broadcast MPEG recorder 
stops, WinLGX displays the “Add to library” window (see Illustration 181).  
Select the library folder in which the corresponding MPEG file library resource 

will be created. 

  NOTES:  WinLGX will not create a library resource for a file that possesses 

the same video filename and length as a pre-existing library 
resource. 

  If the new file possesses the same title as another resource, but 

has a different video filename and/or length, WinLGX will copy the 
new file to the library with a numbered increment added to its title.  
For example, if this is the first time you have reused the title of a 

pre-existing library resource, WinLGX will add the new file to the 
library under the name “title01.” 

Illustration 181, “Add to library folder” Window 

 

2. Select and record an input through one of the following options: 
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 Use the switcher panel as follows: 

a. From the switcher panel on the bottom of the Control Panel window (see 
Illustration 166, Control Panel “Switch” “Buttons” View, for an example), go 
to the MPEG recorder output row and click on the external input device or 

switcher resource that you would like to record.  

b. Click the  button to begin recording. 

c. Once the file reaches the desired length, click the  button to stop the 
recording.   

 Use the “MPEG Ingest” option as follows: 
Use the MPEG ingest option to record playback from your switch resources or 
any of the external devices connected to your switcher inputs.  This option also 

allows you to activate a selected external input device, enter a broadcast MPEG 
recorder activation delay, and set a record time length.   

a. Click on the “MPEG Ingest” button on the MPEG recorder control panel to 
display the window shown in Illustration 182, “MPEG Ingest” Window. 

Illustration 182, “MPEG Ingest” Window 

 

b. From the “Input/Source” drop down list, select the external device or switch 
resource that you would like to record. 

c. DVply-controlled DVD devices only: to cue a specific DVD title:chapter for 
playback, enter the desired title and chapter in the “Title:Chapter” field and 
then click the “CUE” button. 

d. If desired, set a delay time for the broadcast MPEG recorder from the 
“Recorder delay” field.  This is the time it will take before the recorder begins 

ingesting playback after both devices have been activated.  Once the 
recorder has been activated, WinLGX displays a countdown window that 
allows you to cancel the delay. 

e. If desired, enter a record time in the “Length” field.   The input device and 
broadcast MPEG recorder automatically stop at the end of the record time. 

f. Activate the source and broadcast MPEG recorder according to one of the 
following steps: 

 If you selected an external input device, either: 
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 Click  to simultaneously activate both devices. 

OR 

 Click the  button to start playback of the source device and 

then the  button to activate the MPEG recorder. 

 If you selected a switch resource, just click the  button to activate 
the MPEG recorder. 

g. If you did not enter a record time in the “Length” field, stop the input device 
or switch resource and broadcast MPEG recorder by performing one of the 

following steps: 

 If you selected an external input device, either: 

 Click  to simultaneously stop both the device and MPEG 

recorder. 

OR 

 Click the  button under “Input/Source” to stop playback of the 

source device and then the  button under “Destination” to stop 

the MPEG recorder. 

 If you selected a switch resource, just click the  button under 
“Destination” to stop the MPEG recorder. 

h. Click the “Close” button to exit the window. 

 

MONITORING AN MPEG FILE RECORDING 

Once an MPEG file recording has been been initiated from a scheduled event or the 
control panel, WinLGX allows you to watch the recorded video on the control panel ’s 
confidence monitor.  Select the MPEG recorder icon in the control panel window’s 

“Device” list to display the corresponding recorder control panel and then click the 
“Monitor” tab (see Illustration 183).  After the recording is initiated, the confidence 
monitor automatically begins to display the recorded video footage after the number of 

seconds specified on the “Preview Monitor” tab of the “Preferences” window (default is 
10 seconds; see page 130 for more details).  To control playback of the recorded 
video, refer to the information below on the confidence monitor controls: 
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Illustration 183, MPEG Recorder Confidence "Monitor" Tab Window 

 

 “Recorder” Time Display: shows the total length of the recording file in 
hours:minutes:seconds 

 “Confidence Monitor” Time Display: shows the current playback time of the 

video in the preview window in hours:minutes:seconds. 

 Jump Reverse Button: single click to move back in the video by the number of 

seconds specified on the “Preview Monitor” tab of the “Preferences” window (see 
page 130 for more details).  The default number is 10 seconds. 

 Play/Pause Button: click to toggle between pause and playback of the video. 

 Step Forward Button: moves the video forward one GOP each time it is clicked. 

 Jump Forward Button: single click to move back in the video by the number of 
seconds specified on the “Preview Monitor” tab of the “Preferences” window (see 
page 130 for more details).  The default number is 10 seconds. 

 Seek End Button: moves current playback position to the end of the recorded file. 

 Volume Control: click and drag the volume control slider to adjust video’s volume.  

The volume control defaults to lowest audio setting. 

 Mute Button: click the mute button to toggle between silenced and restored audio. 

 Current Recording File Properties: provides the name, length, video bit rate, 

audio sample rate, and storage device of the selected MPEG file. 
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CONTROLLING EXTERNAL DEVICES 

IR or PRO-BUS-Controlled Devices (Supported Digital Video Recorders, VCRs, 
DVD, ¾”, 8mm, Beta SP, and HI-8mm Players) 

When one of the above devices is selected in the Control Panel window’s “Device” list, 

the corresponding device control panel is displayed (see Illustration 184, Example of a 
PRO-BUS-Controlled Device Control Panel).  

NOTE: Some interface commands trigger a control sequence unique to the device’s 

brand and/or model.  To determine the device-specific actions triggered by 
the control commands, consult the PRO-BUS interface manual for a PRO-

BUS-controlled device or Table 21, IR Port Configuration Options, for an IR-
controlled device.   

Illustration 184, Example of a PRO-BUS-Controlled Device Control Panel 

 

 Device properties: the left side of the panel displays the following: 

1. “Format”: type of device 

2. “Interface type”: device interface to which the device is connected 

3. “Device”: the device interface number 

4. “Input”: if applicable, the switcher input number to which the device is 
connected   

 Playing a File 

To play a file, click the  button. 

 Recording a File 

NOTE: Scheduled record events will interrupt any record and ingest 
operations started from the Control Panel.  The scheduled record will 
occur, but the Control Panel recording will be stopped. 

To record a file, click the  button and then the  button. 
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 Stopping a File 

To stop a file, click the  button. 

 Rewinding a File 

To rewind a file, click the  button.  

DVply-Controlled Devices 

Select the DVply device icon in the Control Panel window’s “Device” list to display the 

corresponding control panel (see Illustration 185, Control Panel DVply Device) and 
perform the following steps: 

Illustration 185, Control Panel DVply Device  

 

 Device properties: the left side of the panel displays the following: 

1. “Format”: type of device 

2. “Interface type”: device interface to which the device is connected 

3. “Device”: indicates the number of the DVply port on the back of the 
Controller 

4. “Input”: if applicable, the switcher input number to which the device is 
connected   

 Loading a Disc: Sony DVP-CX777ES or Pioneer DV-F07 only 
Enter the disc’s number position within the DVD device and then click the 
“Load” button. 

 Cuing a File for Playback 
To cue a specific DVD title:chapter for playback, enter the desired title and 
chapter in the “Title:Chapter” field and then click the “CUE” button. 

 Playing a File 

To play a file, click the  button. 
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 Pausing a File 

To pause a file, click the  button. 

 Stopping a File 

To stop a file, click the  button. 

GPI Output Devices 

Select the GPI device icon in the “Device” list to display the corresponding control 

panel (see Illustration 186, Control Panel: GPI Device Control) and perform the 
following steps: 

Illustration 186, Control Panel: GPI Device Control   

 

 Device properties: the left side of the panel displays the following: 

1. “Format”: type of device 

2. “Interface type”: always a “PRO-BUS” device interface for GPI devices 

3. “Device”: device number given to the PRO-BUS address via switches on the 
PRO-BUS interface. 

 Control options: depending on how you configured your GPI PRO-BUS 

interface’s dip switches (refer to your PRGPI PRO-BUS Interface Manual for 
more details), the buttons on the right side of the panel will either: 

1. Close the corresponding GPI output until a command is sent to close a 
different GPI output. 

Or 

2. Pulse the corresponding GPI output closed for 750 mS.  



NEXUS Series 

Software Operation 

Page 326   LEIGHTRONIX, INC. 
WinLGX ver. 7.0.2.60  2018-06-08 
 

UltraNEXUS/UltraNEXUS-SDI Only: ePRO-BUS Record Devices 

Select the ePRO-BUS record device icon in the “Device” list to display the 
corresponding control panel (see Illustration 187, Control Panel: ePRO-BUS Record 

Device Control) with the following information:  

Illustration 187, Control Panel: ePRO-BUS Record Device Control   

 

  “Format”: type of device.  This should be a tape or DVD device. 

 “Interface type”: always a “PRO-BUS” device interface for ePRO-BUS record 
devices 

 “Device”: PRO-BUS address number assigned to the PEGvault-SD or LABvault-SD 

recorder you wish to control.  The PRO-BUS address numbers are configured via 
the "ePRO-BUS" Tab Screen in WebNEXUS (see the “UltraNEXUS/UltraNEXUS-
SDI Only: Configuring ePRO-BUS Setttings” section on page 442 for more details). 

 “Input”: should be set to “<None>,” as ePRO-BUS record devices are outputs 

Immediately start/stop a record on your PEGvault-SD or LABvault-SD recorder 

according to the following steps.  Start a remote ePRO-BUS record session if the 
ePRO-BUS record device is networked to your UltraNEXUS system.  A local ePRO-
BUS record should be initiated for ePRO-BUS record devices that are directly wired to 
your UltraNEXUS system’s internal or external switcher.  

 Remote ePRO-BUS Record: click the record icon to initiate a record on your 
PEGvault-SD or LABvault-SD.  When you have captured the desired footage, click 
the stop record icon. 

 Local ePRO-BUS Record: for ePRO-BUS record devices directly connected to your 

UltraNEXUS system’s internal or external system switcher, you will first need to 
switch a video source over to your PEGvault-SD or LABvault-SD before initiating a 
record.  Perform the following: 

1. Use the control panel’s switcher subpanel underneath the ePRO-BUS device 

controls to switch a video source input to the output connected to your recorder. 

2. If applicable, activate playback on your video source by selecting the input 

device in the left-hand column of the control panel.  Use the corresponding 
control panel controls to start playback on the video source input. 
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3. Return to the recorder controls by clicking the ePRO-BUS device resource in 
the control panel’s left-hand column.  Click the record icon to initiate a record on 

your recorder.  When you have captured the desired footage, click the stop 
record icon.  
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MANAGING STORAGE OF VIDEO, SLIDE, AND OVERLAY FILES 

Manage digital media storage for one or more LEIGHTRONIX video 
servers/controllers with the WinLGX “Storage Manager” window.   The Storage 
Manager provides access to your MPEG videos, JPEG slides, PNG overlays, and 

JPG/PNG background images.  Just select the file type you want to manage and then 
add and delete the files to and from your local (PC/network) and remote (NEXUS 
series compact Flash, USB hard drives, and NAS) storage devices. 

UltraNEXUS-SDI / 
UltraNEXUS Only: 

VOD streaming files are automatically transferred to 

LEIGHTRONIX streaming services sites (ex., PEG Central) and 
then deleted from your USB drives. 

Open the Storage Manager window by selecting “Storage Manager” from the “File” 

menu or click the  icon on the main toolbar (see Illustration 188, Storage Manager 
Window).   

Illustration 188, Storage Manager Window 

 

Perform any of the file management operations listed under the following sections: 

 “Choosing File Storage Devices” on page 329 

“File type” 

Selection Options 

Depending on selected storage 
device, lists files stored on local 
or remote storage devices for the 

selected “File type” 
Lists files stored only on 
remote storage devices 

for the selected “File type” 
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 “Managing all Digital Files” on page 330 

 “Previewing Video Files” on page 332 

 "Creating a Default Slide” on page 333 

 “Creating & Managing Background SubFolders” on page 333  

 “Transferring Graphic/Text Layers with Slides Created in a WebNEXUS Slide 

Editor,” on page 335 

When you are finished, click the “Close” button to exit the “Storage Manager” window.  

CHOOSING FILE STORAGE DEVICES 

1. Select one of the following to enable the display of the corresponding file type: 

 “Video”: displays MPEG files only 

 “Slides”: displays JPEG slides only 

 “Overlay”: displays PNG graphic overlays only 

 “Background”: displays JPEG/PNG graphics available for slide creation in 
your WebNEXUS slide editor 

2. The left side of the Storage Manager window allows you to access both your local 
and remote storage devices.  Select a storage device as follows: 

 “Local storage device”: select to access files stored on your PC or network.  

Use the “Drive” drop down box and file navigation window to find and select 
your videos or graphics files. 

 “Remote storage device”: select to access the internal and external storage 

devices for your NEXUS series system.  Specify the NEXUS series storage 
device you wish to access as follows:   

a. Select a NEXUS series system from the “Controller” drop down box.  All 
WinLGX connected NEXUS series server/controllers will appear in the 

drop down box, allowing you to access the remote storage devices for the 
NEXUS series system that you choose.  

b. From the “Device” drop down box, select a remote storage device based 

on the file type chosen in step 1: 

 “Video”: select the USB hard drive or network attached storage 

(NAS) device containing the MPEG files you wish to access 

 “Slides”: select a user account folder containing the slides you wish 

to access.  The “public” folder serves as a common storage area into 
which all users can add slides and cannot be displayed in slide 
shows. 

 “Overlay”: select the “Emergency” or “Standard” folder 

 “Background”: the “Background” subfolders are not accessible from 
the left side of the “Storage Manager” window. Instead, select “Local 
Storage Device” to display the NEXUS series server’s background 

subfolders and contents on the right side of the “Storage Manager” 
window. 
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3. The right side of the Storage Manager window only allows you to access your 

NEXUS series remote storage devices.  Refer to the remote storage device 

selection instructions in step 2, while noting the following for the “Background” 
folder: 

“Background”: when “Background” is selected, the right side of the Storage 
Manager shows the file folders containing graphics for your WebNEXUS slide 
editor’s “Images” selection window. By default, your NEXUS series server includes 

several folders of background images and icons available for use during slide 
creation.  

MANAGING ALL DIGITAL FILES 

 Preview slides, overlays, and backgrounds: single click on a JPEG or PNG file 
to display it in the “Preview” window. 

 Select one or more files 

Selected files are highlighted with a blue stripe. 

 Single file: single click on the file 

 All Files: right click on a file and select “Select All” from the right-click menu. 

 Block of Files Next to Each Other: while holding down the “Shift” key on your 

keyboard, single click two files to select both files plus any in between. 

 Random: hold down the “Ctrl” key on your keyboard and click on the desired 

files. 

 Copy files from one storage area to another 

Copying leaves the original files in their current locations.  Select one or more files 
and then right click on the selected file(s) to display the right-click menu.  Select 

“Copy” from the menu.  A dialog box (see Illustration 189, Storage Manager Copy 
Dialog Box) will ask whether or not you would like the file copied to the storage 
device selected on the opposite side of the Storage Manager screen.  Depending 

on your selected storage device/file type, you may also perform the following: 

 Create a library resource for the file: if you are copying a video, slide, or 

background to a remote storage device, you may click the “Add to library” 
option to create a WinLGX library resource for the file (see Illustration 189). 
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 Export XML data to local storage device: if you are copying a digital file from a 
remote to a local storage device, you will see an “Export XML data” checkbox in 
place of the “Add to library option.”  The “Export XML data” checkbox is 
reserved for future use. 

Illustration 189, Storage Manager Copy Dialog Box 

 

NOTE: Clicking the “Cancel” button on the FTP window stops the transfer, leaving a 

file fragment which should be deleted.  Cancel only when necessary.  When 
multiple files are finished, a summary dialog appears giving the final results. 

 Move file(s) from one storage area to another 

Moved files are removed from their original locations and transferred to the selected 
storage areas.  Select one or more files and then right click on the selected file(s) to 

display the right-click menu.  Select “Move” from the menu.  Depending on your 
selected storage device/file type, you may also perform the following:  

 Create a library resource for the file: if you are copying a video, slide, or 
background to a remote storage device, you may click the “Add to library” 
option to create a WinLGX library resource for the file. 

 Export XML data to local storage device: if you are copying a digital file from a 
remote to a local storage device, you will see an “Export XML data” checkbox in 
place of the “Add to library option.”  The “Export XML data” checkbox is 
reserved for future use. 

NOTE: Clicking the “Cancel” button on the FTP window stops the transfer, leaving 

a file fragment which should be deleted.  Cancel only when necessary.  

When multiple files are finished, a summary dialog appears giving the final 
results. 

 Delete files from your storage areas 

 Select desired file(s) and press the “Delete” key. 

 Right click on the selected file(s) and select “Delete” from the right-click menu.   

A pop-up box will appear, showing the name and path of the digital file to be 

deleted.  If you are deleting the file off of a remote internal or external storage 
device for your NEXUS series system, the Storage Manager will also allow you to 
select an option that automatically deletes any library resources and events 

containing the file.  Click “Yes” to complete the deletion or “No” to abort. 
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Illustration 190, Storage Manager Digital File Delete Option 

 

 Rename files 

Right click on the selected file(s) and select “Rename” from the menu. Enter new 
volume name in the “Rename File” window. 

NOTE: NEXUS series server/controllers will not display files with filenames 
containing spaces. 

 Create library resources for your MPEG videos and JPEG slides 

Right click on the file(s) selected on one of your remote storage devices and select 

“Add to library” from the right-click menu to display the “Add to library folder” 
Window shown in Illustration 181.  Select the library folder you want to contain the 

corresponding library resource(s) and click “OK.” 

NOTES:  WinLGX will not create a library resource for a file that possesses the 

same filename and length as a pre-existing library resource. 

  If the new file possesses the same title as another resource, but has a 

different filename and/or length, WinLGX will copy the new file to the 

library with a numbered increment added to its title.  For example, if this is 
the first time you have reused the title of a pre-existing library resource, 
WinLGX will add the new file to the library under the name “title01.”  

 Rename remote storage device(s) 

In a remote storage device file listing on either side of the Storage Manager 

window, right click and select “Rename volume.”  Enter the new volume name in 
the “Rename Volume” window and click “OK” to make the change or “Cancel” to 
abort. 

 Refresh file listing 

Click the “Refresh” button to update the files on the Storage Manager window. 

PREVIEWING VIDEO FILES 

WinLGX gives you the option to display the MPEG files in the Storage Manager 
“Video” listings within the instant video preview monitor by either double clicking the 
file or right clicking on the file and selecting “View” in the right-click menu.  For more 

information on the preview monitor, go to the “Using Instant Video Preview Monitor to 
Display MPEG Files within WinLGX” section on page 230. 
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ENABLING AND AUTHORIZING SLIDES FOR DISPLAY IN SLIDE SHOWS 

Slide .jpg files must be enabled and authorized before they will display in slides 
shows (see Illustration 191).  All users who have the right to upload slides can 

indicate their slides are appropriate for slide shows by checking the “Enable” box next 
to each slide in their user folders.  However, the “Authorize” box next to each slide 
must also be checked before it will display on-air in slide shows.  Only the “admin” 

user and users with the “Slide administrator” right can authorize slides in any user 
folder.  Slides uploaded by users with the “Automatic slide authorization” right into their 
own user folders will be automatically approved for display.  Refer to “Setting User 
Account Rights (Including WinLGX Password Changes)” on page 110. 

Illustration 191, Slide Show Authorize and Enable Options 

 

CREATING A DEFAULT SLIDE 

The default slide will display if a slide show is scheduled in a slide show without slides 
or without approved slides. 

1. The “admin” user must upload the slide into his “admin” user account folder (see 

the “Managing all Digital Files” on page 330). 

2. Right-click on the file and select “Rename” from the menu.  Change the slide 

filename to “Default.jpg.” 

3. Enable and approve the slide for display (see the “Enabling and Authorizing Slides 
for Display in Slide Shows” section on page 333). 

CREATING & MANAGING BACKGROUND SUBFOLDERS 

Graphic files in the “/Internal/DATA/backgrounds” subfolders are available for use 
during slide creation from your WebNEXUS slide editor’s “Images” selection window 
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(see “Creating New Slides” on starting on page 373 for more details). The subfolders 
are on your NEXUS series server’s internal compact Flash storage area and contain 

factory default slide templates, backgrounds, and icon graphics from LEIGHTRONIX 
as well as any files you have chosen to upload.   

NOTE: The “Background” file type on the “Storage Manager” window only appears 
for users with the “Slide Administrator” user right.  Users must also be 

granted the “Send and Receive” user right in order to transfer any files 
between local and remote storage areas.  See “Setting User Account Rights 
(Including WinLGX Password Changes)” on page 110 for more information 

on adding and assigning rights to user accounts. 

You may create additional subfolders for your own PNG and/or JPEG background files 

created with any third-party graphic program.  Create and delete background 
subfolders according to the following steps: 

 Create a background subfolder 

1. Ensure you have selected “Local Storage Device” on the left side of the 
“Storage Manager” window.   

2. On the right side of the “Storage Manager” window, right click in the 
“backgrounds” directory window and select “Create directory” as shown in 
Illustration 192. In the “Create directory” window that appears, type in a name 

for your subfolder and click “OK” to create the subfolder or “Cancel” to abort. 

NOTE: Your WebNEXUS slide editor will only display graphics within the 

“backgrounds” subfolders.  

Illustration 192, “Create directory” Backgrounds Option 

 

3. Copy or move files into the new subfolder according to “Managing all Digital 

Files” on page 330. 

NOTE: Images of any size resolution may be uploaded to a WebNEXUS 

slide editor, but keep in mind the editor slide creation area and save 
resolution is 720 pixels wide x 540 pixels high. 

 Delete a background subfolder 

1. Ensure you have selected “Local Storage Device” on the left side of the 
“Storage Manager” window.   

2. On the right side of the “Storage Manager” window, right click on a subfolder in 
“/Internal/DATA/backgrounds” and select “Delete directory” in the pop-up menu 
that appears.  Click “Yes” to delete the subfolder or “No” to abort. 
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TRANSFERRING GRAPHIC/TEXT LAYERS WITH SLIDES CREATED IN A 
WEBNEXUS SLIDE EDITOR 

Slides created in a WebNEXUS slide editor can still be modified after they are 

transferred to a local storage device or another NEXUS series server if they are 
copied/moved from the WinLGX Storage Manager with their graphic/text layers.  By 
choosing the Storage Manager’s “Show Edit Files” option and transferring slides with 

their graphic/text layers to a NEXUS series server (remote storage device), you will be 
able to modify the slides’ layers in your WebNEXUS slide editor.  To transfer a slide 
with its layers, perform the following: 

1. Select the “Slides” file type. 

2. Select your storage devices on the 

right and left sides of the Storage 
Manager window (see “Choosing 

File Storage Devices,” on page 
329 for instructions). 

3. Select the “Show Edit Files” option 
to list the .fie files for any slides 

originally created in a WebNEXUS 
slide editor.  Each .fie file contains 
the text/graphic layers used to 

create the slide with the same 
name.   

4. Show each .fie file next to its 
corresponding .jpg slide in the 

slide listing by clicking the “Name” 
category header.  The Storage 
Manager does not provide preview 

images of the .fie files. 

Illustration 193, “Show Edit Files” Option 

 
 

5. Select both the slide’s .jpg and .fie files as follows: while holding down your 

keyboard’s “Ctrl” key, single click both the .jpg and .fie files to select the pair.  
While still holding down the “Ctrl” key, right click to display the file management 

menu (see Illustration 194).    

“Show Edit Files” 

Slides Option 

Example of .fie file 

and .jpg slide pair 

“Name” 

Category Header 
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Illustration 194, Transfer Slide and Layer Files 

 
 

6. From the file management menu (see Illustration 194), select either “Move” to 

remove the files from the storage device and transfer them to the storage device 
selected on the opposite side of the Storage Manager window or “Copy” to create a 

duplicate of the slide files on the other selected storage device.  If your target file 
destination was a slide user folder on a NEXUS series remote storage device, you 
may modify the slide in the server’s WebNEXUS slide editor (see the "Creating 

New Slides” section starting on page 373, as applicable). 
 
 

File Management 

Menu 
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RETRIEVING LOG FILES 

Each NEXUS series server/controller keeps track of everything done to or by it in 

internal log files.  The NEXUS series log files cannot be deleted, written to, or 
manipulated by a user in any way; however, once downloaded, you can then save, 
write, and format the file just like any other text document. 

WinLGX allows you to access the NEXUS series log files with the “Get log” menu item 

under the “File” menu or  icon on the main toolbar.  Selecting one of these options 
will display the "Select Controller Log File" Window shown in Illustration 195.   

Illustration 195, "Select Controller Log File" Window 

 

At the top of the “Select Controller Log File” window, you will see three different tabs 
for accessing the NEXUS series log files.  Access the NEXUS series event, system, 
and firmware log files as follows: 

Event Log Files 

Especially useful for tracking playback events, each NEXUS series server/controller 
logs its event execution status into a .CSV file spreadsheet on a monthly basis (see 

Illustration 196).  The execution results for each event are logged under the 
spreadsheet’s “Result” column, with “Ok” indicating the event was successfully 
executed and “Exception” meaning the event was not executed.  For those events with 

the “Exception” status, refer to the “Report” column on the spreadsheet for more 

Log File Tabs 
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information about why the event did not occur.  Also logged are each event’s date and 
time of execution, format type, device type, and other major event descriptors. 

Illustration 196, Example of Event Log File 

 

To access event log files, perform the following steps: 

1. Click on the “As played” tab on the “Select Controller Log File” window.   

2. Single click on the desired .CSV file to select it and then click “OK.”   

3. A “Save as Played log File” window will open.  Save the .CSV file to a new file path 
or use the WinLGX default log file path (Shared 

Documents\Leightronix\WinLGX\Controller Data\IP xxx.xxx.xxx.xxx\Log”).   

4. Click the “Save” button to save the file to your chosen file path.  The “Save as 

Played log File” and “Select Controller Log File” windows  will close.   

5. Navigate to the file path for the saved .CSV file and open it in Excel. 
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System Log Files 

The NEXUS series system activity log files are called “EVENTS.LOG” and 
“OLDEVNTS.LOG.”  When a new NEXUS series server/controller is powered on for 

the first time, it creates a file called “EVENTS.LOG.”  The NEXUS series system will 
continually write to this file until it reaches 7 MB.  Once “EVENTS.LOG” reaches 7 MB, 
the NEXUS system will rename it to “OLDEVNTS.LOG” (deleting the previous 

“OLDEVNTS.LOG”) and then create a new “EVENTS.LOG.”  This ongoing cycle 
ensures that recent events are always logged.  

The NEXUS series system log files are useful in identifying specific events within the 
system, such as when a particular program aired, when a user logged in from a 
remote terminal, and more.  To view a system log file, perform the following steps: 

1. Click on the “System” tab on the “Select Controller Log File” window (see 
Illustration 197, “System” Tab on the “Select Controller Log File” Window).  

Illustration 197, “System” Tab on the “Select Controller Log File” Window 

 

2. Select one of the log files from the listing and then download log records based on 
the following filter options: 

 “Date/Time filter”: check box to enable the date/time fields 
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 Within a range of dates and times: use the start/end date and start/end 

time fields to download all log records within the selected dates and times  

 No filter: click the “Raw data (no filter)” button to download all log records  

 MPEG playback events of low severity: click the “MPEG Playback” filter 

preset button to download all noncritical log records containing the text 
“MPEG Playback” in their action descriptions 

 Severity of event action: download all log records with the event severity 

code selected with the “Severity filter” drop down menu 

 Group action type: download all log records with the group action type 

selected with the “Group filter” drop down menu 

 Action descriptions: download all log records with action descriptions 
containing one of the text options selected with the drop down menu under 
“Text filter.”  To create your own action description filter, select “User text” 

from the drop down menu and type in the desired keyword in the “User text” 
comment field. 

3. Click “OK” to open the “Save Log File” dialog box.  Once saved to the desired 
location, the log is displayed in a text editor of your choosing (see Illustration 198, 

Example of Log File).  This will also turn off the log LED  that appears on the 
NEXUS system’s front panel when a severity 1 or 2 event action is logged. 

NOTE: The default viewer is Notepad, but the viewer can be changed from the 

“Tools”/“Preferences”/”Application” tab (for more details, see “Setting 
WinLGX Viewing and Communication Preferences,” beginning on page 
124).  
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Illustration 198, Example of Log File 

 

Each action performed through or by the NEXUS series server/controller is recorded in 

the log file along with its date and time, severity, and action type.  The following 
information identifies and explains each part of the “EVENTS.LOG” file in more detail. 

 Date 

 Time 

 Severity of event action—event actions are classified according to the following 
three levels of severity: 

 0: events that occur during the course of normal operations 

 1: warning events 

 2: critical events or failures 

 Types of actions recorded: 

 Deck: actions based on PRO-BUS, DVply, and IR interface functions 

 Diagnostic: NEXUS series system health and status  

 File: actions involving files, typically file transfers (also NEXUS series image 
send/retrieve)  
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 Front Panel: actions performed based on commands given by user through 
the front panel of the NEXUS series system 

 MPEG: MPEG player/recorder actions 

 Remote: actions performed based on commands given by user from the 
WinLGX control panel 

 Schedule: actions performed based on user-created schedule  

 Switcher: actions based on switcher events and functions 

 USB drive: actions pertaining to the external USB hard drives 

 Web: actions performed through the WebNEXUS interface 

 Descriptive message of actions performed 
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Firmware Update Log Files 

Each NEXUS series server/controller creates log files that specifically track firmware 
updates.  LEIGHTRONIX uses firmware update logs to troubleshoot unsuccessful 

firmware updates.  A separate firmware update log is created each time you firmware 
update your NEXUS series system and is named after the corresponding firmware 
update file.  To open a firmware update log file, perform steps 1–3 under “System Log 
Files.” 

1. Click on the “All” tab on the “Select Controller Log File” window (see Illustration 
199). 

NOTE: System and event log files can also be accessed from the “All” tab.  

Illustration 199, "All" Tab on the "Select Controller Log File" Window 

 

2. Select one of the log files from the listing and then download log records based on 
the filter options as described in step 2 under “System Log Files.”  

3. Click “OK” to open the “Save Log File” dialog box.  Once saved to the desired 
location, the log is displayed in a text editor of your choosing (see Illustration 198, 

Example of Log File). 

System Log File 

Firmware Update 

Log File 
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NOTE: The default viewer is Notepad, but the viewer can be changed from the 

“Tools”/“Preferences”/”Application” tab (for more details, see “Setting 

WinLGX Viewing and Communication Preferences,” beginning on page 
124). 
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UPDATING FIRMWARE/SOFTWARE 

LEIGHTRONIX places the most current firmware/software files for each 

LEIGHTRONIX product on its Support Center website.  Save the update files to an 
accessible directory on your PC. 

UPDATING NEXUS SERIES SERVER/CONTROLLER AND/OR DVPLY FIRMWARE 

NOTE: Firmware updates can only be performed by the WinLGX "admin" user 

or users with "Administrator" rights. 

1. Open the WinLGX software and log in to your NEXUS series system (see “Opening 

WinLGX and Connecting to NEXUS Series Server/Controller” on page 215). 

2. Choose “Controller” under the “Tools” menu to open the “Controller” window shown 
in Illustration 200. 

Illustration 200, Controller Window 

  

3. Under “Firmware update,” click “Browse” to open the “Choose controller firmware 

file” window shown in Illustration 201.   
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Illustration 201, “Choose Controller Firmware File” Window  

 
 

4. Navigate to and open one of the following file types: 

 ______.lpf: updates your NEXUS series server/controller’s firmware and, if 
needed, your WebNEXUS interface.  Once you have selected and opened the 

file, the “Select firmware options” window is displayed (see Illustration 202).  
Click “OK” to save your firmware update options or “Cancel” to abort the 
changes and close the dialog.  If you would like to reopen the window, click the 
“Options” button under “Firmware update.” 
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Illustration 202, “Select Firmware Options” Window 

 

 TascamDVply*.fmw: updates your Tascam DVply firmware.  DVply firmware 
may only be updated in this method for UltraNEXUS/NEXUS server/controllers 

with DVply firmware version 1.4 and above already installed.  Use the NEXUS 
system’s front panel display to check your DVply firmware version (see 
“Display” under the “NEXUS Series Front Panels” section on page 42 of this 

document for more information on viewing the NEXUS system’s front panel 
screens). 

NOTE: If your NEXUS series server/controller has an earlier version of DVply 
firmware installed, contact LEIGHTRONIX technical support at 800-
243-5589 for further instructions. 

 DVply*.fmw for Supported DVD Changer: separate option for controlling a 

supported DVD Changer.  Contact LEIGHTRONIX technical support at 800-
243-5589 for more information on purchasing this option.  The DVply ports can 
only control two Tascam DVD players or one supported DVD changer.  

5. Click “Update” to continue the firmware update.  Click “Yes” when prompted to start 

the update. 
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6. Once the update has completed, click “OK” to apply the changes and reboot the 
NEXUS series server/controller.  You will be logged out and the “Site Manager” 

window will be displayed. 

NOTE: You will not be able to log back in until the NEXUS series system 
finishes rebooting.  The update may take several minutes. 

7. After the NEXUS series system finishes rebooting, log back in and confirm the 
NEXUS system has been upgraded to the latest firmware version in the “Site 
Manager” database.   

UPDATING WINLGX SOFTWARE 

1. Close WinLGX. 

2. Navigate to and open the WinLGX_vx.x.x.x_Installer.exe.  Follow the prompts to 

install the latest version of the client software.  

3. Click “OK” to continue WinLGX update. 

4. Follow the prompts to complete the installation. 
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WEB CONTROL 

ABOUT THIS SECTION 

NOTE: The screen captures shown in this section were taken when logged into an 
UltraNEXUS.  Screens for the NEXUS and UltraNEXUS-SDI will vary slightly, 
as noted. 

Access your NEXUS series system from the Internet with WebNEXUS, a built-in, 

password-protected web interface.  WebNEXUS provides the ability to manage slides, 
create and display emergency messages, create looping playlists for display between, 
as, or in place of scheduled programming, transfer MPEG files to specified 

destinations, record MPEG files, and view the NEXUS series system’s status, program 
guide, and log files.  Note that slides can only be activated for broadcast through the 
WinLGX scheduler and control panel.   

WebNEXUS works on any computer with Microsoft Internet Explorer 8 and above, 

Google Chrome, Firefox , Safari, and Opera.  While WebNEXUS may work with other 
browsers, full functionality is not guaranteed.  No special software installation is 
required.     

Up to 32 different users can log into WebNEXUS.  All user accounts may perform the 
following: 

 Upload JPEG slides into their own user folders on the NEXUS series system’s 
internal flash drive 

 Specify slide availability settings for slide shows 

 Add text and program guides to slides 

 View NEXUS series system status 

Some user accounts have access to additional WebNEXUS features, as outlined in 
Table 55.  The “admin” user account has access to all WebNEXUS features.  See 

“Setting User Account Rights (Including WinLGX Password Changes)” on page 110, 
for instructions on assigning rights to user accounts. 

Table 55, User Rights with Access to Additional WebNEXUS Features 

Description 
“Administrator” 

Right 

“Slide 
Administrator” 

Right 

“MPEG/Slide 
control 
(record/ 
setup)” 

Right 

“No file 
access” 

Right 

“Receive only,” 
“Send and 

receive,” and 
“Send, receive, 

rename, & delete” 

Rights 

Create and display 
emergency messages 
over digital programs   
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Description 
“Administrator” 

Right 

“Slide 
Administrator” 

Right 

“MPEG/Slide 
control 
(record/ 
setup)” 

Right 

“No file 
access” 

Right 

“Receive only,” 
“Send and 

receive,” and 
“Send, receive, 

rename, & delete” 

Rights 

Authorize slides for on-
air display in slide 

shows 

 
 

   

Add, edit, rename, and 
delete slides with all 

user account folders 

 

 

   

UltraNEXUS-SDI and 
UltraNEXUS Only: 

configure file transfer 
destinations as well as 
enable recording of 
VOD files for PEG 

Central 

 
 

 
  

UltraNEXUS-SDI and 
UltraNEXUS Only: 

transfer MPEG files to 
another NEXUS series 
system, LGX-SVOD, 
FTP destination, and/or 

PEG Central 

 
   

 

UltraNEXUS Only: 
record MPEG files and 
add PEG Central index 

points 

 

 

 
  

Display program guide 
  

   

View log files 
 

    

Manage “System” 
settings  

    

Create looping Virtual 
Channel playlists  
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OPENING AND LOGGING INTO WEBNEXUS 

1. Open WebNEXUS through one of the following steps: 

 If you already have WinLGX open and are logged into the desired NEXUS 

series system’s IP address, select “Web interface” from the “Tools” menu or 

click on the  toolbar icon to open WebNEXUS in your default web browser. 

 Enter your NEXUS series system’s IP address into the address bar of a web 
browser (see Illustration 203 for an example). 

Illustration 203, Accessing NEXUS Series System from Internet Explorer 

 

2. A login prompt will appear (see Illustration 204, Login Prompt).  Enter your 

username and password. 

NOTE: Your username and password are assigned through WinLGX.  Refer to 
“Setting User Account Rights (Including WinLGX Password Changes),” 
on page 110 for information on adding/editing usernames and 

passwords.  

Illustration 204, Login Prompt 
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If login is successful, the window shown in Illustration 205, “System Dashboard” 

Screen, opens.  All web-based control functions are accessible from the menu sidebar. 

Illustration 205, “System Dashboard” Screen 

 

“SITE INFORMATION” 

Displays your NEXUS series system’s site information, including serial number and 
firmware version. 

“STORAGE” 

Displays the storage availability on your NEXUS series system’s compact flash drive 
and for any connected USB drive and NAS storage device. 

MPEG PLAYER/RECORDER STATUSES 

Displays the properties of the files currently playing on MPEG Players 1 and 2 and the 
file currently being recorded by the broadcast MPEG Recorder.  Click the tab of the 
desired MPEG player or recorder to display the corresponding information. 

“NETWORK SETTINGS” 

Displays your NEXUS series system’s network addresses. 

“SWITCHER STATUS” 

Quick overview of which of your inputs are currently switched to the switcher outputs.  
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ULTRANEXUS-SDI / ULTRANEXUS ONLY: MANAGING MPEG AND 

VOD FILES 

The WebNEXUS “File Management” and “File Destinations” screens give 
UltraNEXUS-SDI and UltraNEXUS owners the ability to enable video-on-demand 
(VOD) file recording and control MPEG and VOD file transfers from the Internet.   

ENABLING/DISABLING VOD RECORDER 

The UltraNEXUS-SDI / UltraNEXUS VOD recorder will not capture programming for 
the LEIGHTRONIX PEG Central streaming video-on-demand service until you enable 
the VOD recorder through WebNEXUS.  To enable the VOD recorder, click the 

“Destinations” menu button, select the “PEG Central” tab, and then click to select the 
“Automatic Upload” checkbox.  Send the setting change to your UltraNEXUS system 
by clicking the “Apply Changes” button.   

Illustration 206, Video-on-Demand Streaming Enabled 

 

Once enabled, the UltraNEXUS or an UltraNEXUS-SDI installed with a distribution 

amp will record both an MPEG and a VOD file each time a scheduled or manual 
record is initiated.  The VOD files are automatically transferred to a LEIGHTRONIX 
streaming services site (contact LEIGHTRONIX for details on setting up a streaming 

VOD account).  This process will continue until you disable the VOD recorder by 
unchecking the “Automatic Upload” box or use the WinLGX “No VOD file” override 
feature in scheduled or control panel recording events. 

NOTE: If the UltraNEXUS-SDI VOD recorder is connected to a different switcher or 

video source output than the broadcast recorder, the same video source 

“Automatic Upload” 
Checkbox 
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input will have to be switched to the VOD recorder through a control panel or 
scheduled switch event before the recording event starts. 

SETTING UP TRANSFER DESTINATIONS 

Easily control where your recorded files are transferred by clicking the 
“DESTINATIONS” button and using the “File Destinations” screen tabs.  Recorded 
files may be automatically or manually transferred to a NEXUS series server/controller, 

LEIGHTRONIX PEG Central streaming VOD website, LGX-SVOD, and/or third party 
server with FTP capabilities, as outlined below.  The settings apply to each recording 
session until you change them. 

NEXUS Series Video Server Destination 

If you own another LEIGHTRONIX NEXUS series video server, you can send your 

MPEG files to any of the other server’s storage volumes.  Enter the destination 
NEXUS server’s IP address, username, and password along with the name of the 
volume that you want to store the files.  The names of your storage volumes can be 

viewed in the WinLGX “Storage Manager” window.  Complete the remaining settings 
according to the steps below and click the “Apply Changes” button when you have 

finished (refer to Illustration 207). 

1. “Verify Connectivity”: after entering your NEXUS series unit’s IP address, 
username, and password, click the “Verify Connectivity” button to ensure your 

UltraNEXUS/UltraNEXUS-SDI can connect to the destination server. 

2. “Automatic Upload”: when selected, files will be automatically transferred to the 

specified NEXUS series system after each recording session. 

3. “Transfer Holdoff Schedule”: 7 day/24-hour timeline allows you to decide which 
hours of the week your UltraNEXUS/UltraNEXUS-SDI will transfer files to your 

destination NEXUS series system.  Single click each hour segment on the timeline 
to toggle transfer capabilities on or off (green = on, red = off). 

4. “Enable Auto-Play CH” (UltraNEXUS Only): once the “PEGcasting” option is 
enabled on the UltraNEXUS “Record Settings” tab (see “UltraNEXUS ONLY: 

Setting up MPEG File Record ,” on page 360), you may choose to have a 
transferring file stream automatically begin playing on your second NEXUS series 
system’s MPEG Player 1 and/or 2 while the file is still recording. Select a “Playback 

Delay” of 2-60 minutes to specify how long after the file stream is transferred that it 
should begin playing on the selected channel(s).  
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Illustration 207, "NEXUS/UltraNEXUS" File Destinations Tab 

 

 

LEIGHTRONIX PEG Central Streaming Video-on-Demand Website 
 

This option causes the UltraNEXUS-SDI / UltraNEXUS to record and transfer VOD 
files to the LEIGHTRONIX PEG Central Web hosting and streaming video-on-demand 

service.  The UltraNEXUS-SDI / UltraNEXUS encodes files for this destination at a 
default setting optimized for streaming. Files that are successfully transferred are 
automatically deleted from the USB drives.  Complete the settings according to the 

steps below and click the “Apply Changes” button when you have finished (refer to 
Illustration 208). 

NOTE: The UltraNEXUS-SDI / UltraNEXUS will only record VOD files if the 

“Automatic Upload” option is checked for the “Internet VOD 
Streaming” destination. 

1. “Automatic Upload”: when checked, files will be automatically transferred to 

LEIGHTRONIX streaming video-on-demand site after each recording session. 

2. “Transfer Holdoff Schedule”: 7 day/24-hour timeline allows you to decide which 

hours of the week your UltraNEXUS/UltraNEXUS-SDI will transfer files to your 
destination NEXUS series system.  Single click each hour segment on the timeline 

to toggle transfer capabilities on or off (green = on, red = off). 

1 
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Illustration 208, "PEG Central" File Destinations Tab 

 

 

LGX-SVOD Server 
 

Enter your LGX-SVOD server’s IP address, username, and password and then 

complete the remaining settings according to the steps below and click the “Apply 
Changes” button when you have finished (see Illustration 209). 

1. “Verify Connectivity”: after entering your LGX-SVOD’s IP address, username, 

and password, click the “Verify Connectivity” button to ensure your 

UltraNEXUS/UltraNEXUS-SDI can connect to the destination server. 

2. “Automatic Upload”: when checked, files will be automatically transferred to the 

specified LGX-SVOD after each recording session. 

3. “Transfer Holdoff Schedule”: 7 day/24-hour timeline allows you to decide which 
hours of the week your UltraNEXUS/UltraNEXUS-SDI will transfer files to your 

LGX-SVOD server.  Single click each hour segment on the timeline to toggle 
transfer capabilities on or off (green = on, red = off). 



NEXUS Series 

Web Control 

Page 358   LEIGHTRONIX, INC. 
WinLGX ver. 7.0.2.60  2018-06-08 
 

Illustration 209, "LGX-SVOD" File Destinations Tab 
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Server with FTP Capabilities 
 

Push your files to another LEIGHTRONIX or third party video server with FTP 
capabilities.  Enter your server’s IP address, username, and password along with the 

name of the destination path.  Complete the remaining settings according to the steps 
below and click the “Apply Changes” button when you have finished (refer to 
Illustration 210).  

1. “Verify Connectivity”: after entering your server’s IP address, username, and 

password, click the “Verify Connectivity” button to ensure your 
UltraNEXUS/UltraNEXUS-SDI can connect to the destination server. 

2. “Automatic Upload”: when checked, MPEG broadcast files will be automatically 
transferred to the specified server after each recording session. 

3. “Transfer Holdoff Schedule”: 7 day/24-hour timeline allows you to decide which 

hours of the week your UltraNEXUS/UltraNEXUS-SDI will transfer files to your 
destination server.  Single click each hour segment on the timeline to toggle 
transfer capabilities on or off (green = on, red = off). 

Illustration 210, "FTP Server" File Destinations Tab 
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ULTRANEXUS ONLY: SETTING UP MPEG FILE RECORD SETTINGS 

From WebNEXUS, UltraNEXUS users can change their record quality and automation 
settings for MPEG file recordings. 

Click the “DESTINATIONS” button and then select the “Record Settings” tab.  Edit any 
of the following record settings and then click the “Apply Changes” button to send the 
changes to your UltraNEXUS or “Cancel” to abort.  The settings will be applied to 
every recording session until they are changed. 

Illustration 211, "Record Settings" 

 

 “Volume”: select the USB hard drive or NAS storage device that WebNEXUS 
broadcast file recordings will be added to  

NOTE: VOD files are automatically deleted from your UltraNEXUS system’s 
storage once they are transferred to PEG Central 

 “File Name”: in the “File Name” field, enter up to 14 characters (letters, numbers, 
and underscores only—no spaces).  If you use the same filename for more than 
one recording session, the record date and start time will be appended to the name 

of each additional recorded file as “yy/mm/dd-hh/mm/ss” (year/month/day-
hours/minutes/seconds). 

 “Create Unique Files”: when this option is selected, the record date and start time 
will be appended to the filename of every recorded file as “yy/mm/dd-hh/mm/ss” 
(year/month/day-hours/minutes/seconds). 
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 “File Quality”: select a “File Quality” recording preset for your VOD files.  Each 
recording quality preset represents the range of bit rates within which your 
broadcast files will be recorded.  

NOTE: PEG Central and LGX-SVOD VOD files will always be recorded at the 
streaming quality bit rate. 

 “PEGcasting”: if you want your recorded files transferred to a second NEXUS 
series server 15 seconds after the files begin recording, select the “Enable” 
“PEGcasting” option.  To use the PEGcasting Next to Live autoplay feature for 
simulated live broadcasting, you must still complete the “PEGcasting N2L” 

configuration settings on the “NEXUS/UltraNEXUS” tab (see “Setting Up Transfer 
Destinations,” on page 355). 

 “Closed Captions”: Select the “Enable Closed Captions” option to capture any 
closed caption data from the source.  Closed captions are hidden in the video 
signal and decoded for display on televisions with built-in decoders or televisions 
connected to external decoders. 

ULTRANEXUS ONLY: RECORDING 

WebNEXUS allows UltraNEXUS users to immediately start/stop file recordings and 
add index point to any PEG Central VOD file that is being recorded.  Start/Stop 

recording and add index points to your files through the “MPEG Recorder” panel on 
the WebNEXUS sidebar as follows: 

NOTE: Ensure the desired record quality, name, and automation settings have been 
selected on the “File Destinations”/”Record Settings” tab (see “UltraNEXUS 
ONLY: Setting up MPEG File Record Settings,” on page 360 for instructions). 

Illustration 212, MPEG Recorder Closeup 

 

1. Choose the video source you want to record from the “Source” drop down menu.  

You may select one of your UltraNEXUS’s MPEG players or a video source 

connected to your switcher. 

2. Click the record button to start recording your file.  

Stop Record Button 

Index Point  
Name Field 

“Set Index” Button 

“Clear Index” Button 

Record Button 

Video “Source” 

Drop Down Menu 



NEXUS Series 

Web Control 

Page 362   LEIGHTRONIX, INC. 
WinLGX ver. 7.0.2.60  2018-06-08 
 

3. LEIGHTRONIX LGX-SVOD and PEG Central VOD Streaming Service Users Only: 

add video index points for use in PEG Central or other LEIGHTRONIX VOD 

streaming application.  Index points appear as links next to the published video in 
the streaming application’s player window, allowing viewers to quickly move to 
points of interest within the video.  

Either enter a custom name (64 characters maximum) for your index points into the 
index name field or leave it blank and the UltraNEXUS will use the current 

date/time as the name. Each index point also indicates the hours:minutes:seconds 
into the video that it marks. When you have chosen your naming method, click the 
“Set Index” button to add an index point to the recording file. Create additional 

index points at key intervals in the recording with each click of the “Set Index” 
button.  If a custom name was entered, each additional index point will be assigned 
the same custom name until the name field is reset. To add an index point with a 

new custom name, click the “Clear Index” button and then type a new name into 
the name field before clicking the “Set Index” button.    

4. To end the recording session, click the stop recording button.  If a file destination 

was configured and enabled in WebNEXUS, your recorded file will be automatically 

transferred to the destination. 
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MANUALLY TRANSFERRING MPEG FILES 

Click the “Files” menu button to display the screen shown in Illustration 213.  The “File 
Management” screen displays a “Video Files” listing of the MPEG video files on your 

UltraNEXUS system’s storage volumes and an MPEG/VOD file transfer queue.   

NOTE: Ensure that any destinations you want to receive files have been configured 
on the “File Destinations” screen. 

Illustration 213, Pop-Up Menu for "Video Files" Listing on the "File Management" Screen 

 

VIEW FILE INFORMATION 

Hovering over a filename in the “Video Files” listing with your mouse pointer will bring 
up a popup that shows the file’s storage volume, filename, length, size, and date of 
creation.  Except for storage volume, this information is also displayed in each row of 
the “Video Files” listing. 

“Video Files” Listing 
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ADD FILES TO TRANSFER QUEUE 

Under the “Video Files” listing, use one of the following methods to add an MPEG file 
to your transfer queue: 

 Drag the desired file to the right side of the screen 

 Double click the desired file 

 Single click on the MPEG file you would like to transfer and click the “Add” 
button to transfer the file to any configured destination(s) 

 Right click on the file and select a configured destination(s) from the pop-up 

menu (see Illustration 213).   

RENAME MPEG FILES 

Under the “Video Files” listing on the left side of the screen, either single click on the 

file you would like to rename and then click the “Rename” button or just right click on 
the file and select “Rename” from the menu that appears (see Illustration 214).  In the 
“Rename File” window that appears, enter a new filename of up to 27 alphanumeric 
characters, no spaces, and click “Ok” to accept the change or “Cancel” to abort.    

Illustration 214, Pop-Up Menu for "Video Files" Listing on the "File Management" Screen 

 

DELETE FILES FROM STORAGE DEVICE/TRANSFER QUEUE 

• Storage Device:  under the “Video Files” listing, either single click on the file you 

would like to delete and then click the “Delete” button or just right click on the file 
and select “Delete File” from the pop-up menu.  Click “Yes” when prompted to 
delete the file or “No” to abort. 

• Transfer Queue: to delete a single file under “Video Transfers,” either single click 
on the file you would like to delete and then click the “Remove” button or just right 

click on the file and select “Remove Transfer” from the pop-up menu.  To remove 
all files from the transfer catalog, either single click on a file and then click the 
“Remove All” button or just right click on the file and select “Remove All Transfers” 
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from the pop-up menu.  Click “Yes” when prompted to delete the file(s) or “No” to 
abort. 

CHANGE FILE TRANSFER DESTINATIONS 

Change the destination of any file in the “Video Transfers” queue by right clicking on 
the file and selecting one of the add/remove options in the popup menu (see 

Illustration 215).  The remove options de-select current file transfer destinations, while 
the add options transfer the file to the corresponding destinations.   

Illustration 215, Pop-Up Menu for "Video Transfers" Listing on the "File Management" Screen 

 

STOP FILE TRANSFERS 

End a file transfer from the “Video Transfers” queue by either single clicking the 

filename and then clicking the “Remove” button or right clicking on the file and 
selecting the remove option for the file’s intended destination.  To end all file transfers, 
either click the “Remove All” button or right click on a file and select the “Remove All 

Transfers” option. 
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MANAGING LOG FILES 

Each NEXUS series server keeps track of everything done to or by it in internal log 
files which are accessible from WebNEXUS.  Click the “LOGS” menu button to display 

the list of current logs for your NEXUS series server on the “Log Files” screen (see 
Illustration 216 and Table 56).  

Illustration 216, "Log Files" Screen 

 

Table 56, Log File Types 

Log File Type Description 

Playback Event Each playback event log file is a monthly record of MPEG 
video and slide playback events scheduled on your NEXUS 

series system (see Illustration 196 for an example).  Playback 
event log filenames are formatted as “PLyear-month.CSV.” 

Tracked in each playback event log are playback event dates 
and start times, format types, device types, and other major 
event descriptors, including the status of each event.  Event 

execution results are logged in the file’s “Result” column, with 
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Log File Type Description 

“OK” indicating the event was successfully completed and 

“Exception” meaning the event did not occur.  For those 
events with the “Exception” status, refer to the “Report” column 
in the file for more information about why the playback event 

was not executed. 

System Event The NEXUS series system activity log files are called 
“EVENTS.LOG” and “OLDEVNTS.LOG” (see Illustration 198 

for example).  When a new NEXUS series system is powered 
on for the first time, it creates a file called “EVENTS.LOG.”  
The NEXUS series system will continually write to this file until 

it reaches 7 MB.  Once “EVENTS.LOG” reaches 7 MB, the 
NEXUS will rename it to “OLDEVNTS.LOG” (deleting the 
previous “OLDEVNTS.LOG”) and then create a new 

“EVENTS.LOG.” This ongoing cycle ensures that recent 
events are always logged. 

The system event logs are useful in identifying specific events 
occurring on the NEXUS series system, such as when a 
particular program aired, user logins, file transfers, all 

schedule event actions, and more.  Refer to page 341 for more 
detailed information on system event logs. 

Firmware Update NEXUS series server systems create log files that specifically 

track firmware installations.  LEIGHTRONIX uses firmware 
update logs to troubleshoot unsuccessful firmware updates.  A 
separate firmware update log is created each time you update 

your NEXUS series server and is named after the 
corresponding firmware update file.   

Disk Diagnostics The “scan_C.log” file displays information from the most recent 

NEXUS series server drive scan performed with the “Disk 
Diagnostics” utility.  The “scan_C.log” file is automatically 
overwritten each time you run a drive scan. 

   
Manage your NEXUS series server log files according to the following: 

SAVE/OPEN A LOG FILE 

From the top panel on the “Log Files” screen, single click on the desired log file to 
select it and then click the “Save” button to display an open/save file dialog box.  Either 
open or save the selected log file on your computer or network as a .txt file. 

SEARCH A LOG FILE 

Search for specific entries within either of the event or firmware logs.  From the top 
panel on the “Log Files” screen, single click the desired log file to display the “Find” 
box and corresponding log information.  Enter your search term into the “Find” box and 
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click the “Search” button to filter out any entries not containing the search term.  Use 
the “Previous” and “Next” buttons to move up and down between entries in the log file.  

DELETE A LOG FILE 

From the top panel on the “Log Files” screen, single click the desired log file to select it 
and then click the “Delete Log” button.  A popup box will appear, asking whether or not 
you wish to delete the file.  Click “Yes” to delete or “No” to abort. 
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MANAGING SLIDES 

Click the “Slides” menu button to display the "JPEG Slide Management" Screen (see 

Illustration 205, “System Dashboard” Screen).  The WebNEXUS slide management 
screen allows all users to upload, create, edit, and delete slides in their own user 
account folders on your NEXUS series server/controller.  Additionally, all users may 

specify if and when their slides will appear in slide shows through each slide’s 
metadata settings.  The following subsections provide instructions for using the slide 
management features. 

IMPORTANT!  SLIDES MUST BE AUTHORIZED AND ENABLED BEFORE 

THEY WILL DISPLAY IN SLIDE SHOWS.  Refer to “Approving 
Slides for Display in Slide Shows,” on page 390 for 

instructions on how to enable and authorize slides. 

  Slides and slide shows can only be activated for display through 
the WinLGX scheduler or control panel. 

Illustration 217, "JPEG Slide Management" Screen 
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UPLOADING SLIDES TO A NEXUS SERIES SERVER/CONTROLLER 

NOTE: Slides within each user folder play back in alphabetical order when 
scheduled in slide shows, so assign filenames accordingly. 

1. In the “File” list on the lefthand side of the screen, single click on the user folder 

you want to contain the slide.   

2. Click the  button to open the upload file window shown in Illustration 218.   

Illustration 218, New Slide Upload Window 

 

3. Click the  browse button to open the “Select file(s)” window shown in Illustration 
219.  Navigate to the desired file and click “Open.” 

NOTE: NEXUS series server/controllers only support slide names containing up 
to 27 characters (no spaces) in addition to the “.jpg” extension. 
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Illustration 219, “Choose File to Upload” Window 

 

4. WebNEXUS allows you to add and remove slides from the “Upload File” window as 
follows: 

 Add slides: to upload a batch of slides, click the plus  button and repeat step 

3 for each additional slide.   

 Remove one slide: click the red “x”  button next to the slide you wish to 

remove. 

 Remove all slides: click the blue trash  button to clear the upload file listing. 

5. Click the  upload button to load the slide(s) onto the NEXUS series system or 

“Cancel” to abort the change (see Illustration 220).  When each slide has finished 
loading, the “Upload File(s)” window will indicate the slide is “100%.” 



NEXUS Series 

Web Control 

Page 372   LEIGHTRONIX, INC. 
WinLGX ver. 7.0.2.60  2018-06-08 
 

Illustration 220, "Upload File" Window 

 

6. When you have finished uploading files, click the close “x” button in the upper right 

corner of the window. 
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CREATING NEW SLIDES 

The following section describes the NEXUS series server slide editors.  The NEXUS 
includes a basic slide editor that allows users to upload their own images or select 

from included images and then add text and/or graphics.  The UltraNEXUS and 
UltraNEXUS-SDI come with an Advanced Slide Editor, which builds on the NEXUS 
slide editor functions to provide enhanced drawing and image effects tools as well as 

the ability to capture images from your webcam. 

NOTE: Throughout this section, screen captures of the Advanced Slide Editor 

are used to illustrate the text and descriptions of its more advanced 
features are also included.  Some features are only available to 
UltraNEXUS and UltraNEXUS-SDI users and are excluded from the NEXUS 

slide editor.  Contact the LEIGHTRONIX sales department to learn more 
about upgrading to an UltraNEXUS. 

Click the  button on the “JPEG Slide Management” screen to open your NEXUS 
series server’s slide editor window (see Illustration 221, Advanced Slide Editor 
Window and Illustration 222, Advanced Slide Editor Toolbox) or, if you have already 

been working in your slide editor, select the “File”/”New” menu option.  To abort your 

changes and close the slide editor, click the  button in the upper right corner of the 

editor or select the “File”/”Close” menu option and then click the “Close Without 
Saving” button. 

Illustration 221, Advanced Slide Editor Window 

 



NEXUS Series 

Web Control 

Page 374   LEIGHTRONIX, INC. 
WinLGX ver. 7.0.2.60  2018-06-08 
 

1. Using the “Grid” menu options, set up your canvas grid and safe title/safe action 
guidelines to aid in slide layout: 

 “Grid Settings”: use to adjust the color and spacing of the canvas grid 

 “Show Grid”: toggles the canvas grid on/off 

 “Snap to Grid”: when checked, elements re-positioned on the canvas will align 
with the nearest grid lines 

 “Grid at Top”/”Grid at Bottom”: toggle between these options to move the grid 

from the top of your layer stack to underneath all of your layers 

 “Safe Title”: use to toggle the red safe title border on/off.  Text that extends 

beyond the safe title area may be cut off when the slide is displayed on-air. 

 “Safe Action”: use to toggle the red safe action border on/off.  The portion of 

any graphic that extends beyond the safe action area may be cut off when the 
slide is displayed on-air. 

2. Add graphics and/or text to the slide editor’s canvas using the tools in the editor’s 

toolbox (see Illustration 222).  Each new graphic or text element will be 

automatically placed on a separate layer, allowing you to individually manipulate 
each image and text message on the canvas (see the “Layer Management” section 
below).  Refer to the following “Layer Types” section for more information on the 

graphics and text that may be added to the editor’s canvas and the custom display 
settings available for each layer type. 

NOTE: Some tools are not available in the NEXUS slide editor. 

Illustration 222, Advanced Slide Editor Toolbox 

 



NEXUS Series 

Web Control 

LEIGHTRONIX, INC.  Page 375 
2018-06-08  WinLGX ver. 7.0.2.60 
 

Layer Management 

When adding your layers, keep in mind the following slide editor layer management 

features: 

 Zoom (UltraNEXUS/UltraNEXUS-SDI Only): if no layer is selected, the 

“Canvas Info” panel displays the width and height of the canvas in pixels, while 
also providing a zoom slider for viewing the canvas in more or less detail.  

 Delete: to remove a layer from your slide, select the layer on the canvas with 

the  cursor tool or by clicking on the layer in the “Layers” panel.  Click the 

 icon on the bottom of the “Layers” panel or press your keyboard “Delete” 
key. 

 Graphic Toolbar (UltraNEXUS/UltraNEXUS-SDI Only): each slide editor also 
provides a universal graphic toolbar that provides display settings for any layer 

type except text (see Illustration 223).  The graphic toolbar appears at 

the top of the editor whenever the cursor tool is clicked or an image layer 
is added to the canvas.  To apply any of the settings described in Illustration 
223, first select the layer on the canvas with the cursor tool or by clicking on its 

layer in the “Layers” panel.  

Illustration 223, Graphic Toolbar 

 

Layer Types 

The following is a list of the graphic/text elements you can add to your slide 

canvas: 

 Images: add one or more .JPEG, .PNG, or .GIF image files to the canvas from 
any of the following sources: 

 Local storage area 

a. Click “Image”/”Import” to open the “Select file to upload” window. 
b. Navigate to an image file and click “Open.”   

 UltraNEXUS/UltraNEXUS-SDI only: third-party webcam 

a. Click “Image”/”Webcam” or click the  webcam tool to open the 
editor’s “Webcam” window.   

b. If this is the first time you have opened the “Webcam” window since 
connecting a webcam to your computer, you will see a settings box.  
From the “Privacy” panel, allow your UltraNEXUS system to access your 

webcam by clicking the “Allow” option (see Illustration 224).  Save this 
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setting by clicking “Remember” and then click “Close” to exit the settings 
box. 

NOTE: If the “Privacy” panel is not currently displayed, click the  
icon. 

Illustration 224, Webcam "Privacy" Setting 

 

c. Click the “Ok” button to create a still image from the current webcam 
display or “Cancel” to return to the canvas without creating an image.  

Any image created will be in the resolution of your webcam (typically 640 
x 480 pixels). 

  Clip Art Tool: click the clip art tool to display a window containing the 

graphic backgrounds and images included with your slide editor along with 
any custom JPEG/PNG background files that may have been uploaded 

through the WinLGX “Storage Manager” window.  To add an image graphic 
to the slide canvas, just click on the image. 

 Gradient Layer 

An easy way to create a background for your slide is with the  gradient tool.  
Click the gradient tool and select your gradient color, pattern, and opacity from 
the gradient toolbar at the top of the editor (see Illustration 225) according to the 
following: 

Illustration 225, Gradient Toolbar 

 

 Select gradient pattern 

o “Linear”: select “Linear” to create a gradient that transitions in the 

direction of the line you create when dragging the gradient tool across 
the canvas.  The first and last points of the line mark the start and end of 
the gradient, which transitions from left to right through the color cup 

values on the “Spread” bar.  The shorter the line, the more abrupt the 
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gradient color transitions will be.  Choose one of the three linear gradient 
patterns: 

− “Pad”: extends the last color cup value in your gradient from where 
your gradient line stops to fill the remainder of your canvas 

− “Reflect”: a mirror image of your gradient will be reflected on both 
ends of your drawn line and, depending on the length of your gradient 
line, will continue reflecting throughout the canvas 

− “Repeat”: your gradient will repeat the length and direction of your 
drawn line across the canvas, with short lines resulting in greater 

repetition 
o “Radial”: the gradient line you create forms the radius of a circle, with 

the first point of the line establishing the center of the circle.  The radial 

gradient starts with the leftmost “Spread” color cup value at the center of 
the circle and concludes with the last color cup value forming the 
outermost diameter of the circle and filling the remainder of the canvas.  

 Change gradient color values 

Create a gradient that transitions between two or more colors of your 
choosing with the “Spread” color value bar.  By default, the left end of the 
bar will automatically show a lighter color cup transitioning to a darker color 

cup on the opposite end.  To change, perform any of the following: 

− Change a color: double click the color cup to display the “Color Picker” 

window.  Use the slider to adjust the color palette and then click on a 
color within the palette.  Click “Ok” to make your selection.   

− Add color cups: increase the number of color transitions within your 
gradient by clicking on the “Spread” bar to add a color cup.  Drag the cup 
to the desired position on the bar.   

− Delete a color cup, single click the color cup icon and then click the “X” 
button. 

 Change gradient opacity 

Change the opacity of each color value in your gradient by single clicking on 
a color cup icon and then typing a number value from 0 to 100 into the 
“Alpha” box. A value of “0” renders the color invisible, while “100” returns the 

color to full opacity. 

With the gradient tool positioned over the canvas, click your left mouse button 

and drag the tool across the slide canvas to create your gradient layer.  The 
gradient created will be based on the length and direction of the line you 
dragged on the canvas.  If you don’t like the effect, you can always delete the 

layer and experiment with dragging your gradient tool in different directions and 
lengths. 

 Shapes 

Click the desired basic shape tool or, for UltraNEXUS/UltraNEXUS-SDI users, 
the polygon or arrow shape tool (see Illustration 222, Advanced Slide Editor 
Toolbox).  With your mouse pointer positioned over the editor’s canvas, hold 

down the left button on your mouse and drag the pointer to create your shape.  
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When you let go of your mouse button, the editor will finalize your shape and 
add the shape element to a canvas layer. 

Use the shape/line toolbar at the top of the editor (see Illustration 226) to select 

the shape’s fill and outline color, outline width, and orientation according to the 
following: 

Illustration 226, Shape Toolbar 

 

Shape Gradients: clicking on the gradient fill swatch will open the window 

shown in Illustration 227.  When you have finished selecting your gradient 
settings based on the following information, click “Ok” to make your changes.  

Illustration 227, "Gradient Fill" Window 

 

 Select gradient pattern  

o “Linear”: select “Linear” to automatically apply a gradient that transitions 
in a straight line across your selected shape.  “Linear” gradients may be 

rotated clockwise from 0 to 360 degrees within your shape by either 
using the “Rotate” slider or entering a degree number value in the 
“Rotate” field and pressing your “Enter” key. 

o “Radial”: select “Radial” to automatically apply a circular gradient to the 
center of your shape.  Radial gradients begin with the leftmost “Spread” 
color cup value at the center of the circle and conclude with the last color 

cup value forming the outermost diameter of the circle and filling the 
remainder of the shape. 

Color Cup 

No-Fill Swatch 

Color Swatch 
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 Change gradient color values 

Create a gradient that transitions between two or more colors of your 
choosing with the “Spread” color value bar.  By default, the left end of the 
bar will automatically show a lighter color cup transitioning to a darker color 

cup on the opposite end.  To change, perform any of the following: 

o Change a color: double click the color cup or first single click the color 

cup and then the color swatch to display the “Color Picker” window.  Use 
the slider to adjust the color palette and then click on a color within the 
palette.  Click “Ok” to make your selection.   

o Add color cups: increase the number of color transitions within your 
gradient by clicking on the “Spread” bar to add a color cup.  Drag the cup 

to the desired position on the bar.   

o Delete a color cup, single click the color cup icon and then click the “X” 

button. 

 Change gradient opacity 

Change the opacity of each color value in your gradient by single clicking on 
a color cup icon and then typing a number value from 0 to 100 into the 

“Alpha” box. A value of “0” renders the color invisible, while “100” returns the 
color to full opacity. 

 Remove fill color from shape: click the  no-fill swatch to completely 
remove any color applied to your shape and close the “Gradient Fill” 
window. 

 Lines 

Your slide editor provides the following tools for drawing lines.  When you select 
a line tool, use the shape/line toolbar that appears at the top of the editor (see 

Illustration 226) to select the line’s color and thickness. 

 Straight line: click the  line tool and use your mouse to position the tool 
on the canvas.  Hold down your left mouse button and drag the tool to 

create a straight line at any angle.  Let go of the mouse button to finalize 
your line and add the line element to a canvas layer. 

 Freeform line (UltraNEXUS/UltraNEXUS-SDI only): click the  pencil 

line tool and use your mouse to position the tool on the canvas.  While 
holding down your left mouse button, drag the tool to draw a custom line.  
Let go of the mouse button to finalize your line and add the line element to a 

canvas layer.  

 Curved line (UltraNEXUS/UltraNEXUS-SDI only): click the  curved line 

tool and use your mouse to position the tool on the canvas.  Hold down your 
left mouse button and drag the tool to create a straight line at any angle.  
When the line is the length you want, let go of the mouse button.  Then left 

click on the line and while holding down the mouse button, drag your mouse 
to curve the line in the direction you are dragging.  Let go of the mouse 
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button to finalize your curved line and add the line element to a canvas 
layer. 

 Text 

Click the  text tool.  Use the text toolbar that appears at the top of the editor 
(see Illustration 228) to select the orientation, font, font size, and color. 

Illustration 228, Text Toolbar 

 

Click your mouse pointer on the area of the canvas that you would like to add 
text.  Type in your message and then press your keyboard “Enter” key to add 

the text element to a canvas layer. 

3. If desired, enhance individual graphic and/or text layers with graphic effects.  To 

apply an effect, first select a layer on the canvas with the cursor tool or by clicking 
on its layer in the “Layers” panel.  Change any of the following: 

 Layer Position: when a layer is selected, the “Canvas Info” panel displays the 

position of the layer along the canvas’s x and y axes.  The x/y position values 
for the selected layer may be changed by typing a new value into either or both 

fields and pressing the “Enter” key. 

 Layer Size 

When a layer is selected, the “Canvas Info” panel displays the height and width 

of the selected layer element.  The height/width values for the selected layer 
element may be changed by simply typing a new value into the desired field(s) 
and pressing the “Enter” key.  If the height/width values are locked, entering a 

new value in only one of the fields will keep both values true to the proportion of 
the original dimensions.  To distort the layer element by only changing the 
height or width, click the padlock to unlock before entering in the new 

dimension. 

 Color of Shape/Line/Text 

 Choose a color from any graphic/text element on the canvas: select the 

 eyedropper tool and then click on a color within any canvas element. 

 Select a color from the “Swatches” color palette: click on the “Swatches” 

tab to display the color palette (see Illustration 229).  Click on one of the 
color swatches to select a new color. 
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Illustration 229, "Swatches" Tab Panel 

 

 Image Saturation (UltraNEXUS/UltraNEXUS-SDI Only) 

Desaturate: click the  black/white tool to remove the color from a selected 
image layer. 

 Text Filter Effects (UltraNEXUS/UltraNEXUS-SDI Only): clicking a text filter 
effect icon will cause selected text to take on the look depicted by the filter icon 

(see Table 57, Text Filter Effects). 

Table 57, Text Filter Effects 

Filter Icon Effect Name Result 

 

Black Plastic 

 
 

 

Candy 

 

 

Casino 

 

 

Chrome 

 

 

Gold 

 

 

Horizon 

 

 

Horizon2 

 

 

Mercury 
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Filter Icon Effect Name Result 

 

Metal 

 

 

Neon 

 

 

Plastic 

 

 

Water 

 

 Layer Blend Modes (UltraNEXUS/UltraNEXUS-SDI Only): on the “Layers” 

panel, click the down arrow next to “Normal” to display a drop down menu of 
layer blend effects.  The blend modes create a composite image from the 
selected layer and, depending on their canvas size and opacity, the first one or 

more layers below it in the layer stack.  Refer to Table 58, Layer Blend Modes, 
for a description of each blend mode. 

Table 58, Layer Blend Modes 

Filter Effect Result  

“Normal”: Returns the selected image layer to 

its original settings 

 
“Add”: Blends layers together by adding the 

colors in the selected layer to the 
colors in the underlying layer(s) 

 
“Alpha”: N/A  
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Filter Effect Result  

“Darken”: Blends the selected layer with the 
layer(s) below it, putting the darker of 
the colors from each layer on the 

surface 

 
“Difference”: Blends the selected layer with the 

layer below it, subtracting the RGB 
values of the darker colors from the 

RGB values of the lighter colors to 
the obtain color values for the 
blended image 

 
“Erase”: N/A  

“Hardlight”: Darkens the darkest areas on the 
selected layer while blending the 
lightest areas with the layer(s) below 

it 

 
“Invert”: Displays the layer(s) just beneath the 

selected layer and changes the 
colors of the underlying layer(s) to 

their opposite RGB color values 

 
“Layer”: N/A  
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Filter Effect Result  

“Lighten”: Blends the selected layer with the 
layer(s) below it, putting the lighter of 
the colors from each layer on the 

surface 

 
“Multiply”: Blends the selected layer with the 

layers below it by multiplying the 
layers’ RGB color values together for 

a darkening effect 

 
“Overlay”: Blends the selected layer with the 

layer(s) below it by lightening the 

lighter pixels and darkening the 
darker pixels in each layer 

 
“Screen”: Blends the selected layer with the 

layer(s) below it by multiplying the 

opposite RGB color values of the 
selected layer by the complementary 
RGB color values of the underlying 

layer 
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Filter Effect Result  

“Subtract”: Subtracts the RGB color values in 
the selected layer from RGB color 
values in the underlying layer(s) 

 

 Layer Filters (UltraNEXUS/UltraNEXUS-SDI Only) 

 Blur 

Click the  blur tool or select “Filters”/”Blur” to display the “Blur” window.  
Adjust the sliding scale between “0” to “50” to decrease/increase the amount 
of blur applied to the selected element.  Click “Ok” to make the change or 
“Cancel” to abort. 

 Sharpen 

The sharpen filter creates more defined edges in fuzzy and dim image 

layers by increasing the contrast between light and dark pixels.  Apply the 
“Sharpen” filter to your selected image layer by selecting “Filters”/”Sharpen.”  

The “Sharpen” filter may be repeatedly applied to achieve the desired effect.  

 Bevel 

A quick way to create a three dimensional effect, the “Bevel” filter gives each 
selected layer a shadow on its right and bottom inner edges and a highlight 

on its top and left inner edges.  To apply, select “Filters”/”Bevel” to display 
the “Bevel” window.  Use the “Blur” and “Distance” sliders to customize the 
bevel effect and then click “OK” to finalize or “Cancel” to abort. 

Illustration 230, "Bevel" Effect Window 

 

 Glow 

The “Glow” filter applies a blurred shadow of a custom size and color to the 

outer edges of the selected layer.  To apply, select “Filters”/”Glow” to display 
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the “Glow” window.  Use the color swatch and “Distance” slider to 
respectively adjust the color and size of the glow.  Click “OK” to finalize or 

“Cancel” to abort. 

 Shadow 

Use the “Shadow” filter to add dark shadow to the right and bottom outer 
edges of the selected layer.  To apply, select “Filters”/”Shadow” to display 

the “Shadow” window and use the “Blur” and “Distance” sliders to customize 
the effect.  Click “OK” to finalize or “Cancel” to abort. 

4. When you have finished making changes, save your slide by clicking the  save 

icon or selecting the “File”/”Save” menu option.  The “Save Slide” window shown in 

Illustration 231 will appear, allowing you to add metadata to your slide that will 
control display of the slide in slide shows.  Perform the following:   

Illustration 231, "Save Slide" Window 

 

a. In the “File Name” field, type in a filename with up to 27 characters (no spaces).  
If the filename already exists, a pop-up box will prompt you to either click “Ok” 

to overwrite the existing file or “Cancel” to enter a new filename on the “Save 
Slide” window. 

b. If you logged into WebNEXUS under an “admin” account or are using an 
account with the “slide administrator” or “automatic slide authorization” right, the 
“Authorize” box will be available for selection.  Authorize the slide for display in 

slide shows by checking the “Authorize” box (see “Approving Slides for Display 
in Slide Shows” on page 390 for more information on authorizing slides).  

c. Complete the remaining slide show metadata fields according to the instructions 
in “Adding Slide Show Settings to Slide Metadata,” on page 388, with the 
following exceptions: 

 “Program Guide”: checking the box will cause the slide to show the 

scheduled, upcoming programs for the channel its slide show is displayed 
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on, while leaving the box unchecked disables the program guide setting for 
the slide during slide shows 

 “Duration”: type in or use the up/down arrows to select the number of hours, 
minutes, and/or seconds (hours:minutes:seconds) that you would like the 

slide to display within a slide show 

d. Click “Ok” to save or “Cancel” to abort.  The slide editor automatically saves a 

.jpeg and .fie file for each slide, where the .jpeg file is the actual slide and the 

.fie file contains the editable layers data for the slide.  The .fie files are only 
visible in the WinLGX Storage Manager window and are useful if you wish to 

transfer slides to a local storage device and then back to your NEXUS series 
server for editing in your slide editor (see “Managing Storage of Video, Slide, 
and Overlay,” starting on page 328). 

CREATING A DEFAULT SLIDE 

Create a default slide that will automatically display if a slide show is scheduled 
without slides or without approved slides.  

1. Select the “admin” user folder in the “File” list.  Your NEXUS series system will only 

look for a default slide in the “admin” user folder. 

NOTE: If you do not see an “admin” folder, the user account you logged into 
does not have “admin” or “Slide Administrator” rights. 

2. Upload the slide you would like to serve as the default (see “Uploading Slides to a 

NEXUS Series Server/Controller,” on page 370). 

3. Rename the slide to “Default.jpg” (see “Renaming Slides on a NEXUS Series 

Server/Controller,” on page 392). 

4. Approve the slide for display (see “Approving Slides for Display in Slide Shows,” on 
page 390). 

FINDING SLIDES/USER FOLDERS 

WebNEXUS provides the following tools for managing and searching your slide list for 
user folders and files: 

 “Expand All/Collapse All” links: by default, the WebNEXUS slide management page 
opens with all slide user folders fully expanded.  If you have a lot of slides, this can 

make for a really long file listing.  To quickly locate a particular folder of slides, click 
the “Collapse All” link at the bottom of the window.  This action is easily reversed 
by clicking the “Expand All” link. 

 “Filter” box: if you know the name or even the first few letters of the filename or 

folder you are looking for, display the “Filter” box by clicking the drop down arrow 
next to “Filter.”  Then type the name of a file or folder to find an exact match or just 
enter the first few letters to get a list of possible files and folders.  
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ADDING SLIDE SHOW SETTINGS TO SLIDE METADATA 

Each NEXUS series server/controller processes slide metadata to determine when 
your slides will appear in scheduled slide shows.  Perform the following steps to modify 

the slide show availability settings for your slides (refer to “Scheduling/Editing Library 
Resources,” on page 275, for information on scheduling a slide show).   

NOTE: Slide metadata settings do not put your slides on-air.  The settings limit 

when the slides will appear when scheduled in slide shows.  All slide 
shows must be scheduled for display through WinLGX.     

1. Select the desired file in the “File” list to enable the metadata fields on the right side 
of the slide management screen (see Illustration 232, Slide Metadata Fields).  The 
following settings may be modified: 

Illustration 232, Slide Metadata Fields 

 

 “Transition Effect” drop down list: select from the following to determine how 
the slide will be displayed on screen: 

 “Cut”: displays entire slide image at once  
 “Random Wipes”: reveals slide image with 14 possible transitions 
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 “Slide Duration” drop down list: select between 5–99 seconds to determine 

how long the slide will be displayed on screen.  

 “Guide Channel” drop down list: use this setting to display a list of up to ten 

upcoming programs on the selected slide during a slide show.  Each program is 
listed on the program guide according to its schedule event time and 
“Comment” text in the default font size, color, and style (see Illustration 105, 

Example of Onscreen Program Guide, on page 204).  The “File” list will show a 

 icon next to each slide that has the program guide option activated.  Select 

one of the following options:   

 “OFF”: disables the program guide setting for the slide 

 “AUTO”: slide will display its scheduled channel’s upcoming programs 
 Channel Output:  slide will display the selected channel’s upcoming 

programs, regardless of which channel the slide show is scheduled on 

 “Limit Date” button: if you would like the slides to appear only between 

specified dates, click to check the corresponding box and perform any of the 
following steps: 

 Enter the slide display start date into the top month/day/year fields and 
the display end date into the bottom month/day/year fields by using the 
corresponding drop down calendar.  Just click in either field to display 

the calendar and perform the following: 
a. First select the appropriate month and year as follows: 

o Click on the calendar month to show a list of months. Click to 

select the desired month. 
o Click on the calendar year to show a list of years. Click to select 

the desired year. 

b. Next, select the date on the calendar by clicking. 
 Click the “Today” button to automatically enter today’s date into the top 

and bottom month/day/year fields.   

 Click the “1 Week” button to automatically enter today’s date into the top 
month/day/year fields and the date seven days from today into the 
bottom month/day/year fields. 

 Click the “2 Weeks” button to automatically enter today’s date into the 
top month/day/year fields and the date fourteen days from today into the 
bottom month/day/year fields. 

 Click to check the “Automatic Delete” box if you would like the slide 
deleted from the NEXUS series system at the conclusion of the display 
period. 

 “Limit Days of Week” fields: check the desired day boxes to specify which 

days you would like the slide displayed and/or use the following buttons: 

 “All Days”: click this button to automatically select every day of the week.  

 “Mon-Fri”: click this button to automatically select Monday through Friday. 
 “Sat & Sun”: click this button to automatically select Saturday and Sunday.  
 “Clear”: click this button to clear the day fields. 
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 “Limit Time of Day” fields: click to check the “Limit Time of Day” box to 

enable the time fields and perform any of the following steps: 

  Type in the start and end times for slide display and select AM or PM for 

each from the drop down boxes.  
 Click the “Morning” button to automatically enter 12 am into the “Start” field 

and 12 pm into the “End” field 

 Click the “Afternoon” button to automatically enter 12 pm into the “Start” field 
and 5 pm into the “End” field 

 Click the “Evening” button to automatically enter 5 pm into the “Start” field 

and 12 pm into the “End” field 

2. Click the  button to save your slide metadata.  If you don’t click the 

“Save Metadata” button, your changes will be lost when you select a different slide 
or folder or close the slide management screen. 

3. If desired, enable and authorize the slide for display in slide shows according to 
“Approving Slides for Display in Slide Shows” on page 390. 

APPROVING SLIDES FOR DISPLAY IN SLIDE SHOWS 

There is a two part approval process for allowing each slide to be part of a slide show.  
Each slide must be enabled as well as authorized for slide show display as described 
below. This approval process does not apply to the display of single slides. 

 “Enable” Slides: when set, the “Enable” setting tells your NEXUS series server that 

the slide is allowed to be included in slide shows.  Each user has the ability to 
enable slides in his own user folder, while the “admin” user and users with the 
“Slide Administrator” right can change the “Enable” setting for all slides.  To enable 

a slide, just select the slide in the “File” list and click the  button.  Each 

enabled slide will have a  icon next to it in the “File” list. 

 “Authorize” Slides: the “Authorize” setting lets your NEXUS series server know 

whether or not each slide has been approved for display in slide shows by the 
system “admin” user or a user with advanced slide management rights. 

 Automatic approval: all slides uploaded by user accounts granted the 
“automatic slide authorization” user right will be automatically approved for 

display in slide shows.  The “admin” account and user accounts with the “slide 
administrator” right automatically have this right.  Refer to “Setting User Account 
Rights (Including WinLGX Password Changes),” on page 110 for more 
information on assigning users the “automatic slide authorization right.”  

 Selective approval: the “admin” account and accounts with the “slide 
administrator” right can also approve slides that have been uploaded through 

accounts without the automatic slide authorization right as follows (refer to 
Illustration 233, WebNEXUS Authorize and Enable Buttons, throughout the 
following steps): 
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Illustration 233, WebNEXUS Authorize and Enable Buttons 

 

1. Scroll to the desired user folder in the “File” list to display the selected 

user’s slides. 

2. Highlight the desired filename in the “File” list. 

3. Click the  button.  The  authorization icon appears in the “File” 
list next to each slide authorized for display in slide shows.  

EDITING SLIDES CREATED IN WEBNEXUS 

WebNEXUS gives you the ability to edit any slides created in your NEXUS series 
server/controller’s slide editor.  Perform the following steps: 

NOTE: Slides can only be changed in the editor used to create them. 

1. From the “JPEG Slide Management” screen, single click on the slide you wish to 

edit in the “File” list (see Illustration 234).  When selected, the slide will be 
highlighted in orange. 

Illustration 234, WebNEXUS Slide Editing Feature 

 

2. If the selected slide can be modified in your slide editor, the “Edit” button will be 
enabled.  Click on the “Edit” button (see Illustration 234) to display your selected 

slide in the slide editor window for your system. 

3. Edit your slide with any of the formatting options described in steps 2 and 3 of the 

“Creating New Slides” section on page 373 

“Authorize” 

Button 

“Enable” 

Button 
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4. Save over your existing slide or save out your changes as a new slide with a 
different filename with up to 27 characters (no spaces) according to step 4 of the 

“Creating New Slides” section on page 386. 

RENAMING SLIDES ON A NEXUS SERIES SERVER/CONTROLLER 

1. Single click to select the desired file in the “File” list. 

2. Click  icon to open the rename window shown in Illustration 235. 

Illustration 235, “Rename File” Window 

 

3. Enter up to 27 characters in the rename field. 

4. Click the “Ok” button to make the change or “Cancel” to abort. 

DELETING SLIDES FROM A NEXUS SERIES SERVER/CONTROLLER 

1. Select the desired file in the “File” list. 

2. Click the  icon.  A dialog box will appear asking whether or not you would like to 
delete the selected slide from the NEXUS series server/controller.  Click “Yes” to 

make the change or “No” to abort. 
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CREATING EMERGENCY MESSAGES 

NOTE: Only the “admin” user and users with the “slide administrator” right 
are able to access the emergency messaging screen. 

Use the emergency messaging feature to immediately alert viewers to weather 
conditions, school closings, road construction, and any other urgent events.  You have 
the option of displaying a partial or full screen graphic with or without a text message 

over scheduled and unscheduled (activated from the Control Panel) digital 
programming.   

The emergency message will be displayed by the selected MPEG player for the 
specified duration or until the message is manually deactivated.  WebNEXUS offers 

varying levels of emergency messaging activation, so that you may choose to have 
your emergency message displayed on whichever channel the selected MPEG 
player(s) is currently switched to or switch and lock the selected player to its 

associated channel (MPEG Player 1 to Channel 1 or MPEG Player 2 to Channel  2).  If 
you are using the UltraNEXUS/NEXUS server’s internal switcher, you may even 
display your emergency message with MPEG Player 1 on all three rear panel outputs 
in one click. 

To create an emergency message, click the “Messaging” menu button to open the 
emergency messaging screen (see Illustration 236, Emergency Messaging Screen) 
and perform the following steps: 

NOTE: To display the emergency messaging steps on the “Emergency Messaging” 
screen, click the expand/collapse arrow button on the “Instructions” panel. 
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Illustration 236, Emergency Messaging Screen 

 

CREATING A NEW EMERGENCY MESSAGE 

1. If you need to clear a previously entered emergency message, click the “New” 

button. 

2. Select a graphic overlay through one of the following methods: 

 In the “File” list window, open the “Graphic Files” or “Saved Presets” folder and 

single click on a file to select it. 

 Search for a graphic overlay file in the “Filter” field.  Click the expand/collapse 
arrow next to “Filter” to reveal the corresponding field and then type any part of 

the filename you are looking for.  WebNEXUS will display all folders/files in the 
“File” window that contain the text in their names.  Single click on the desired 
file to select it. 
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 Click the  button and add your own overlay through the “Upload 
Graphics” window (see Illustration 237).  

NOTE: The emergency messaging feature utilizes “.png” files.  These images 

can be created in most popular graphics programs.  PNG files can 
contain transparent areas, allowing your MPEG player programming to 
be seen behind your overlays. 

Illustration 237, New Graphic Overlay Upload Window 

 

a. Click the  browse button to open the “Select file(s)” window shown in 

Illustration 238.  Navigate to the desired file and click “Open.” 

NOTE: NEXUS series server/controllers only support overlay names 
containing up to 27 characters (no spaces) in addition to the 
“.png” extension. 
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Illustration 238, “Select file(s)” Window 

 

b. WebNEXUS allows you to add and remove overlays from the “Upload 
Graphics” window as follows: 

 Add overlays: to upload a batch of overlays, click the plus  button and 

repeat step 3 for each additional overlay.   

 Remove one overlay: click the red “x”  button next to the overlay you 

wish to remove. 

 Remove all overlays: click the blue trash  button to clear the upload 

graphics listing. 

c. Click the  upload button to load the overlay(s) onto the NEXUS series 

system or “Cancel” to abort the change.  When each overlay has finished 

loading, the “Upload Graphics” window will indicate the overlay file is 
“100%.” 

Illustration 239, "Upload Graphics" Window 
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d. When you have finished uploading files, click the close “x” button in the 
upper right corner of the window. 

3. In the message box on the right, type a sequence of up to 12 pages of two-line 

messages, as shown in Illustration 240.  Move to each new line of text by pressing 
“Enter” on your keyboard.  These messages will appear in the lower third position 
of the overlay screen as 22 pt, bold Ligurino text. The bottom line of text on each 

page is positioned just above the safe title guideline.   

Illustration 240, Text Entry on Emergency Messaging Screen 

 

A preview window at the top of the “Emergency Messaging” screen shows your 
image with safe action and title lines.  Above it, the buttons numbered 1–12 

correspond to the separate two-line text message pages on the overlay.  You can 
view how each page of text will appear on your overlay image by clicking on the 
page number buttons. 

4. On the “Options” panel shown in Illustration 241, complete the following steps: 
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Illustration 241, "Options" Panel 

 

a. From the “Page Dwell Time” drop down list, select how many seconds you 

would like each page of messages to display on the overlay, starting with 8 
seconds, skipping to 10, and then increasing in increments of 5 seconds, up to 
a total of 30 seconds.  Once activated, your message pages will change from 

one to another on the selected overlay. 

b. From the “Event Duration” field, choose to display your emergency message for 

up to 7 days, 99 hours, and 59 minutes or select the “Rest of day” field to 
display the overlay until midnight.  The message pages will continue cycling 
until the duration time completes. 

5. If you wish to save the message for reuse, click the “Save” button. 

6. If desired, activate the emergency message for display according to “Activating an 

Emergency Message,” on page 398. 

ACTIVATING AN EMERGENCY MESSAGE 

1. If you wish to display a saved emergency message, click on the “Saved Presets” 
tab and single click the desired message in the presets listing.  Otherwise, create a 

new message according to the steps in the “Creating Emergency Messages” 
section on page 393. 

2. Click the “Activate” button to display the “Activation Options” dialog box and select 
one of the following three activation levels for your message.  The “System Status” 

panel on the “Emergency Messaging” screen indicates the message activation 
status for each MPEG player. 

 Level 1 (see Illustration 242): click to select either MPEG Player 1 or 2 to display 
your message and then click the “Activate” button.  The selected MPEG player 

will display your emergency message on its current channel output for the 
duration specified on the “Options” panel or until the message is manually 
deactivated.  Non-MPEG events scheduled for the same channel output will 

override the emergency message. 
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Illustration 242, Level 1 "Activation Options" 

 

 Level 2 (see Illustration 243): click the “Activate” button to display your message 

on both MPEG Players 1 and 2.  The MPEG players will display your message 
on their current channel outputs for the duration specified on the “Options” panel 

or until the event is manually deactivated.  Non-MPEG events scheduled for the 
same channel outputs will override the emergency message. 

Illustration 243, Level 2 "Activation Options" 

 

 Level 3 (see Illustration 244): refer to the following for information on the level 3 

activation options.  The message will be displayed for the duration specified on 
the “Options” panel or until the message is manually deactivated.  All scheduled 
events will occur, but the associated switcher actions will be held off until the end 

of the emergency messaging event.  The originally scheduled programming will 
be in progress when it resumes. 
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Illustration 244, Level 3 "Activation Options" 

 

 Display Message on All UltraNEXUS/NEXUS System Outputs: click the 

“Activate All” button to display your message on MPEG Player 1, which will be 
forced and held to all of the outputs on the UltraNEXUS/NEXUS internal 
switcher.  A dialog box will automatically display a warning stating that any 

content currently being displayed on MPEG Player 1 will be broadcasted 
on all channel outputs (see Illustration 245).  Click “Yes” to continue. 

Illustration 245, Level 3 Warning Dialog Box for Activation of all Channels 

 

 Display Message on Channel 1 or 2: click the “Activate P1” button to display 
your message on MPEG Player 1 or the “Activate P2” button to display on 

MPEG Player 2.  The selected MPEG player will be forced and held to the 
output configured in your WinLGX system setup for the channel output tab of 
the same number (MPEG Player 1 to the output on channel output tab 1 and 

MPEG Player 2 to the output on channel output tab 2).  Refer to “Configuring 
the Switch Type of a NEXUS Series System,” page 136, for more information 
on WinLGX channel output tab assignments. 

After you click one of the MPEG player activate buttons, a dialog box will 

automatically display a warning stating that any content currently being 
displayed on the selected MPEG Player will be broadcasted on the output 
assigned to the specified channel (see Illustration 246).  Click “Yes” to 
continue.   
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Illustration 246, Level 3 Warning Dialog Box for Channel 1 or 2 Activation 

 

DEACTIVATING AN EMERGENCY MESSAGE 

To end an emergency message before the event duration completes, click the 

“Deactivate” button. 
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VIEWING WEB PROGRAM GUIDE 

View upcoming programs on the current NEXUS series system schedule from the 

WebNEXUS screen, a web browser, or your own website. 

VIEWING PROGRAM GUIDE WITHIN WEBNEXUS 

1. Click the “Program Guide” menu button to display a program guide screen like the 
example shown in Illustration 247.   

Illustration 247, WebNEXUS Program Guide Screen 

 

2. From the “Channel” drop down menu, click one of the channel outputs to only 
display the programming lineup for the selected channel or click “All Channels” to 
display the programming schedule for all WinLGX channel tabs. 
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3. From the “Mode” drop down menu, select “Day” if you would like to view 
programming for just one day in your schedule (see Illustration 247) or choose 

“Week” to view programming for all seven days of your schedule (see Illustration 
248).  If you choose “Week,” the “Day Headers” buttons are enabled on the toolbar.  
Selecting “on” will cause each day’s programming to be displayed under separate 

day, date, and program time headings, as shown in Illustration 248.  If the “Day 
Headers” option is set to “off,” each day’s programming will be displayed under one 
set of date, day, and program time headers. 

Illustration 248, Program Guide Screen in Week Mode with Day Headers "ON" 

 

Day Headers 
ON 
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4. For the “Day” mode view, click on a day of the week to view programming for the 
corresponding weekday.  If you selected the “Week” mode, clicking a day button 

will sort your programming schedule by the selected day. 

5. If you wish to display the program start time down to the second, click the “Show 

Seconds” “on” button.  The default option is “off.” 

VIEWING PROGRAM GUIDE FROM A WEB BROWSER OR YOUR OWN WEBSITE 

The NEXUS series program guide frame has been validated by the W3C to be a valid 

XHTML 1.0 transitional document.  It has been successfully tested in the following 
browsers:  

 Microsoft Internet Explorer 

 Google Chrome 
 Mozilla Firefox 
 Opera 

 Apple Safari  

Web Browser 

Users without access to the WebNEXUS schedule display can use a web address to 

view the current NEXUS series schedule online.   To obtain the web address and 
display the program guide in a web browser, perform the following steps: 

1. Click the “Program Guide” menu button to display your NEXUS series system’s 

program guide (see Illustration 247 for an example).  

2. Click the URL link on the “Program Guide” screen as shown in Illustration 249 to 

open your NEXUS program guide in a separate browser tab window. 

Illustration 249, Program Guide URL Link 

 

Program Guide URL 
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3. Copy the program guide web address and, if desired, edit the following variables 
(shown in red) in the web address to change the programming display: 

 “http://10.255.11.142:50001/websched.php?channel=1&mode=day&day=fri&he

aders=0”: change to the IP address of the NEXUS series server/controller 
containing the schedule you wish to display 

 “http://10.255.11.142:50001/websched.php?channel=1&mode=day&day=fri&he
aders=0”: 

 “channel=0”: displays the programming on all channels 

 “channel=1”: displays the programming on channel one 

 “channel=2”: displays the programming on channel two 

 “http://10.255.11.142:50001/websched.php?channel=1&mode=day&day=fri&he

aders=0”: to show programming for one day, leave mode as “day” or to display 
up to seven days of your schedule’s programming, enter “week” 

 “http://10.255.11.142:50001/websched.php?channel=1&mode=day&day=fri&he

aders=0”: to show the day of the week without the date on top of your 
programming display, change “date” to “day” and then enter the first three 

letters of the day whose programming you wish to view from the current 
schedule 

 “http://10.255.11.142:50001/websched.php?channel=1&mode=day&day=fri&he

aders=0”: if you are using the “week” mode, you may change the “headers” 
value to “1” to display each day’s programming under separate day, date, and 
program time headings (see Illustration 248) 

 “http://10.255.11.142:50001/websched.php?channel=1&mode=day&day=fri&he

aders=0&secs=0”: to display each program’s start time down to the second, 
change the “secs” value to “1” 

 “http://10.255.11.142:50001/websched.php?channel=1&date=09/17/2007”: to 

show programming for a specific date, change “day” to “date” followed by the 
month, day, and year.   

4. Distribute the web address as a link or with instructions to paste the address into 
the address bar of one of the supported web browsers. 

 
Your Own Website 

NOTE: The WebNEXUS program guide is linked to Port 50001, preventing 

unauthorized users from accessing the other WebNEXUS features.  If you 
need to select a different port number for the program guide, refer to “Editing 
Web Schedule Port,” on page 81. 

First make the program guide publically accessible by forwarding Port 50001 through 

your firewall to your NEXUS series server/controller.  Port forwarding requires an 
external, public IP address which is configured in the router to have certain ports 
forwarded to the NEXUS system’s internal IP Address. Forward Port 50001 of the 

http://10.255.11.142:50001/websched.php?channel=1&mode=day&day=
http://10.255.11.142:50001/websched.php?channel=1&mode=day&day=
http://10.255.11.142:50001/websched.php?channel=1&mode=day&day=
http://10.255.11.142:50001/websched.php?channel=1&mode=day&day=
http://10.255.11.142:50001/websched.php?channel=1&mode=day&day=
http://10.255.11.142:50001/websched.php?channel=1&mode=day&day=
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external IP address to your NEXUS series server/controller, then point your website to 
the external address. 

Once your program guide has been made publically accessible, add the WebNEXUS 

program guide embed code to one of your own web pages according to the following 
steps: 

1. Click the WebNEXUS “Program Guide” button to display the corresponding screen.  

2. To display the embed code, click on the “Embed Script” arrow (see Illustration 
250).   

Illustration 250, WebNEXUS Program Guide "Embed Script" 

 

3. Drag your mouse cursor across the code to highlight and select it, then 
simultaneously press the “Ctrl” and “C” keys on your keyboard to copy the code.   

4. Paste the code onto one of your web pages by simultaneously pressing the “Ctrl” 

and “V” keys on your keyboard. 

5. If desired, customize the code for your website by editing the embed code 

variables as described below: 

 var channel = "1"; 

 "channel=0": displays the programming on all channels 
 "channel=1": displays the programming on channel one 

 "channel=2": displays the programming on channel two  

 var mode = "day"; 

 var mode= "day": displays programming for the current day 
 var mode= "week": displays seven days of programming 

 var headers = "0"; 

 var headers= "0": displays the day’s programming under one set of date, day, and program 

time headers  
 var headers= "1": displays each day’s programming under separate day, date, and program 

time headings 

 var showSecs = "0"; 

 var headers= "0": hides the second of each program’s start time  
 var headers= "1": displays the second of each program’s start time 

6. Upload the web page with the embed code to your web server.  The embedded 

program guide will dynamically update to display your current program schedule.  
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USING VIRTUAL CHANNELS 

OVERVIEW 

NOTE: Only users with the “administrator” right are able to access the Virtual 
Channels feature. 

The Virtual Channels provide looping playlists consisting of your MPEG clips, slides, 
switcher input devices, and LEIGHTRONIX TOTAL INFO, a subscription-based 
dynamic video content service (30 day, free trial available for NEXUS and 1 year free 

for the UltraNEXUS and UltraNEXUS-SDI).  Virtual Channel playlists are convenient 
for filling time when a schedule is not running or between scheduled programs and 
also can be easily scheduled as program events.  

Click on the “Virtual Channel” menu button to access the WebNEXUS Virtual Channel 

editor (see Illustration 251).  The four content boxes on the right side of the Virtual 
Channel editor contain the resources that may be added to your playlists, as described 
in Table 59, Virtual Channel Playlist Resources. 



NEXUS Series 

Web Control 

Page 408   LEIGHTRONIX, INC. 
WinLGX ver. 7.0.2.60  2018-06-08 
 

Illustration 251, Virtual Channel Editor 

 

Table 59, Virtual Channel Playlist Resources 

CONTENT BOX DESCRIPTION 

TOTAL INFO Displays the available TOTAL INFO 
data categories.  “Sports,” 

“News,” “Financial,” and “Dailies” selections offer worldwide 
headlines, while “Traffic” and “Weather” information is specific to 
the registered location.   

MPEG Files Displays a list of the MPEG files on your attached digital media 
storage devices. 

Slide Show Displays a list of all user accounts on your NEXUS series server.  

Virtual Channel 
Selection Buttons 

Playlist 
Resources 
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CONTENT BOX DESCRIPTION 

When you add a user account to a Virtual Channel playlist, 
enabled and authorized slides within that account will display as 
a slide show. Individual slide durations, transitions, and 
time/date display restrictions can be specified in each slide’s 
metadata from the WebNEXUS “JPEG Slide Management” 
screen (see “Finding Slides/User Folders 

WebNEXUS provides the following tools for managing and 
searching your slide list for user folders and files: 

 “Expand All/Collapse All” links: by default, the 
WebNEXUS slide management page opens with all 

slide user folders fully expanded.  If you have a lot of 
slides, this can make for a really long file listing.  To 
quickly locate a particular folder of slides, click the 

“Collapse All” link at the bottom of the window.  This 
action is easily reversed by clicking the “Expand All” 
link. 

 “Filter” box: if you know the name or even the first few 

letters of the filename or folder you are looking for, 
display the “Filter” box by clicking the drop down arrow 
next to “Filter.”  Then type the name of a file or folder to 

find an exact match or just enter the first few letters to 
get a list of possible files and folders.  

 

ADDING Slide Show Settings to Slide Metadata,” on page 
387).  

NOTE: Adding a user account without enabled/authorized 
slides to a Virtual Channel playlist will cause the 
Virtual Channel to freeze and display black. 

External Input Displays a list of your routing switcher’s inputs.  In the 
UltraNEXUS/NEXUS internal switcher mode, eight inputs will be 
shown as available.  When the NEXUS series system is 
controlling an external switcher, the number of available inputs in 
this field will correlate to the number of inputs on the external 
switcher. 

NOTE: This option is disabled for the UltraNEXUS-SDI switch 
type (configuration without an external switcher) and 
the Zoned TOTAL INFO feature. 

 
Set up and use your Virtual Channels according to the following 
steps: 

1. Select Virtual Channel 1 or 2 by clicking the corresponding “Channel” button on top 

of the Virtual Channel editor screen (see Illustration 251, Virtual Channel Editor on 
page 408). 
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2. If you have a new TOTAL INFO subscription or just wish to take advantage of the 
free trial, you will need to submit the necessary location and contact information 

before you can display TOTAL INFO content in your Virtual Channel playlists.  
TOTAL INFO enhances your digital video playback with automatically updated 
video content, including news, sports, and entertainment.  Refer to “TOTAL INFO 

Configuration,” on page 410, for setup and configuration information. 

3. Refer to the following sections for playlist management instructions: 

 “Creating/Modifying Virtual Channel Playlists,” on page 424 

 “Saving Virtual Channel Playlists,” on page 430 

 “Deleting Virtual Channel Playlist,” on page 438 

4. Activate Virtual Channel playlists for display according to “Displaying Virtual 
Channel Playlists,” on page 434. 

TOTAL INFO CONFIGURATION 

SETTING UP TOTAL INFO 

Before you can display TOTAL INFO content on your Virtual Channels, you must 

submit the necessary configuration information to LEIGHTRONIX.  For your 
convenience, WebNEXUS gives you the option to submit this information online.  
LEIGHTRONIX will use the information submitted through WebNEXUS to register your 
Virtual Channels and activate TOTAL INFO on your NEXUS series server. 

NOTES:  A free trial (and each TOTAL INFO paid subscription) covers two, same-

location Virtual Channels per NEXUS series system.  A location is 

defined by a combination of zip code, closest metropolitan area, and 
time zone.  If you would like to set up separate TOTAL INFO location 
information for each Virtual Channel, you will need to purchase two 

TOTAL INFO subscriptions and contact LEIGHTRONIX for help with the 
configuration. 

  The free trial starts counting down from the date you submit the 

WebNEXUS configuration information. 

1. If you are not already on the Virtual Channel editor screen (see Illustration 251, 

Virtual Channel Editor), click on the “Virtual Channel” menu button. 

2. On the Virtual Channel editor screen, click on the “Channel” button for the Virtual 
Channel you would like to configure (see Illustration 251, Virtual Channel Editor on 

page 408). 
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a. Click the “TOTAL INFO Configuration” button on the selected Virtual Channel 
(see Illustration 252).   

Illustration 252, "TOTAL INFO" Configuration Message on Virtual Channel Editor 

 

A dialog box will appear, explaining the TOTAL INFO activation process (see 
Illustration 253).  Click “Next” to continue. 

Illustration 253, “TOTAL INFO Subscription Configuration” Box 

 

b. If you are using the same TOTAL INFO subscription for both Virtual Channels, 
click the “Next” button following the subscription location information (see 
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Illustration 254) and proceed to the next step.  Otherwise, click “Cancel” and 
contact LEIGHTRONIX to set up your separate TOTAL INFO subscriptions. 

Illustration 254, TOTAL INFO Subscription Location Information 
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c. In the subscription configuration box (see Illustration 255), enter the following 
information: 

Illustration 255, TOTAL INFO Subscription Configuration Information 

 

 “Name,” “Company,” “Email,” and “Telephone”: LEIGHTRONIX uses 
this information to contact users about TOTAL INFO.       

 “Contact Preference”: method LEIGHTRONIX will use to contact user 

about TOTAL INFO. 

 Location Configuration: information entered into the “Location Type,” 

“ZIP/Location Code,” “Metro Area,” and “Time Zone” fields will be used by 
the NEXUS series system to download and display traffic and weather 
information for your area.   

 “Location Type” and “ZIP/Location Code” fields: select your location type 
and then enter the corresponding information into the “ZIP/Location 

Code” field.  Entering a U.S. zip code will cause TOTAL INFO to display 
weather information for the corresponding area, while the 4-character 
International Civil Aviation Organization (ICAO) and 5-digit World 

Meteorological Organization (WMO) codes cause TOTAL INFO to pull 
meteorological information from the weather observing station 
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associated with the code.  The ICAO or WMO codes provide weather 
information for locations both in and outside the U.S. 

 “Metro Area”: traffic data is displayed for the selected area.  

 “Time Zone”: information containing sporting event times, such as game 
start times, will be adjusted to local times. 

 “MPEG Volume”: select the NEXUS series storage device that you would 
like to hold your TOTAL INFO system and MPEG video background files 

(occupies approximately 700 MB of storage).  

d. Click “Next” once you are satisfied with your settings or “Cancel” to abort.  

Clicking “Next” will cause WebNEXUS to ask whether or not you would like to 
transmit your TOTAL INFO activation information to LEIGHTRONIX.  Please 
read the TOTAL INFO user agreement.  Click “Accept” to transmit your TOTAL 

INFO subscription information to LEIGHTRONIX or “Decline” to abort. 

e. If you clicked “Accept,” a subscription information box will appear.  At this time, 

you have the option to select one or more data categories listed on the box and 
then click the “Add” button to immediately add the selected TOTAL INFO 
content to your Virtual Channel playlist before your subscription is officially 

activated (see Illustration 256).  Alternatively, just click the “Finish” button and 
wait for your subscription to be activated before adding TOTAL INFO content to 
your Virtual Channel playlists. 

Illustration 256, Adding TOTAL INFO Content to Current Playlist 

 

f. Click “Done” to close the last window in the TOTAL INFO subscription 

configuration process. 
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CONFIGURING OPTIONAL TOTAL INFO SETTINGS 

Customizing TOTAL INFO Logo 

Add your station ID, logo, bug, or other custom graphics/text to all of the TOTAL INFO 
content displayed on the selected Virtual Channel or remove a previously selected bug 
overlay according to the following steps: 

NOTE: Create your custom bug overlays with a third-party graphics program such 

as Adobe Photoshop®.  Overlays must be saved as PNG files. 

1. Click the “Advanced” button on the top of the Virtual Channel screen to display the 

“Advanced Virtual Channel Options” window.  Click the “TOTAL INFO” tab (see 
Illustration 257, "Advanced Virtual Channel Options"). 

Illustration 257, "Advanced Virtual Channel Options" 

 

2. If you do not display an overlay, select “NONE” from the “Logo Bug Overlay” drop 

down menu for the currently selected Virtual Channel.  Otherwise, click the “Upload 
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Image” button to open the “TOTAL INFO Bug Upload” window (see Illustration 
258). 

Illustration 258, "TOTAL INFO Bug Upload" Window 

 

3. Either enter the file path of the desired PNG overlay or click the “Browse” button to 

open the “Choose file to upload” window shown in Illustration 259.  Navigate to the 
desired file and click “Open.” 

NOTE: NEXUS series systems only support overlay names containing up to 27 
characters (no spaces) in addition to the “.png” extension. 

Illustration 259, “Choose File” Window 
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4. Click the “Upload” button on the upload window to add the overlay to the “Logo Bug 
Overlay” drop down menu on the “Advanced Virtual Channel Options” box’s 

“TOTAL INFO” tab. 

5. Select the uploaded overlay file from the selected Virtual Channel’s “Logo Bug 
Overlay” drop down menu.  The selected over lay file will only be displayed over 
TOTAL INFO content. 

Customizing TOTAL INFO Audio 

You may either play the provided audio background music or your own audio input 
source behind your TOTAL INFO MPEG video backgrounds as follows: 

1. Click the “Advanced” button on the top of the Virtual Channel screen to display the 

“Advanced Virtual Channel Options” window.  Click the “TOTAL INFO” tab (see 
Illustration 257, "Advanced Virtual Channel Options"). 

2. From the “Audio Source” drop down box for the currently selected Virtual Channel, 
select “From MPEG” to opt for the default music included with each TOTAL INFO 

video background file or select an audio source connected to one of your inputs as 
follows: 

NOTE: You may only use an audio source connected directly to the audio inputs 
on your NEXUS series system.  

 NEXUS/UltraNEXUS only: select an audio input on your NEXUS or 

UltraNEXUS’s rear panel that is connected to an audio source.   

 UltraNEXUS-SDI only: select an “Analog,” “AES,” “Embedded 1-2,” 

“Embedded 3-4,” “Embedded 5-6,” or “Embedded 7-8” audio input source 
connected directly to the corresponding audio input on the rear panel. 

 
Customizing TOTAL INFO MPEG Video Background Files 

If preferred, you may also customize the TOTAL INFO MPEG video background files 
representing each TOTAL INFO data category (one video background per category) 
for both Virtual Channels.  To do this, perform the following steps:   

1. Using a third-party video software program, create your own MPEG background 

files.  As you save the files, be certain to name each file after the TOTAL INFO 
data category it represents (ex., “Sports.mpg” and “News.mpg”).   

2. Then use a third-party file transfer protocol (FTP) program (ex., Filezilla) to access 
the file directory of your NEXUS series server. Perform the following steps: 

a. Open the folder of the NEXUS system’s storage volume that you selected to 
hold your video background files during the initial configuration of TOTAL INFO. 

b. Open the "totalinfo" subfolder. 

c. Rename or delete the LEIGHTRONIX TOTAL INFO video background files. 

d. Transfer your custom TOTAL INFO video background files into the "totalinfo" 

subfolder. 

3. From the WebNEXUS Virtual Channel editor, click the "Advanced" button and then 

click on the "TOTAL INFO" tab to display the window shown in Illustration 260. This 
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option is shared by both Virtual Channels and may be performed from either 
channel's editor.  Perform the following steps: 

a. Ensure the NEXUS system’s storage volume containing your new TOTAL INFO 
backgrounds is selected in the top field. 

b. Next, uncheck the "Automatically Update TOTAL INFO MPEG files" box. 

c. Click "Save" to makes the changes. 

Illustration 260, "TOTAL INFO" Video Background Files Settings 

 
 

Changing Storage Location of TOTAL INFO MPEG Video Background Files 

From the WebNEXUS Virtual Channel editor, click the “Advanced” button and then 
click on the “TOTAL INFO” tab to display the window shown in Illustration 260.  This 
option is shared by both Virtual Channels and may be performed from either channel’s 

editor.  Select the storage volume from the “Background MPEG File Source” drop 
down menu list and then click “Save” to make the change. 
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Updating the LEIGHTRONIX TOTAL INFO MPEG Video Background Files 

From the WebNEXUS Virtual Channel editor, click the “Advanced” button and then 
click on the “TOTAL INFO” tab to display the window shown in Illustration 260.  This 
option is shared by both Virtual Channels and may be performed from either channel’s 

editor.  Perform the following on the options window: 

1. Ensure the “Automatically Update TOTAL INFO MPEG files” box is checked.  If 

not, select it and click the “Save” button. 

2. Click the “Check for Update” button to check for updated video background files.   

3. Close the options window by clicking the “Cancel” button or “x” icon.  The update 
will continue to run as a background process.  

Displaying TOTAL INFO Horoscopes or Entertainment News 

From the WebNEXUS Virtual Channel editor, click the “Advanced” button and then 

click on the “TOTAL INFO” tab to display the window shown in Illustration 261.  
Enable/disable the following information displays for the selected Virtual Channel:  

 Check the “Horoscopes in Dailies Feed” box by clicking to display horoscopes 
within the TOTAL INFO “Dailies” category. 

 Check “Entertainment News in News Feed” by clicking to display entertainment 
information within the TOTAL INFO “News” category.   

Illustration 261, "TOTAL INFO" Data Enable/Disable Settings 
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Activating/Deactivating Zoned TOTAL INFO Multi-Zone Display Feature 

NOTES:  Zoned TOTAL INFO is only available for UltraNEXUS/UltraNEXUS-

SDI servers. 

  A TOTAL INFO subscription is required in order to activate the multi-
zone display feature.  

Zoned TOTAL INFO gives UltraNEXUS and UltraNEXUS-SDI users the ability to 
simultaneously display digital video clips and/or slide shows with TOTAL INFO local 
weather as well as news, sports, dailies, financials, and/or metro traffic.  The multi-

zone display feature can be used on either or both of the UltraNEXUS/UltraNEXUS-
SDI server’s digital playback channels.  Video/slides are scaled to fit on the left side of 
viewers’ television screens while TOTAL INFO local weather is always displayed on 

the right. For the lower third of the screen, users choose which of the remaining 
TOTAL INFO data categories (news, sports, dailies, financials, and/or metro traffic) will 
display in rotation.  See Illustration 262 for an onscreen display example of Zoned 

TOTAL INFO. 

Illustration 262, Zoned TOTAL INFO Onscreen Display Example 

 

 
Use the WebNEXUS interface to set up when Zoned TOTAL INFO as follows:  

1. From the selected Virtual Channel tab screen, click the “Advanced” button and then 

click on the “General” tab to display the window shown in Illustration 263. 

Digital 
Video/Slide 

Show Area 

Selected 

TOTAL INFO 

Content 

TOTAL INFO 

Weather 
(always 

displayed in 
the right 

screen zone) 
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Illustration 263, "General" Tab on the “Advanced Virtual Channel Options” Window 

 

2. Under the “Zone Mode” section, single click to select one of the following zone 

display modes: 

 “Off”: deactivates Zoned TOTAL INFO on the selected Virtual Channel 

 “With Virtual Channel”: causes Zoned TOTAL INFO to be displayed with Virtual 

Channel playlists (see “Displaying Virtual Channel Playlists,” on page 434 for 
more details). 

  “Always”: causes the UltraNEXUS MPEG player corresponding to the selected 

Virtual Channel to display Zoned TOTAL INFO with all digital programming, 

including scheduled programming, Control Panel events, and Virtual Channel 
playlists.  Zoned TOTAL INFO content on Virtual Channel 1 will be displayed by 
MPEG Player 1 on the switcher output assigned to WinLGX Channel/Output 

Tab 1 while an active playlist on Virtual Channel 2 will be displayed by MPEG 
Player 2 on the output assigned to WinLGX Channel/Output Tab 2. 
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3. Click “Save” to make the change or “Cancel” to abort. If you selected either the 
“With Virtual Channel” or “Always” mode, you will notice that the “TOTAL INFO” 

icons are changed into a checklist on the Virtual Channel editor.  TOTAL INFO 
weather is always in the right onscreen zone when the “Zone” mode is activated, 
so this category will be automatically selected.  Select at least one additional 

TOTAL INFO data category for display in the zone on the bottom of the screen 
(see Illustration 264).  Click the “Current” button to change your TOTAL INFO data 
selections in the onscreen Zoned TOTAL INFO display. 

Illustration 264, Virtual Channel Editor with Zoned TOTAL INFO Settings 

 

Customizing Zoned TOTAL INFO Image Backgrounds 

Zoned TOTAL INFO includes a separate PNG image file for display behind each 

TOTAL INFO data category.  If desired, you may replace the included files with your 
own custom image backgrounds created with any third party graphics program.  The 
files must be saved in the PNG format and adhere to the following size and filename 
guidelines: 

 TOTAL INFO Weather Zone: the graphic for weather on the right side of the screen 
must be 180 pixels wide x 400 pixels high and saved under the filename 
“wbar.png” 

 Mixed TOTAL INFO Data Zone: the graphics for display under the rotating TOTAL 

INFO data on the bottom of the screen must be 720 pixels wide x 140 pixels high.  
Files must be saved under the following names: 

 Traffic: “TrafficL3.png” 

 Sports: “SportsL3.png” 

 Sports Scores: “ScoresL3.png” 

 News: “NewsL3.png” 

 Financial: “FinancialL3.png” 

Zoned TOTAL INFO 

Category Seletions 
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 Dailies: “DailiesL3.png” 

Once the new files have been created, use a third party FTP program to access the 
“Internal”/“totalinfo”/”zone_backgrounds” folder on the Flash drive of your NEXUS 

series server system. Replace the existing files with your new, custom files. 
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CREATING/MODIFYING VIRTUAL CHANNEL PLAYLISTS 

A Virtual Channel playlist is a collection of playback resources from the four content 
boxes on the right hand side of the Virtual Channel editor.  There are three types of 

Virtual Channel playlists—day/default playlist presets/configuration files (.vcf), playlist 
files (.vc), and the “Current” playlist.  The day presets allow you to create and save a 
separate playlist for automatic display in the empty time slots between scheduled 

programming on each day of the week, while the “Default” preset acts as a backup 
playlist for any empty day presets.  Unique day/default playlist presets can be saved 
for each week in Virtual Channel configuration files (.vcf).  Individual playlists can also 

be saved as Virtual Channel playlist files (.vc) for scheduling as program events or 
immediate display through the WinLGX control panel.  The “Current” playlist contains 
the playlist resources that were last submitted to your NEXUS series server either by 

clicking the “Current” button or automatically through a day/default preset or a 
scheduled Virtual Channel playlist file (.vc).  Any playlist may be displayed in place of 
a schedule. 

Create or edit playlists with up to 100 resources per list according to the following 
steps: 

1. If you are modifying an existing playlist, load it according to the corresponding set 
of steps below.  Otherwise, skip to step 2 on page 426. 

 Load Resources from a Virtual Channel Playlist File (.vc) or a Day/Default 
Preset: from the “Preset/Day” drop down box at the top of the Virtual Channel 

editor, select a playlist file or day/default preset to load the corresponding 
playback resources into the playlist window (see Illustration 265).   

Illustration 265, Loading a Playlist Preset into the Virtual Channel Playlist Window 

 

Preset/Day Drop Down Box 

Virtual Channel 

Playlist Window 
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 Load Resources from a Virtual Channel Configuration File (.vcf): 

a. Click the “Advanced” button to display the “Advanced Virtual Channel 
Options” window and then click the “List Config” tab to display the window 

shown in Illustration 266. 

Illustration 266, "List Config" Tab on "Advanced Virtual Channel Options" Window 

 

b. Single click to select a configuration file in the file listing and then click the 
“Load” button to populate the “Preset/Day” drop down menu’s day/default 

presets with the file’s playback resources or “Cancel” to abort. 

c. From the “Preset/Day” drop down box, select a day/default preset to load 
the playlist you wish to modify (see Illustration 265). 
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2. Add, remove, and re-order resources in the Virtual Channel playlist window 
according to Illustration 267 and Table 60.  Virtual Channel playlist resources will 

play in the order listed.  Display durations for each resource type are as follows: 

NOTES:  Resources highlighted green in the “MPEG Files,” “Slide Show,” and 

“External Input” content boxes are in the current Virtual Channel 
playlist.   

  Red highlights on Virtual Channel playlist items indicate resources 
that are no longer available on the NEXUS series server’s storage 
areas and will be skipped during playlist playback.   

 TOTAL INFO: data displays at a rate of 180 words/minute, with a total minimum 

duration of three minutes 

 MPEG: each video clip displays for its file duration 

 Slide Show: slide show display durations are a total of each slide’s display 
length as specified in its metadata (default is 10 seconds per slide) 

 External Input: when a switcher input resource is added to the playlist window, 
each resource is automatically assigned a default duration.  To modify, refer to 
step 3 in this section on page 429. 
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Illustration 267, Virtual Channel Playlist 

 

 

Table 60, Creating Playlists in the Virtual Channel Playlist Window 

Action Steps 

Select a single 
resource 

Single click the resource.  A successfully selected resource 
will be highlighted in orange. 

Preset/Day Drop 
Down Box 

Virtual Channel 

Playlist Window 

4 Content Boxes of 

Playback Resources 
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Action Steps 

Select multiple 
resources 

Perform one of the following: 

 Select a group of consecutive resources: single click 
the first resource in the group you wish to select and 

then hold down your keyboard’s “Shift” key and single 
click the last resource.  All resources between the first 
and last clicked resources will also be selected. 

 Select a non-consecutive group of resources: hold 

down your keyboard’s “Ctrl” key and then single click 
on each of the desired resources.   

Successfully selected resources will be highlighted in 
orange. 

Add a single resource 

to a Virtual Channel 
playlist 

Individual playback resources may be added to the Virtual 

Channel playlist window in one of the following ways: 

 Select a single playback resource and then click the  

add button. 

 Double click the resource.   

Add multiple 
resources from one 

content box to a Virtual 
Channel playlist 

Select multiple resources in the same content box and then 

add to a Virtual Channel playlist window by clicking the  

add button. 

Remove resources 

from a playlist 

Select one or more playback resources in the playlist 

window and then click the  remove button.  Alternatively, 
double clicking a resource in the playlist will also remove 

the resource. 

Remove all resources 
from a playlist 

Click the  clear list button to remove all resources from 
the playlist window.  When prompted, click “Yes” to delete 

the resources from the playlist or “No” to cancel. 

Change the order of a 
playlist 

 One row at a time: select one or more playback 

resources in the playlist window and click the  move 

up or  move down buttons to move the resource(s) 
up or down in the list by one row. 

 First and last playlist positions: select one or more 

playback resources in the playlist window and click the 

 move to top or  move to bottom buttons to move 
the resource(s) all the way to the first or last rows in 

the playlist. 

Depending on the operation performed, the remaining 

playlist resources will be pushed above or below the 
moved resources. 
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Action Steps 

Copy and paste 
resources within and 

between playlists 

Select one or more playback resources in the playlist 

window and click the  copy button.  Click the  paste 

button to add the resources to the bottom of the currently 
loaded playlist preset. 

NOTE: Copy and paste are not available in the Chrome 

and Firefox browsers. 

3. If any switcher input resources were added to the playlist, access each resource’s 

display duration setting by double clicking its length on the playlist window.  The 

resource’s length field will become active, allowing you to type a new length into 
the hours, minutes, and seconds fields.  When you are finished, click off the playlist 
window to complete the change. 

4. If any slide shows were added to your playlist, you may add or remove audio by 

clicking the “Advanced” button and then the “General” tab (see Illustration 268).  
Any audio preferences you specify will apply to all slide shows.  From the 
“Background Audio Source” drop down list, add or remove audio as follows: 

Illustration 268, Slide Show Audio Settings 
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 No audio: select an input on your NEXUS series system that does not have an 

audio source connected to it. 

 Audio:   
 “From MPEG”: pick an MPEG file from the “MPEG File Name” drop down 

list.  This listing displays the MPEG files on your attached digital media 
storage devices. The selected MPEG file’s audio will be played behind the 
slide show.  Any video in the file will not be displayed. 

 NEXUS/UltraNEXUS only: select an audio source connected to an input on 
the NEXUS/UltraNEXUS’s internal switcher. 

 UltraNEXUS-SDI only: select an “Analog,” “AES,” “Embedded 1-2,” 

“Embedded 3-4,” “Embedded 5-6,” or “Embedded 7-8” audio source 
connected directly to the corresponding audio input on the rear panel. 

5. Once you have finished creating or modifying your playlist, either continue to 

“Saving Virtual Channel Playlists” on page 430 to learn about the Virtual Channel 

Editor’s options for saving a playlist or click the “Current” button to add the 
resources into the “Current” playlist and submit the resources to your NEXUS 
series server.  The “Current” playlist overrides any previously submitted playlist 

resources and will immediately display if a scheduled program or control panel 
event is not currently being displayed and if the Virtual Channel has already been 
previously activated through a WinLGX schedule or control panel command (see 

“Displaying Virtual Channel Playlists,” on page 434, for more details). 

NOTE: If the Virtual Channel is inactive when the “Current” playlist is submitted, 

the playlist will not be displayed.  The “Current” playlist is overwritten with 
the resources currently in the Virtual Channel playlist window each time 
the “Current” button is clicked or when a day/default playlist preset or 

Virtual Channel playlist file (.vc) is submitted. 
 

SAVING VIRTUAL CHANNEL PLAYLISTS 

A separate Virtual Channel playlist can be saved for one or more weekdays (seven 

days total plus a default playlist to cover empty days) as well as in files not tied to 
specific days. 

1. Create the playlist according to “Creating/Modifying Virtual Channel Playlists,” on 
page 424. 

2. Save the playlist according to one of the following save options: 
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 Save as a Virtual Channel Playlist File (.vc): save one playlist in a file for 

display in place of scheduled programming or as a scheduled program as 
follows: 

 If you edited an existing .vc file, click the  save button.  

 For new .vc files or to overwrite an existing .vc file, click the  save list as 
button on top of the Virtual Channel playlist window to display the "Save 

Preset" Window shown in Illustration 269 and perform the following steps: 

Illustration 269, "Save Preset" Window 

 

a. Perform one of the following save options: 

o Create a new file: type up to 27 alphanumeric characters without 

spaces into the “File Name” field.   

o  Save over an existing file: single click to select an existing file to 

replace.   

b. Click the “Save” button to save your Virtual Channel playlist file or 

“Cancel” to abort. 
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 Save as a Day or Default Preset: save one playlist in a preset for display in 

place of scheduled programming or to fill time between scheduled programs on 
a specific day as follows: 

 If you edited an existing preset, click the  save button.  

 To overwrite a preset, click the  save list as button on top of the Virtual 
Channel playlist window to display the "Save Preset" Window shown in 

Illustration 269 and perform the following steps: 

a. In the preset file listing, single click on either a day preset to save the 

playlist for display on the specified day or the “Default” preset to save the 
playlist for display when the NEXUS series server encounters an empty 

day preset. 

b. Click the “Save” button to save your playlist in a Virtual Channel preset 

or “Cancel” to abort. 

c. If desired, save one or more of your day/default presets in a Virtual 
Channel configuration file (.vcf) as described in the following subsection. 

 Save as a Virtual Channel Configuration File (.vcf): save a collection of up to 

seven weekday playlist presets and one “Default” preset in a .vcf file as follows: 

a. Click the “Advanced” button on the Virtual Channel editor window and then 

click the “List Config” tab to display the window shown in Illustration 270. 

Illustration 270, "List Config" Tab Window 
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b. Perform one of the following save options: 

 Create a new file: type up to 27 alphanumeric characters without spaces 
into the “File Name” field.   

  Save over an existing file: single click to select an existing file to replace.   

c. Click the “Save” button to save your configuration file or “Cancel” to abort. 

3. If desired, immediately activate your Virtual Channel and display your playlist 

according to “Displaying Virtual Channel Playlists,” on page 434. 
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DISPLAYING VIRTUAL CHANNEL PLAYLISTS 

Virtual Channel playlists may be displayed in place of a schedule, as programs within 
a schedule, or in the unfilled time between scheduled programs.  The MPEG player 
and output that display your Virtual Channel playlists are determined by your switch 
type as follows: 

 Internal Switcher Mode/“UltraNEXUS-SDI” Switch Type:  
Virtual Channel 1 playlists as well as playlist files added to the first channel 

output tab will be displayed by MPEG Player 1 on the output assigned to 
WinLGX Channel/Output Tab 1, while the Virtual Channel 2 playlist and playlist 
files added to the second channel output tab will be displayed by MPEG Player 

2 on the output assigned to WinLGX Channel/Output Tab 2 (see Illustration 
271, Virtual Channel WinLGX Tab Assignments). 

Illustration 271, Virtual Channel WinLGX Tab Assignments 

 

 External Switcher:  
In your WinLGX NEXUS series image file, assign the external switcher outputs 

that you wish to display Virtual Channel content to the NEXUS series MPEG 
player inputs and first two WinLGX channel/output tabs.  For more information, 
see “Editing Internal MPEG Player and Recorder Device Resource,” on page 

155 and “Configuring the Switch Type of a NEXUS Series System,” on page 
136. 

If a NEXUS series image file with switcher settings has not been sent to your 
NEXUS series unit and a Virtual Channel playlist is then activated, the Virtual 
Channel will use the MPEG player and channel output defined in its 
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WebNEXUS default switcher settings. To set up default switcher settings for 
each of your Virtual Channels, perform the following steps:     

1. Click the “Advanced” button on the Virtual Channel editor to display the 
“Advanced Virtual Channel Options” window.   

2. Click the “General” tab to display the window shown in Illustration 272.  

Under the “Switcher” section, select an MPEG input and channel output 
from the drop down menus for each Virtual Channel.   

 “MPEG Input”: choose the input on your external switcher that is 

connected to the NEXUS series MPEG player for each Virtual Channel 

 “Channel Output”: choose the output you wish to air each Virtual 
Channel’s active playlists. 

Illustration 272, Default External Switcher Settings 

 

3. Click “Save” to make your selections or “Cancel” to abort.  Both buttons also 
close the window. 
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The following sections describe each method for displaying your Virtual Channel 
playlists: 

 “Displaying a Playlist between Scheduled Program Events” on page 436 

 “Displaying a Playlist as a Scheduled Program Event” on page 437 

 “Displaying a Playlist in Place of a Schedule” on page 437 

DISPLAYING A PLAYLIST BETWEEN SCHEDULED PROGRAM EVENTS 

Saved day/”Default” Virtual Channel playlists will automatically fill the channel 
switchbacks on the WinLGX schedule editor’s first two channel output tabs.  Virtual 
Channel 1 playlists are tied to NEXUS series MPEG Player 1 and the first WinLGX 

channel output tab and Virtual Channel 2 playlists are tied to the second MPEG player 
and channel output tab (see Illustration 271, Virtual Channel WinLGX Tab 
Assignments). 

To display a Virtual Channel playlist between scheduled programs, perform the 

following steps: 

1. If your day/default playlist(s) are saved in a Virtual Channel configuration file (.vcf), 

load it in WebNEXUS as follows: 

a. Click the “Advanced” button to display the “Advanced Virtual Channel Options” 
window and then click the “List Config” tab to display the window shown in 
Illustration 266. 

b. Single click to select a configuration file in the file listing and then click the 
“Load” button to add the file’s playlists into the Virtual Channel’s day/”Default” 

presets. 

2. In your WinLGX schedule file (.nmg), be sure to do the following: 

a. Enable your Virtual Channels for use as WinLGX switchback resources by 

selecting “Yes” from the “Virtual Channel” drop down menu in the “System 
Configuration” properties (see “Configuring the Switch Type of a NEXUS Series 
System,” on page 136).  

b. Perform any of the following to fill channel switchbacks on the first two WinLGX 
channel output tabs: 

 During configuration of WinLGX: when selecting your switchback inputs 

for the first two WinLGX schedule tabs (see “Configuring the Switch Type of 
a NEXUS Series System” on page 136 for further instructions), choose 
“Virtual Channel” as the video source in the “Switchback Input” field.   

 During scheduling: when scheduling a resource on the first two channel 
output tabs, the switchback input may be changed to “Virtual Channel” in the 
resource’s event properties window. 

Your NEXUS series server will automatically display the current day playlist preset, 
or the “Default” playlist preset if the day playlist is empty, during a channel 
switchback at the beginning of the schedule or following the end of a scheduled 

event.   
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DISPLAYING A PLAYLIST AS A SCHEDULED PROGRAM EVENT 

Add a Virtual Channel playlist file (.vc) to your programming lineup with the “VC List” 
library resource.  Refer to page 210 for information on creating a Virtual Channel 

playlist file library resource and page 295 for instructions on scheduling the library 
resource. 

DISPLAYING A PLAYLIST IN PLACE OF A SCHEDULE 

Any type of Virtual Channel playlist may be displayed 24/7 in place of a schedule as 
described in the following steps.       

NOTE: An active Virtual Channel playlist will continue to loop on air until another 
playlist is activated, the MPEG player is stopped from the WinLGX control 
panel, or a scheduled digital program event is sent to the NEXUS series 
server. 

 “Current” Virtual Channel Playlist 

1. Add/remove resources in the Virtual Channel playlist window (see 
“Creating/Modifying Virtual Channel Playlists,” on page 424). 

2. Click the “Current” button to submit the resources as your “Current” playlist.  

3. If the “Current” playlist does not display, go to the WinLGX Control Panel, select 

the Virtual Channel’s MPEG player, and click the “Force Start Virtual Channel” 
button. 

 Virtual Channel Day/Default Playlist Presets 

1. Select one or more day/default playlists through one of the following options: 

 Select the current day’s playlist or “Default” from the “Preset/Day” drop down 

menu. 

 Select multiple day/default playlists through a configuration file (.vcf) as 

follows: 

a. Click the “Advanced” button to display the “Advanced Virtual Channel 

Options” window and then click the “List Config” tab to display the 
window shown in Illustration 266. 

b. Single click to select a configuration file in the file listing and then click 
the “Load” button to add the file’s day/default playlists to the Virtual 
Channel editor. 

2. If the current day or default preset does not display, go to the WinLGX Control 
Panel, select the Virtual Channel’s MPEG player, and click the “Force Start 

Virtual Channel” button. 

 Saved Virtual Channel Playlist File 

1. Go to the WinLGX Control Panel and select the MPEG player you want to 

display the playlist’s MPEG video and JPEG slide resources.   

2. Click the ellipsis button to open the “Select Virtual Channel List” window.   

3. Select a Virtual Channel playlist as follows: 
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 Double-click the desired file to accept selection and close “Select Virtual 
Channel List” window.  

 Select the desired file and click “OK” to accept or “Cancel” to abort selection.  

Once a playlist file selection is made, the playlist will immediately display. 

DELETING VIRTUAL CHANNEL PLAYLIST FILES 

To remove a saved Virtual Channel playlist file (.vc) from your NEXUS series server, 
perform the following steps: 

1. From the “Preset/Day” drop down menu, select the playlist file you wish to delete. 

2. Click the  icon on the Virtual Channel toolbar. 

3. On the “Delete Preset” popup window, click “Yes” to delete the file or “No” to cancel 

the action and close the popup. 
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EDITING NEXUS SERIES SITE NAME AND LOCATION 

NOTE: Only the “admin” account and users with the “slide administrator” 
right are able to see the “System Management” screen. 

Customize the “Site Name” and “Site Location” on the WebNEXUS “System 

Dashboard” screen and WinLGX “Controller Site Manager” window.  Click the 
“SYSTEM” button to display the “System Management” screen and then click the “Site 
Information” tab.  Enter a new identification name for your site into the “Site Name” 

field and a location description in the “Site Location” field.  Click “Apply Changes” to 
change the information on your “System Dashboard” screen. 

Illustration 273, “Site Information” Screen 

 

CHANGING NEXUS SERIES SYSTEM TIME 

Click the “SYSTEM” button to display the “System Management” screen and then click 
the “Site Information” tab.  NEXUS series server “Time” shows the date and time 

currently on your server.  To change the NEXUS series server’s date/time, perform 
one of the following:  

 Sync your NEXUS series server’s date and time to your computer’s current date 
and time by clicking the “Set” button next to the “Computer Time” field.  

 Manually change the NEXUS series server’s date and time by editing the “Manual” 

fields as follows: 

1. Use the up/down arrows to adjust the time fields. 

2. Click on the date field and select a new date in the calendar that appears.  

3. Click the “Set” button to make the changes. 
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CHANGING THE FRONT PANEL AND “ADMIN” PASSWORDS 

Click the “SYSTEM” button to display the “System Management” screen and then click 
the “Security” tab. See Illustration 274 and refer to the following: 

 “System User (admin)”: the “admin” user account password provides access to 

your NEXUS series server through WinLGX and WebNEXUS.  Enter the new 
password into both fields and then click the “Change Password” button to make 

the change. 

 “Front Panel Password”: click on a combination of five arrows for the new front 

panel password.  Then, click “Save” to accept new password or “Clear” to 
cancel. 

Illustration 274, "Security" Tab Screen 
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MAINTAINING USB DRIVES AND COMPACT FLASH 

Use the WebNEXUS disk diagnostics feature to automatically fix many common File 
Allocation Table (FAT) errors that may impair your NEXUS series system’s USB drives 
and compact flash drive or cause data loss on the drives.  LEIGHTRONIX 

recommends using the feature on a monthly basis to ensure optimal drive 
performance as well as any time you discover file/drive errors in your log files or notice 
drive performance issues.   

NOTE: The disk diagnostics process does not fix physical hardware degradation.   
 

To run the disk diagnostics feature, log into the WebNEXUS interface and click the 
“SYSTEM” button and then the “Maintenance” tab to display the screen shown in 
Illustration 275.   

Illustration 275, "Maintenance" Tab Screen 

 

Click the “Disk Diagnostics” button and then select the popup menu’s “Yes” option to 

perform the disk check process.  When the diagnosis has been completed, a log file 
describing any errors discovered and actions performed will be added to your system’s 
“EVENTS.LOG” file (see the “System Log Files” section on page 339 for more 

information on the “EVENTS.LOG” file).   

UPDATING SYSTEM FIRMWARE 

LEIGHTRONIX places the most current NEXUS series firmware files on the 

LEIGHTRONIX Support Center website.  Save the update files to an accessible 
directory on your computer or network. 

Once you have downloaded the NEXUS series firmware update file from the Support 
Center, open WebNEXUS and click the “SYSTEM” menu button.  Select the 

“Maintenance” tab and use the “Browse” button to navigate to the saved location of the 
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firmware file (see Illustration 275).  Click the “Update” button to download and install 
the firmware file onto your NEXUS series server. 

ULTRANEXUS/ULTRANEXUS-SDI ONLY: CONFIGURING EPRO-BUS 

SETTTINGS 

The ePRO-BUS control feature allows you to send ePRO-BUS control commands over 
your Ethernet network to up to 16 PEGvault-SD or LABvault-SD digital video recorders 
or other supported devices.  To get started, the ePRO-BUS feature must be configured 

for your UltraNEXUS/UltraNEXUS-SDI server and each PEGvault-SD or LABvault-SD 
according to the following steps: 

 PEGvault-SD or LABvault-SD: refer to the device’s manual for instructions. 

 UltraNEXUS/UltraNEXUS-SDI Server:  

1. Click the “SYSTEM” menu button and then the “ePRO-BUS” tab to display the 
window shown in Illustration 276.  

Illustration 276, "ePRO-BUS" Tab Screen 

 

2. For each of your PEGvault-SD or LABvault-SD recorders, select a PRO-BUS 
address and enter the recorder’s static IP address. When you schedule or 
immediately send ePRO-BUS commands in WinLGX, your LEIGHTRONIX 

server uses the PRO-BUS address assignments to determine which recording 
devices should receive the commands.  The “PRO-BUS Address” and “IP 
Address” fields can be edited once they are double clicked and any changes 

you make are saved when you click off the row.  Make your changes based on 
the following control options:  

 Assign each PEGvault-SD or LABvault-SD IP address to a separate PRO-
BUS address: control each of your recorders individually by entering the IP 
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address for each of your PEGvault-SD or LABvault-SD recorders on a 
separate “PRO-BUS Address” line. 

 Assign the same PRO-BUS address to multiple PEGvault-SDs or LABvault-
SDs: to control multiple recorders from one PRO-BUS address, enter each 

recorder’s IP address on a separate line and then make the PRO-BUS 
address numbers the same for the desired PEGvault-SD or LABvault-SD IP 
addresses.  Given that the PEGvault-SD and LABvault-SD each has only 

one recorder, using one ePRO-BUS address for multiple 
PEGvaults/LABvaults is especially useful for simultaneously recording a 
video source as a broadcast file on one PEGvault or LABvault and a 

streaming video-on-demand file on another. 

 Give the same PEGvault-SD or LABvault-SD IP address to different PRO-

BUS addresses: allows you to control one PEGvault-SD/LABvault-SD 
independently and as part of a group of PEGvaults/LABvaults. 

3. Click the “Enable” checkbox for each PEGvault-SD/LABvault-SD you want to 
receive ePRO-BUS commands from your UltraNEXUS server. 

4. Create a “DVD” or “tape” device resource in WinLGX for each of your ePRO-
BUS-controlled devices.  Use the device resources to schedule (see 

“UltraNEXUS/UltraNEXUS-SDI Only: Scheduling/Editing ePRO-BUS-Controlled 
Device Resources,” on page 269) or immediately (see the control panel 
subsection on “Controlling External Devices,” on page 323) start/stop recording 

on your PEGvault-SDs/LABvault-SDs. 
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CONFIGURING TOTAL SHARE SETTINGS 

If you have purchased the LEIGHTRONIX TOTAL SHARE option for expanded 
storage, the “Total Share” feature can be used to enter the network address settings 

for your LEIGHTRONIX-supported network attached storage (NAS) devices.  The NAS 
configuration settings enable your NEXUS series system to recognize your NAS 
devices.   

NOTE: If LEIGHTRONIX preconfigured all of the NEXUS series systems and NAS 
devices for your TOTAL SHARE network at the factory, then you can skip 
this step. 

Click the “SYSTEM” menu button and then select the “Total Share” tab to display the 
window shown in Illustration 277. 

Illustration 277, "Total Share" Tab Screen 

 

Enter the requested information for each of your NAS devices and click “Save 
Changes.” 

NOTES:  If you have more than one NEXUS series system connected to your 
TOTAL SHARE network, you will need to repeat these steps on the 
WebNEXUS interface for each NEXUS system. 

  For further instructions on setting up your TOTAL SHARE network, refer 
to the “TOTAL SHARE” tutorial. 
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LOGGING OUT OF WEBNEXUS 

Click the “LOGOUT” button in the menu bar to log out of WebNEXUS and return to the 
login screen. 
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TOTAL BACKUP  

With Total Backup, you can ensure that your MPEG videos, slides, and critical NEXUS 
series system information are automatically protected against loss.  Perform 

immediate or scheduled backups of all connected USB drives to save copies of your 
MPEG videos and the internal NEXUS series storage area to preserve your slides, 
network configuration settings (IP address), usernames and passwords, front panel 

password, and the current schedule.  The internal storage information may be copied 
onto a local drive or network storage area, while digital video files on attached USB 
drives may be saved on a PC, network, or another USB drive connected to your PC.   

Restoring your internal and external NEXUS series server/controller’s storage areas is 

just as easy.  If you have backed up your MPEG videos onto an external USB drive 
purchased from LEIGHTRONIX, you can instantly swap it with one of your NEXUS 
series system’s external storage drives.  Total Backup also lets you instantly download 

backup information on your local and network drives to the NEXUS series system in 
just a few mouse clicks. 
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OPENING AND LOGGING INTO TOTAL BACKUP 

1. Select “Preferences” under the “Tools” menu to open the “Preferences” window.  
Ensure the file path under “Total Backup application folder” matches the location 
where the Total Backup program is installed on your computer or network (see 

Illustration 278) and then click “OK” to close window. 

Illustration 278, File Path Field for NEXUS Series Total Backup 

 

2. Open the Total Backup program using one of the following methods:     

 Double click the Total Backup desktop icon.  This method automatically 
displays the NEXUS series system settings for Total Backup, but does not log 
into your controller.  To log in, perform the steps in the note below.   

 From WinLGX, select “Total Backup” from the “Tools” menu or click the  icon 
on the toolbar.  Total Backup will automatically log into your current NEXUS 
series system connection and display the Total Backup Main Window shown in 

Illustration 279. 
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Illustration 279, Total Backup Main Window 

 

NOTE: To log in or change the Total Backup controller connection, click the 

“Login” button to display the “Login” window.  Enter the following 
information and then click “OK” to log in or “Cancel” to abort. 

 “IP Address”: IP address of the NEXUS series system you want to 

backup or restore 

 “User”: username for the entered IP address 

 “Password”: corresponding password for the entered IP address  
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SELECTING STORAGE LOCATIONS FOR NEXUS SERIES 

INFORMATION 

Next, specify where you would like to create fully redundant copies of your NEXUS 
series system’s internal memory and attached USB drives by performing the following 
steps: 

1. From the “Total Backup” window, select “Local Path Settings” from the “File” menu 

to display the backup path window shown in Illustration 280.   

Illustration 280, Backup Path Window 

 

2. Save your NEXUS series data to one or more of the following locations: 

 One Storage Location: click the top radio button.  Browse to a local or network 

storage area in the “Browse for Folder” window and click “OK.”  

 Multiple Storage Locations: click the bottom radio button and make the following 
selections:  

 NEXUS series internal storage area: select a storage location for your 
slides, current schedule on the NEXUS series server/controller, and system 

information (network configuration settings, usernames and passwords, and 
the front panel password).  Click the “Browse” button to display the “Browse 
for Folder” window.  Navigate to a local or network storage area and click 

“OK.” 
 Each of your USB drives: select a storage location for your MPEG videos.  

Click the “Browse” button to display the “Browse for Folder” window.  

Navigate to a local or network storage area or even another external USB 
drive connected to your PC and click “OK.”  Downloading a copy of your 
NEXUS series system’s USB drive to another external USB drive allows you 
to quickly swap the drives, if necessary. 
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NOTES: o A backup drive intended to be used as a physical 
replacement for any drives connected to your NEXUS series 

server/controller must be purchased from LEIGHTRONIX. 
 o USB drives used for backup must be formatted with the 

FAT32 file system. 

3. Click “OK” to save storage path settings and close the “Settings” window.  

4. Perform one of the following: 

 Immediately perform file backup: perform steps under “Performing an 

Immediate Backup,” on page 451 

 Schedule automatic file backups: perform steps under “Performing Scheduled 
Backup,” on page 451 

 Restore NEXUS series storage areas: perform steps under “Restoring NEXUS 
Series System Information,” on page 452 
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PERFORMING AN IMMEDIATE BACKUP 

Total Backup uses your “Local Path Settings” to determine where to save the backup 
information for the selected NEXUS series server/controller storage areas. 

1. On the “UltraNEXUS/NEXUS Total Backup” window, check the boxes next to the 
NEXUS series server/controller storage areas you would like backed up.   

2. Click the “Backup” button to start an immediate backup.  Click the “Stop” button to 
halt a backup before it finishes.  To restart, click the “Backup” button again.  The 

backup will resume from where it left off. 

PERFORMING SCHEDULED BACKUPS 

Total Backup uses your “Local Path Settings” to determine where to save the backup 
information for the selected NEXUS series server/controller storage areas. 

You must leave the Total Backup software running in order for a scheduled 
backup to occur.  Total Backup will run as a background task without interfering 
with other programs open on your computer. 

1. Click the “Modify” button or “Scheduler Settings” under the “File” menu to open the 

“Backup Scheduler” Window shown in Illustration 281. 

Illustration 281, “Backup Scheduler” Window 

 

2. Using the date and time drop down boxes, specify how often you would like the 

backup to occur. 

3. Check boxes next to the NEXUS series server/controller storage areas you would 

like backed up. 

4. Click “OK” to make backup schedule changes or “Cancel” to abort. 
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RESTORING NEXUS SERIES SYSTEM INFORMATION 

Total Backup uses your “Local Path Settings” to find the backup information for the 
NEXUS series server/controller storage areas you wish to restore. 

1. On the “Total Backup” window, click the “Restore” button to open the “Restore” 

Window shown in Illustration 282. 

Illustration 282, “Restore” Window 

 

2. Check the “Unit Settings” box if you would like to restore network configuration 
settings, usernames and passwords, and front panel password. 

3. Check boxes next to the NEXUS series storage areas you would like to restore 

with the last saved backup information. 

4. Select “Overwrite existing files?” to replace existing files that have the same name 

as the backup files. 

5. Click “OK” to restore files or “Cancel” to abort. 
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TOTAL IMPORT  

In a few steps, Total Import allows you to create NEXUS series compatible, high 

quality digital video files from non-encrypted MPEG-1 and MPEG-2 DVDs.  Just insert 
a DVD into your PC’s disc drive and specify where on your PC or network you would 
like to save the digital video files.  You may also customize the files for your video 
system by changing the Total Import encoding settings and filename assignments. 

Each title on a DVD is segmented into one or more ½ hour MPEG-1 or 2 video and 
audio files.  Total Import saves the files within the selected DVD title on your PC or 
network and then converts the files into one industry standard MPEG-2 file with layer 2 

audio.  Once converted, simply use the Storage Manager in the LEIGHTRONIX 
management software, WinLGX, to transfer the MPEG file from your PC to the 
external USB hard drives connected to your NEXUS series server/controller. 

 

1. Double click on the Total Import desktop icon to display the Total Import program 

window (see Illustration 283, Total Import Main Window). 

Illustration 283, Total Import Main Window 

 

2. Insert a DVD into your PC’s DVD drive.  Load the DVD titles (files) into the 

“Source” panel on the Total Import window according to the following steps (see 
Illustration 284): 
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Illustration 284, Total Import DVD “Source” Panel 

 

a. Click the “Browse” button.  In the “Browse for folder” window that appears, 
navigate to your local DVD drive and select the DVD drive letter.  Click “OK” to 

display a list of your DVD’s titles on the “Source” panel. 

b. Select each DVD title you would like to import by checking the boxes to the left 

of the titles.  A selected title will have a green checkmark in its box.   

3. In the “Settings” panel,  LEIGHTRONIX recommends leaving the “Stream copy 

video” option checked and just selecting a target audio bit rate to encode the DVD 
audio files into Audio layer II (see Illustration 285).  While the video and audio will 

still be combined into one MPEG-2 file, the “Stream copy video” option leaves the 
video for your DVD files at its original quality rather than re-encoding and possibly 
degrading the quality of the video.   

NOTE: If you experience sync problems between your DVD video and audio 
files in the final MPEG-2 file or you just want to create a smaller file, you 

may uncheck the “Stream copy video” option and select a video bit rate 
for encoding (see Illustration 286).  While a lower video bit rate may 
result in a smaller MPEG file size, keep in mind the file quality may also 

be lower. 

Illustration 285, Total Import "Settings" Panel 
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Illustration 286, Total Import "Settings" Panel with Selectable Video Bit Rate 

 

4. Under “Destination,” specify where on your PC you would like your newly encoded 

MPEG file(s) saved (see Illustration 287).  Total Import will create a separate 

MPEG file for each DVD title within the specified storage area.   

Illustration 287, Total Import "Destination" Panel 

 

a. Click the “Browse” button and in the “Browse for folder” window that appears, 

navigate to a storage area on your PC large enough to hold the MPEG files.  
The Total Import encoding process will create MPEG files that are larger than 
the original DVD titles. 

b. Use the “Temporary Storage” field’s “Browse” button to specify where on your 
PC you would like Total Import to store the imported DVD titles.  Total Import 

automatically deletes the imported titles once they are converted into an MPEG-
2 file.   

c. Assign filenames with either the “Filename” or “Filename Prefix” field as follows:  

NOTE: NEXUS series systems do not recognize filenames with spaces. 

 “Filename”:  this field becomes available if you are only converting one title.  

Enter up to 27 characters, no spaces, in the field.  Total Import will 
automatically add “.mpg” to the filename.  

 “Filename Prefix”:  if you are converting more than one title, the “Filename” 
field is disabled and the “Filename Prefix” field becomes available.  Enter up 

to 17 characters, no spaces, in the field and your entry will be added before 
each converted DVD title’s job ID and title numbers (for example, 
“promotional_video-DVD000-01.mpg”). 

d. Check the “Overwrite” box if you want to save the file over an existing file with 

the same name. 

5. Click the “Start” button to import and encode the DVD titles.  The percentage of the 

job completed will be displayed in the “Source” panel next to the “Start” and “Stop” 
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buttons.  Click “Stop” if you need to prematurely end the job.  Any of the job’s DVD 
titles not fully encoded will need to be reimported and encoded from the beginning. 

Once you have finished importing and encoding your DVD titles through Total Import, 

use the Storage Manager in WinLGX to transfer the new MPEG files to your NEXUS 
series system’s hard drives.  See “Managing Storage of Video, Slide, and Overlay,” on 
page 328, for instructions.
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TROUBLESHOOTING 

Always ensure that the NEXUS series system physical connections (power cable, 
video/audio cables, PRO-BUS, DVply, and Ethernet cables) are secure. 

PARTS REPLACEMENT 

Due to the placement and sensitivity of components inside each NEXUS series 
server/controller, the systems do not contain any user-serviceable parts.   

The NEXUS series server/controller must be sent back to the factory if battery 
replacement is necessary.  Whenever the NEXUS series system is unplugged, its 

backup battery automatically provides standby power to the unit.  Leaving the NEXUS 
series system unplugged for extended periods of time will drain its backup battery. 

CHECKING EXTERNAL USB DRIVES AND INTERNAL COMPACT 
FLASH DRIVE 

Use the WebNEXUS disk diagnostics feature to automatically fix many common File 

Allocation Table (FAT) errors that may impair your NEXUS series system’s USB drives 
and compact flash drive or cause data loss on the drives.  LEIGHTRONIX 
recommends using the feature on a monthly basis to ensure optimal drive 

performance as well as any time you discover file/drive errors in your log files or notice 
drive performance issues.   
NOTE: The disk diagnostics process does not fix physical hardware degradation.   
 

To run the disk diagnostics feature, log into the WebNEXUS interface and click the 
“SYSTEM” menu button and then the “Maintenance” tab to display the screen shown 

in Illustration 288.   

Illustration 288, "System" Screen with "Disk Diagnostics" Button 
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Click the “Disk Diagnostics” button and then select the pop-up menu’s “Start 
Diagnostics” option to perform the disk check process.  When the diagnosis has been 

completed, a log file describing any errors discovered and actions performed will be 
added to your system’s “EVENTS.LOG” file (see the “System Log Files” section on 
page 339 for more information on the “EVENTS.LOG” file).   

CONTACTING LEIGHTRONIX TECHNICAL SUPPORT 

If you are experiencing a problem that you are unable to resolve, you may: 

Visit our website: www.leightronix.com 
E-mail us at: support@leightronix.com 

Call us at: 
(800) 243-5589 
(517) 694-1600 Fax 

Our technical support phone lines are open Monday through Friday, excluding 
holidays, from 8:30AM – 5:30PM, Eastern Time (ET). 
 
When you report a problem, please provide the following information: 

 Your name, and your company name, address, and phone number 

 Model number 

 Serial number 

 Software version 

 Firmware version 

 Description of the problem 

 Status of the unit when the problem occurred (please try to include information on 

user and network activity at the time of the problem) 
 

Please contact the LEIGHTRONIX Technical Support Department at the number 
below for an RMA (Return Material Authorization) number before sending an item in 
for repair. 
 

LEIGHTRONIX, INC. 
1125 N Cedar Rd 

Mason, MI  48854 
Phone:  (800) 243-5589 

Fax:  (517) 694-1600 

http://www.leightronix/
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WARRANTY 

LEIGHTRONIX, INC. warrants this NEXUS series server/controller against defective 

workmanship or materials for a period of five (5) years from the original date of 
purchase. 

During this warranty period, any parts found to be defective will be replaced at no 

charge.  Labor to repair or replace defective parts will also be performed at no charge 

during the warranty period. 

This warranty does not cover abuse, shipping damage, neglect, tampering by 
unauthorized personnel, acts of God, damage inadvertently caused by the user, 

preventive maintenance, or any product whose serial number is removed or defaced. 

The sole responsibility of LEIGHTRONIX shall be to repair or replace in accordance 
with this warranty.  The seller’s and manufacturer’s only obligation shall be to repair or 

replace such quantity of the product proved to be defective. 

The customer shall bear the cost of shipping products returned to LEIGHTRONIX for 
warranty repair.  The cost for return shipment to the customer will be assumed by 

LEIGHTRONIX and shipped via an equal priority service shipper prepaid and insured. 

Neither seller nor manufacturer shall be liable for any injury, loss or damage, direct or 
consequential, arising out of the use of, or the inability to use the product.  Before 

using, the user shall determine the suitability of the product for his/her intended use, 
and user assumes all risk and liability whatsoever in connection therewith. 

The warranty and the obligations and liabilities thereunder shall replace all other 

warranties or guarantees, express or implied.
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DECLARATION OF STANDARDS CONFORMITY 

FCC NOTICE 

NOTE:   This equipment has been tested and found to comply with the limits 
for a Class A digital device, pursuant to part 15 of the FCC Rules.  
These limits are designed to provide reasonable protection against 

harmful interference when the equipment is operated in a commercial 
environment.  This equipment generates, uses, and can radiate radio 
frequency energy and, if not installed and used in accordance with 

the instruction manual, may cause harmful interference to radio 
communications.  Operation of this equipment in a residential area is 
likely to cause harmful interference in which case the user will be 
required to correct the interference at his own expense. 

 

CAUTION 

Changes or modifications to this device not expressly approved by 

LEIGHTRONIX, INC. could void the user’s authority to operate 
this device. 

This equipment is intended to be installed in a controlled environment with 

restricted access. 
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PRODUCT SAFETY CERTIFICATIONS 

The NEXUS series products have been certified by ETL Semko for U.S. Standards for 
Audio, Video & Similar Electronic Apparatus (UL-60065) and Canadian Standard(s) for 
Safety Requirements for Audio, Video & Similar Electronic Apparatus (CAN/CSA-

C22.2 No. 60065)
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APPENDIX A: PRO-BUS INTERFACE CONNECTIONS 

Each NEXUS series server/controller comes equipped with a LEIGHTRONIX PRO-
BUS control output.  By connecting addressable PRO-BUS interfaces to your NEXUS 

series server/controller, you can use pre-programming or immediate remote control to 
operate up to 16 of your devices (play, rewind, record, and stop).     

PRO-BUS interfaces use standard phone cables with RJ-11 connectors that loop 

between each interface.  Each NEXUS series system provides both control signals 

and power to your devices through PRO-BUS interfaces.  Connect your PRO-BUS 
interfaces as follows (refer to Illustration 289, PRO-BUS Interface): 

Illustration 289, PRO-BUS Interface 

 

DIP Switches 
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SET SWITCHES 

ASSIGN INTERFACE AN ADDRESS 

Each PRO-BUS interface relays the control commands issued to its address number.  

The interface’s activity LED toggles from its previous state (ON or OFF) when the 
interface receives a command.  To assign your interface an address, set Switches 1–4 
(see Illustration 289, PRO-BUS Interface) according to Table 61, PRO-BUS Address 

Configuration.  For organizational purposes, please: 

 Assign your interfaces consecutive address numbers, starting with “01” at the 

Controller. 

NOTES:  If your Controller has two PRO-BUS ports, continue numbering 

the first interface in the second PRO-BUS chain where the first 
chain left off. 

 For interfaces attached to a TCD/IP Controller, the address 
settings for Switches 1–4 shown in Table 61, PRO-BUS 
Address Configuration are repeated for each PRO-BUS chain 

(for example, Switches 1–4 for Device 1 and Device 17 are the 
same). 

 If possible, match each device’s interface address to its switcher input number.  

 Label devices and interfaces with their address and input numbers. 

 Document your entire PRO-BUS interface/device/switcher setup. 

Table 61, PRO-BUS Address Configuration 

DEVICE 01 DEVICE 02 DEVICE 03 DEVICE 04 

DEVICE 05 DEVICE 06 DEVICE 07 DEVICE 08 

DEVICE 09 DEVICE 10 DEVICE 11 DEVICE 12 

DEVICE 13 DEVICE 14 DEVICE 15 DEVICE 16 

CONFIGURE INTERFACE TO SEND CONTROL COMMANDS 

When an interface receives a PRO-BUS command, it checks the settings of Switches 
5–8 and emits the corresponding command(s). The emitted command(s) will change 

the device from its initial, operational mode to a new mode.  The settings for Switches 
5–8 vary depending on the PRO-BUS interface model, so refer to the corresponding 
PRO-BUS manual for more information. 

 1 2 3 4  1 2 3 4  1 2 3 4  1 2 3 4 

 1 2 3 4  1 2 3 4  1 2 3 4  1 2 3 4 

 1 2 3 4  1 2 3 4  1 2 3 4  1 2 3 4 

 1 2 3 4  1 2 3 4  1 2 3 4  1 2 3 4 
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ATTACH PRO-BUS TO CORRESPONDING DEVICE 

LEIGHTRONIX PRO-BUS interfaces are sold separately for many brands and models 
of professional video equipment and are available with infrared, mini-jack, and multi-
pin connectors. Refer to your PRO-BUS interface’s manual for more information on 
connecting the interface to a device. 

CONNECT PRO-BUS TO CONTROLLER AND OTHER PRO-BUS 
INTERFACES 

Starting from the PRO-BUS port on your NEXUS series server/controller, daisy-chain 
the provided RJ-11 cables between interfaces as shown in Illustration 290, PRO-BUS 

Daisy Chain, observing the “IN” and “OUT” labels on the interfaces.  These labels 
indicate the signal path from the Controller.  Do not loop the last interface back to 
the NEXUS series server/controller!  It should have an OPEN “OUT” connector.  
Only 16 interfaces may be connected in a chain. 

 

CAUTION 

Interfaces will not work and equipment may be damaged if the “IN” and 
“OUT” labels are not observed! 

Illustration 290, PRO-BUS Daisy Chain 
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APPENDIX B: CABLE PINOUTS FOR LEIGHTRONIX-

SUPPORTED EXTERNAL SWITCHERS  

Each NEXUS series server/controller is equipped with a male DB9M RS-232 port 

(“COM 1”) for an external switcher.  Table 62 lists the external switcher cables 
compatible with the NEXUS series systems.   

NOTE: LEIGHTRONIX ships the following external switcher cables with each 
NEXUS series system: part #s 10-4869, 10-4421, and 10-2372.   

Table 62, Cable Information for LEIGHTRONIX-Supported External Switchers 

LEIGHTRONIX  

PART # 

COMPATIBLE 

SWITCHER(S) 

CABLE 

ILLUSTRATION 
PINOUT DIAGRAM 

10-4869  Extron 

 Knox 

 Utah (9 pin) 

 Creator 

Illustration 291 Figure 4 

10-4421  Autopatch 

 Leitch 

 LGX NET-164 

 Pesa 

Illustration 292 Figure 5 

10-4617 LGX PRO-16 Illustration 293 Figure 6 

10-2372  Kramer 

 Sigma 

Illustration 294 Figure 7 

10-4588 Sierra  Figure 8 

 
Reliable operation with cables other than those provided by LEIGHTRONIX cannot be 
guaranteed. Custom cables may be fabricated according to the following pinouts.  

The color and molding of cables shipped with each NEXUS series system may differ 
from the cables shown in the following illustrations.  

NOTE: Handshaking lines are driven, but not utilized. 



NEXUS Series 

Appendix B 

LEIGHTRONIX, INC.  Page 467 
2018-06-08  WinLGX ver. 7.0.2.60 
 

Illustration 291, DB9F-DB9M Straight-Through Cable, Part #10-4869 

 

 

Figure 4, Pinout of DB9F-DB9M Straight-Through Cable, Part #10-4869 
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Illustration 292, DB9F-DB9F Null Cable, Part #10-4421 

 

 

Figure 5, Pinout of DB9F-DB9F Null Cable, Part #10-4421 
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Illustration 293, DB9F-DB25F 6’ Straight-Through Cable, Part #10-4617 

 
 

Figure 6, Pinout of DB9F-DB25F 6’ Straight-Through Cable, Part #10-4617 
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Illustration 294, DB9F-DB9M 6’ Null Cable, Part #10-2372 

 
 

Figure 7, Pinout of DB9F-DB9M 6’ Null Cable, Part #10-2372 
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Illustration 295, DB9F-DB9M 6’ Serial Cable, Part #10-4588 

 
 

Figure 8, Pinout of DB9F-DB9M 6’ Serial Cable, Part #10-4588 
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APPENDIX C: CABLE PINOUTS FOR LEIGHTRONIX-

SUPPORTED EXTERNAL CLOCKS  

Each NEXUS series system is equipped with a male DB9M RS-232 port (“COM 2”) 
which may be connected to a LEITCH or ESE clock.  Custom cables may be 

fabricated according to the following pinouts.  The color and molding of cables shipped 
with each NEXUS series system may differ from the cables shown in the following 
illustrations. 

NOTE: Handshaking lines are driven, but not utilized. 

Illustration 296, DB9F-DB25M Straight-Through Cable, Part #10-4381      

 

Figure 9, Pinout of DB9F-DB25M 6’ Straight-Through Cable for LEITCH Clock, Part #10-4381 

NOTE: If you are constructing your own LEITCH cable, only the TXD, RXD, and 
Ground wires are needed. 
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Illustration 297, DB9F-DB9M Serial Cable 

 
 

Figure 10, Pinout of DB9F-DB9M 6’ Serial Cable for ESE Clock 



NEXUS Series 

Appendix D 

Page 474   LEIGHTRONIX, INC. 
WinLGX ver. 7.0.2.60  2018-06-08 
 

APPENDIX D: COPYRIGHT STATEMENTS 

The UltraNEXUS/NEXUS and UltraNEXUS-SDI firmware contains portions of the 
following software. 

WHITSOFT SLIMFTPD 

Portions of the LEIGHTRONIX FTP Server are derived from WhitSoft SlimFTPd. 
 

Copyright (c) 2006, Matt Whitlock and WhitSoft Development 
All rights reserved. 
 

Redistribution and use in source and binary forms, with or without 
modification, are permitted provided that the following conditions are met: 
 

  * Redistributions of source code must retain the above copyright notice, 
    this list of conditions and the following disclaimer. 
  * Redistributions in binary form must reproduce the above copyright notice, 

    this list of conditions and the following disclaimer in the documentation 
    and/or other materials provided with the distribution. 
  * Neither the names of Matt Whitlock and WhitSoft Development nor the names 

    of their contributors may be used to endorse or promote products derived 
    from this software without specific prior written permission. 
 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND 
CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 

MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE 
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, 

SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT 
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF 
USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED 

AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT 
LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN 
ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 

POSSIBILITY OF SUCH DAMAGE. 
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THE PHP LICENSE, VERSION 3.0 

Copyright © 1999–2002 The PHP Group. All rights reserved. 

--------------------------------------------------------------------  

Redistribution and use in source and binary forms, with or without modification, is 
permitted provided that the following conditions are met: 

1. Redistributions of source code must retain the above copyright notice, this list of 
conditions and the following disclaimer. 

2. Redistributions in binary form must reproduce the above copyright notice, this list of 
conditions and the following disclaimer in the documentation and/or other materials 

provided with the distribution. 

3. The name “PHP” must not be used to endorse or promote products derived from 

this software without prior written permission. For written permission, please 
contact group@php.net. 

4. Products derived from this software may not be called “PHP”, nor may “PHP” 

appear in their name, without prior written permission from group@php.net.  You 
may indicate that your software works in conjunction with PHP by saying “Foo for 
PHP” instead of calling it “PHP Foo” or “phpfoo” 

5. The PHP Group may publish revised and/or new versions of the license from time 

to time. Each version will be given a distinguishing version number.  Once covered 
code has been published under a particular version of the license, you may always 
continue to use it under the terms of that version. You may also choose to use 

such covered code under the terms of any subsequent version of the license 
published by the PHP Group. No one other than the PHP Group has the right to 
modify the terms applicable to covered code created under this License. 

6. Redistributions of any form whatsoever must retain the following acknowledgment: 

“This product includes PHP, freely available from <http://www.php.net/>”. 

 

THIS SOFTWARE IS PROVIDED BY THE PHP DEVELOPMENT TEAM ``AS IS’’ AND 

ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED 
TO,THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE ARE DISCLAIMED.  IN NO EVENT SHALL THE 

PHPDEVELOPMENT TEAM OR ITS CONTRIBUTORS BE LIABLE FOR ANY 
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL 
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 

SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR 
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF 
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING 

NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF 
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 
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This software consists of voluntary contributions made by many individuals on behalf 
of the PHP Group. 

The PHP Group can be contacted via Email at group@php.net. 

For more information on the PHP Group and the PHP project, please see 
<http://www.php.net>. 

This product includes the Zend Engine, freely available at <http://www.zend.com>. 

GD STATEMENT  

 Portions copyright 1994, 1995, 1996, 1997, 1998, 1999, 2000, 2001, 2002, 2003, 

2004 by Cold Spring Harbor Laboratory. Funded under Grant P41-RR02188 by the 
National Institutes of Health. 

 Portions copyright 1996, 1997, 1998, 1999, 2000, 2001, 2002, 2003, 2004 by 
Boutell.Com, Inc. 

 Portions relating to GD2 format copyright 1999, 2000, 2001, 2002, 2003, 2004 
Philip Warner. 

 Portions relating to PNG copyright 1999, 2000, 2001, 2002, 2003, 2004 Greg 
Roelofs. 

 Portions relating to gdttf.c copyright 1999, 2000, 2001, 2002, 2003, 2004 John 
Ellson (ellson@graphviz.org). 

 Portions relating to gdft.c copyright 2001, 2002, 2003, 2004 John Ellson 
(ellson@graphviz.org). 

 Portions relating to JPEG and to color quantization copyright 2000, 2001, 2002, 

2003, 2004, Doug Becker and copyright © 1994, 1995, 1996, 1997, 1998, 1999, 
2000, 2001, 2002, 2003, 2004 Thomas G. Lane. This software is based in part on 
the work of the Independent JPEG Group. See the file README-JPEG.TXT for 
more information. 

 Portions relating to GIF compression copyright 1989 by Jef Poskanzer and David 
Rowley, with modifications for thread safety by Thomas Boutell. 

 Portions relating to GIF decompression copyright 1990, 1991, 1993 by David 
Koblas, with modifications for thread safety by Thomas Boutell. 

 Portions relating to WBMP copyright 2000, 2001, 2002, 2003, 2004 Maurice 
Szmurlo and Johan Van den Brande. 

 Portions relating to GIF animations copyright 2004 Jaakko Hyvätti 
(jaakko.hyvatti@iki.fi) 

mailto:jaakko.hyvatti@iki
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IJPEG STATEMENT 

 “this software is based in part on the work of the Independent JPEG Group” 

FREETYPE STATEMENT 

“Portions of this software are copyright © 1996-2002 The FreeType Project 
(www.freetype.org).  All rights reserved.” 

http://www.freetype/
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GLOSSARY 

The following terms are used throughout this manual. 

TERM DEFINITION 

Baud Rate Controller’s data transmission rate in bits per second  

Bit Rate Bit rate is the speed at which pieces of information are 

transmitted. A bit is the single smallest piece of 
information that is transmitted, and the speed is 

expressed as the number of bits that are transmitted per 
second.  

BNC Type of connector used with coaxial cables 

CBR Constant Bitrate; the NEXUS series CBR recording 

preset option ensures the internal broadcast MPEG 
recorder records a program at the user-defined video bit 

rate. This option works best for video with little motion 
and allows you to reliably predict the record time of a 
video file. 

Character Generator Electronic device which produces graphics and 
characters for creating video titles 

Client (software) Software program that is used to contact and obtain data 

from a server software program on another computer 

Controller Provides unattended, automatic control over a wide 

variety of video devices including digital video servers, 
digital disc recorders, DVD players, video/audio routing 
switchers, VCRs, and the like 

Cross-Over Cable A twisted pair patch cable wired to route the transmit 

signals from one piece of equipment to the receive 
signals of another piece of equipment, and vice versa. 

Decoder A software program and/or hardware device that converts 

a signal back into its original format 

Destination Output 

Device Any source (input) controlled by a PRO-BUS, IR, DVply, 

or switch interface; also referred to as “deck” 

DHCP Dynamic Host Configuration Protocol; protocol that 

automatically assigns IP addresses to devices as they 
are attached to a network 

DTE Data Terminating Equipment; refers to a communications 

device that is the source or destination of network signals 
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TERM DEFINITION 

DVply Serial device ports providing advanced control for select 

DVD players with random title:chapter access 

Encoder A software program and/or hardware device that converts 
a signal back into a coded format 

Ethernet Method of networking computers in a local area network 

(LAN) 

Event Control element that holds information about “what” is 

supposed to happen and “when” 

Event Action Any switch or device function 

Fallback Input Applies to internal UltraNEXUS/NEXUS switcher only: 

if valid video is lost on an output, the selected fallback 
input will be switched to the output  

FAT File Allocation Table; part of a hard disk where data is 

stored 

Firmware Software contained in a hardware device 

FPTV Full-power television 

Gateway Address IP address of computer or router that transfers 
communications from the local network to the broader 

network 

GPI General Purpose Interface 

Host IP-capable machine connected to an IP network 

Image File See NEXUS Series Image File 

Immediate (control) Control of UltraNEXUS/NEXUS through WinLGX control 

panel instead of a schedule 

IP Address Internet Protocol; 4-byte address used to identify devices 
on a network 

IRD Integrated Receiver Decoder 

JPEG file Graphic file that may be used to create slides and slide 
shows.  Use the stock JPEG images included with the 

NEXUS series system and add messages with the text 
editor or upload any JPEG files you have created with 
third-party software.   

LAN Local Area Network; computer network that covers a 
relatively small area (single building) 

LED Light-emitting diode 
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TERM DEFINITION 

Library Resource Contains the event actions of a frequently scheduled 

device medium.  Each library resource contains event 
actions for a specific MPEG video, slide, tape, disc, or 
switch action. 

Locked Event An event with an editable, fixed time entered by the user 

Log File List of NEXUS series system actions and alarms 

LPTV Low-power television 

MATV Master-antenna television 

Mb/s Megabytes per second 

Metadata Data used to describe other data.  Each NEXUS series 

system processes user-assigned, WebNEXUS slide 
metadata to determine when slides will appear in slide 

shows scheduled through WinLGX. 

MPEG Moving Pictures Expert Group; standards for 
compressing digital video and audio data 

Network A group of connected computers that can communicate 

with one another. Networks enable computers to share 
files and resources and exchange messages. 

NEXUS Series Image File Contains system, device, and library properties and may 

contain a schedule of events 

NIC Network Interface Card; Ethernet card used to connect to 

a network 

OS Operating System 

Overlay PNG file that may be layered over digital video and slide 

playback to add station IDs, emergency alerts, 
messages, and more to program playback 

PC Personal Computer 

PNG file Graphic file format that supports transparency.  PNG files 
may be formatted to include station IDs, icons, message 

banners, and more and then placed over digital 
programming without blocking the entire slide or video 
picture.  Use the stock PNG images included with the 

NEXUS series system and add messages with the text 
editor or upload any PNG files you have created with 
third-party software. 

Preroll Amount of time the NEXUS series system waits before 

switching device on-air (prevents the transmittal of black 
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video or static found at beginning of a program) 

PRO-BUS Interfaces used to connect VCRs/DVD players to an 

Controller 

RCA Plug and jack connector for a two-wire coaxial cable 

Reset Time Time the device is unavailable for scheduling after the 

end of the event, usually due to “Rewind” time. 

Setup Time Amount of time device needs to prepare for playback; 

begins when device receives a playback command and 
ends at the first sign of video 

Slide JPEG file 

SMTP Simple Mail Transfer Protocol; protocol used to transfer 

email between or among servers 

Source Input (video and/or audio) 

Subnet Mask Separates IP address into network address and host 

address as assigned within the network 

Switchback Input Once the scheduled event time ends, the selected 

switchback input will be switched to the event’s channel 
tab output 

TCP/IP Transmission Control Protocol/Internet Protocol 

TOTAL INFO An optional, subscription-based dynamic, video content 
service (30-day, free trial available) offered exclusively by 

LEIGHTRONIX.  Part of the WebNEXUS Virtual Channel 
feature, TOTAL INFO adds local weather and traffic 
information as well as world news, sports, and 

entertainment to NEXUS series MPEG playback 
channels. 

Unlocked Event An event whose start time is assigned by WinLGX to 

coincide with the ending time of the event above it.  This 
time is not fixed and will be adjusted by WinLGX if events 
above it are inserted, deleted, moved, or modified. 

USB 2.0 Hi-Speed Universal Serial Bus: capable of transmitting 

data between computer and external devices at 480 
Mbits/second 

VBR Variable Bit Rate; the NEXUS series VBR recording 

preset option allows the internal MPEG recorder to 
automatically adjust the record rate of a program between 

the user-defined minimum and maximum video bit rates. 
This option ensures that the MPEG recorder captures the 
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more detailed portions of the program (particularly 
important for motion-intensive video). 

VFD Vacuum Fluorescent Display 

Video MPEG file 

Virtual Channel The WebNEXUS Virtual Channel feature provides two 

looping video sources that may be configured to 
automatically appear between scheduled programs or in 
place of a schedule. 

VOD Video-on-Demand; UltraNEXUS-SDI/UltraNEXUS VOD 
files are available for viewing at any time from 

LEIGHTRONIX PEG Central 
  



NEXUS Series 

Index 

 

LEIGHTRONIX, INC.  Page 483 
2018-06-08  WinLGX ver. 7.0.2.60 
 

INDEX 

AUTOMATIC MPEG AND VOD FILE 

TRANSFERS .................................... 354 

BACKGROUNDS 
Filenames ....................................... 37 
Recommended resolutions ............ 36 

CAUTION ........................ 62, 70, 460, 464 

CHANNEL OUTPUT TABS...................... 232 

CONFIDENCE MONITOR ....................... 320 

CONTROLLER WINDOW ....................... 113 

COPYING/CUTTING/PASTING EVENTS .. 241 

DAY TABS 
Adding an event............................ 238 
Functions ...................................... 233 

DELETING EVENTS .............................. 242 

DEVICE EVENT PROPERTIES ........ 248, 268 

DVD TO MPEG CONVERSION SOFTWARE

 ...................................................... 453 

DVPLY 
Firmware version ............................ 44 
Immediate control ......................... 323 
Scheduling devices ..... 248, 253, 268, 

270 
Updating firmware ................ 323, 344 

EDITING EVENTS ................................. 241 

EPRO-BUS 
Configuring in WebNEXUS .......... 441 

Creating device resources ........... 167 

ETHERNET 
Connecting directly to a PC via 
Ethernet .......................................... 72 
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Display............................................. 43 

Keypad ............................................ 43 
LEDs ................................................ 47 
Password, changing ..................... 113 

Password, entering ......................... 75 

FTP TCP BUFFER SIZE ........................ 81 

IMAGE FILES 
Creating ........................................... 94 
Opening ......................................... 219 

Saving ........................................... 224 
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140 
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Connections .............................. 61, 65 

Control options .......................... 48, 49 
Immediate control ......................... 322 
Scheduling devices ....................... 251 

Scheduling media ......................... 274 
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 ....................................................... 211 
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 ....................................................... 226 
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LOG FILES 
Downloading from a NEXUS series 
system ........................................... 336 
Viewer ........................................... 125 
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MPEG CLIP ....................................... 313 
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Printing .......................................... 301 

PRO-BUS 
Connections ...................... 61, 65, 462 
Control options .......................... 48, 49 
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Scheduling devices ....................... 251 
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SERIAL PORT ........................................ 78 

SHARED SWITCHER 
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 ......................................................... 78 
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Approving for display .................... 389 
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Filenames ........................................ 36 
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	1. Read these instructions.
	2. Keep these instructions.
	3. Heed all warnings.
	4. Follow all instructions.
	5. Do not use this apparatus near water.
	6. Clean only with dry cloth.
	7. Do not block any ventilation openings. Install in accordance with the manufacturer’s instructions.
	8. Do not install near any heat sources such as radiators, heat registers, stoves, or other apparatus (including amplifiers) that produce heat.
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	12. Unplug this apparatus during lightning storms or when unused for long periods of time.
	13. Refer all servicing to qualified service personnel. Servicing is required when the apparatus has been damaged in any way, such as power-supply cord or plug is damaged, liquid has been spilled or objects have fallen into the apparatus, the apparatu...
	14. When the apparatus is turned off, certain components in the power supply and system board remain energized. In order to remove all electrical power from the apparatus, unplug the power cord from the MAINS socket outlet.
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	LEDs

	ULTRANEXUS/NEXUS Rear Panel
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	About this Section
	Packing List
	Installation Overview
	Using the UltraNEXUS/NEXUS Internal Switcher
	Using the UltraNEXUS-SDI No Switch Configuration
	Using an External Switcher with an UltraNEXUS or NEXUS
	Using an External Switcher with the UltraNEXUS-SDI

	Connecting NEXUS/UltraNEXUS Signal Wiring
	1. Rack mount your UltraNEXUS or NEXUS as follows, ensuring the ventilation holes on the side of the unit are not covered and adequate space is available behind the back panel for the USB drives.
	a. Insert the UltraNEXUS/NEXUS into the rack, aligning the holes of the Controller’s mounting bracket with those of the rack.
	b. Secure the UltraNEXUS/NEXUS to the rack with user-supplied rack screws.

	3. Route the video/audio from your VCRs, DVD players, studio/satellite feeds, character generator, etc. to the switcher input connectors.
	4. Connect switcher output connectors to the desired destinations (such as modulators or television monitors).
	5. If using, connect your external devices to the following interfaces:
	6. If using, attach a Leitch CDS-5300, ESE Master Clock, or C&A GPS-200 external time source to “COM 2.”
	7. Attach up to four, LEIGHTRONIX-approved USB hard drives to the USB ports.  The NEXUS supports a total USB storage capacity of 1 TB, while each UltraNEXUS system can support up to 4 TB.  For more information on USB drives compatible with the UltraNE...
	8. Attach the included power cord to the power cord connecter on the back of the UltraNEXUS/NEXUS, and then plug it into an AC power source.
	9. Turn on the UltraNEXUS/NEXUS by simultaneously pressing the right and left arrows on the front panel for one second.
	10. Ensure that the corresponding USB drive LED on the rear panel is lit for each attached USB drive (see Table 4, USB Drive LED Descriptions).
	11. Proceed to “Configuring Ethernet Network Host Management,” on page 72, to configure UltraNEXUS/NEXUS for remote control through Ethernet network host management.

	Connecting UltraNEXUS-SDI Signal Wiring
	1. Rack mount your UltraNEXUS-SDI as follows, ensuring the ventilation holes on the side of the unit are not covered and adequate space is available behind the back panel for the USB drives.
	a. Insert the UltraNEXUS-SDI into the rack, aligning the holes of the server/controller’s mounting bracket with those of the rack.
	b. Secure the UltraNEXUS-SDI to the rack with user-supplied rack screws.

	2. If using, connect a LEIGHTRONIX-supported external switcher with an input/output capacity of 4x4 (minimum) to 250x250 (maximum) to the “COM 1” port.  Finish installing your switcher according to the following steps:
	a. Configure your switcher according to the corresponding parameters listed in Table 3, Supported External Switchers and Parameters. This is necessary to ensure your switcher works with the UltraNEXUS-SDI.
	b. Route the video/audio from any VCRs, DVD players, studio/satellite feeds, character generator, etc. to the switcher input connectors.  If desired, connect your external devices to the following interfaces:
	c. Connect switcher output connectors to the desired destinations (such as modulators or television monitors).

	3. Connect video cables to the UltraNEXUS-SDI’s MPEG players as follows:
	4. Connect video to the UltraNEXUS-SDI’s broadcast and VOD MPEG recorders through one of the following options:
	5. Your UltraNEXUS-SDI audio connections are determined by the type of audio signals you wish to record and play out, as described below:
	a. Prepare your audio wiring for connection to the terminal blocks by stripping approximately a 1/4 inch of shield off the end of each wire.  Twist each wire’s individual strands together to prevent separation.
	b. Perform the following steps for each MPEG player and/or recorder that you want to use with non-embedded audio (refer to Illustration 21, Audio Terminal Blocks on Rear Panel of UltraNEXUS-SDI).
	i. With your fingers, gently grasp the desired terminal block on the UltraNEXUS-SDI’s rear panel and pull to separate the block from the server/controller.
	ii. Secure each of your prepared audio wires in their appropriate terminals as follows, referring to Table 6 for each wire’s placement on the terminal block:
	(1) Using a slotted, pocket clip screwdriver with a maximum tip width of 2.5mm and thickness of .4mm, open the terminal’s tension clamp by inserting the screwdriver tip into the clamp’s corresponding tension release slot (see Illustration 25 for an ex...
	(2) Insert the audio wire into its corresponding terminal until it is touches the bottom.
	(3) While holding the wire in place, pull the screwdriver from the slot.  The wire should now be clamped into place and should not fall out of the terminal if gently tugged.
	(4) Repeat steps 5.b.ii(1)–(3) for each of the remaining terminals in your audio terminal block configuration.

	iii. Push the wired terminal block back into its slot on the rear panel of the UltraNEXUS-SDI (see Illustration 27 for an example).  The block only fits one way into its holder on the rear panel.


	6. If using, attach a Leitch CDS-5300 or ESE Master Clock external time source to “COM 2.”
	7. Attach up to four, LEIGHTRONIX-approved USB hard drives to the USB ports.  The UltraNEXUS-SDI system can support up to 4 TB.  For more information on USB drives compatible with the UltraNEXUS-SDI, refer to www.leightronix.com or contact LEIGHTRONIX.
	8. Attach the included power cord to the power cord connector on the back of the UltraNEXUS-SDI, and then plug it into an AC power source.
	9. Turn on the UltraNEXUS-SDI by simultaneously pressing the right and left arrows on the front panel for one second.
	10. Proceed to “Configuring Ethernet Network Host Management,” on page 72, to configure UltraNEXUS-SDI for remote control through Ethernet network host management.

	Configuring Ethernet Network Host Management
	Connecting NEXUS System to an Existing Ethernet Network
	1. Obtain the following from your technical support personnel or network administrator and enter into the front panel of your NEXUS series system (see “Configuring Front Panel Settings,” on page 76):
	2. Using a straight-through RJ-45 Ethernet cable, connect the NEXUS system’s left Ethernet port (labeled “1”) to a 10/100/1000 BASE-T hub or switch on the TCP/IP network.
	3. Ensure the PC from which you wish to control your NEXUS series system has been configured and attached to the TCP/IP network.
	4. Ensure your NEXUS system and PC have been properly configured for Ethernet network access (see “Confirming Ethernet Network Configuration,” on page 74).

	Connecting a NEXUS System Directly to a PC via Ethernet
	1. If necessary, install and configure a 10/100/1000 BASE-T Ethernet Network Interface Card (NIC) on the PC.  Refer to the NIC documentation and technical support for help in getting the NIC operational.
	2. Obtain your PC’s TCP/IP networking IP address and subnet mask as follows:
	a. Click on the Windows “Start” menu.
	b. Open the “Run” dialog box and type “command.” Click “OK” or press “Enter” on your keyboard to open the command.com window.
	c. Type in “IPconfig” at the C:\ prompt of the command.com window to reveal your PC’s IP and subnet mask address.

	3. Enter the following IP and subnet mask addresses into the front panel of your NEXUS series system (see “Configuring Front Panel Settings,” on page 76):
	4. Using a cross-over RJ-45 Ethernet cable (not a standard cable), connect the NEXUS system to the PC’s network interface card (NIC).
	5. Ensure your NEXUS system and PC have been properly configured for Ethernet network access (see “Confirming Ethernet Network Configuration,” on page 74).

	Confirming Ethernet Network Configuration

	Turning a NEXUS Series System ON/OFF
	Configuring Front Panel Settings
	Entering Password
	1. From the front panel of your NEXUS series server/controller, press the right arrow key from any one of the status screens to display the password entry screen (see Illustration 29, Password Entry Screen).
	2. Press five-key password.
	3. If the password entered is correct, the NEXUS system’s configuration menu will be displayed (see Illustration 30, Configuration Menu Screen).

	Editing TCP/IP Network Addresses
	Editing Shared Switcher IP Address
	Selecting Serial Port Settings
	Sharing External Time Clock with Multiple NEXUS Series Servers
	Editing Web Schedule Port
	Editing FTP TCP Buffer Size


	Software Installation & Configuration
	About this Section
	WinLGX Minimum System Requirements
	Installing WinLGX Software
	1. Place the LEIGHTRONIX Product Resource Disc in your DVD drive.  A web page should automatically load in your default web browser.
	a. Open the Windows “Computer” folder.
	b. Right click on your DVD drive and select “Click to display main menu.”

	2. From the LEIGHTRONIX web page, click the button for your NEXUS series server product.  This will load a new page with content specifically for your system.
	3. From your NEXUS series server’s web page, click on the “WinLGX Software” link.  If the file does not automatically download, choose the save file option when prompted.
	4. Navigate to where the WinLGX installer (“WinLGX v* Installer.EXE”) was saved on your computer or network.
	5. Right click the WinLGX installer and choose the run as administrator option to start the installation.  Follow the prompts to complete setup.
	6. As WinLGX installs, a succession of two additional installation windows will be displayed.  Refer to the following for a description of each window and installation guidelines:
	7. Click “Finish” to close the WinLGX setup wizard and return to Windows.

	Changing WinLGX Appearance (Themes)
	1. Go to the “View” drop down menu and select “Themes and Colors.”
	2. On the "Themes and Colors" window, click the "Skins and Themes" tab if it is not already selected (see Illustration 31).
	3. Click to choose a different interface, menu bar, and/or tab theme (see Illustration 32). To return to the WinLGX default appearance, just select the "Default" button for each theme that was changed.
	4. Once you are finished with your changes, either click the “Done” button or the close icon in the upper right corner of the pop-up window.

	Adding / Deleting NEXUS Locations in the Site Manager
	1. If not already open, click “Site manager” in the “Tools” menu or the  icon on the main toolbar to open the “Controller Site Manager” window shown in Illustration 33.
	2. Click “Add” on the “Controller Site Manager” window (see Illustration 33) to open the “Add new controller” window shown in Illustration 34.  Complete the following fields:
	3. Click “Find.”  If you are adding the correct IP address, your server’s site ID, location, serial number, and time zone displays in the “Add new” window.
	4. Click “OK” to enter your NEXUS series server in the site manager database or “Cancel” to abort entry.
	5. If applicable, repeat steps 2–4 for each additional NEXUS series server in your system.
	1. Highlight the NEXUS series IP address you wish to delete.
	2. Click “Delete” to display the delete confirmation box.  Click “OK” to delete the NEXUS series IP address from the site manager location.
	3. Click “OK” at the bottom of the “Site Manager” window to save your changes to the database, or click “Cancel” to discard your changes.

	Connecting to Your NEXUS Series Server/Controller
	1. Open the WinLGX “Site Manager” window (see Illustration 42) by performing one of the following:
	2. Once the WinLGX “Controller Site Manager” is open, you should see a list of your NEXUS series systems.  If not, refer back to “Adding / Deleting NEXUS Locations in the Site Manager,” on page 89.
	3. If desired, reorder your NEXUS series server listing.  Clicking on any column header in the “Site Manager” sorts the associated information in ascending order, while clicking the header again sorts the list in descending order.
	4. Connect as follows (see Illustration 42):
	a. Select one or more IP addresses.  You may select up to eight IP addresses by holding down your keyboard “Ctrl” key and clicking each address with the left mouse button.
	b. Log in with the username and password given to you by the NEXUS system administrator.  To simultaneously log into multiple servers, all of the selected IP addresses must have the same username and password.
	c. Click “Connect” or press “Enter” to connect to the chosen NEXUS series server/controller(s) and close the login dialog box.  Once you are connected, a tab appears for each NEXUS series server/controller on the main window beneath the toolbar.  If y...


	Creating New NEXUS Image Files
	1. WinLGX automatically opens with an empty image file loaded.  If you need to clear any settings, select “New” under the “File” menu.
	2. Select “Save as/Export” in the “File” menu to open the window shown in Illustration 120, “Save As” Window.”
	3. From the “Save in” drop down box at the top of the window, navigate to the folder where you want to save the NEXUS series image file.
	4. Type a name for the image in the “File name” field.
	5. Ensure the “Controller Image (*.nmg)” option has been selected in the “Save as type” field.
	6. Click “Save” to save the image under the entered name or “Cancel” to abort the “Save as.”
	7. As you enter your configuration settings according to the “Configuring WinLGX” section starting on page 97, periodically save your settings in your image file by selecting “Save” from the “File” menu or clicking the  toolbar button.

	Configuring WinLGX
	About the Main Window Components
	Configuring the Main Window Components
	Configuring WinLGX Interface Colors
	Setting User Account Rights (Including WinLGX Password Changes)
	1. Select “User accounts” in the “Tools” menu to open the “User Accounts” window (see Illustration 50).
	2. WinLGX and WebNEXUS user rights are described in Table 19, User Control and Configuration Rights (see page 112) and Table 20, User File Access Rights (see page 113).  Perform any of the following according to the steps below:
	3. When finished configuring user information, exit the “User Accounts” window by clicking the “Close” button.

	Changing Front Panel Password
	1. Select “Set front panel password” in the “Tools” menu to open the window shown in Illustration 51.
	2. Click on a combination of five arrows for the new front panel password.
	3. Click “Set” to accept new password or “Clear” to cancel.
	4. Click “Done” to close the “Set Front Panel Password” window.

	Configuring Site Information, Clock, Updating Firmware, and Rebooting
	1. In the “Tools” menu, choose “Controller” to open the window shown in Illustration 52, “Controller” Window.
	2. Use the “Controller” window to set the following configuration maintenance settings.  After clicking “Set,” “Update,” or the “Reboot” button, you will be prompted for confirmation to perform the action on the connected NEXUS series server/controlle...
	3. Click “Close” to close the “Controller” configuration window.

	Creating Templates for Exporting/Printing Schedules
	1. Create a schedule template per the following steps:
	a. Click “Export/Print templates” in the “Tools” menu to open the window shown in Illustration 53.
	b. Select template display items as follows:
	 Determine which event windows will be filtered for the schedule template:
	 Check the “Export/print switchbacks” checkbox to display channel switchbacks between programs.
	 Check “Export/print all records” to include all events in the selected event windows.
	 Specify the schedule column information you want the template to add to your printouts and exported files as follows:
	c. Click “Save” to save the template to a file.

	2. To revise a template:
	a. Click “Export/Print templates” in the “Tools” menu to open the window shown in Illustration 53, “Export/Print Templates” Window.
	b. Click “Load.”  In the “Select Export/Print Template” window that appears, browse for the desired template and open.  The filename will then appear in the “Template” box at the top of the “Export/Print Templates” window.
	c. Click “Save” to open the “Save Export/Print Template” window.  Click the “Save” button and then “yes” to overwrite the template file.

	3. Click “Done” when finished to close the “Export/Print Templates” window.

	Configuring Page Layouts For Schedules Printed from WinLGX
	1. Select “Page Setup” in the “File” menu to open the box shown in Illustration 54, “Page Setup” Window, and configure the schedule printout according to the following options:
	2. Click “OK” to save your settings or “Cancel” to close the window without saving.

	Configuring Printer and Paper Settings for Schedules Printed from WinLGX
	1. Selecting “Print Setup” in the “File” menu opens the box shown in Illustration 56, “Print Setup” Window, which allows you to configure the printer and paper settings as follows:
	2. Click “OK” to save your settings or “Cancel” to close the window without saving.

	Creating Custom Schedule Columns
	1. Click “User defined data” under the “Tools” menu to open the window shown in Illustration 58.
	2. Select the fields displayed on your schedule as follows:
	3. Click on the field which you would like to rename.  In the “Edit Field Options” window that appears (see Illustration 59), perform the following:
	a. Enter a new schedule heading into the “Menu title” field.
	b. Add a list of menu options that will be used to define schedule events for the custom column.  The number of menu items that may be added corresponds to the number of options shown over each section of field names on the window.

	4. Click “OK” to accept changes or “Cancel” to abort all editing changes made in the “Edit Field Options” window and return to the “User Defined Data” window.
	5. Click “OK” to accept or “Cancel” to abort all field changes and close the “User Defined Data” window.

	Setting WinLGX Viewing and Communication Preferences
	1. Under “Format type,” select the format of the device/library event properties window you would like to configure.
	2. Perform any of the following options:

	Configuring the Switch Type of a NEXUS Series System
	Configuring NEXUS Series IR Port Properties
	1. IR Port: configure each IR port for a VCR or DVD input device by selecting the corresponding format from each IR port field’s drop down list.
	2. “Manufacturer”: choose the corresponding, LEIGHTRONIX-supported manufacturer for each input device format (see Table 21, IR Port Configuration Options, for a list of the LEIGHTRONIX-supported VCR/DVD manufacturers).
	3. “Type”: configure each IR port to match the connected device’s communication mode.  Refer to Table 21, IR Port Configuration Options, for a list of the LEIGHTRONIX-supported VCR/DVD manufacturers and their corresponding communication modes.

	Configuring Broadcast MPEG Recording Presets
	Editing Internal MPEG Player and Recorder Device Resource Properties
	1. Click on the “Devices” folder on the right side of the schedule editor window to display the “Devices” window (refer to Illustration 78, “Devices” Window).
	2. In the “Resource View,” click on the desired UltraNEXUS/NEXUS internal device icon to reveal the corresponding properties fields.

	Creating External Device Resources
	1. Click on the “Devices” folder on the right side of the schedule editor window to display the “Devices View” window (refer to Illustration 80, New Device Properties).
	2. Right click in the “Resource View” window and select “New” to display the device type menu.  Select a device type to add a new device to the window (see Illustration 80, New Device Properties).
	3. Complete the “Properties” fields for the selected device format:

	UltraNEXUS/UltraNEXUS-SDI Only: Creating ePRO-BUS-Controlled Device Resources
	1. Click on the “Devices” folder on the right side of the schedule editor window to display the “Devices View” window (refer to Illustration 80, New Device Properties).
	2. Right click in the “Resource View” window and select “New” to display the device type menu.  Select either the “DVD” or “Tape” device type to add a new device resource to the window (see Illustration 85, New Device Properties).
	3. Complete the properties fields shown in Illustration 86, ePRO-BUS Resource Properties Window according to Table 26, ePRO-BUS Resource Properties.

	Creating Overlays
	1. Select the “Overlay Templates” tab view on the main WinLGX window.
	2. Add an overlay template to the template listing by clicking the  icon and assigning a title in the “Create overlay template” box that appears (see Illustration 89, Add Overlay Template).  Click “OK” to create template or cancel to abort.  Click the...
	3. Drag up to ten overlay library resources into the desired segments on the overlay template and click “OK” in each overlay properties box that appears.

	Creating Library Resources
	1. Click on the “Library” folder on the right side of the schedule editor window to display the library view (see Illustration 91, “Library View” Windows).
	2. Right-click in the “Resource View” window and select “New” in the context menu to insert an undefined, new resource in the window (see Illustration 92, New Library Resource Windows).
	3. Complete the “Properties” fields for one of the following library resources:

	Exporting MPEG Library Resources
	1. Right click on the “Library” configuration folder containing the library resources you wish to export and select “Export” from the pop-up menu (see Illustration 111) to display the “Export MPEG Resource” window (see Illustration 112).  Resource fil...
	2. If the selected library folder contains resources for MPEG videos on more than one USB or NAS device, you will see a list of storage devices at the top of the “Export MPEG Resource” window (see Illustration 112).  Single click to select the storage...
	3. If you wish to overwrite an existing resource file, single click to select the file in “Resource Files” listing.  Click the “Export” button and, if saving a new resource file, enter an alphanumeric filename without spaces into the “Export resource”...
	4. When the resource file has been uploaded to the selected NEXUS series USB or NAS storage device, click “Ok” when you are prompted.
	5. If desired, repeat the steps in this section for each set of library resources in the folder referencing MPEG videos on your other storage devices.



	Software Operation
	About this Section
	Performing General WinLGX Operations
	Opening WinLGX and Connecting to NEXUS Series Server/Controller
	1. Double click the WinLGX desktop icon.  The login window shown in Illustration 114 automatically appears when WinLGX is opened or when you click one of the following:
	2. If desired, reorder your IP address listing.  Clicking on any column header in the “Site Manager” sorts the associated information in ascending order, while clicking the header again sorts the list in descending order.
	3. Connect as follows (see Illustration 114, “Site Manager” Window):
	a. Select one or more IP addresses.  You may select up to eight IP addresses by holding down your keyboard “Ctrl” key and clicking each address with the left mouse button.
	b. Log in with the username and password given to you by the NEXUS series system administrator.  To simultaneously log into multiple servers, all of the selected IP addresses must have the same username and password.
	c. Click “Connect” or press “Enter” to connect to the chosen NEXUS series server/controller(s) and close the login dialog box.  Once you are connected, a tab appears for each NEXUS series server/controller on the main window beneath the toolbar.
	d. If you logged into more than one NEXUS series system, switch between the servers by clicking on the product tabs on the main window.


	Displaying WinLGX Version Number
	Disconnecting from a NEXUS Series Server/Controller
	1. Select “Site manager” in the “Tools” menu or click the  icon on the toolbar to open the “Site Manager” window shown in Illustration 114.
	2. Select the NEXUS series address(es) you would like to disconnect.  If you want to disconnect from more than one address, hold down your keyboard “Ctrl” key and click on each address with the left mouse button.
	3.  Click the “Disconnect” button.  A box will appear asking whether or not you would like to disconnect from the current NEXUS series location(s).  Click “Yes” to disconnect or “No” to remain connected.

	Exiting WinLGX
	1. Select “Exit” in the “File” menu or click the  in the upper right corner of the main window.
	2. If an image file has not been saved for one of the connected NEXUS series server/controllers, the dialog box shown in Illustration 116 appears and asks if you want to save the changes.  Select one of the following options:


	Opening NEXUS Series Image Files
	Opening a Saved Image File
	1. Select “Open” in the “File” menu or click the  icon on the main toolbar to open the file selection window shown in Illustration 117.
	2. Ensure the “Controller Image (*.nmg)” option has been selected in the “Files of type” field.
	3. Select an image file folder from the “Look in” drop down box at the top of the window.
	4. Single click a .nmg file to select it and click “Open” or double click the file.  The image file data is then loaded into WinLGX.
	5. As you enter/edit your schedule events according to the “Scheduling Events” section starting on page 232, periodically save your settings in an image file as described in “Saving NEXUS Series Image Files,” on page 225.

	Opening an Image File as New
	1. Select “Open as new” in the “File” menu or click the  icon on the main toolbar to open the file selection window shown in Illustration 118, Open Image File as New Window.
	2. Ensure the “Controller Image (*.nmg)” option has been selected in the “Files of type” field.
	3. Select an image file folder from the “Look in” drop down box at the top of the window.
	4. Single click a .nmg file to select it and click “Open” or double click the file.  The image file data minus the schedule is then loaded into WinLGX as an unnamed file.
	5. As you enter/edit your schedule events according to the “Scheduling Events” section starting on page 232, periodically save your settings in an image file as described in “Saving NEXUS Series Image Files,” on page 225.

	Receiving Image Files from the Connected NEXUS Series Server/Controller(s)
	1. Download the last image file sent to one or more of your NEXUS series server/controllers as follows:
	2. As you enter/edit your schedule events according to the “Scheduling Events” section starting on page 232, periodically save your settings in an image file as described in “Saving NEXUS Series Image Files,” on page 225.

	Associating NEXUS Series Image Files with WinLGX

	Saving NEXUS Series Image Files
	1. From the “Save in” drop down box at the top of the window, navigate to the folder where you want to save the NEXUS series image file.
	2. Type a name for the image in the “File name” field.
	3. If you plan to re-open this file in WinLGX, ensure the “Controller Image (*.nmg)” option has been selected in the “Save as type” field.
	4. Click “Save” to save the image under the entered name or “Cancel” to abort the “Save as.”  If you enter a name of a file that already exists, WinLGX will ask you if you want to overwrite it.

	Importing MPEG Library Resources
	1. Right click on the “Library” configuration folder you wish to import MPEG library resource properties into and select “Import” from the pop-up menu (see Illustration 121) to display the “Import MPEG Resource” window (see Illustration 122).  Resourc...
	2. If more than one device is shown in the “Storage Device” listing on the “Import MPEG Resource” window (see Illustration 122, "Import MPEG Resource" Window), single click to select the storage device containing the resource files with the library re...
	3. If more than one resource file exists, single click to select the file with the library resources you wish to import (see Illustration 123).
	4. Click the “Import” button to start importing the resources or “Done” to cancel the operation and close the “Import MPEG Resource” window.
	5. After clicking the “Import” button, click “Yes” when prompted to import the file’s MPEG library resource properties or “No” to abort.
	6. When the MPEG library resource properties have been imported, click “Ok” when you are prompted.  The imported library resources will be shown in the “Resource View” (see Illustration 124 for an example).
	7. If you wish to import MPEG library resource properties from additional resource files, repeat steps 1–6.

	Using Instant Video Preview Monitor to Display MPEG Files within WinLGX
	Scheduling Events
	About Schedule Window Components
	Scheduling/Editing/Deleting All Events
	1. Select a scheduling event window as follows:
	a. Click the desired day tab to select the day you want the event to occur.
	b. Select one of the following channel tabs:

	2. Drag an icon from the “Device” or “Library” “Resource View” into the selected event window.  This opens an “Event properties” box with editable event information like the one shown in Illustration 129, Day/Channel Output Event Properties Box.
	3. To add or change the event information, click on each of the desired editable fields (described on pages 249–298) and enter the new information.  An icon can be dragged and dropped into a day/channel output event window in the following five ways:
	a. To select a date, change “Absolute date” to “Yes.”  A date field appears below to allow date entry.
	b. To enter a day, change the desired day field(s) to “Yes.”  These fields can be toggled quickly by double clicking on the day name.


	Scheduling/Editing Device Resources
	UltraNEXUS/UltraNEXUS-SDI Only: Scheduling/Editing ePRO-BUS-Controlled Device Resources
	1. Select the WinLGX-LT tab on the bottom of the scheduling window.  If you do not see this tab, go to the “Tools”/”Preferences”/”Applications” tab and select the “Show WinLGX-LT tab” option.
	2. Open the ePRO-BUS record “Event Properties” window (see Illustration 144, Remote ePRO-BUS Record Event Properties Window) by either adding or editing the ePRO-BUS record event. To add a new ePRO-BUS-controlled remote record event, drag the desired ...
	3. Complete or edit the event properties fields according to Table 45, Editable Remote ePRO-BUS Record Event Properties.  Some of the fields will vary, depending on whether you used a “DVD” or “Tape” format to create your ePRO-BUS resource.

	Scheduling/Editing Library Resources
	Changing Channel Switchbacks
	1. Select “Switchback editor” under “Tools”/”System Tools” to open the “Channel Switchback Editor” (see Illustration 158).
	2. Select the channel output/day tab schedule window containing the switchback inputs you would like to change by selecting a channel output under “Channel” and a day under “Day of week.”  You may select “All” under “Day of week” to select all schedul...
	3. Under “Replace all,” select the switchback input you would like to change.
	4. Use the “With” drop down menu to select a new switchback input.
	5. Click “OK” to make the changes or “Cancel” to abort.

	Checking Schedule and Library Resources for Missing MPEG Files
	1. If you have not already done so, open a NEXUS series image file in WinLGX.
	2. Click the  sync icon on the main toolbar or choose the “Tools”/”System tools”/”Sync Library Resources” menu item.  Those events containing missing MPEG files are highlighted in the schedule and a “Sync Library Resources” box pops up to report the t...


	Sending NEXUS Series Image Files
	1. Send an image file to one or more of the currently connected server/controllers according to the following steps:
	2. Once each transfer is completed, the NEXUS series system(s) will contain and execute the scheduled events.

	Printing Schedules from WinLGX
	1. Create a print template to select the desired schedule information for printing (see “Creating Templates for Exporting/Printing Schedules,” on page 116).
	2. Determine the page layout of your schedule printout (see “Configuring Page Layouts For Schedules Printed from WinLGX,” on page 118).
	3. Select “Print” in the “File” menu or click the  icon on the main toolbar to open the template selection window shown in Illustration 161.
	4. Choose the desired template from the “File name” list in the “Select Export/Print Template” Window (see Illustration 161) and click “Open,” or double click the template file to open the “Print” window.  Click “Cancel” to abort the print.
	5. In the “Print” window, configure the printer and copy settings according to the following steps. Click “OK” to print or “Cancel” to abort the print.

	Exporting Schedules into Comma Separated Values (CSV) Files
	1. Ensure the schedule you wish to export is currently open in WinLGX (see “Opening NEXUS Series Image Files,” on page 220).
	2. If you have not already done so, create a template (see “Creating Templates for Exporting/Printing Schedules,” on page 116).
	3. Select “Save as” in the “File” menu to open the window shown in Illustration 162, which allows you to export the loaded schedule as a comma separated values file (.csv) as follows:
	a. Select a folder in the “Save in” field.
	b. Type a name for the exported file in the “File name” field.  If you leave the extension off, WinLGX puts it on for you.
	c. Select the .csv export format in the “Save as type” drop down menu.
	d. Click “Save” to open the template selection window shown in Illustration 163, “Select Export/Print Template” Window.  To apply a template to your schedule information, select the desired template and either click “Open” or double click the template...


	Using Control Panel to Perform Immediate Device and Switch Actions
	1. Open the Control Panel window (see Illustration 164) by clicking “Control Panel” under the “Tools” menu or  icon on the main toolbar.
	2. If desired, sort the device icons by right clicking in the “Devices” column and selecting one of the sorting filters in the right-click menu that appears (see Illustration 165, Control Panel Device Sorting Menu).
	3. Perform any of the following steps:
	4. When finished, click “Close” to exit the Control Panel.
	Stop/Start a Schedule
	Performing Forced Switches and Viewing Switcher Status
	Controlling Internal MPEG Players 1 and 2
	Controlling Internal MPEG Recorder(s)
	1. Select the MPEG file recording parameters:
	a. Check the “Record CC data” box to capture any closed caption data from the source during recording.  Closed captions are hidden in the video signal and decoded for display on televisions with built-in decoders or televisions connected to external d...
	b. UltraNEXUS/UltraNEXUS-SDI only: the “No VOD file” option allows you to override the VOD recorder enable/disable feature in WebNEXUS (see “Enabling/Disabling VOD Recorder,” on page 354, for more details).  If the VOD recorder has been enabled in Web...
	c. Select one of the following record overwrite options:
	d. Select the volume of the drive on which you would like to store the recorded file from the “Storage Device” drop down list.
	e. Under “File,” enter up to 27 characters (no spaces) for the filename.
	f. Select one of the user-defined record presets for the desired recording quality.  See “Configuring Broadcast MPEG Recording Presets,” on page 152 for more information on defining the recording quality settings.
	g. If you would like a library resource for the MPEG file added to the “Library” tab window, select the “Add to library” option.  Once the broadcast MPEG recorder stops, WinLGX displays the “Add to library” window (see Illustration 181).  Select the l...

	2. Select and record an input through one of the following options:

	Monitoring an MPEG File Recording
	Controlling External Devices

	Managing Storage of Video, Slide, and Overlay Files
	Choosing File Storage Devices
	1. Select one of the following to enable the display of the corresponding file type:
	2. The left side of the Storage Manager window allows you to access both your local and remote storage devices.  Select a storage device as follows:
	3. The right side of the Storage Manager window only allows you to access your NEXUS series remote storage devices.  Refer to the remote storage device selection instructions in step 2, while noting the following for the “Background” folder:

	Managing all Digital Files
	Previewing Video Files
	Enabling and Authorizing Slides for Display in Slide Shows
	Creating a Default Slide
	1. The “admin” user must upload the slide into his “admin” user account folder (see the “Managing all Digital Files” on page 330).
	2. Right-click on the file and select “Rename” from the menu.  Change the slide filename to “Default.jpg.”
	3. Enable and approve the slide for display (see the “Enabling and Authorizing Slides for Display in Slide Shows” section on page 333).

	Creating & Managing Background SubFolders
	Transferring Graphic/Text Layers with Slides Created in a WebNEXUS Slide Editor
	5. Select both the slide’s .jpg and .fie files as follows: while holding down your keyboard’s “Ctrl” key, single click both the .jpg and .fie files to select the pair.  While still holding down the “Ctrl” key, right click to display the file managemen...
	6. From the file management menu (see Illustration 194), select either “Move” to remove the files from the storage device and transfer them to the storage device selected on the opposite side of the Storage Manager window or “Copy” to create a duplica...


	Retrieving Log Files
	1. Click on the “As played” tab on the “Select Controller Log File” window.
	2. Single click on the desired .CSV file to select it and then click “OK.”
	3. A “Save as Played log File” window will open.  Save the .CSV file to a new file path or use the WinLGX default log file path (Shared Documents\Leightronix\WinLGX\Controller Data\IP xxx.xxx.xxx.xxx\Log”).
	4. Click the “Save” button to save the file to your chosen file path.  The “Save as Played log File” and “Select Controller Log File” windows will close.
	5. Navigate to the file path for the saved .CSV file and open it in Excel.

	Updating Firmware/Software
	Updating NEXUS Series Server/Controller and/or DVply Firmware
	1. Open the WinLGX software and log in to your NEXUS series system (see “Opening WinLGX and Connecting to NEXUS Series Server/Controller” on page 215).
	2. Choose “Controller” under the “Tools” menu to open the “Controller” window shown in Illustration 200.
	3. Under “Firmware update,” click “Browse” to open the “Choose controller firmware file” window shown in Illustration 201.
	4. Navigate to and open one of the following file types:
	5. Click “Update” to continue the firmware update.  Click “Yes” when prompted to start the update.
	6. Once the update has completed, click “OK” to apply the changes and reboot the NEXUS series server/controller.  You will be logged out and the “Site Manager” window will be displayed.
	7. After the NEXUS series system finishes rebooting, log back in and confirm the NEXUS system has been upgraded to the latest firmware version in the “Site Manager” database.

	Updating WinLGX Software
	1. Close WinLGX.
	2. Navigate to and open the WinLGX_vx.x.x.x_Installer.exe.  Follow the prompts to install the latest version of the client software.
	3. Click “OK” to continue WinLGX update.
	4. Follow the prompts to complete the installation.



	Web Control
	About this Section
	Opening and Logging into WebNEXUS
	1. Open WebNEXUS through one of the following steps:
	2. A login prompt will appear (see Illustration 204, Login Prompt).  Enter your username and password.
	“Site Information”
	“Storage”
	MPEG Player/Recorder Statuses
	“Network Settings”
	“Switcher Status”

	UltraNEXUS-SDI / UltraNEXUS Only: Managing MPEG and VOD Files
	Enabling/Disabling VOD Recorder
	Setting Up Transfer Destinations
	1. “Verify Connectivity”: after entering your NEXUS series unit’s IP address, username, and password, click the “Verify Connectivity” button to ensure your UltraNEXUS/UltraNEXUS-SDI can connect to the destination server.
	2. “Automatic Upload”: when selected, files will be automatically transferred to the specified NEXUS series system after each recording session.
	3. “Transfer Holdoff Schedule”: 7 day/24-hour timeline allows you to decide which hours of the week your UltraNEXUS/UltraNEXUS-SDI will transfer files to your destination NEXUS series system.  Single click each hour segment on the timeline to toggle t...
	4. “Enable Auto-Play CH” (UltraNEXUS Only): once the “PEGcasting” option is enabled on the UltraNEXUS “Record Settings” tab (see “UltraNEXUS ONLY: Setting up MPEG File Record ,” on page 360), you may choose to have a transferring file stream automatic...
	1. “Automatic Upload”: when checked, files will be automatically transferred to LEIGHTRONIX streaming video-on-demand site after each recording session.
	2. “Transfer Holdoff Schedule”: 7 day/24-hour timeline allows you to decide which hours of the week your UltraNEXUS/UltraNEXUS-SDI will transfer files to your destination NEXUS series system.  Single click each hour segment on the timeline to toggle t...
	1. “Verify Connectivity”: after entering your LGX-SVOD’s IP address, username, and password, click the “Verify Connectivity” button to ensure your UltraNEXUS/UltraNEXUS-SDI can connect to the destination server.
	2. “Automatic Upload”: when checked, files will be automatically transferred to the specified LGX-SVOD after each recording session.
	3. “Transfer Holdoff Schedule”: 7 day/24-hour timeline allows you to decide which hours of the week your UltraNEXUS/UltraNEXUS-SDI will transfer files to your LGX-SVOD server.  Single click each hour segment on the timeline to toggle transfer capabili...
	1. “Verify Connectivity”: after entering your server’s IP address, username, and password, click the “Verify Connectivity” button to ensure your UltraNEXUS/UltraNEXUS-SDI can connect to the destination server.
	2. “Automatic Upload”: when checked, MPEG broadcast files will be automatically transferred to the specified server after each recording session.
	3. “Transfer Holdoff Schedule”: 7 day/24-hour timeline allows you to decide which hours of the week your UltraNEXUS/UltraNEXUS-SDI will transfer files to your destination server.  Single click each hour segment on the timeline to toggle transfer capab...

	UltraNEXUS ONLY: Setting up MPEG File Record Settings
	UltraNEXUS Only: Recording
	1. Choose the video source you want to record from the “Source” drop down menu.  You may select one of your UltraNEXUS’s MPEG players or a video source connected to your switcher.
	2. Click the record button to start recording your file.
	3. LEIGHTRONIX LGX-SVOD and PEG Central VOD Streaming Service Users Only: add video index points for use in PEG Central or other LEIGHTRONIX VOD streaming application.  Index points appear as links next to the published video in the streaming applicat...
	4. To end the recording session, click the stop recording button.  If a file destination was configured and enabled in WebNEXUS, your recorded file will be automatically transferred to the destination.

	Manually Transferring MPEG Files

	Managing Log Files
	Save/Open a Log File
	Search a Log File
	Delete a Log File

	Managing Slides
	Uploading Slides to a NEXUS Series Server/Controller
	1. In the “File” list on the lefthand side of the screen, single click on the user folder you want to contain the slide.
	2. Click the  button to open the upload file window shown in Illustration 218.
	3. Click the  browse button to open the “Select file(s)” window shown in Illustration 219.  Navigate to the desired file and click “Open.”
	4. WebNEXUS allows you to add and remove slides from the “Upload File” window as follows:
	5. Click the  upload button to load the slide(s) onto the NEXUS series system or “Cancel” to abort the change (see Illustration 220).  When each slide has finished loading, the “Upload File(s)” window will indicate the slide is “100%.”
	6. When you have finished uploading files, click the close “x” button in the upper right corner of the window.

	Creating New Slides
	1. Using the “Grid” menu options, set up your canvas grid and safe title/safe action guidelines to aid in slide layout:
	2. Add graphics and/or text to the slide editor’s canvas using the tools in the editor’s toolbox (see Illustration 222).  Each new graphic or text element will be automatically placed on a separate layer, allowing you to individually manipulate each i...
	3. If desired, enhance individual graphic and/or text layers with graphic effects.  To apply an effect, first select a layer on the canvas with the cursor tool or by clicking on its layer in the “Layers” panel.  Change any of the following:
	4. When you have finished making changes, save your slide by clicking the  save icon or selecting the “File”/”Save” menu option.  The “Save Slide” window shown in Illustration 231 will appear, allowing you to add metadata to your slide that will contr...
	a. In the “File Name” field, type in a filename with up to 27 characters (no spaces).  If the filename already exists, a pop-up box will prompt you to either click “Ok” to overwrite the existing file or “Cancel” to enter a new filename on the “Save Sl...
	b. If you logged into WebNEXUS under an “admin” account or are using an account with the “slide administrator” or “automatic slide authorization” right, the “Authorize” box will be available for selection.  Authorize the slide for display in slide sho...
	c. Complete the remaining slide show metadata fields according to the instructions in “Adding Slide Show Settings to Slide Metadata,” on page 388, with the following exceptions:
	d. Click “Ok” to save or “Cancel” to abort.  The slide editor automatically saves a .jpeg and .fie file for each slide, where the .jpeg file is the actual slide and the .fie file contains the editable layers data for the slide.  The .fie files are onl...


	Creating a Default Slide
	1. Select the “admin” user folder in the “File” list.  Your NEXUS series system will only look for a default slide in the “admin” user folder.
	2. Upload the slide you would like to serve as the default (see “Uploading Slides to a NEXUS Series Server/Controller,” on page 370).
	3. Rename the slide to “Default.jpg” (see “Renaming Slides on a NEXUS Series Server/Controller,” on page 392).
	4. Approve the slide for display (see “Approving Slides for Display in Slide Shows,” on page 390).

	Finding Slides/User Folders
	Adding Slide Show Settings to Slide Metadata
	1. Select the desired file in the “File” list to enable the metadata fields on the right side of the slide management screen (see Illustration 232, Slide Metadata Fields).  The following settings may be modified:
	2. Click the  button to save your slide metadata.  If you don’t click the “Save Metadata” button, your changes will be lost when you select a different slide or folder or close the slide management screen.
	3. If desired, enable and authorize the slide for display in slide shows according to “Approving Slides for Display in Slide Shows” on page 390.

	Approving Slides for Display in Slide Shows
	Editing Slides Created in WebNEXUS
	1. From the “JPEG Slide Management” screen, single click on the slide you wish to edit in the “File” list (see Illustration 234).  When selected, the slide will be highlighted in orange.
	2. If the selected slide can be modified in your slide editor, the “Edit” button will be enabled.  Click on the “Edit” button (see Illustration 234) to display your selected slide in the slide editor window for your system.
	3. Edit your slide with any of the formatting options described in steps 2 and 3 of the “Creating New Slides” section on page 373
	4. Save over your existing slide or save out your changes as a new slide with a different filename with up to 27 characters (no spaces) according to step 4 of the “Creating New Slides” section on page 386.

	Renaming Slides on a NEXUS Series Server/Controller
	1. Single click to select the desired file in the “File” list.
	2. Click  icon to open the rename window shown in Illustration 235.
	3. Enter up to 27 characters in the rename field.
	4. Click the “Ok” button to make the change or “Cancel” to abort.

	Deleting Slides from a NEXUS Series Server/Controller
	1. Select the desired file in the “File” list.
	2. Click the  icon.  A dialog box will appear asking whether or not you would like to delete the selected slide from the NEXUS series server/controller.  Click “Yes” to make the change or “No” to abort.


	Creating Emergency Messages
	Creating a New Emergency Message
	1. If you need to clear a previously entered emergency message, click the “New” button.
	2. Select a graphic overlay through one of the following methods:
	3. In the message box on the right, type a sequence of up to 12 pages of two-line messages, as shown in Illustration 240.  Move to each new line of text by pressing “Enter” on your keyboard.  These messages will appear in the lower third position of t...
	4. On the “Options” panel shown in Illustration 241, complete the following steps:
	a. From the “Page Dwell Time” drop down list, select how many seconds you would like each page of messages to display on the overlay, starting with 8 seconds, skipping to 10, and then increasing in increments of 5 seconds, up to a total of 30 seconds....
	b. From the “Event Duration” field, choose to display your emergency message for up to 7 days, 99 hours, and 59 minutes or select the “Rest of day” field to display the overlay until midnight.  The message pages will continue cycling until the duratio...

	5. If you wish to save the message for reuse, click the “Save” button.
	6. If desired, activate the emergency message for display according to “Activating an Emergency Message,” on page 398.

	Activating an Emergency Message
	1. If you wish to display a saved emergency message, click on the “Saved Presets” tab and single click the desired message in the presets listing.  Otherwise, create a new message according to the steps in the “Creating Emergency Messages” section on ...
	2. Click the “Activate” button to display the “Activation Options” dialog box and select one of the following three activation levels for your message.  The “System Status” panel on the “Emergency Messaging” screen indicates the message activation sta...

	Deactivating an Emergency Message

	Viewing Web Program Guide
	Viewing Program Guide within WebNEXUS
	1. Click the “Program Guide” menu button to display a program guide screen like the example shown in Illustration 247.
	2. From the “Channel” drop down menu, click one of the channel outputs to only display the programming lineup for the selected channel or click “All Channels” to display the programming schedule for all WinLGX channel tabs.
	3. From the “Mode” drop down menu, select “Day” if you would like to view programming for just one day in your schedule (see Illustration 247) or choose “Week” to view programming for all seven days of your schedule (see Illustration 248).  If you cho...
	4. For the “Day” mode view, click on a day of the week to view programming for the corresponding weekday.  If you selected the “Week” mode, clicking a day button will sort your programming schedule by the selected day.
	5. If you wish to display the program start time down to the second, click the “Show Seconds” “on” button.  The default option is “off.”

	Viewing Program Guide from a Web Browser or Your Own WebSite
	1. Click the “Program Guide” menu button to display your NEXUS series system’s program guide (see Illustration 247 for an example).
	2. Click the URL link on the “Program Guide” screen as shown in Illustration 249 to open your NEXUS program guide in a separate browser tab window.
	3. Copy the program guide web address and, if desired, edit the following variables (shown in red) in the web address to change the programming display:
	4. Distribute the web address as a link or with instructions to paste the address into the address bar of one of the supported web browsers.
	1. Click the WebNEXUS “Program Guide” button to display the corresponding screen.
	2. To display the embed code, click on the “Embed Script” arrow (see Illustration 250).
	3. Drag your mouse cursor across the code to highlight and select it, then simultaneously press the “Ctrl” and “C” keys on your keyboard to copy the code.
	4. Paste the code onto one of your web pages by simultaneously pressing the “Ctrl” and “V” keys on your keyboard.
	5. If desired, customize the code for your website by editing the embed code variables as described below:
	6. Upload the web page with the embed code to your web server.  The embedded program guide will dynamically update to display your current program schedule.


	Using Virtual Channels
	Overview
	1. Select Virtual Channel 1 or 2 by clicking the corresponding “Channel” button on top of the Virtual Channel editor screen (see Illustration 251, Virtual Channel Editor on page 408).
	2. If you have a new TOTAL INFO subscription or just wish to take advantage of the free trial, you will need to submit the necessary location and contact information before you can display TOTAL INFO content in your Virtual Channel playlists.  TOTAL I...
	3. Refer to the following sections for playlist management instructions:
	4. Activate Virtual Channel playlists for display according to “Displaying Virtual Channel Playlists,” on page 434.

	TOTAL INFO Configuration
	1. If you are not already on the Virtual Channel editor screen (see Illustration 251, Virtual Channel Editor), click on the “Virtual Channel” menu button.
	2. On the Virtual Channel editor screen, click on the “Channel” button for the Virtual Channel you would like to configure (see Illustration 251, Virtual Channel Editor on page 408).
	a. Click the “TOTAL INFO Configuration” button on the selected Virtual Channel (see Illustration 252).
	b. If you are using the same TOTAL INFO subscription for both Virtual Channels, click the “Next” button following the subscription location information (see Illustration 254) and proceed to the next step.  Otherwise, click “Cancel” and contact LEIGHTR...
	c. In the subscription configuration box (see Illustration 255), enter the following information:
	d. Click “Next” once you are satisfied with your settings or “Cancel” to abort.  Clicking “Next” will cause WebNEXUS to ask whether or not you would like to transmit your TOTAL INFO activation information to LEIGHTRONIX.  Please read the TOTAL INFO us...
	e. If you clicked “Accept,” a subscription information box will appear.  At this time, you have the option to select one or more data categories listed on the box and then click the “Add” button to immediately add the selected TOTAL INFO content to yo...
	f. Click “Done” to close the last window in the TOTAL INFO subscription configuration process.

	1. Click the “Advanced” button on the top of the Virtual Channel screen to display the “Advanced Virtual Channel Options” window.  Click the “TOTAL INFO” tab (see Illustration 257, "Advanced Virtual Channel Options").
	2. If you do not display an overlay, select “NONE” from the “Logo Bug Overlay” drop down menu for the currently selected Virtual Channel.  Otherwise, click the “Upload Image” button to open the “TOTAL INFO Bug Upload” window (see Illustration 258).
	3. Either enter the file path of the desired PNG overlay or click the “Browse” button to open the “Choose file to upload” window shown in Illustration 259.  Navigate to the desired file and click “Open.”
	4. Click the “Upload” button on the upload window to add the overlay to the “Logo Bug Overlay” drop down menu on the “Advanced Virtual Channel Options” box’s “TOTAL INFO” tab.
	5. Select the uploaded overlay file from the selected Virtual Channel’s “Logo Bug Overlay” drop down menu.  The selected overlay file will only be displayed over TOTAL INFO content.
	1. Click the “Advanced” button on the top of the Virtual Channel screen to display the “Advanced Virtual Channel Options” window.  Click the “TOTAL INFO” tab (see Illustration 257, "Advanced Virtual Channel Options").
	2. From the “Audio Source” drop down box for the currently selected Virtual Channel, select “From MPEG” to opt for the default music included with each TOTAL INFO video background file or select an audio source connected to one of your inputs as follows:
	1. Ensure the “Automatically Update TOTAL INFO MPEG files” box is checked.  If not, select it and click the “Save” button.
	2. Click the “Check for Update” button to check for updated video background files.
	3. Close the options window by clicking the “Cancel” button or “x” icon.  The update will continue to run as a background process.
	1. From the selected Virtual Channel tab screen, click the “Advanced” button and then click on the “General” tab to display the window shown in Illustration 263.
	2. Under the “Zone Mode” section, single click to select one of the following zone display modes:
	3. Click “Save” to make the change or “Cancel” to abort. If you selected either the “With Virtual Channel” or “Always” mode, you will notice that the “TOTAL INFO” icons are changed into a checklist on the Virtual Channel editor.  TOTAL INFO weather is...

	Creating/Modifying Virtual Channel Playlists
	1. If you are modifying an existing playlist, load it according to the corresponding set of steps below.  Otherwise, skip to step 2 on page 426.
	2. Add, remove, and re-order resources in the Virtual Channel playlist window according to Illustration 267 and Table 60.  Virtual Channel playlist resources will play in the order listed.  Display durations for each resource type are as follows:
	3. If any switcher input resources were added to the playlist, access each resource’s display duration setting by double clicking its length on the playlist window.  The resource’s length field will become active, allowing you to type a new length int...
	4. If any slide shows were added to your playlist, you may add or remove audio by clicking the “Advanced” button and then the “General” tab (see Illustration 268).  Any audio preferences you specify will apply to all slide shows.  From the “Background...
	5. Once you have finished creating or modifying your playlist, either continue to “Saving Virtual Channel Playlists” on page 430 to learn about the Virtual Channel Editor’s options for saving a playlist or click the “Current” button to add the resourc...

	Saving Virtual Channel Playlists
	1. Create the playlist according to “Creating/Modifying Virtual Channel Playlists,” on page 424.
	2. Save the playlist according to one of the following save options:
	3. If desired, immediately activate your Virtual Channel and display your playlist according to “Displaying Virtual Channel Playlists,” on page 434.

	Displaying Virtual Channel Playlists
	1. If your day/default playlist(s) are saved in a Virtual Channel configuration file (.vcf), load it in WebNEXUS as follows:
	a. Click the “Advanced” button to display the “Advanced Virtual Channel Options” window and then click the “List Config” tab to display the window shown in Illustration 266.
	b. Single click to select a configuration file in the file listing and then click the “Load” button to add the file’s playlists into the Virtual Channel’s day/”Default” presets.

	2. In your WinLGX schedule file (.nmg), be sure to do the following:
	a. Enable your Virtual Channels for use as WinLGX switchback resources by selecting “Yes” from the “Virtual Channel” drop down menu in the “System Configuration” properties (see “Configuring the Switch Type of a NEXUS Series System,” on page 136).
	b. Perform any of the following to fill channel switchbacks on the first two WinLGX channel output tabs:


	Deleting Virtual Channel Playlist Files
	1. From the “Preset/Day” drop down menu, select the playlist file you wish to delete.
	2. Click the  icon on the Virtual Channel toolbar.
	3. On the “Delete Preset” popup window, click “Yes” to delete the file or “No” to cancel the action and close the popup.


	Editing NEXUS Series Site Name and Location
	Changing NEXUS Series System Time
	Changing the Front Panel and “admin” Passwords
	Maintaining USB Drives and Compact Flash
	Updating System Firmware
	UltraNEXUS/UltraNEXUS-SDI Only: Configuring ePRO-BUS Setttings
	Configuring Total Share Settings
	Logging Out of WebNEXUS

	Total Backup
	Opening and Logging into Total Backup
	1. Select “Preferences” under the “Tools” menu to open the “Preferences” window.  Ensure the file path under “Total Backup application folder” matches the location where the Total Backup program is installed on your computer or network (see Illustrati...
	2. Open the Total Backup program using one of the following methods:

	Selecting Storage Locations for NEXUS Series Information
	1. From the “Total Backup” window, select “Local Path Settings” from the “File” menu to display the backup path window shown in Illustration 280.
	2. Save your NEXUS series data to one or more of the following locations:
	3. Click “OK” to save storage path settings and close the “Settings” window.
	4. Perform one of the following:

	Performing an Immediate Backup
	1. On the “UltraNEXUS/NEXUS Total Backup” window, check the boxes next to the NEXUS series server/controller storage areas you would like backed up.
	2. Click the “Backup” button to start an immediate backup.  Click the “Stop” button to halt a backup before it finishes.  To restart, click the “Backup” button again.  The backup will resume from where it left off.

	Performing Scheduled Backups
	1. Click the “Modify” button or “Scheduler Settings” under the “File” menu to open the “Backup Scheduler” Window shown in Illustration 281.
	2. Using the date and time drop down boxes, specify how often you would like the backup to occur.
	3. Check boxes next to the NEXUS series server/controller storage areas you would like backed up.
	4. Click “OK” to make backup schedule changes or “Cancel” to abort.

	Restoring NEXUS Series System Information
	1. On the “Total Backup” window, click the “Restore” button to open the “Restore” Window shown in Illustration 282.
	2. Check the “Unit Settings” box if you would like to restore network configuration settings, usernames and passwords, and front panel password.
	3. Check boxes next to the NEXUS series storage areas you would like to restore with the last saved backup information.
	4. Select “Overwrite existing files?” to replace existing files that have the same name as the backup files.
	5. Click “OK” to restore files or “Cancel” to abort.


	Total Import
	1. Double click on the Total Import desktop icon to display the Total Import program window (see Illustration 283, Total Import Main Window).
	2. Insert a DVD into your PC’s DVD drive.  Load the DVD titles (files) into the “Source” panel on the Total Import window according to the following steps (see Illustration 284):
	a. Click the “Browse” button.  In the “Browse for folder” window that appears, navigate to your local DVD drive and select the DVD drive letter.  Click “OK” to display a list of your DVD’s titles on the “Source” panel.
	b. Select each DVD title you would like to import by checking the boxes to the left of the titles.  A selected title will have a green checkmark in its box.

	3. In the “Settings” panel,  LEIGHTRONIX recommends leaving the “Stream copy video” option checked and just selecting a target audio bit rate to encode the DVD audio files into Audio layer II (see Illustration 285).  While the video and audio will sti...
	4. Under “Destination,” specify where on your PC you would like your newly encoded MPEG file(s) saved (see Illustration 287).  Total Import will create a separate MPEG file for each DVD title within the specified storage area.
	a. Click the “Browse” button and in the “Browse for folder” window that appears, navigate to a storage area on your PC large enough to hold the MPEG files.  The Total Import encoding process will create MPEG files that are larger than the original DVD...
	b. Use the “Temporary Storage” field’s “Browse” button to specify where on your PC you would like Total Import to store the imported DVD titles.  Total Import automatically deletes the imported titles once they are converted into an MPEG-2 file.
	c. Assign filenames with either the “Filename” or “Filename Prefix” field as follows:
	d. Check the “Overwrite” box if you want to save the file over an existing file with the same name.

	5. Click the “Start” button to import and encode the DVD titles.  The percentage of the job completed will be displayed in the “Source” panel next to the “Start” and “Stop” buttons.  Click “Stop” if you need to prematurely end the job.  Any of the job...
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